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About VMware Validated Design
Deployment of Region A 1
VMware Validated Design Deployment of Region A provides step-by-step instructions for installing,
configuring, and operating a software-defined data center (SDDC) based on the VMware Validated
Design for Software-Defined Data Center.

VMware Validated Design Deployment of Region A does not contain step-by-step instructions for
performing all required post-configuration tasks because they often depend on customer requirements.

Intended Audience
The VMware Validated Design Deployment of Region A document is intended for cloud architects,
infrastructure administrators, and cloud administrators who are familiar with and want to use VMware
software to deploy in a short time and manage an SDDC that meets the requirements for capacity,
scalability, backup and restore, and extensibility for disaster recovery support.

Required VMware Software
VMware Validated Design Deployment of Region A is compliant and validated with certain product
versions. See VMware Validated Design Release Notes for more information about supported product
versions.
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Region A Virtual Infrastructure
Implementation 2
The Virtual Infrastructure in Region A is implemented through the following high-level procedures.

Procedure

1 Install and Configure ESXi Hosts in Region A

Start the deployment of your virtual infrastructure by installing and configuring all the ESXi hosts in
Region A.

2 Deploy and Configure the Platform Services Controller and vCenter Server Components in Region A

3 Deploy and Configure the NSX Instance for the Management Cluster in Region A

4 Deploy and Configure the Shared Edge and Compute Cluster Components in Region A

Deploy and configure the shared edge and compute cluster components.

5 Deploy and Configure the Shared Edge and Compute Cluster NSX Instance in Region A

Deploy and configure the NSX instance for the shared edge and compute cluster in Region A.

Install and Configure ESXi Hosts in Region A
Start the deployment of your virtual infrastructure by installing and configuring all the ESXi hosts in
Region A.

Procedure

1 Prerequisites for Installation of ESXi Hosts in Region A

2 Install ESXi Interactively on All Hosts in Region A

Install all ESXi hosts for all clusters interactively.

3 Configure the Network on All Hosts in Region A

After the initial boot, use the ESXi Direct Console User Interface (DCUI) for initial host network
configuration and administrative access.

4 Configure vSphere Standard Switch On a Host in the Management Cluster in Region A

You must perform network configuration from the VMware Host Client for a single host. You perform
network configuration for the other hosts after the deployment of the vCenter Server.
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5 Configure SSH and NTP on the First Host in Region A

Time synchronization issues can result in serious problems with your environment. Configure NTP
and SSH on the first host. NTP and SSH configuration for the other hosts will take place after the
installation of vCenter Server.

Prerequisites for Installation of ESXi Hosts in Region A
Install and configure the ESXi hosts for the management cluster and the shared edge and compute
cluster by using the same process.

Before you start:

n Make sure that you have a Windows host that has access to your data center. You use this host to
connect to the data center and perform configuration steps.

n Ensure that routing is in place between the two regional management networks 172.16.11.0/24 and
172.17.11.0/24 as this is required to join the common SSO domain.

You must also prepare the installation files.

n Download the ESXi ISO installer.

n Create a bootable USB drive that contains the ESXi Installation. See "Format a USB Flash Drive to
Boot the ESXi Installation or Upgrade" in vSphere Installation and Setup.

IP Addresses, Hostnames, and Network Configuration
The following values are required to configure your hosts.

Table 2‑1.  Management Cluster Hosts

FQDN IP VLAN ID  Default Gateway NTP Server

sfo01m01esx01.sfo01.rainpole.local 172.16.11.101 1611 172.16.11.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

sfo01m01esx02.sfo01.rainpole.local 172.16.11.102 1611 172.16.11.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

sfo01m01esx03.sfo01.rainpole.local 172.16.11.103 1611 172.16.11.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

sfo01m01esx04.sfo01.rainpole.local 172.16.11.104 1611 172.16.11.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

Table 2‑2.  Shared Edge and Compute Cluster Hosts

FQDN IP VLAN ID Default Gateway NTP Server

sfo01w01esx01.sfo01.rainpole.local 172.16.31.101 1631 172.16.31.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

sfo01w01esx02.sfo01.rainpole.local 172.16.31.102 1631 172.16.31.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local
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Table 2‑2.  Shared Edge and Compute Cluster Hosts (Continued)

FQDN IP VLAN ID Default Gateway NTP Server

sfo01w01esx03.sfo01.rainpole.local 172.16.31.103 1631 172.16.31.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

sfo01w01esx04.sfo01.rainpole.local 172.16.31.104 1631 172.16.31.253 n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

Install ESXi Interactively on All Hosts in Region A
Install all ESXi hosts for all clusters interactively.

Procedure

1 Power on the sfo01m01esx01 host.

2 Mount the USB drive containing the ESXi ISO file and boot from that USB drive. 

3 On the Welcome to the VMware 6.5.0 Installation screen, press Enter to start the installation.

4 On the End User License Agreement (EULA) screen, press F11 to accept the EULA.

5 On the Select a Disk to Install or Upgrade screen, select the USB drive or SD card under local
storage to install ESXi and press Enter to continue.
 

 
6 Select the keyboard layout and press Enter.

7 Enter the esxi_root_user_password, enter the password a second time to confirm the spelling and
press Enter.

8 On the Confirm Install screen, press F11 to start the installation.

9 After the installation completes successfully, unmount the USB drive and press Enter to reboot the
host.

10 Repeat this procedure for all hosts, using the respective values for each host you configure.

Deployment for Region A
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Configure the Network on All Hosts in Region A
After the initial boot, use the ESXi Direct Console User Interface (DCUI) for initial host network
configuration and administrative access.

Perform the following tasks to configure the host network settings:

n Configure the network adapter (vmk0) and VLAN ID for the Management Network.

n Configure the IP address, subnet mask, gateway, DNS server, and FQDN for the ESXi host.

Repeat this procedure for all hosts in the management and shared edge and compute clusters. Enter the
respective values from the prerequisites section for each host that you configure. See Prerequisites for
Installation of ESXi Hosts in Region A.

Procedure

1 Open the DCUI on the physical ESXi host sfo01m01esx01.sfo01.rainpole.local.

a Open a console window to the host.

b To enter the DCUI, press F2.

c Log in using the following credentials.

Setting Value

User name root

Password esxi_root_user_password

2 Configure the network.

a Select Configure Management Network and press Enter.

b Select VLAN (Optional) and press Enter.

c Enter 1611 as the VLAN ID for the Management Network and press Enter.

d Select IPv4 Configuration and press Enter.

e Configure the IPv4 network using the following settings and press Enter.

Setting Value

Set static IPv4 address and network
configuration

Selected

IPv4 Address 172.16.11.101

Subnet Mask 255.255.255.0

Default Gateway 172.16.11.253
 

f Select DNS Configuration and press Enter. 

Deployment for Region A
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g Configure DNS by using the following settings and press Enter.

Setting Value

Use the following DNS Server
address and hostname

Selected

Primary DNS Server 172.16.11.5

Alternate DNS Server 172.16.11.4

Hostname sfo01m01esx01.sfo01.rainpole.local
 

h Select Custom DNS Suffixes and press Enter.

i Ensure that there are no suffixes listed and press Enter.

3 After you configure all host network settings, press Escape to exit and press Y to confirm the
changes.

4 Repeat this procedure for all hosts.

Configure vSphere Standard Switch On a Host in the Management
Cluster in Region A
You must perform network configuration from the VMware Host Client for a single host. You perform
network configuration for the other hosts after the deployment of the vCenter Server.

You configure a vSphere Standard Switch with two port groups:

n The existing virtual machine port group.

n VMkernel port group.

This configuration provides connectivity and common network configuration for virtual machines that
reside on each host.

Procedure

1 Log in to the vSphere host using the VMware Host Client.

a Open a Web browser and go to https://sfo01m01esx01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password esxi_root_user_password
 

2 Click OK to Join the Customer Experience Improvement Program.

3 Configure a VLAN for the VM Network port group.

a In the Navigator, click Networking, click the Port Groups tab, select the VM Network port group,
and click Edit Settings.

b On the Edit port group - VM Network window, enter 1611 for VLAN ID, and click Save.

Deployment for Region A
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Configure SSH and NTP on the First Host in Region A
Time synchronization issues can result in serious problems with your environment. Configure NTP and
SSH on the first host. NTP and SSH configuration for the other hosts will take place after the installation
of vCenter Server.

Procedure

1 Log in to the vSphere host using the VMware Host Client.

a Open a Web browser and go to https://sfo01m01esx01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password esxi_root_user_password
 

2 Configure SSH.

a In the Navigator, click Manage, click the Services tab, select the TSM-SSH service, and click the
Actions menu. Select Policy and click Start and stop with host.

b Click Start to start the service.

3 Configure the NTP Daemon (ntpd).

a In the Navigator, click Manage, click the System tab, click Time & date, and click Edit Settings.

b In the Edit Time configuration dialog box, select the Use Network Time Protocol (enable NTP
client) radio button, change the NTP service startup policy to Start and stop with host, and
enter ntp.sfo01.rainpole.local,ntp.lax01.rainpole.local.

c Click Save.

d Start the service by clicking Actions, hover over NTP service, and select Start.

Deploy and Configure the Platform Services Controller
and vCenter Server Components in Region A
Deploy and configure the components for both the management cluster and the shared edge and
compute cluster.

Procedure

1 Prerequisites for Implementation of Platform Services Controllers and vCenter Server Components
in Region A

Before you deploy the Platform Services Controllers and vCenter Server components, verify that
your environment satisfies the requirements.

2 Deploy the External Platform Services Controllers for the vCenter Server Instances in Region A

Deployment for Region A
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3 Join the Platform Services Controller Instances to Active Directory in Region A

After you have successfully installed the Platform Services Controller instance, you must add the
appliance to your Active Directory domain. After that, add the Active Directory domain as an identity
source to vCenter Single Sign-On. Users in the Active Directory domain are then visible to vCenter
Single Sign-On and can be assigned permissions to view or manage SDDC components.

4 Replace the Platform Services Controller Certificates in Region A

To establish trusted connection with the other SDDC management components, you replace the
default or expiring machine SSL certificate on each Platform Services Controller instance in the
region with a custom certificate. The certificate, generated by the CertGenVVD utility, is signed by the
certificate authority (CA) available on the parent Active Directory (AD) server .

5 Update the Platform Services Controller SSO Configuration and Endpoints in Region A

Before installing vCenter Server, the Platform Services Controller endpoints must be updated to
reflect the name of the load balancer's virtual IP.

6 Deploy the Management vCenter Server Instance in Region A

You can now install the vCenter Server appliance for the management applications and configure
licensing and security.

7 Replace the Certificate of the Management vCenter Server in Region A

To establish trusted connection with the other SDDC management components, you replace the
machine SSL certificate on each vCenter Server instance in the region with a custom certificate. The
certificate, generated by the CertGenVVD utility, is signed by the certificate authority (CA) available
on the parent Active Directory (AD) server.

8 Set SDDC Deployment Details on the Management vCenter Server in Region A

9 Configure the Management Cluster in Region A

Create and configure the vSphere cluster.

10 Create a vSphere Distributed Switch for the Management Cluster in Region A

After adding all ESXi hosts to the cluster, create a vSphere Distributed Switch to handle the SDDC
traffic. You also create port groups to prepare your environment to migrate the Platform Services
Controller and vCenter Server instances to the distributed switch.

11 Create vSAN Disk Groups for the Management Cluster in Region A

vSAN disk groups must be created on each host that is contributing storage to the vSAN datastore.

12 Enable vSphere HA on the Management Cluster in Region A

After the vSphere distributed switch has been created and connected with all hosts, enable vSphere
High Availability on the cluster.

13 Change Advanced Options on the ESXi Hosts in the Management Cluster in Region A

Change the default ESX Admins group to achieve greater levels of security and enable vSAN to
provision the Virtual Machine Swap files as thin to conserve space in the vSAN datastore.

Deployment for Region A
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14 Mount NFS Storage for the Management Cluster in Region A

Mount an NFS datastore as a storage location for future backups.

15 Create and Apply the Host Profile for the Management Cluster in Region A

Host Profiles ensure that all hosts in the cluster have the same configuration.

16 Set Virtual SAN Policy on Management Virtual Machines in Region A

After you apply the host profile to all hosts, set the storage policy of the virtual machines to the vSAN
Default Storage Policy. Set the Platform Services Controller and vCenter Server appliances to the
default vSAN storage policy.

17 Create the VM and Template Folders in Region A

Create folders to group objects of the same type for easier management.

18 Create Anti-Affinity Rules for the Platform Services Controllers in Region A

Anti-Affinity rules prevent virtual machines from running on the same host. This helps to maintain
redundancy in the event of host failures.

19 Create VM Groups to Define Startup Order in the Management Cluster in Region A

You can define the startup order of virtual machines with VM Groups. Startup orders are used during
vSphere HA events such that vSphere HA powers on virtual machines in the correct order.

Prerequisites for Implementation of Platform Services Controllers
and vCenter Server Components in Region A
Before you deploy the Platform Services Controllers and vCenter Server components, verify that your
environment satisfies the requirements.

IP Addresses and Host Names
Verify that static IP addresses and FQDNs for the management networks are available for the SDDC
deployment.

Allocate the required IP addresses and FQDNs:

n Two static IP addresses and FQDNs for the Platform Services Controllers

n One static IP address and FQDN for the Platform Services Controller load balancer

n One static IP address and FQDN for the Management vCenter Server

Table 2‑3.  Network Names for SDDC Components

vCenter Server and Platform Services Controllers Network

vCenter Server VM Network

Platform Services Controllers VM Network

Deployment for Region A
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Table 2‑4.  IP Addresses and Host Names for the vCenter Server and Platform Services
Controllers in Region A

Role IP Address FQDN

Management Platform Services
Controller

172.16.11.61 sfo01m01psc01.sfo01.rainpole.local

Compute Platform Services
Controller

172.16.11.63 sfo01w01psc01.sfo01.rainpole.local

Management vCenter Server 172.16.11.62 sfo01m01vc01.sfo01.rainpole.local

PSC load balancer VIP address 172.16.11.61 (temporary) sfo01psc01.sfo01.rainpole.local

172.16.11.71

Default gateway 172.16.11.253 -

DNS server n 172.16.11.5
n 172.16.11.4

-

Subnet mask 255.255.255.0 -

NTP servers n 172.16.11.251
n 172.16.11.252

n ntp.sfo01.rainpole.local

Deployment Prerequisites
Verify that your environment satisfies the following prerequisites for the deployment of Platform Services
Controller and vCenter Server.

Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per vCenter Server:
n Initial storage for the vCenter Server: 270 GB

n Required storage per Platform Services Controller node
n Initial storage for Platform Services Controller: 60 GB

Software Features n Verify that SSH is enabled on ESXi Hosts.

Installation Package n Download the .iso file for the vCenter Server and Platform Services Controller.

License n Verify that you have obtained vCloud Suite license with a quantity that satisfies the requirements of
this design.

Active Directory n Verify that you have a parent active directory with the SDDC user roles configured for the
rainpole.local domain.

svc-domain-join(Enterprise Admins)

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the vCenter Server and

Platform Services Controller nodes. See the VMware Validated Design Planning and Preparation
documentation.

Deployment for Region A
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Deploy the External Platform Services Controllers for the vCenter
Server Instances in Region A
Two external Platform Services Controller instances must be deployed in Region A. The first instance is
associated with the management cluster and the second with the shared edge and compute cluster. Both
instances belong to the same SSO domain for Identity Management. Work through this procedure twice,
using the vCenter Server appliance ISO file and the customized data for each instance. 

Procedure

1 Log in to the Windows host that has access to your data center as an administrator.

2 Start the vCenter Server Appliance Installer wizard.

a Browse to the vCenter Server Appliance ISO file.

b Open the <dvd-drive>:\vcsa-ui-installer\win32\Installer.exe application file.

3 Complete Stage 1 of the vCenter Server Appliance Deployment wizard.

a Click Install to start the installation.

b Click Next on the Introduction page.

c On the End user license agreement page, select the I accept the terms of the license
agreement check box, and click Next.

d On the Select deployment type page, click Platform Services Controller and click Next.

e On the Appliance deployment target page, enter the following settings and click Next.

Setting Value

ESXi host or vCenter Server name sfo01m01esx01.sfo01.rainpole.local

HTTPS port 443

User name root

Password esxi_root_user_password

f In the Certificate Warning dialog box, click Yes to accept the host certificate.

g On the Set up appliance VM page, enter the following settings, and click Next.

Setting Management Value Compute Value

VM name sfo01m01psc01 sfo01w01psc01

Root password mgmtpsc_root_password comppsc_root_password

Confirm root password mgmtpsc_root_password comppsc_root_password

Deployment for Region A
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h On the Select datastore page, perform the following steps, and click Next.

Setting Management Value Edge/Compute Value

Select
datastore

Select Install on a new Virtual SAN datastore on the target
host and click Next

Select the existing vSAN
datastore

Confirm at least one Cache tier and two Capacity tier disks
have been claimed

Select Enable Thin Disk Mode Select Enable Thin Disk Mode

i On the Configure network settings page, enter the following settings and click Next.

Setting Management Value Edge/Compute Value

Network VM Network VM Network

IP version IPv4 IPv4

IP assignment static static

System name sfo01m01psc01.sfo01.rainpole.local sfo01w01psc01.sfo01.rainpole.local

IP address 172.16.11.61 172.16.11.63

Subnet mask or prefix length 255.255.255.0 255.255.255.0

Default gateway 172.16.11.253 172.16.11.253

DNS servers 172.16.11.5,172.16.11.4 172.16.11.5,172.16.11.4

HTTP 80 80

HTTPS 443 443

j On the Ready to complete stage 1 page, review the configuration and click Finish to start the
deployment.

k When the deployment completes, click Continue to proceed to second stage of the installation,
setting up the Platform Services Controller Appliance.

4 Complete Stage 2 of the Set Up Platform Services Controller Appliance wizard.

a Click Next on the Introduction page.

b On the Appliance configuration page, enter the following settings and click Next.

Setting Value

Time synchronization mode Synchronize time with NTP servers

NTP servers (comma-separated list) ntp.sfo01.rainpole.local, ntp.lax01.rainpole.local

SSH access Enabled

Deployment for Region A
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c On the SSO configuration page, enter the following settings, and click Next.

Setting Management Value Edge/Compute Value

SSO configuration Create a new SSO domain Join an existing SSO domain

Platform Services Controller N/A sfo01m01psc01.sfo01.rainpole.local

HTTPS port N/A 443

Single Sign-On domain name vsphere.local vsphere.local

Single Sign-On password sso_password sso_password

Confirm password sso_password N/A

Site name SFO01 N/A

d On the SSO Site Name page, select Join an existing site radio button, choose SFO01 from the
SSO site name drop-down menu, and click Next. This page appears only during the deployment
of the second Platform Services Controller.

e On the Configure CEIP page, verify that the Join the VMware's Customer Experience
Improvement Program (CEIP) check box is checked and click Next.

f On the Ready to complete page, review the configuration and click Finish to complete the
setup.

g Click OK on the Warning.

h When the installation completes, click Close.

5 Repeat this procedure for each platform services controller, using the respective values for each.

Join the Platform Services Controller Instances to Active Directory
in Region A
After you have successfully installed the Platform Services Controller instance, you must add the
appliance to your Active Directory domain. After that, add the Active Directory domain as an identity
source to vCenter Single Sign-On. Users in the Active Directory domain are then visible to vCenter Single
Sign-On and can be assigned permissions to view or manage SDDC components.

Perform this procedure twice, once for the management cluster and again for the shared edge and
compute cluster.

Platform Services Controller URL

Platform Services Controller for the management cluster https://sfo01m01psc01.sfo01.rainpole.local

Platform Services Controller for the shared edge and compute
cluster

https://sfo01w01psc01.sfo01.rainpole.local

Deployment for Region A

VMware, Inc.  16



Procedure

1 Log in to the administration interface of the Platform Services Controller.

a Open a Web browser and go to https://sfo01m01psc01.sfo01.rainpole.local.

b Click the link for Platform Services Controller web interface.

c Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
 

2 Add the Platform Services Controller instance to the Active Directory domain.

a In the Navigator, click Appliance Settings,  click the Manage tab, and click Join.

b In the Join Active Directory Domain dialog box, enter the following settings, and click OK.

Setting Value

Domain sfo01.rainpole.local

User name svc-domain-join@rainpole.local

Password svc-domain-join_password
 

3 To apply the changes, reboot the Platform Services Controller instance.

a Click the Appliance settings tab, and click the VMware Platform Services Appliance link.

b Log in to the VMware vSphere Appliance Management interface with the following credentials.

Setting Value

User name root

Password psc_root_password
 

c On the Summary page, click Reboot.

d In the System Reboot dialog box, click Yes.

e Wait for the reboot process to finish.

4 Log in to https://sfo01m01psc01.sfo01.rainpole.local again using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
 

5 Verify that the Platform Services Controller has successfully joined the domain, click Appliance
Settings and click the Manage tab.

Deployment for Region A
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6 Add Active Directory as a vCenter Single Sign-On identity source.

a In the Navigator, click Configuration and click the Identity Sources tab.

b To add a new identity source, click the Add icon.

c In the Add Identity Source dialog box, select the following settings and click OK. 

Setting Value

Identity source type Active Directory (Integrated Windows Authentication)

Domain name SFO01.RAINPOLE.LOCAL

Use machine account Selected
 

d Under Identity Sources, select the rainpole.local identity source and click Set as Default
Domain to make rainpole.local the default domain.

e In the confirmation dialog box, click Yes.

7 Repeat steps 1 through 5 of this procedure for the Platform Services Controller for the shared edge
and compute cluster. Only perform step 6 on the Platform Services Controller for the Management
cluster.

Note   Do not repeat step 6 when joining the Shared Edge and Compute Platform Services Controller
to Active Directory.

Replace the Platform Services Controller Certificates in Region A
To establish trusted connection with the other SDDC management components, you replace the default
or expiring machine SSL certificate on each Platform Services Controller instance in the region with a
custom certificate. The certificate, generated by the CertGenVVD utility, is signed by the certificate
authority (CA) available on the parent Active Directory (AD) server .

The machine certificate on both Platform Services Controller instances in the region must be the same
because they are load-balanced according to this validated design. The certificate must have the same
common name as the load-balanced Fully Qualified Domain Name (FQDN). Each Platform Services
Controller FQDN and short name, as well as the load-balanced FQDN and short name must be in the
Subject Alternative Name (SAN) of the generated certificate.

Table 2‑5.  Certificate-Related Files on Platform Services Controller Instances

Platform Services Controller Certificate Filename

sfo01m01psc01.sfo01.rainpole.local n sfo01psc01.1.cer
n sfo01psc01.key
n Root64.cer

sfo01w01psc01.sfo01.rainpole.local n sfo01psc01.1.cer
n sfo01psc01.key
n Root64.cer

Deployment for Region A
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Procedure

1 Open a Secure SHell connection to the Platform Services Controller virtual machine.

a Open an SSH connection to sfo01m01psc01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

Username root

Password psc_root_password
 

2 To allow secure copy (scp) connections for the root user, change the Platform Services Controller
command shell to the Bash shell.

shell

chsh -s "/bin/bash" root

3 Copy the generated certificates to the Platform Services Controller.

a To create a new temporary folder, run the following command.

mkdir -p /root/certs

b Copy the certificate files sfo01psc01.1.cer, sfo01psc01.key, and Root64.cer to
the /root/certs folder.

You can use an scp software like WinSCP.

4 Replace the certificate on the Platform Services Controller.

a Start the vSphere Certificate Manager utility on the Platform Services Controller.

/usr/lib/vmware-vmca/bin/certificate-manager

b Select Option 1 (Replace Machine SSL certificate with Custom Certificate).

c Enter the default vCenter Single Sign-On user name administrator@vsphere.local and the
vsphere_admin password.

d Select Option 2 (Import custom certificate(s) and key(s) to replace existing Machine SSL
certificate).

e When prompted for the custom certificate, enter /root/certs/sfo01psc01.1.cer.

f When prompted for the custom key, enter /root/certs/sfo01psc01.key.

g When prompted for the signing certificate, enter /root/certs/Root64.cer.

h When prompted to Continue operation, enter Y.

The Platform Services Controller services automatically restart.
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5 After Certificate Manager replaces the certificates, restart the vami-lighttp service to update the
certificate in the virtual application management interface (VAMI) and to remove certificate files from
Platform Services Controller.

service vami-lighttp restart

cd /root/certs

rm sfo01psc01.1.cer sfo01psc01.key Root64.cer

6 Switch the shell back to the appliance shell.

chsh -s /bin/appliancesh root

7 Repeat the procedure to replace the certificate on sfo01w01psc01.sfo01.rainpole.local.

Update the Platform Services Controller SSO Configuration and
Endpoints in Region A
Before installing vCenter Server, the Platform Services Controller endpoints must be updated to reflect
the name of the load balancer's virtual IP.

Prerequisites

Before completing this procedure, a DNS A record must be created for the load balancer's virtual IP
address and FQDN. This A record will temporarily be set to the IP address of the Management PSC
(sfo01m01psc01.sfo01.rainpole.local) and will be adjusted to the proper address after the load balancer is
configured.

Procedure

1 Create a DNS record for the load balancer FQDN.

a Open a remote desktop connection to your DNS server.

b Create a DNS A record with the values shown in the following table.

FQDN IP

sfo01psc01.sfo01.rainpole.local 172.16.11.61

2 Update the Platform Services Controller SSO configuration on sfo01m01psc01.sfo01.rainpole.local.

a Open an SSH connection to sfo01m01psc01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password mgmtpsc_root_password
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c Enter cd /usr/lib/vmware-sso/bin/ and press Enter.

d Enter python updateSSOConfig.py --lb-fqdn=sfo01psc01.sfo01.rainpole.local and
press Enter.

3 Update the Platform Services Controller SSO configuration on sfo01w01psc01.sfo01.rainpole.local.

a Open an SSH connection to sfo01w01psc01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password comppsc_root_password

c Enter cd /usr/lib/vmware-sso/bin/and press Enter.

d Enter python updateSSOConfig.py --lb-fqdn=sfo01psc01.sfo01.rainpole.local and
press Enter.

4 Update the Platform Services Controller endpoints on sfo01m01psc01.sfo01.rainpole.local.

Note   Only perform this procedure on one of the Platform Services Controllers.

a Open an SSH connection to sfo01m01psc01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password mgmtpsc_root_password

c Enter cd /usr/lib/vmware-sso/bin/ and press Enter.

d Enter python UpdateLsEndpoint.py ––lb-fqdn=sfo01psc01.sfo01.rainpole.local
--user=Administrator@vsphere.local and press Enter.

e Enter the vsphere_admin_password when prompted.

Deploy the Management vCenter Server Instance in Region A
You can now install the vCenter Server appliance for the management applications and configure
licensing and security.

Procedure

1 Start the vCenter Server Appliance Deployment wizard.

a Browse to the vCenter Server Appliance ISO file.

b Open the <dvd-drive>:\vcsa-ui-installer\win32\Installer application file.
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2 Complete the vCenter Server Appliance Deployment wizard.

a To start the installation, click Install.

b Click Next on the Introduction page.

c On the End user license agreement page, select the I accept the terms of the license
agreement check box and click Next.

d On the Select deployment type page, under External Platform Services Controller, select
the vCenter Server (Requires External Platform Services Controller) radio button and click
Next.

e On the Appliance deployment target page, enter the following settings and click Next.

Setting Value

ESXi host or vCenter Server name sfo01m01esx01.sfo01.rainpole.local

HTTPS port 443

User name root

Password esxi_root_user_password

f In the Certificate Warning dialog box, click Yes to accept the host certificate.

g On the Set-up appliance VM page, enter the following settings and click Next.

Setting Value

VM name sfo01m01vc01

Root password mgmtvc_root_password

Confirm root password mgmtvc_root_password

h On the Select deployment size page, select Small vCenter Server and click Next.

i On the Select datastore page, select the vsanDatastore datastore, select the Enable Thin Disk
Mode check box, enter sfo01-m01dc for the Datacenter Name, enter sfo01-m01-mgmt01 for the
Cluster Name, and click Next.
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j On the Configure network settings page, enter the following settings and click Next.

Setting Value

Network VM Network

IP version IPv4

IP assignment Static

System name sfo01m01vc01.sfo01.rainpole.local

IP address 172.16.11.62

Subnet mask or prefix length 255.255.255.0

Default gateway 172.16.11.253

DNS servers 172.16.11.5,172.16.11.4

HTTP 80

HTTPS 443

k To start the deployment, on the Ready to complete stage 1 page, review the configuration and
click Finish.

l To proceed to stage 2 of the installation, click Continue when the deployment completes.

3 Complete the Install - Stage 2: Set Up vCenter Server Appliance wizard.

a Click Next on the Introduction page.

b On the Appliance configuration page, enter the following settings and click Next.

Setting Value

Time synchronization mode Synchronize time with NTP servers

NTP servers (comma-separated list) ntp.sfo01.rainpole.local

SSH access Enabled
 

c On the SSO configuration page, enter the following settings and click Next.

Setting Value

Embedded or External Platform
Services Controller

sfo01psc01.sfo01.rainpole.local

HTTPS port 443

Single Sign-On domain name vsphere.local

Single Sign-On user name administrator

Single Sign-On password vsphere_admin_password
 

d On the Ready to Complete page, review your entries and click Finish.

e Click OK on the Warning dialog box.

f To shut down the wizard, click Close when the set up completes.
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4 Add new licenses for this vCenter Server instance and the ESXi hosts.

a Open a Web browser and go to
https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
 

c Click the Home icon above the Navigator and select the Administration menu item.

d On the Administration page, click Licenses and click the Licenses tab.

e To add license keys, click the Create New Licenses icon.

f On the Enter license keys page, enter license keys for vCenter Server, ESXi and vSAN, one per
line, and click Next.

g On the Edit license name page, enter a descriptive name for each license key and click Next.

h On the Ready to complete page, review your entries and click Finish.

5 Assign the newly added licenses to the vCenter Server asset.

a Click the Assets tab.

b Select the vCenter Server instance, and click the Assign License icon.

c Select the vCenter Server license that you entered in the previous step, and click OK. 

6 Assign the vCenterAdmins domain group to the vCenter Server Administrator role.

a In the Navigator, click Administration.

b In the Administration window, click Global Permissions and select the Manage tab.

c In the Global Permissions box, click the Add Permission icon.

d In the Global Permissions Root - Add Permissions window, click the Add button.

e Select sfo01.rainpole.local from the Domain drop-down menu.

f Enter vCenterAdmins in the Search text box and press Enter.

g Select the vCenterAdmins group, click the Add button, and then click OK.

h Ensure Administrator is selected and the Propagate to children check box is selected under
Assigned Role and click OK.
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Replace the Certificate of the Management vCenter Server in
Region A
To establish trusted connection with the other SDDC management components, you replace the machine
SSL certificate on each vCenter Server instance in the region with a custom certificate. The certificate,
generated by the CertGenVVD utility, is signed by the certificate authority (CA) available on the parent
Active Directory (AD) server.

Table 2‑6.  Certificate-Related Files on the vCenter Server Instance

vCenter Server FQDN Files for Certificate Replacement

sfo01m01vc01.sfo01.rainpole.local n sfo01m01vc01.key
n sfo01m01vc01.1.cer
n Root64.cer

Procedure

1 Log in to vCenter Server by using Secure Shell (SSH) client.

a Open an SSH connection to the sfo01m01vc01.sfo01.rainpole.local virtual machine.

b Log in using the following credentials.

Setting Value

User name root

Password vcenter_server_root_password
 

2 To allow secure copy (scp) connections for the root user, change the vCenter Server appliance
command shell to the Bash shell .

shell

chsh -s "/bin/bash" root

3 Copy the generated certificates to the vCenter Server Appliance.

a Run the following command to create a new temporary folder.

mkdir -p /root/certs

b Copy the certificate files sfo01m01vc01.1.cer, sfo01m01vc01.key, and Root64.cer to
the /root/certs folder.

You can use an scp software such as WinSCP.
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4 Replace the CA-signed certificate on the vCenter Server instance.

a Start the vSphere Certificate Manager utility on the vCenter Server instance.

/usr/lib/vmware-vmca/bin/certificate-manager

b Select Option 1 (Replace Machine SSL certificate with Custom Certificate), enter the
default vCenter Single Sign-On user name administrator@vsphere.local and the
vsphere_admin_password password.

c When prompted for the Infrastructure Server IP, enter the IP address of the Platform Services
Controller that manages this vCenter Server instance.

vCenter Server instance IP Address of managing Platform Services Controller

sfo01m01vc01.sfo01.rainpole.local 172.16.11.61
 

d Select Option 2 (Import custom certificate(s) and key(s) to replace existing Machine SSL
certificate).

e When prompted, provide the full path to the custom certificate, the root certificate file, and the key
file that you copied over earlier, and confirm the import with Yes (Y).

vCenter Server Input to the vSphere Certificate Manager Utility

sfo01m01vc01.sfo01.rainpole.local Please provide valid custom certificate for Machine SSL.

File : /root/certs/sfo01m01vc01.1.cer

Please provide valid custom key for Machine SSL.

File : /root/certs/sfo01m01vc01.key

Please provide the signing certificate of the Machine SSL certificate.

File : /root/certs/Root64.cer
 

5 When status shows 100% Completed, wait several minutes until all vCenter Server services are
restarted.

6 Restart the vami-lighttp service to update the certificate on the virtual appliance management
interface (VAMI) and to remove certificate files.

service vami-lighttp restart

cd /root/certs/

rm sfo01m01vc01.1.cer sfo01m01vc01.key Root64.cer

Set SDDC Deployment Details on the Management vCenter Server
in Region A
Set an identity of your SDDC deployment on vCenter Server. You can also use this identity as a label in
tools for automated SDDC deployment.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Global Inventory Lists.

3 In the Navigator, click vCenter Servers under Resources.

4 Click the sfo01m01vc01.sfo01.rainpole.local vCenter Server object and click the Configure tab in
the central pane.

5 Under the Settings pane, click Advanced Settings and click the Edit button.

6 In the Edit Advanced vCenter Server Settings dialog box, set the following value pairs one by one,
clicking Add after each entry.

Name Value

config.SDDC.Deployed.Type VVD

config.SDDC.Deployed.Flavor Standard

config.SDDC.Deployed.Version 4.3.0

config.SDDC.Deployed.WorkloadDomain Management

config.SDDC.Deployed.Method DIY

config.SDDC.Deployed.InstanceId unique_identifier*

Note   * To generate a unique identifier, use the Online UUID Generator website 
https://www.uuidgenerator.net/ and copy/paste the UUID into the config.SDDC.Deployed.InstanceId
value. The Online UUID Generator is a universally unique identifier that generates random numbers
using a secure random number generator.

7 Click OK to close the window.

Configure the Management Cluster in Region A
Create and configure the vSphere cluster.

This process consists of the following actions:

n Enable vSphere DRS.

n Enable Enhanced vMotion Compatibility.
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n Add the hosts to the cluster.

n Add a host to the active directory domain.

n Rename the vSAN datastore.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Enable vSphere DRS.

a Expand the sfo01-m01dc data center object.

b Click the sfo01-m01-mgmt01 cluster object then click the Configure tab.

c Select the vSphere DRS under Services , and click Edit.

d Select the Turn On vSphere DRS check box then click OK.

3 Enable VMware EVC.

a Under the Configuration page, select the VMware EVC and click Edit.

b Set EVC mode to the highest available baseline that is supported for the lowest CPU architecture
on the hosts in the cluster and click OK.

4 Add additional hosts to the cluster.

a Right-click the sfo01-m01-mgmt01 cluster, and click Add Host.

b On the Name and location page, enter sfo01m01esx02.sfo01.rainpole.local in the Host
name or IP address text box and click Next.

c On the Connection settings page, enter the following credentials and click Next.

Setting Value

User name root

Password esxi_root_user_password
 

d In the Security Alert dialog box, click Yes.

e On the Host summary page, review the host information and click Next.

f On the Assign license page, select the ESXi license key that you entered during the vCenter
Server deployment and click Next.
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g On the Lockdown mode page, click Next.

h On the Resource pool page, click Next.

i On the Ready to complete page, review your entries and click Finish.

5 Repeat the previous step for the remaining hosts to add them to the cluster.

Setting Value

Host 3 sfo01m01esx03.sfo01.rainpole.local

Host 4 sfo01m01esx04.sfo01.rainpole.local
 

6 Add an ESXi host to the Active Directory domain

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01m01vc01.sfo01.rainpole.local tree.

b Select the sfo01m01esx01.sfo01.rainpole.local host.

c Click the Configure tab.

d Under System, select Authentication Services.

e In the Authentication Services panel, click the Join Domain button.

f In the Join Domain dialog box, enter the following settings and click OK.

Setting Value

Domain sfo01.rainpole.local

Using credentials Selected

User name svc-domain-join@rainpole.local

Password svc-domain-join_password
 

7 Set the Active Directory Service to Start and stop with host.

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01m01vc01.sfo01.rainpole.local tree.

b Select the sfo01m01esx01.sfo01.rainpole.local host.

c Click the Configure tab.

d Under System, select Security Profile.

e Click the Edit button next to Services.

f Select the Active Directory Service, change the Startup Policy to Start and stop with host,
and click OK.
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8 Rename the vSAN datastore.

a In the Navigator, click Storage and expand the entire sfo01m01vc01.sfo01.rainpole.local tree.

b Select vsanDatastore, and select Actions > Rename.

c In the Datastore - Rename dialog box, enter sfo01-m01-vsan01 as the datastore name, and
click OK.

Create a vSphere Distributed Switch for the Management Cluster
in Region A
After adding all ESXi hosts to the cluster, create a vSphere Distributed Switch to handle the SDDC traffic.
You also create port groups to prepare your environment to migrate the Platform Services Controller and
vCenter Server instances to the distributed switch.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create the vSphere Distributed Switch.

a In the Navigator, click Networking and expand the sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01dc data center, and select Distributed Switch > New Distributed
Switch to start the New Distributed Switch wizard.

c On the Name and location page, enter sfo01-m01-vds01 as the name and click Next.

d On the Select version page, ensure the Distributed switch: 6.5.0 radio button is selected and
click Next.

e On the Edit settings page, enter the following values and click Next.

Setting Value

Number of uplinks 2

Network I/O Control Enabled

Create a default port group Deselected
 

f On the Ready to complete page, review your entries and click Finish.
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3 Edit the settings of the sfo01-m01-vds01 distributed switch.

a Right-click the sfo01-m01-vds01 distributed switch and select Settings > Edit Settings.

b Click the Advanced tab.

c Enter 9000 as MTU (Bytes) value and click OK.

4 Create port groups in the sfo01-m01-vds01 distributed switch for the management traffic types.

a Right-click the sfo01-m01-vds01 distributed switch and select Distributed Port Group > New
Distributed Port Group. 

b Create port groups with the following settings and click Next.

Port Group Name Port Binding VLAN Type VLAN ID

sfo01-m01-vds01-
management

Ephemeral - no binding VLAN 1611

sfo01-m01-vds01-vmotion Static binding VLAN 1612

sfo01-m01-vds01-vsan Static binding VLAN 1613

sfo01-m01-vds01-nfs Static binding VLAN 1615

sfo01-m01-vds01-
replication

Static binding VLAN 1616

sfo01-m01-vds01-uplink01 Static binding VLAN 2711

sfo01-m01-vds01-uplink02 Static binding VLAN 2712

Note   The port group for VXLAN traffic is automatically created later during the configuration of
the NSX Manager.

c On the Ready to complete page, review your entries and click Finish.

d Repeat this step for each port group.

5 Change the port groups to use the Route Based on Physical NIC Load teaming algorithm.

a Right-click the sfo01-m01-vds01 distributed switch and select Distributed Port Group > Manage
Distributed Port Groups.

b On the Select port group policies page, select Teaming and failover and click Next.

c Click the Select distributed port groups button, add all port groups except sfo01-m01-vds01-
uplink01 and sfo01-m01-vds01-uplink02, click OK, and click Next.

d On the Teaming and failover page, select Route based on physical NIC load from the Load
balancing drop-down menu and click Next.

e Click Finish.

6 Configure the uplinks for the sfo01-m01-vds01-uplink01 and sfo01-m01-vds01-uplink02 port groups.

a Right click the sfo01-m01-vds01-uplink01 port group and click Edit Settings.

b Select Teaming and Failover.
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c Move Uplink2 to Unused uplinks and click OK.

d Right click the sfo01-m01-vds01-uplink02 port group and click Edit Settings.

e Select Teaming and Failover.

f Move Uplink1 to Unused uplinks and click OK.

7 Connect the ESXi host, sfo01m01esx01.sfo01.rainpole.local, to the sfo01-m01-vds01 distributed
switch by migrating its VMkernel network adapters.

a Right-click the sfo01-m01-vds01 distributed switch and click Add and Manage Hosts.

b On the Select task page, select Add hosts and click Next. 

c On the Select hosts page, click New hosts.

d In the Select new hosts dialog box, select sfo01m01esx01.sfo01.rainpole.local and click OK.

e On the Select hosts page, click Next.

f On the Select network adapter tasks page, ensure that Manage physical adapters
and Manage VMkernel adapters check boxes are selected and click Next.

g On the Manage physical network adapters page, click vmnic1 and click Assign uplink.

h In the Select an Uplink for vmnic1 dialog box, click Uplink2 and click OK.

i On the Manage physical network adapters page, click Next.

8 Configure the VMkernel network adapters.

a On the Manage VMkernel network adapters page, select vmk0 and click Assign port group.

b Select sfo01-m01-vds01-management and click OK.

c On the Manage VMkernel network adapters page, click On this switch and click New
adapter. 

d On the Add Networking page, click Select an existing network, select the sfo01-m01-vds01-
vsan port group, click OK, and click Next.

e On the Port properties page, select the vSAN check box and click Next.

f On the IPv4 settings page, select Use static IPv4 settings, enter IP address
172.16.13.101, enter subnet 255.255.255.0, and click Next.

g Click Finish.

h Repeat steps 8c to 8f to create the remaining VMkernel network adapters and then click Next.

Port Group Port Properties IPv4 Address Netmask

sfo01-m01-vds01-replication n vSphere Replication
n vSphere Replication NFC

172.16.16.101 255.255.255.0

sfo01-m01-vds01-nfs N/A 172.16.15.101 255.255.255.0
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i On the Analyze impact page, click Next.

j On the Ready to complete page, review your entries and click Finish.

9 Create the vMotion VMkernel adapter.

a In the Navigator, click Host and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

b Click sfo01m01esx01.sfo01.rainpole.local.

c Click the Configure tab and select VMkernel adapters.

d Click the Add host networking icon, select VMkernel Network Adapter, and click Next.

e On the Add Networking page, click Select an existing network, select the sfo01-m01-vds01-
vmotion port group, click OK, and click Next.

f On the Port properties page, select vMotion from the TCP/IP Stack drop-down menu and click
Next.

g On the IPv4 settings page, select Use static IPv4 settings, enter IP address
172.16.12.101, enter subnet 255.255.255.0, and click Next.

h On the Ready to complete page, review the configuration and click Finish.

10 Configure the MTU on the vMotion VMkernel adapter.

a Select the vMotion VMkernel adapter created in the previous step and click Edit Settings.

b Click the NIC Settings page.

c Enter 9000 for the MTU value and click OK.

11 Configure the vMotion TCP/IP stack.

a Under Networking , click TCP/IP configuration.

b Select vMotion and click the Edit TCP/IP stack configuration icon.

c Click Routing, under VMkernel gateway enter 172.16.12.253, and click OK.

Note   If the VMkernel gateway option is grayed out, make sure the vMotion VMkernel's TCP/IP
Stack is properly configured in Step 9.

12 Migrate the Platform Services Controllers and vCenter Server instances from the standard switch to
the distributed switch.

a In the Navigator, click Networking and expand the sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01-vds01 distributed switch and click Migrate VMs to Another Network.
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c On the Select source and destination networks page, browse the following networks and click
Next.

Setting Value

Source network VM Network

Destination network sfo01-m01-vds01-management

d On the Select VMs to migrate page, select sfo01m01psc01, sfo01w01psc01 and
sfo01m01vc01, and click Next.

e On the Ready to complete page, review your entries and click Finish.

13 Define Network I/O Control shares for the different traffic types on the sfo01-m01-vds01 distributed
switch.

a Click the sfo01-m01-vds01 distributed switch, click the Configure tab, and click Resource
Allocation > System traffic.

b Under System Traffic, configure each of the following traffic types with the following values.

Traffic Type Shares

Fault Tolerance (FT) Traffic Low

Management Traffic Normal

NFS Traffic Low

Virtual Machine Traffic High

iSCSI Traffic Low

vMotion Traffic Low

vSAN Traffic High

vSphere Data Protection Backup Traffic Low

vSphere Replication (VR) Traffic Low

14 Migrate the last physical adapter from the standard switch to the sfo01-m01-vds01 distributed switch.

a In the Navigator, click Networking and expand the sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01-vds01 distributed switch and select Add and Manage Hosts.

c On the Select task page, select Manage host networking and click Next.

d On the Select hosts page, click Attached hosts.

e In the Select member hosts dialog box, select sfo01m01esx01.sfo01.rainpole.local, click OK,
and click Next.

f On the Select network adapter tasks page, select Manage physical adapters only and
click Next.

g On the Manage physical network adapters page, select vmnic0 and click Assign uplink.

h In the Select an Uplink for vmnic0 dialog box, select Uplink1, click OK, and click Next.

Deployment for Region A

VMware, Inc.  34



i On the Analyze Impact page, click Next.

j On the Ready to complete page, click Finish.

15 Enable vSphere Distributed Switch Health Check.

a In the Navigator, click Networking and expand the sfo01m01vc01.sfo01.rainpole.local tree.

b Select the sfo01-m01-vds01 distributed switch and click the Configure tab.

c In the Navigator, select Health check and click the Edit button.

d Select Enabled for VLAN and MTU and Teaming and failover and click OK.

16 Delete the vSphere Standard Switch.

a In the Navigator, click Hosts and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

b Click sfo01m01esx01.sfo01.rainpole.local and then click the Configure tab.

c On the Configure page, select Virtual switches, select vSwitch0, and click the Remove
selected standard switch icon.

d In the Remove Standard Switch dialog box, click Yes to confirm the removal.

Create vSAN Disk Groups for the Management Cluster in Region A
vSAN disk groups must be created on each host that is contributing storage to the vSAN datastore.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, select Hosts and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Click the sfo01-m01-mgmt01 cluster and click the Configure tab.

4 Under vSAN, click Disk Management.

5 Select sfo01m01esx02.sfo01.rainpole.local and click the Create a New Disk Group button.

6 In the Create Disk Group window, select a flash disk for the cache tier, two hard disk drives for the
capacity tier and click OK.
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7 Repeat Step 5 and Step 6 for sfo01m01esx03.sfo01.rainpole.local and
sfo01m01esx04.sfo01.rainpole.local.

8 Assign a license to vSAN.

a Right Click the sfo01-m01-mgmt01 cluster and select Assign License.

b In the sfo01-m01-mgmt01- Assign License window, select the previously added Virtual SAN
License and click OK.

Enable vSphere HA on the Management Cluster in Region A
After the vSphere distributed switch has been created and connected with all hosts, enable vSphere High
Availability on the cluster.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Host and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local tree.

3 Select the sfo01-m01-mgmt01 cluster.

4 Click the Configure tab and click vSphere Availability.

5 Click Edit.

6 In the sfo01-m01-mgmt01 - Edit Cluster Settings dialog, select the Turn on vSphere HA check
box.

7 Click Failures and Responses, and select the following values:

Setting Value

Enable Host Monitoring Selected

Host Failure Response Restart VMs

Response for Host Isolation Power off and restart VMs

Datastore with PDL Disabled

Datastore with APD Disabled

VM Monitoring VM Monitoring Only
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8 Click Admission Control and enter the following settings.

Setting Value

Host failures cluster tolerates 1

Define host failover capacity by Cluster resource percentage

Override calculated failover capacity Deselected

Performance degradation VMs tolerate 100%
 

9 Click OK.

Note   When you enable vSphere HA, the operation fails on hosts 2,3, and 4. This is expected
behavior, networking is configured during host profile steps setup.

Change Advanced Options on the ESXi Hosts in the Management
Cluster in Region A
Change the default ESX Admins group to achieve greater levels of security and enable vSAN to provision
the Virtual Machine Swap files as thin to conserve space in the vSAN datastore.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Change the default ESX Admins group.

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01m01vc01.sfo01.rainpole.local tree.

b Select the sfo01m01esx01.sfo01.rainpole.local host.

c Click the Configure tab, click System > Advanced System Settings.

d Click the Edit button.

e In the filter box, enter esxAdmins and wait for the search results.

f Change the value of Config.HostAgent.plugins.hostsvc.esxAdminsGroup to SDDC-Admins
and click OK.
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3 Provision Virtual Machine swap files on vSAN as thin.

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01m01vc01.sfo01.rainpole.local tree

b Select the sfo01m01esx01.sfo01.rainpole.local host.

c Click the Configure tab, click System > Advanced System Settings.

d Click the Edit button.

e In the filter box, enter vsan.swap and wait for the search results.

f Change the value of VSAN.SwapThickProvisionDisabled to 1 and click OK.

4 Disable the SSH warning banner.

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01m01vc01.sfo01.rainpole.local tree

b Select the sfo01m01esx01.sfo01.rainpole.local host.

c Click the Configure tab, click System > Advanced System Settings.

d Click the Edit button.

e In the filter box, enter ssh and wait for the search results.

f Change the value of UserVars.SuppressShellWarning to 1 and click OK.

Mount NFS Storage for the Management Cluster in Region A
Mount an NFS datastore as a storage location for future backups.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Host and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local tree.

3 Click sfo01m01esx01.sfo01.rainpole.local.

4 Click Datastores.

5 Click the Create a New Datastore icon.

6 On the Type page, select NFS and click Next.
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7 On the Select NFS version page, select NFS 3 and click Next.

8 On the Name and configuration page, enter the following datastore information and click Next.

Setting Value

Datastore Name sfo01-m01-bkp01

Folder /VVD_backup01_nfs01_MgmtA_6TB

Server 172.16.25.251

9 On the Ready to complete page, review the configuration and click Finish.

Create and Apply the Host Profile for the Management Cluster in
Region A
Host Profiles ensure that all hosts in the cluster have the same configuration.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create a Host Profile from sfo01m01esx01.sfo01.rainpole.local.

a In the Navigator, select Hosts and Clusters and expand the
sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click sfo01m01esx01.sfo01.rainpole.local and select Host Profiles > Extract Host
Profile.

c In the Extract Host Profile window, enter sfo01-m01hp-mgmt01 as the name of the host profile
and click Next.

d On the Ready to complete page, click Finish.

3 Attach the Host Profile to the cluster.

a In the Navigator, select Hosts and Clusters and expand the
sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01-mgmt01 cluster, and select Host Profiles > Attach Host Profile.

c In the Attach Host Profile window, click sfo01-m01hp-mgmt01, select the Skip Host
Customization box, and click Finish.
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4 Create a host customization profile for the hosts in the cluster.

a From the Home menu, select Policies and Profiles from the drop-down menu.

b In the Navigator, click Host Profiles.

c Right-click sfo01-m01hp-mgmt01 and select Export Host Customizations. Click Save.

d Save the sfo01-m01hp-mgmt01_host_customizations.csv file that is generated.

e Open the file with Excel.
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f Edit the Excel file to include the following values.

ESXi Host

Active
Directory
Configuration
Password

Active Directory
Configuration
Username

NetStack Instance
defaultTcpipStack-
>DNS
configuration
Name for this host

NetStack
Instance
vmotion->DNS
configuration

sfo01m01esx01.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01m01esx01 sfo01m01esx01

sfo01m01esx02.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01m01esx02 sfo01m01esx02

sfo01m01esx03.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01m01esx03 sfo01m01esx03

sfo01m01esx04.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01m01esx04 sfo01m01esx04

ESXi Host

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
management:management->IP
address settings Host IPv4 address

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
management:management->IP
address settings SubnetMask

sfo01m01esx01.sfo01.rainpole.local 172.16.11.101 255.255.255.0

sfo01m01esx02.sfo01.rainpole.local 172.16.11.102 255.255.255.0

sfo01m01esx03.sfo01.rainpole.local 172.16.11.103 255.255.255.0

sfo01m01esx04.sfo01.rainpole.local 172.16.11.104 255.255.255.0

ESXi Host

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
nfs:<UNRESOLVED>->IP address
settings Host IPv4 address

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
nfs:<UNRESOLVED>->IP address
settings SubnetMask

sfo01m01esx01.sfo01.rainpole.local 172.16.15.101 255.255.255.0

sfo01m01esx02.sfo01.rainpole.local 172.16.15.102 255.255.255.0

sfo01m01esx03.sfo01.rainpole.local 172.16.15.103 255.255.255.0

sfo01m01esx04.sfo01.rainpole.local 172.16.15.104 255.255.255.0

ESXi Host

Host virtual NIC sfo01-m01-vds01:sfo01-m01-vds01-
replication:vSphereReplication,vSphereReplicationNFC-
>IP address settings Host IPv4 address

Host virtual NIC sfo01-m01-vds01:sfo01-m01-vds01-
replication:vSphereReplication,vSphereReplicationNFC-
>IP address settings SubnetMask

sfo01m01esx01.sfo01.rainpole.local 172.16.16.101 255.255.255.0

sfo01m01esx02.sfo01.rainpole.local 172.16.16.102 255.255.255.0

sfo01m01esx03.sfo01.rainpole.local 172.16.16.103 255.255.255.0

sfo01m01esx04.sfo01.rainpole.local 172.16.16.104 255.255.255.0
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ESXi Host

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-vsan:vsan-
>IP address settings Host IPv4
address

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
vsan:vsan->IP address settings
SubnetMask

sfo01m01esx01.sfo01.rainpole.local 172.16.13.101 255.255.255.0

sfo01m01esx02.sfo01.rainpole.local 172.16.13.102 255.255.255.0

sfo01m01esx03.sfo01.rainpole.local 172.16.13.103 255.255.255.0

sfo01m01esx04.sfo01.rainpole.local 172.16.13.104 255.255.255.0

ESXi Host

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
vmotion:vmotion->IP address
settings Host IPv4 address

Host virtual NIC sfo01-m01-
vds01:sfo01-m01-vds01-
vmotion:vmotion->IP address
settings SubnetMask

sfo01m01esx01.sfo01.rainpole.local 172.16.12.101 255.255.255.0

sfo01m01esx02.sfo01.rainpole.local 172.16.12.102 255.255.255.0

sfo01m01esx03.sfo01.rainpole.local 172.16.12.103 255.255.255.0

sfo01m01esx04.sfo01.rainpole.local 172.16.12.104 255.255.255.0

g When you have updated the Excel file, save it in the CSV file format and close Excel.

h Click the Configure tab.

i Click the Edit Host Customizations button.

j On the Select hosts page, click Next.

k On the Customize hosts page, click the Browse button, select the customization CSV file you
created previously, and click Finish.

5 Remediate the hosts in the cluster.

a On the Policies and Profiles page, click sfo01-m01hp-mgmt01, click the Monitor tab, and then
click the Compliance tab.

b Click sfo01-m01-mgmt01 in the Host/Cluster column and click Check Host Profile
Compliance icon.

Note   This compliance test shows that the first host is Compliant, but the other hosts are Not
Compliant.

c Click each of the non-compliant hosts, click Remediate host based on its host profile icon,
and then click Finish on the wizard that appears.

All hosts should show a Compliant status in the Host Compliance column.

6 Schedule nightly compliance checks.

a On the Policies and Profiles page, click sfo01-m01hp-mgmt01, click the Monitor tab, and then
click the Scheduled Tasks subtab.

b Click Schedule a New Task then click Check Host Profile Compliance.
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c In the sfo01-m01hp-mgmt01: Check Host Profile Compliance (scheduled) window click
Scheduling Options.

d Enter sfo01-m01hp-mgmt01 Compliance Check in the Task Name field.

e Click the Change button on the Configured Scheduler line.

f In the Configure Scheduler window select Setup a recurring schedule for this action, change
the Start time to 10:00 PM, and click OK.

g Click OK in the sfo01-m01hp-mgmt01: Check Host Profile Compliance (scheduled) window.

Set Virtual SAN Policy on Management Virtual Machines in Region
A
After you apply the host profile to all hosts, set the storage policy of the virtual machines to the vSAN
Default Storage Policy. Set the Platform Services Controller and vCenter Server appliances to the default
vSAN storage policy.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Hosts and Clusters.

3 Expand the sfo01m01vc01.sfo01.rainpole.local tree.

4 Select the sfo01m01psc01 virtual machine.

5 Click the Configure tab, click Policies, and click Edit VM Storage Policies.

6 In the Edit VM Storage Policies dialog, from the VM storage policy drop-down menu, select vSAN
Default Storage Policy, and click Apply to all.

7 Click OK to apply the changes.

8 Verify that the Compliance Status column shows a Compliant status for all items in the table.

9 Repeat this step to apply the vSAN Default Storage Policy on sfo01m01vc01 and sfo01w01psc01
virtual machines.

Create the VM and Template Folders in Region A
Create folders to group objects of the same type for easier management.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create folders for each of the management applications. 

a In the Navigator, click VMs and Templates and expand the
sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01dc data center, and select New Folder > New VM and Template
Folder.

c In the New Folder dialog box, enter sfo01-m01fd-mgmt as the name to label the folder and click
OK.

d Repeat this step to create the remaining folders.

Management Applications Folder

vCenter Server, Platform Services Controllers, and Update Manager Download Service sfo01-m01fd-mgmt

vRealize Automation and vRealize Business sfo01-m01fd-vra

vRealize Automation (Proxy Agent) and vRealize Business (Data Collector) sfo01-m01fd-vraias

vRealize Operations Manager sfo01-m01fd-vrops

vRealize Operations Manager (Remote Collectors) sfo01-m01fd-vropsrc

vRealize Log Insight sfo01-m01fd-vrli

NSX Manager, Controllers, and Edges sfo01-m01fd-nsx

VMware Site Recovery Manager and vSphere Replication sfo01-m01fd-bcdr

3 Move the vCenter Server and Platform Services Controller virtual machines to the sfo01-m01fd-mgmt
folder.

a In the Navigator, click VMs and Templates and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

b Expand the Discovered Virtual Machines folder.

c Drag sfo01m01vc01, sfo01w01vc01, sfo01m01psc01, and sfo01w01psc01to the sfo01-m01fd-
mgmt folder.
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4 Delete the Discovered Virtual Machines folder.

a In the Navigator, click VMs and Templates and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

b Right-click the Discovered Virtual Machines folder and click Remove from Inventory.

c On the Confirm Remove dialog, click Yes.

Create Anti-Affinity Rules for the Platform Services Controllers in
Region A
Anti-Affinity rules prevent virtual machines from running on the same host. This helps to maintain
redundancy in the event of host failures.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, select Hosts and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

4 Under the Configuration group of settings, select VM/Host Rules.

5 On the VM/Host Rules page, click the Add button to create a new VM/Hosts Rule.

6 In the Create VM/Host Rule dialog box, enter the following details and click Add.

Setting Value

Name anti-affinity-rule-psc

Enable rule Selected

Type Separate Virtual Machines
 

7 In the Add Rule Member dialog, select sfo01m01psc01 and sfo01w01psc01 and click OK.

8 Click OK to create the rule.
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Create VM Groups to Define Startup Order in the Management
Cluster in Region A
You can define the startup order of virtual machines with VM Groups. Startup orders are used during
vSphere HA events such that vSphere HA powers on virtual machines in the correct order.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, select Host and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Create a VM Group for the Platform Services Controllers.

a Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

b On the Configure page, click VM/Host Groups.

c On the VM/Host Groups page, click the Add button.

d In the Create VM/Host Group dialog, enter Platform Services Controllers in the Name
text box, select VM Group from the Type drop-down menu, and click the Add button.

e In the Add VM/Host Group Member dialog, select sfo01m01psc01 and sfo01w01psc01 and click
OK.

f On the Create VM/Host Group dialog, click OK.

4 Create a VM Group for the vCenter Servers.

a Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

b On the Configure page, click VM/Host Groups.

c On the VM/Host Groups page, click the Add button.

d In the Create VM/Host Group dialog, enter vCenter Servers in the Name text box, select VM
Group from the Type drop-down menu, and click the Add button.

e In the Add VM/Host Group Member dialog, select sfo01m01vc01 and click OK.

f On the Create VM/Host Group dialog, click OK.
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5 Create a Rule to power on the Platform Services Controllers followed by the vCenter Servers.

a Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

b On the Configure page, click VM/Host Rules.

c On the VM/Host Rules page, click the Add button.

d In the Create VM/Host Rule dialog, enter SDDC Management Virtual Machines in the Name
text box, ensure the Enable rule check box is selected, select Virtual Machines to Virtual
Machines from the Type drop-down menu.

e Select Platform Services Controllers from the First restart VMs in VM group drop-down
menu.

f Select vCenter Servers from the Then restart VMs in VM group drop-down menu and click OK.

Deploy and Configure the NSX Instance for the
Management Cluster in Region A
This design uses two separate NSX instances per region. One instance is tied to the Management
vCenter Server, and the other instance is tied to the Compute vCenter Server. Deploy and configure the
NSX instance for the management cluster in Region A.

Procedure

1 Prerequisites for Implementation of the Management NSX Instance in Region A

Before you deploy the NSX Components of the Management Cluster, verify that your environment
satisfies the requirements for this deployment.

2 Deploy the NSX Manager for the Management Cluster in Region A

NSX Manager and vCenter Server have a one-to-one relationship. For every NSX Manager instance
there is one connected vCenter Server. To deploy the NSX Manager virtual appliance, you first
assign a domain service account which NSX uses as the vCenter Server Administrator role. Deploy
the NSX Manager virtual appliance, then connect it to the vCenter Server instance.

3 Deploy the NSX Controllers for the NSX Instance in Region A

4 Assign Licensing for NSX Instance for Region A

Assign licensing for the NSX instance.

5 Prepare the ESXi Hosts in the Management Cluster for NSX in Region A

NSX kernel modules packaged in VIB files run within the hypervisor kernel and provide services
such as distributed routing, distributed firewall, and VXLAN bridging capabilities. To use NSX, you
must install the NSX kernel modules on the ESXi hosts.

6 Configure the NSX Logical Network for the Management Cluster in Region A

After all the deployment tasks are completed, you configure the NSX logical network.
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7 Update the Host Profile for the Management Cluster in Region A

After you configure NSX logical networking on the hosts, update the host profile and remediate the
hosts to align their configurations. When you make an authorized changes to a host, you must
update the host profile to reflect these changes.

8 Deploy the Platform Services Controllers Load Balancer in Region A

You configure load balancing for all services and components related to Platform Services
Controllers (PSC) using an NSX Edge load balancer. 

9 Configure NSX Dynamic Routing in the Management Cluster in Region A

NSX for vSphere creates a network virtualization layer on top of which all virtual networks are
created. This layer is an abstraction between the physical and virtual networks. You configure NSX
dynamic routing within the management cluster, deploying two NSX Edge devices and a Universal
Distributed Logical Router (UDLR).

10 Distributed Firewall Configuration for Management Applications

Configuring a distributed firewall for use with your SDDC increases the security level of your
environment by allowing only the network traffic that is required for the SDDC to run. The firewall
rules you define allow access to management applications.

11 Test the Management Cluster NSX Configuration in Region A

Test the configuration of the NSX logical network using a ping test. A ping test checks if two hosts in
a network can reach each other.

12 Deploy Application Virtual Networks in Region A

Deploy the application virtual networks for the Management workloads.

13 Deploy the NSX Load Balancer in Region A

Deploy a load balancer for use by management applications connected to the application virtual
network, Mgmt-xRegion01-VXLAN.

Prerequisites for Implementation of the Management NSX
Instance in Region A
Before you deploy the NSX Components of the Management Cluster, verify that your environment
satisfies the requirements for this deployment.

IP Addresses and Host Names
Verify that static IP addresses and FQDNs for the management networks are available for the SDDC
deployment.

Allocate static IP addresses and FQDNs for the NSX Manager, NSX Controller nodes, and components.
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Table 2‑7.  Network Names for SDDC Components

NSX Manager Region A Network

NSX Manager sfo01-m01-vds01-management

NSX Controllers sfo01-m01-vds01-management

Table 2‑8.  IP Addresses and Host Names for the NSX Components in Region A

Role IP Address FQDN

NSX Manager 172.16.11.65 sfo01m01nsx01.sfo01.rainpole.local

NSX Controller Nodes 172.16.11.118 sfo01m01nsxc01.sfo01.rainpole.local

172.16.11.119 sfo01m01nsxc02.sfo01.rainpole.local

172.16.11.120 sfo01m01nsxc03.sfo01.rainpole.local

Edge Services Gateway 01 172.27.11.2 sfo01m01esg01.sfo01.rainpole.local

172.27.12.3

192.168.10.1

Edge Services Gateway 02 172.27.11.3 sfo01m01esg02.sfo01.rainpole.local

172.27.12.2

192.168.10.2

Universal Distributed Logical Router 192.168.10.3 sfo01m01udlr01.sfo01.rainpole.local

192.168.11.1

192.168.31.1

Application Load Balancer 192.168.11.2 sfo01m01lb01.sfo01.rainpole.local

PSC Load Balancer 172.16.11.71 sfo01psc01.sfo01.rainpole.local

Subnet mask 255.255.255.0 -

DNS 172.16.11.5 -

172.16.11.4

Gateway 172.16.11.253 -

NTP servers n 172.16.11.251
n 172.16.11.252

n ntp.sfo01.rainpole.local

Deployment Prerequisites
Verify that your environment satisfies the following prerequisites for the deployment of NSX Manager and
Components.
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Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per NSX Manager:
n Initial storage for the NSX Manager: 60 GB

n Required storage per NSX Controller nodes and Components:
n Storage requirement: 240 GB

Software Features n Verify that management vCenter Server is operational.

Installation Package n Download the .iso file for the NSX Manager.

License n Verify that you have obtained NSX license with a quantity that satisfies the requirements of this
design.

Active Directory n Verify that you have a parent active directory with the SDDC user roles configured for the
rainpole.local domain.

svc-nsxmanager(User Role)

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the NSX Manager. See the

VMware Validated Design Planning and Preparation documentation.

Deploy the NSX Manager for the Management Cluster in Region A
NSX Manager and vCenter Server have a one-to-one relationship. For every NSX Manager instance
there is one connected vCenter Server. To deploy the NSX Manager virtual appliance, you first assign a
domain service account which NSX uses as the vCenter Server Administrator role. Deploy the NSX
Manager virtual appliance, then connect it to the vCenter Server instance.

Procedure

1 Assign an NSX Domain Service Account and Deploy the NSX Manager Appliance in Region A

Assign a domain service account for use by NSX to access the vCenter Server Administrator role.
Deploy the NSX Manager appliance from the OVF file.

2 Replace the Certificate of NSX Manager for the Management Cluster in Region A

3 Assign the NSX Domain Service Account the License Service Administrators Role

Before you connect the NSX Manager to the vCenter Server, you must assign the NSX domain
service account svc-nsxmanager the LicenseService.Administrators SSO role.

4 Connect NSX Manager to the Management vCenter Server in Region A

5 Assign Administrative Access to NSX in Region A

Assign the administrator@vsphere.local account to the NSX Enterprise Administrator Role.

Assign an NSX Domain Service Account and Deploy the NSX Manager
Appliance in Region A
Assign a domain service account for use by NSX to access the vCenter Server Administrator role. Deploy
the NSX Manager appliance from the OVF file.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Administration and click Global Permissions.

3 Click the Manage tab and click the Add permission icon.

4 In the Global Permission Root - Add Permission dialog box, click Add.

5 In the Select Users/Groups dialog box, select rainpole.local from the Domain drop-down menu.

6 In the search box, enter svc-nsxmanager and press Enter.

7 Select svc-nsxmanager and click Add. Click OK to return to the Global Permission Root - Add
Permission window.

8 Assigned Role Administrator, Click OK to give the svc-nsxmanager account vCenter administrative
privileges.

9 Click the Home icon and select Hosts and Clusters.

10 Expand the entire sfo01m01vc01.sfo01.rainpole.local control tree.

11 Right-click the  sfo01-m01-mgmt01 cluster and click Deploy OVF Template.

12 On the Select template page, click the Browse button, select the VMware NSX Manager .ova file,
and click Next. 

13 On the Select name and location page, enter the following settings, and click Next.

Setting Value

Name sfo01m01nsx01

Select a datacenter or folder sfo01-m01fd-nsx

14 On the Select a resource page, select the following values, and click Next.

Setting Value

Cluster sfo01-m01-mgmt01

15 On the Review details page, review the extra configuration option message, and click Next.

16 On the Accept license agreements page, click Accept, and click Next.
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17 On the Select storage page, enter the following settings and click Next.

Setting Value

Select virtual disk format Thin provision

VM storage policy vSAN Default Storage Policy

Datastore sfo01-m01-vsan01

18 On the Select networks page, under Destination Network, select sfo01-m01-vds01-management
and click Next.

19 On the Customize template page, expand the different options, enter the following settings, and
click Next.

Setting Value

DNS Server List 172.16.11.5,172.16.11.4

Domain Search List sfo01.rainpole.local

Default IPv4 Gateway 172.16.11.253

Hostname sfo01m01nsx01.sfo01.rainpole.local

Network 1 IPv4 Address 172.16.11.65

Network 1 Netmask 255.255.255.0

Enable SSH Selected

NTP Server List ntp.sfo01.rainpole.local, ntp.lax01.rainpole.local

CLI "admin" User Password / enter mgmtnsx_admin_password

CLI "admin" User Password / confirm mgmtnsx_admin_password

CLI Privilege Mode Password / enter mgmtnsx_privilege_password

CLI Privilege Mode Password / confirm mgmtnsx_privilege_password

VMware Customer Experience Improvement Program Selected

20 On the Ready to complete page, review your configuration and click Finish.

21 After the deployment completes, expand the entire sfo01m01vc01.sfo01.rainpole.local tree, select
the sfo01m01nsx01 virtual machine, and click the Power on button.

Replace the Certificate of NSX Manager for the Management Cluster in
Region A
After you deploy the appliance of NSX Manager, replace the default certificate with a custom certificate to
establish trusted connection with the other management components in the SDDC. The certificate, that is
generated by the CertGenVVD utility, is signed by the certificate authority on the parent Active Directory
(AD) server.

Use the following certificate file to replace the certificate on the NSX Manager instance:

Deployment for Region A

VMware, Inc.  52



Table 2‑9.  Certificate-Related Files on the NSX Manager Instance for the Management
Cluster in Region A

NSX Manager FQDN Certificate File Name

sfo01m01nsx01.sfo01.rainpole.local sfo01m01nsx01.4.p12

Procedure

1 Log in to the Management NSX Manager appliance user interface.

a Open a Web browser and go to https://sfo01m01nsx01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password nsx_manager_admin_password

2 On the Home page, select Manage Appliance Settings.

3 On the Manage tab, click SSL Certificates, click Upload PKCS#12 Keystore.

4 Browse to the certificate chain file sfo01m01nsx01.4.p12, provide the keystore password or
passphrase, and click Import.

5 Restart the NSX Manager to propagate the CA-signed certificate.

a In the right corner of the NSX Manager page, click the Settings icon. 

b From the drop-down menu, select Reboot Appliance.

c On the Reboot Confirmation dialog box, click Yes.

Assign the NSX Domain Service Account the License Service Administrators
Role
Before you connect the NSX Manager to the vCenter Server, you must assign the NSX domain service
account svc-nsxmanager the LicenseService.Administrators SSO role.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click the Home icon and select Administration.
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3 On the Administration page, under Single Sign-On, click Users and Groups and click Groups.

4 Select the LicenseService.Administrators group.

5 Click Add Member.

6 On the Add Principals page, select the rainpole.local domain.

7 Select the svc-nsxmanager user.

8 Click Ok.

Connect NSX Manager to the Management vCenter Server in Region A
After you deploy the NSX Manager virtual appliance for the management cluster, connect NSX Manager
to the vCenter Server.

Procedure

1 Log in to the Management NSX Manager appliance user interface.

a Open a Web browser and go to https://sfo01m01nsx01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password nsx_manager_admin_password

2 Click Manage vCenter Registration.

3 Under Lookup Service URL, click Edit.

4 In the Lookup Service URL dialog box, enter the following settings and click OK.

Setting Value

Lookup Service Host sfo01psc01.sfo01.rainpole.local

Lookup Service Port 443

SSO Administrator User Name administrator@vsphere.local

Password vsphere_admin_password

5 In the Trust Certificate? dialog box, click Yes.

6 Under vCenter Server, click Edit.

7 In the  vCenter Server dialog box, enter the following settings, and click OK.

Setting Value

vCenter Server sfo01m01vc01.sfo01.rainpole.local

vCenter User Name svc-nsxmanager@rainpole.local

Password svc-nsxmanager_password

8 In the Trust Certificate? dialog box, click Yes.
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9 Wait for the Status indicators for the Lookup Service URL and vCenter Server to change to the
Connected status.

Assign Administrative Access to NSX in Region A
Assign the administrator@vsphere.local account to the NSX Enterprise Administrator Role.

Procedure

1 Log in to the vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name svc-nsxmanager@rainpole.local

Password svc-nsxmanager_password
 

2 Click Home, click Networking & Security, and click Users and Domains.

3 On the Users and Domains page, from the NSX Manager drop-down menu, select 172.16.11.65 .

4 Click the Add icon.

5 On the Identify User page, select the Specify a vCenter user radio button,
enter administrator@vsphere.local in the text box, and click Next.

6 On the Select Roles page, select the Enterprise Administrator radio button and click Finish.

Deploy the NSX Controllers for the NSX Instance in Region A
After the NSX Manager is successfully connected to the vCenter Server, you must promote it to the
primary role and deploy the three NSX Controller nodes that form the NSX Controller cluster.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Promote the NSX Manager to the primary role.

a Under Inventories, click Networking & Security.

b In the Navigator, click Installation and Upgrade.

c On the Management tab, select the 172.16.11.65 instance.

d Click the Actions menu and click Assign Primary Role.

e In the Assign Primary Role dialog box, click Yes.

3 Configure an IP pool for the NSX Controller cluster.

a In the Navigator, click Groups and Tags.

b Under NSX Managers, click the 172.16.11.65 instance.

c Click the IP Pools tab and click the Add New IP Pool icon.

d In the Add Static IP Pool dialog box, enter the following settings, and click OK.

Setting Value

Name sfo01-mgmt01-nsxc01

Gateway 172.16.11.253

Prefix Length 24

Primary DNS 172.16.11.5

Secondary DNS 172.16.11.4

DNS Suffix sfo01.rainpole.local

Static IP Pool 172.16.11.118-172.16.11.120

4 Deploy the NSX Controller cluster. It is important to deploy every node only after the previous one is
successfully deployed.

a In the Navigator, click Installation and Upgrade.

b Under NSX Controller nodes, click the Add icon to deploy three NSX Controller nodes with the
same configuration.

c On the Add Controller page, under Password Settings, enter the following, and click Next.

Note   You configure a password only during the deployment of the first controller. The other
controllers use the same password.

Setting Value

NSX Manager 172.16.11.65

Password mgmtnsx_controllers_password

Confirm Password mgmtnsx_controllers_password
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d In the Add Controller page, under Deployment & Connectivity, enter the following values and
click Finish.

Setting Value

Name sfo01m01nsxc01

Datacenter sfo01-m01dc

Cluster/Resource Pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Connected To sfo01-m01-vds01-management

Select IP Pool sfo01-mgmt01-nsxc01

e After the Status of the controller node changes to Connected, repeat the step and deploy the two
remaining NSX Controller nodes in the controller cluster with the same configuration,
incrementing the name by 1 each time.

5 Enable Controller Disconnected Operation (CDO) Mode.

a Under Inventories, click Networking & Security.

b In the Navigator, click Installation and Upgrade.

c On the Management tab, select the 172.16.11.65 instance.

d Click the Actions menu and click Enable CDO Mode.

e In the Enable CDO Mode dialog box, click Yes.

6 Configure DRS affinity rules for the NSX Controller nodes.

a Return to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01m01vc01.sfo01.rainpole.local tree.

c Select the sfo01-m01-mgmt01 cluster, and click the Configure tab.

d Under Configuration, click VM/Host Rules.

e Click Add.

f In the sfo01-m01-mgmt01 - Create VM/Host Rule dialog box, enter the following settings and
click Add.

Setting Value

Name anti-affinity-rule-nsxc

Enable rule Selected

Type Separate Virtual Machine
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g In the Add Rule Member dialog box, select the check box next to each of the three NSX
Controller virtual machines and click OK.

h In the sfo01-m01-mgmt01 - Create VM/Host Rule dialog box, click OK.

Assign Licensing for NSX Instance for Region A
Assign licensing for the NSX instance.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Add new licenses for this NSX instance.

a Click the Home icon above the Navigator and select the Administration menu item.

b On the Administration page, click Licenses and click the Licenses tab.

c Click the Create New Licenses icon to add license keys.

d On the Enter license keys page, enter license keys for NSX, and click Next.

e On the Edit license name page, enter License name and click Next.

f On the Ready to complete page, review your entries and click Finish.

3 Assign the newly added licenses to NSX.

a Click the Home icon above the Navigator and select the Administration menu item.

b On the Administration page, under Licensing and select Licenses.

c Under Licenses, click the Assets tab, then click the Solutions tab.

d Select NSX for vSphere, and click the Assign License icon.

e On the NSX for vSphere - Assign License page select the license you created in step 2 and
click OK.

Prepare the ESXi Hosts in the Management Cluster for NSX in
Region A
NSX kernel modules packaged in VIB files run within the hypervisor kernel and provide services such as
distributed routing, distributed firewall, and VXLAN bridging capabilities. To use NSX, you must install the
NSX kernel modules on the ESXi hosts.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Networking & Security.

3 Click Installation and Upgrade, and click the Host Preparation tab.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Under NSX Component Installation on Hosts, click Actions then Install for the sfo01-m01-
mgmt01 cluster and click Yes in the confirmation dialog box.

6 Verify that the Installation Status column displays the NSX version for all hosts in the cluster,
confirming that the NSX kernel modules are successfully installed.

Configure the NSX Logical Network for the Management Cluster
in Region A
After all the deployment tasks are completed, you configure the NSX logical network.

To configure the NSX logical network, you perform the following tasks:

n Configure the Segment ID allocation.

n Configure the VXLAN networking.

n Configure the transport zone.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Configure the Segment ID allocation.

a In the Navigator, click Networking & Security.

b Click Installation and Upgrade and select 172.16.11.65 from the NSX Manager drop-down
menu.

c Click the Logical Network Settings tab and navigate to VXLAN Settings > Segment IDs.

d Click Edit, enter the following settings, and click OK.

Setting Value

Segment ID pool 5000-5200

Enable Multicast addressing Selected

Multicast addresses 239.1.0.0-239.1.255.255

Universal Segment ID Pool 30000-39000

Enable Universal Multicast addressing Selected

Universal Multicast addresses 239.2.0.0-239.2.255.255

3 Configure the VXLAN networking.

a Click the Host Preparation tab.

b Under VXLAN, click Not Configured on the sfo01-m01-mgmt01 row, enter the following
settings, and click OK.

Setting Value

Switch sfo01-m01-vds01

VLAN 1614

MTU 9000

VMKNic IP Addressing Use DHCP

VMKNic Teaming Policy Load Balance - SRCID

VTEP 2

4 Configure the transport zone.

a On the Installation and Upgrade page, click the Logical Network Settings tab and
click Transport Zones.

b Select 172.16.11.65 from the NSX Manager drop-down menu. 
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c Click the New Transport zone icon.

d In the New Transport Zone dialog box, enter the following settings and click OK.

Setting Value

Mark this object for Universal Synchronization Selected

Name Mgmt Universal Transport Zone

Replication mode Hybrid

Select clusters to be part of the Transport Zone sfo01-m01-mgmt01

Update the Host Profile for the Management Cluster in Region A
After you configure NSX logical networking on the hosts, update the host profile and remediate the hosts
to align their configurations. When you make an authorized changes to a host, you must update the host
profile to reflect these changes.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Update the host profile.

a In the Navigator, select Policies and Profiles.

b Click Host Profiles, right-click sfo01-m01hp-mgmt01, and select Copy Settings from Host.

c Select sfo01m01esx01.sfo01.rainpole.local and click OK.

3 Verify compliance and remediate the hosts.

a On the Policies and Profiles page, click the sfo01-m01hp-mgmt01 host profile.

b On the Monitor tab, click the Compliance tab.

c Select sfo01-m01-mgmt01 in the Host/Cluster column and click Check Host Profile
Compliance.

This compliance test shows that the first host is Compliant, but the other hosts are Not
Compliant.

d Click each of the non-compliant hosts and click Remediate Hosts Based on its Host Profile.
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e In the Remediate Hosts Based on its Host Profile wizard, enter Host Name if prompted for
NetStack Instance vxlan->DNS configuration, and click Next.

f On the Ready to complete page, click Finish.

All hosts have Compliant status in the Host Compliance column.

Deploy the Platform Services Controllers Load Balancer in Region
A
You configure load balancing for all services and components related to Platform Services Controllers
(PSC) using an NSX Edge load balancer. 

Deploy the Platform Services Controller NSX Load Balancer in Region A
The first step in deploying load balancing for the Platform Services Controller is to deploy the edge
services gateway.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Click the Add icon tab to create an NSX Edge.

The New NSX Edge wizard appears.

6 On the Name and description page, enter the following settings and click Next.

Setting Value

Install Type Edge Services Gateway

Name sfo01psc01

Hostname sfo01psc01.sfo01.rainpole.local

Deploy NSX Edge Selected

Enable High Availability Selected
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Setting Value

Enable HA Logging Selected

Log Level INFO
 

7 On the Settings page, enter the following settings and click Next.

Setting Value

User Name admin

Password edge_admin_password

Enable SSH access Selected

Enable FIPS mode Deselected

Enable auto rule generation Selected

Edge Control Level logging INFO
 

8 On the Configure deployment page, perform the following configuration steps and click Next.

a Select sfo01-m01dc, from the Datacenter drop-down menu.

b Click Large to specify the Appliance Size.

c Click the Add icon, enter the following settings, and click OK.

Setting Value

Resource pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Resource Reservation System Managed
 

d To create a second appliance, click the Add icon again, make the same selections in the Add
NSX Edge Appliance dialog, click OK, and then click Next.

9 On the Configure interfaces page, click the Add icon to configure the sfo01psc01 interface, enter
the following settings, click OK, and click Next.

Setting Value

Name sfo01psc01

Type Internal

Connected To sfo01-m01-vds01-management

Connectivity Status Connected

Primary IP Address 172.16.11.71

Subnet Prefix Length 24

MTU 9000

Send ICMP Redirect Selected
 

10 On the Default gateway settings page, click Next.
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11 On the Firewall and HA page, select the following settings and click Next.

Setting Value

Configure Firewall default policy Selected

Default Traffic Policy Accept

Logging Disable

vNIC Any

Declare Dead Time 15
 

12 On the Ready to complete page, review the configuration settings you entered and click Finish.

13 Configure the Default Gateway.

a In the Navigator, click NSX Edges.

b Select 172.16.11.65 from the NSX Manager drop-down menu.

c Double-click the device labeled sfo01psc01.

d Click the Manage tab and click the Routing tab.

e Click Edit to configure the Default Gateway.

f In the Edit Default Gateway dialog, enter 172.16.11.253 for the Gateway IP and click OK.

g Click Publish Changes.

14 Enable the Load Balancer service.

a In the Navigator, click NSX Edges.

b Select 172.16.11.65 from the NSX Manager drop-down menu.

c Double-click the device labeled sfo01psc01.

d Click the Manage tab, click the Load Balancer tab, click Global Configuration, and click Edit.

e In the Edit load balancer global configuration dialog, select Enable Load Balancer and click
OK.

Create Platform Services Controller Application Profiles in Region A
To define the behavior of a particular type of network traffic, you create an application profile. After
configuring a profile, you associate the profile with a virtual server. The virtual server then processes
traffic according to the values specified in the profile. Using profiles enhances your control over managing
network traffic, and makes traffic-management tasks easier and more efficient.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01psc01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Application Profiles.

6 Click the Add icon and in the New Profile dialog box, enter the following values, and click OK.

Setting Value Value

Name psc-tcp psc-https

Type TCP HTTPS

Enable SSL Passthrough Deselected Selected

Persistence Source IP Source IP

Expires in (Seconds) 60 60

7 Click OK.

Create Platform Services Controller Server Pools in Region A
On the Platform Services Controller load balancer, create two server pools that contain the Platform
Services Controller instances for the management and for the shared edge and compute clusters. The
first server pool handles SSL requests from the vSphere Web Client on port 443 and the second handles
requests to the VMware Directory service on port 389.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01psc01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Pools.

6 Click the Add icon and in the New Pool dialog box, enter the following values and click OK.

Setting Value Value

Name psc-https-443 psc-tcp-389

Algorithm ROUND-ROBIN ROUND-ROBIN

Monitors default_tcp_monitor default_tcp_monitor

7 New Members dialog box, click the Add icon to add the first pool member.

8 In the New Member dialog box, enter the following values, and click OK.

Setting Values for First Server Pool Values for Second Server Pool

Name sfo01m01psc01 sfo01m01psc01

IP Address/VC Container sfo01m01psc01.sfo01.rainpole.local sfo01m01psc01.sfo01.rainpole.local

State Enable Enable

Port

Monitor Port 443 389

Weight 1 1

9 Under Members, click the Add icon to add the second pool member.

10 In the New Member dialog box, enter the following values, click OK, and click OK to save the
Platform Services Controller Pool.

Setting Values for First Server Pool Values for Second Server Pool

Name sfo01w01psc01 sfo01w01psc01

IP Address/VC Container sfo01w01psc01.sfo01.rainpole.local sfo01w01psc01.sfo01.rainpole.local
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Setting Values for First Server Pool Values for Second Server Pool

State Enable Enable

Port

Monitor Port 443 389

Weight 1 1

11 Repeat the procedure to create the remaining server pool.

Create Platform Services Controller Virtual Servers in Region A
After you set up load balancing, the NSX load balancer distributes network traffic across multiple servers.
When a virtual server receives a request, the NSX load balancer selects the appropriate pool to send
traffic to. You create virtual servers for all configured server pools.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01psc01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Virtual Servers.

6 Click the Add icon, and in the New Virtual Server dialog box configure the values for the virtual
server you are adding, and click OK. 

Setting Value Value

Enable Virtual Server Selected Selected

Application Profile psc-tcp psc-https

Name psc-tcp-389 psc-https-443

Description 389-LDAP,2012-Control Interface,2014-RPC Port,2020-
Authentication,636-SSL LDAP

Data from the vSphere Web Client

IP Address 172.16.11.71 172.16.11.71

Protocol TCP HTTPS
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Setting Value Value

Port 389,636,2012,2014,2020 443

Default Pool psc-tcp-389 psc-https-443

7 Repeat step 6 to create a virtual server for each component. Upon completion, verify that you have
successfully entered the virtual server names and their respective configuration values. 

Update DNS Records for the Platform Services Controller Load Balancer in
Region A
You must modify the DNS Address of the Platform Services Controller load balancerin Region A after
setting up load balancing.

For the Platform Services Controller Load Balancer, you edit the DNS entry of
sfo01psc01.sfo01.rainpole.local to point to the virtual IP address (VIP) of the Load Balancer
(172.16.11.71) instead of pointing to the IP address of sfo01m01psc01.

Procedure

1 Log in to the DNS server that resides in the sfo01.rainpole.local domain.

2 Open the Windows Start menu, enter dns in the Search text box and press Enter.

The DNS Manager dialog box appears.

3 In the DNS Manager dialog box, under Forward Lookup Zones, select the sfo01.rainpole.local
domain and locate the sfo01psc01 record on the right.

4 Double-click the sfo01psc01 record, change the IP address of the record from 172.16.11.61 to
172.16.11.71, and click OK.

Setting Value

Fully Qualified domain name (FQDN) sfo01psc01.sfo01.rainpole.local

IP Address 172.16.11.71

Update Associated Pointer (PTR) record Selected

Configure NSX Dynamic Routing in the Management Cluster in
Region A
NSX for vSphere creates a network virtualization layer on top of which all virtual networks are created.
This layer is an abstraction between the physical and virtual networks. You configure NSX dynamic
routing within the management cluster, deploying two NSX Edge devices and a Universal Distributed
Logical Router (UDLR).

Procedure

1 Create a Universal Logical Switch for Use as the Transit Network in the Management Cluster in
Region A

Create a universal logical switch for use as the transit network.
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2 Deploy NSX Edge Devices for North-South Routing in Region A

Deploy two NSX Edge devices for North-South Routing.

3 Disable the Firewall Service in Region A

Disable the firewall of the NSX Edge devices. This is required for equal-cost multi-path (ECMP) to
operate correctly. Perform this procedure for each NSX Edge device.

4 Enable and Configure BGP Routing in Region A

Enable the Border Gateway Protocol (BGP) to exchange routing information between the NSX Edge
services gateway hosts in a network of autonomous systems (AS).

5 Verify Peering of Upstream Switches and Establishment of BGP in Region A

The NSX Edge devices must establish a connection to each of the upstream BGP switches before
BGP updates can be exchanged. Verify that the NSX Edges devices are successfully peering, and
that BGP routing has been established.

6 Deploy the Universal Distributed Logical Router in Region A

Deploy the universal distributed logical router (UDLR).

7 Configure Universal Distributed Logical Router for Dynamic Routing in Region A

Configure the Universal Distributed Logical Router (UDLR) to use dynamic routing.

8 Verify Establishment of BGP for the Universal Distributed Logical Router in Region A

The Universal Distributed Logical router (UDLR) must establish a connection to the Edge Services
Gateways before BGP updates can be exchanged. Verify that peering is successful and BGP routing
has been established.

Create a Universal Logical Switch for Use as the Transit Network in the
Management Cluster in Region A
Create a universal logical switch for use as the transit network.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click Logical Switches.

4 Select the instance labeled 172.16.11.65.
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5 Click the New Logical Switch icon.

6 In the New Logical Switch dialog, enter the following settings and click OK.

Setting Value

Name Universal Transit Network

Transport Zone Mgmt Universal Transport Zone

Replication Mode Hybrid
 

Deploy NSX Edge Devices for North-South Routing in Region A
Deploy two NSX Edge devices for North-South Routing.

Perform this procedure two times to deploy two NSX Edge devices. Enter the name and IP addresses for
the respective device using the values shown in the tables.

Table 2‑10.  NSX Edge Devices

NSX Edge Device Device Name

NSX Edge Device 1 sfo01m01esg01

NSX Edge Device 2 sfo01m01esg02

Table 2‑11.  NSX Edge Interfaces Settings

Interface Primary IP Address sfo01m01esg01 Primary IP Address sfo01m01esg02

Uplink01 172.27.11.2 172.27.11.3

Uplink02 172.27.12.3 172.27.12.2

sfo01m01udlr01 192.168.10.1 192.168.10.2

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.
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5 Click the Add icon to deploy a new NSX Edge.

The New NSX Edge wizard appears.

a On the Name and description page, enter the following settings and click Next.

Settings sfo01m01esg01 sfo01m01esg02

Install Type Edge Service Gateway Edge Service Gateway

Name sfo01m01esg01 sfo01m01esg02

Deploy NSX Edge Selected Selected

Enable High Availability Deselected Deselected

b On the Settings page, enter the following settings and click Next.

Settings Value

User Name admin

Password edge_admin_password

Enable SSH access Selected

Enable FIPS mode Deselected

Enable auto rule generation Selected

Edge Control Level logging INFO

c On the Configure deployment page, click Large to specify the Appliance Size and click the
Add icon. 

d In the Add NSX Edge Appliance dialog, enter the following settings, click OK, and click Next.

Setting Value

Cluster/Resource Pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Resource Reservation System Managed

Deployment for Region A

VMware, Inc.  71



e On the Configure interfaces page, click the Add icon to configure the Uplink01 interface, enter
the following settings, and click OK.

Setting sfo01m01esg01 sfo01m01esg02

Name Uplink01 Uplink01

Type Uplink Uplink

Connected To sfo01-m01-vds01-uplink01 sfo01-m01-vds01-uplink01

Connectivity Status Connected Connected

Primary IP Address 172.27.11.2 172.27.11.3

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

f Click the Add icon to configure the Uplink02 interface, enter the following settings, and click OK.

Setting sfo01m01esg01 sfo01m01esg02

Name Uplink02 Uplink02

Type Uplink Uplink

Connected To sfo01-m01-vds01-uplink02 sfo01-m01-vds01-uplink02

Connectivity Status Connected Connected

Primary IP Address 172.27.12.3 172.27.12.2

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

g Click the Add to configure the UDLR interface, enter the following settings click OK, and click
Next.

Setting sfo01m01esg01 sfo01m01esg02

Name sfo01m01udlr01 sfo01m01udlr01

Type Internal Internal

Connected To Universal Transit Network Universal Transit Network

Connectivity Status Connected Connected

Primary IP Address 192.168.10.1 192.168.10.2

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

h On the Default gateway settings page, deselect the Configure Default Gateway check box
and click Next.
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i On the Firewall and HA page, click Next.

j On the Ready to complete page, review the configuration settings that you entered and
click Finish.

6 Repeat this procedure to configure another NSX edge using the settings for the second NSX Edge
device.

7 Configure DRS anti-affinity rules for the Edge Services Gateways.

Note   You do not perform this step if the management cluster has more than four hosts.

a Go back to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01m01vc01.sfo01.rainpole.local  tree.

c Select the sfo01-m01-mgmt01 cluster, and click the Configure tab.

d Under Configuration, click VM/Host Rules.

e Click Add.

f In the sfo01-m01-mgmt01 - Create VM/Host Rule dialog box, enter the following settings and
click Add.

Setting Value

Name anti-affinity-rule-ecmpedges

Enable rule Selected

Type Separate Virtual Machine

g In the Add Rule Member dialog box, select the check box next to each of the two newly
deployed NSX ESGs and click OK.

h In the sfo01-m01-mgmt01 - Create VM/Host Rule dialog, click OK.

Disable the Firewall Service in Region A
Disable the firewall of the NSX Edge devices. This is required for equal-cost multi-path (ECMP) to operate
correctly. Perform this procedure for each NSX Edge device.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Double-click the sfo01m01esg01 NSX Edge device.

6 Click the Manage tab, then click Firewall.

7 In the Firewall page, click the Stop button.

8 Click Publish Changes.

9 Repeat this procedure for the NSX Edge device sfo01m01esg02.

Enable and Configure BGP Routing in Region A
Enable the Border Gateway Protocol (BGP) to exchange routing information between the NSX Edge
services gateway hosts in a network of autonomous systems (AS).

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Double-click the sfo01m01esg01 NSX Edge device. 
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6 Click the Manage tab and click Routing.

7 On the Global Configuration page, enter the following settings.

a Click the Start button for ECMP.

b To configure dynamic routing, click the Edit button next to Dynamic Routing Configuration.

c Select Uplink01 as the Router ID and click OK.

d Click Publish Changes.

8 On the Routing tab, select Static Routes.

a Click the Add icon, enter the following settings, and click OK.

Setting Value

Network 192.168.11.0/24

Next Hop 192.168.10.3

Interface sfo01m01udlr01

Admin Distance 210

b Click the Add icon, enter the following settings, and click OK.

Setting Value

Network 192.168.31.0/24

Next Hop 192.168.10.3

Interface sfo01m01udlr01

Admin Distance 210

c Click the Add icon, enter the following settings, and click OK.

Setting Value

Network 192.168.32.0/24

Next Hop 192.168.10.3

Interface sfo01m01udlr01

Admin Distance 210

d Click Publish Changes.
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9 On the Routing tab, select BGP.

a Click Edit, enter the following settings, and click OK.

Setting Value

Enable BGP Selected

Enable Graceful Restart Deselected

Enable Default Originate Deselected

Local AS 65003

b On the BGP page, click the Add icon to add a neighbor.

The New Neighbor dialog box appears. You add two neighbors: the first Top of Rack Switch and
the second Top of Rack Switch.

c In the New Neighbor dialog box, enter the following values for the first Top of Rack Switch, and
click OK.

Setting Value

IP Address 172.27.11.1

Remote AS 65001

Weight 60

Keep Alive Time 4

Hold Down Time 12

Password BGP_password

d Click the Add icon to add another neighbor.

The New Neighbor dialog box appears. Add the second Top of Rack switch.

e In the New Neighbor dialog box, enter the following values for the second Top of Rack Switch,
and click OK.

Setting Value

IP Address 172.27.12.1

Remote AS 65001

Weight 60

Keep Alive Time 4

Hold Down Time 12

Password BGP_password

f Click the Add icon to add another Neighbor.

The New Neighbor dialog box appears. Configure the universal distributed logical router (UDLR)
as a neighbor.
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g In the New Neighbor dialog box, enter the following values, and click OK.

Setting Value

IP Address 192.168.10.4

Remote AS 65003

Weight 60

Keep Alive Time 1

Hold Down Time 3

Password BGP_password

h Click Publish Changes.

The three neighbors you added appear in the Neighbors table.

10 On the Routing tab, select Route Redistribution.

a On the Route Redistribution page, click the Edit button.

b In the Change redistribution settings dialog, select the BGP check box and click OK.

c Click the Add icon for Route Redistribution table.

d In the New Redistribution criteria dialog box, enter the following settings and click OK.

Setting Value

Prefix Any

Learner Protocol BGP

OSPF Deselected

Static routes Selected

Connected Selected

Action Permit

e Click Publish Changes.

The route redistribution configuration appears in the Route Redistribution table.

11 Repeat this procedure for the NSX Edge device sfo01m01esg02.

Verify Peering of Upstream Switches and Establishment of BGP in Region A
The NSX Edge devices must establish a connection to each of the upstream BGP switches before BGP
updates can be exchanged. Verify that the NSX Edges devices are successfully peering, and that BGP
routing has been established.
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Procedure

1 Log in to the NSX Edge device using a Secure Shell (SSH) client.

a Open an SSH connection to the NSX Edge device sfo01m01esg01.

b Log in using the following credentials.

Setting Value

User name admin

Password edge_admin_password
 

2 Run the show ip bgp neighbors command to display information about the BGP connections to
neighbors.

The BGP State shows Established, UP if you have peered with the upstream switches.

Note   You have not yet created the universal distributed logical router (UDLR) and it does not appear
as a BGP neighbor.
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3 Run the show ip route command to verify that you are receiving routes using BGP, and that there
are multiple routes to BGP learned networks.

You verify multiple routes to BGP learned networks by locating the same route using a different IP
address. The IP addresses are listed after the word via in the right-side column of the routing table
output. In the following image there are two different routes to the following BGP networks: 0.0.0.0/0
and 172.27.22.0/24. You can identify BGP networks by the letter B in the left-side column. Lines
beginning with C (connected) have only a single route. 

4 Repeat this procedure for the NSX Edge device sfo01m01esg02.

Deploy the Universal Distributed Logical Router in Region A
Deploy the universal distributed logical router (UDLR).

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Click the Add icon to create a new UDLR.

6 Complete the New NSX Edge wizard to deploy and configure the UDLR.

a On the Name and description page, enter the following settings and click Next.

Setting Value

Logical (Distributed) Router Selected

Name sfo01m01udlr01

Deploy Edge Appliance Selected

Enable High Availability Selected

Enable HA Logging Selected

Log Level INFO

b On the Settings page, enter the following settings and click Next.

Setting Value

User Name admin

Password udlr_admin_password 

Confirm password udlr_admin_password 

Enable SSH access Selected

Enable FIPS mode Deselected

Edge Control Level logging INFO

c On the Configure deployment page, click the Add icon. 

d In the Add NSX Edge Appliance dialog box, enter the following settings and click OK.

Setting Value

Cluster/Resource Pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Resource Reservation System Managed
 

e On the Configure deployment page, click the Add icon a second time to add a second NSX
Edge device. 

Deployment for Region A

VMware, Inc.  80



f In the Add NSX Edge Appliance dialog box, enter the following settings and click OK.

Setting Value

Cluster/Resource Pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Resource Reservation System Managed
 

g On the Configure interfaces page, under HA Interface Configuration, click Change and
connect to sfo01-m01-vds01-management.

h On the Configure interfaces page, under Configure interfaces of this NSX Edge, click the
Add icon to configure the interface.

i In the Add Interface dialog box, enter the following settings, click OK, and click Next.

Setting Value

Name Uplink

Type Uplink

Connected To Universal Transit Network

Connectivity Status Connected

Primary IP Address 192.168.10.3

Subnet Prefix Length 24

MTU 9000

j On the Default gateway settings page, deselect Configure Default Gateway and click Next.

k On the Ready to complete page, click Finish.

7 Enable SSH access in the Universal Distributed Logical Router firewall.

a Double-click the device labeled sfo01m01udlr01.

b Click the Manage tab and click the Firewall tab.
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c Click Add icon to create a new firewall rule with the following settings.

Setting Value

Name enableSSH

Source any

Destination any

Service SSH

Action Accept

d Click Publish Changes.

Note   Step 8 is optional and applicable only when the management cluster with more than four
Hosts.

8 Configure DRS anti-affinity rules for the UDLR Virtual Machines and ESG Virtual Machines.

a Go back to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01m01vc01.sfo01.rainpole.local  tree.

c Select the sfo01-m01-mgmt01 cluster, and click the Configure tab.

d Under Configuration, click VM/Host Rules.

e Select System created UDLR anti-affinity-rule

f Click Edit.

g In the sfo01-m01-mgmt01 - Edit VM/Host Rule dialog box, enter the following settings and click
Ok.

Setting Value

Name anti-affinity-rule-edge-

Enable rule Selected

Type Separate Virtual Machine

h Click Add, select the two NSX ESGs, and click OK.

i In the sfo01-m01-mgmt01 - Edit VM/Host Rule dialog box, click OK.

Configure Universal Distributed Logical Router for Dynamic Routing in
Region A
Configure the Universal Distributed Logical Router (UDLR) to use dynamic routing.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Enable HA logging.

a Double-click the device labeled sfo01m01udlr01.

b Click the Manage tab and click the Settings tab

c Click Change in the HA Configuration window.

d Select the Enable Logging checkbox and click OK.

6 Configure the routing for the Universal Distributed Logical Router.

a Double-click sfo01m01udlr01.

b Click the Manage tab and click Routing.

c On the Global Configuration page, perform the following configuration steps. 

d Click Edit under Routing Configuration, select the Enable ECMP check box, and click OK

e Click Edit under Dynamic Routing Configuration, select Uplink as the Router ID, and
click OK.

f Click Publish Changes.

7 On the left, select BGP to configure it.

a On the BGP page, click the Edit button.

b In the Edit BGP Configuration dialog box, enter the following settings and click OK.

Setting Value

Enable BGP Selected

Enable Graceful Restart Deselected

Local AS 65003
 

c Click the Add icon to add a Neighbor.
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d In the New Neighbor dialog box, enter the following values for both NSX Edge devices and
click OK.

You repeat this step two times to configure the UDLR for both NSX Edge devices:
sfo01m01esg01 and sfo01m01esg02.

Setting sfo01m01esg01 Value sfo01m01esg02 Value

IP Address 192.168.10.1 192.168.10.2

Forwarding Address 192.168.10.3 192.168.10.3

Protocol Address 192.168.10.4 192.168.10.4

Remote AS 65003 65003

Weight 60 60

Keep Alive Time 1 1

Hold Down Time 3 3

Password BGP_password BGP_password

e Click Publish Changes.

8 On the left, select Route Redistribution to configure it.

a Click Edit.

b In the Change redistribution settings dialog box, enter the following settings and click OK.

Setting Value

OSPF Deselected

BGP Selected
 

c On the Route Redistribution page, select the default OSPF entry on the Route Redistribution
table and click Edit button.

d Select BGP from the Learner Protocol drop-down menu, and click OK.

e Click Publish Changes.

Verify Establishment of BGP for the Universal Distributed Logical Router in
Region A
The Universal Distributed Logical router (UDLR) must establish a connection to the Edge Services
Gateways before BGP updates can be exchanged. Verify that peering is successful and BGP routing has
been established.
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Procedure

1 Log in to the UDLR by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01m01udlr01.

b Log in using the following credentials.

Setting Value

User name admin

Password udlr_admin_password
 

2 Run the show ip bgp neighbors command to display information about the BGP and TCP
connections to neighbors. 

The BGP State shows Established, UP if you have successfully peered with the Edge Service
Gateway.

3 Run the show ip route command to verify that you are receiving routes using BGP, and that there
are multiple routes to BGP learned networks.

You verify multiple routes to BGP learned networks by locating the same route using a different IP
address. The IP addresses are listed after the word via in the right-side column of the routing table
output. In the following image there are two different routes to the BGP networks: 0.0.0.0/0,
172.27.11.0/24, 172.27.12.0/24, and 172.27.22.0/24. You can identify BGP networks by the letter B in
the left-side column. Lines beginning with C (connected) have only a single route.
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Distributed Firewall Configuration for Management Applications
Configuring a distributed firewall for use with your SDDC increases the security level of your environment
by allowing only the network traffic that is required for the SDDC to run. The firewall rules you define allow
access to management applications.

You define explicit rules for the distributed firewall that allow access to management applications.

Procedure

1 Add vCenter Server Instances to the NSX Distributed Firewall Exclusion List

Exclude vCenter Server from all of your distributed firewall rules. This ensures that network access
between vCenter Server and NSX is not blocked.

2 Create IP Sets for Components of the Management Cluster

Create IP sets for all management applications . You use the IP sets later to create security
groups for use with the distributed firewall rules.

3 Create Security Groups

Create security groups for use in configuring firewall rules for the groups of applications in the
SDDC.

4 Create Distributed Firewall Rules

A firewall rule consists of a section to segregate the firewall rules and the rule itself, which defines
what network traffic is allowed or blocked. You create firewall rules to allow administrators to connect
to the different VMware solutions, to allow user access to the vRealize Automation portal, and to
provide external connectivity to the SDDC.

Deployment for Region A

VMware, Inc.  86



Add vCenter Server Instances to the NSX Distributed Firewall Exclusion List
Exclude vCenter Server from all of your distributed firewall rules. This ensures that network access
between vCenter Server and NSX is not blocked.

You configure NSX Distributed Firewall using vCenter Server. If a rule prevents access between NSX
Manager and vCenter Server, you are not able to manage the distributed firewall. You must exclude
vCenter Server from all of your distributed firewall rules, ensuring that access between the two products is
not blocked.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Exclude vCenter Server instances from firewall protection.

a In the Navigator, click Networking & Security.

b Click Firewall Settings and select the Exclusion List tab.

c Select 172.16.11.65 from the NSX Manager drop-down menu.

d Click the Add button.

e Add sfo01m01vc01 to the Selected Objects list, and click OK.

Create IP Sets for Components of the Management Cluster
Create IP sets for all management applications . You use the IP sets later to create security groups for
use with the distributed firewall rules.

You perform this procedure multiple times to configure all necessary IP sets. For applications that are
load balanced, include their VIP in the IP Set.

Table 2‑12.  IP Sets for the Management Components

Name IP Addresses

Platform Services Controller Instances Platform-Service-Controller_IP's

vCenter Server Instances vCenter-Server_IP's

vRealize Automation Appliances vRealize-Automation-Appliances_IP's

vRealize Automation Windows vRealize-Automation-Windows _IP's

vRealize Automation Proxy Agents vRealize-Automation-Proxy-Agents-IP's
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Table 2‑12.  IP Sets for the Management Components (Continued)

Name IP Addresses

vRealize Business Server vRealize-Business_IP's

vRealize Business Data Collector vRealize-Business-Data-Collector_IP's

VMware VADP Solution vStorage-API for Data-Protection-Solution_IP's

vRealize Operations Manager vRealize-Operations-Manager_IP's

vRealize Operations Manager Remote Collectors vRealize-Operations-Manager-Remote-Collectors_IP's

vRealize Log Insight vRealize-Log-Insight_IP's

vRealize Suite Lifecycle Manager vRealize-Suite-Lifecycle-Manager_IP's

Site Recovery Manager Site-Recovery-Manger_IP's

vSphere Replication vSphere-Replication_IP's

Update Manager Download Service UMDS_IP's

SDDC Management-VLAN_Subnets, Management-VXLAN_Subnets

Administrators Administrators_Subnet

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create an IP set.

a In the Navigator, click Networking & Security.

b Click Groups and Tags and select the 172.16.11.65 instance.

c Click IP Sets.

d Click the Add icon.

e In the New  IP Set dialog box, configure the values for the IP set that you are adding, and
click Add.

Setting Value

Name vCenter Server Instances

IP Addresses 172.16.11.62,172.16.11.64

Universal Synchronization On
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3 Repeat this procedure to create IP sets for all remaining components.

Create Security Groups
Create security groups for use in configuring firewall rules for the groups of applications in the SDDC.

A security group is a collection of assets (or objects) from your vSphere inventory that you group together.

You perform this procedure multiple times to configure all of the necessary security groups. In addition,
you create the VMware Appliances and Windows Servers groups from the security groups you add in the
previous repetitions of this procedure.

Table 2‑13.  Security Groups for the Management Clusters Components in the SDDC

Name Object Type Selected Object

Platform Services Controller Instances IP Sets Platform Services Controller Instances

vCenter Server Instances IP Sets vCenter Server Instances

vRealize Automation Appliances IP Sets vRealize Automation Appliances

vRealize Automation Windows IP Sets vRealize Automation Windows

vRealize Business Server IP Sets vRealize Business Server

vRealize Automation Proxy Agents IP Sets vRealize Automation Proxy Agents

vRealize Business Data Collector IP Sets vRealize Business Data Collector

VMware Storage API for VADP Solution IP Sets VMware VADP

vRealize Operations Manager IP Sets vRealize Operations Manager

vRealize Operations Manager Remote Collectors IP Sets vRealize Operations Manager Remote Collectors

vRealize Suite Lifecycle Manager IP Sets vRealize Suite Lifecycle Manager

Site Recovery Manager IP Sets Site Recovery Manager

vSphere Replication IP Sets vSphere Replication

vRealize Log Insight IP Sets vRealize Log Insight

Update Manager Download Service IP Sets Update Manager Download Service

SDDC IP Sets SDDC

Administrators IP Sets Administrators
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Table 2‑13.  Security Groups for the Management Clusters Components in the SDDC
(Continued)

Name Object Type Selected Object

Windows Servers Security Groups n Site Recovery Manger
n vRealize Automation Windows
n vRealize Automation Proxy Agents

VMware Appliances Security Groups n Platform Services Controller Instances
n vCenter Server Instances
n vSphere Replication
n vRealize Automation Appliances
n vRealize Business Server
n vRealize Business Data Collector
n VMware vStorage API for Data Protection Solution
n vRealize Operations Manager
n vRealize Operations Manager Remote Collectors
n vRealize Suite Lifecycle Manager
n vRealize Log Insight

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Networking & Security and click Groups and Tags.

3 Select the 172.16.11.65 NSX Manger instance, and click the Security Groups tab.

4 Click the Add new Security Group icon. 

The Add Security Group wizard appears.

5 On the Name and description page, enter Platform Services Controller Instances in
the Name text box, click the Universal Synchronization toggle to On, and click Next.

6 On the Select Objects to include page, select IP Sets from the Object Type drop-down menu,
select Platform Services Controller Instances from the list of available objects, click
the Add button, and click Next.

7 On the Ready to Complete page, verify the configuration values that you entered and click Finish.

8 Repeat this procedure to create all of the necessary security groups.
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Create Distributed Firewall Rules
A firewall rule consists of a section to segregate the firewall rules and the rule itself, which defines what
network traffic is allowed or blocked. You create firewall rules to allow administrators to connect to the
different VMware solutions, to allow user access to the vRealize Automation portal, and to provide
external connectivity to the SDDC.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Add a section of rules for the management applications.

a In the Navigator, click Networking & Security and click Firewall.

b From the NSX Manager drop-down menu, select 172.16.11.65.

c Click the Add Section icon.

d In the Add New Section dialog box, enter VMware Management Services in the Section Name
text box, click the Universal Synchronization toggle to On, and click Save.

3 Create a distributed firewall rule to allow SSH access to administrators for the different VMware
appliances.

a Click Add rule in the VMware Management Services section.

b In the Name column of the new rule, enter the rule name as Allow SSH to admins.

c Click the Edit icon in the Source column, change the Object Type to Security Group, add
Administrators to the Selected Objects list, and click Save.

d Click the Edit icon in the Destination column, change the Object Type to Security
Group, add VMware Appliances and Update Manager Download Service to the Selected
Objects list, and click Save.

e Click the Edit icon in the Service column, enter SSH in the Search filter of the Available Objects,
add SSH to the Selected Objects list, and click Save.

f Click Publish.
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4 Repeat the previous step to create the following distributed firewall rules.

Name Source Destination Service / Port

Allow vRA Portal to end users * any n vRealize Automation Appliances
n vRealize Automation Windows
n vRealize Business Server

HTTP, HTTPS

Allow vRA Console Proxy to end users * any vRealize Automation Appliances TCP:8444

Allow SDDC to any SDDC * any * any

Allow PSC to admins Administrators Platform Services Controller Instances HTTPS

Allow SSH to admins Administrators n VMware Appliances
n Update Manager Download Service

SSH

Allow RDP to admins Administrators Windows Servers RDP

Allow Orchestrator to admins Administrators vRealize Automation Appliances TCP:8281,8283

Allow vRB Data Collector to admins Administrators vRealize Business Data Collector HTTP, HTTPS

Allow vROPs to admins Administrators n vRealize Operations Manager
n vRealize Operations Manager Remote

Collectors

HTTP, HTTPS

Allow vRLI to admins Administrators vRealize Log Insight HTTP, HTTPS

Allow vRSLCM to admins Administrators vRealize Suite Lifecycle Manager HTTPS

Allow VAMI to admins Administrators VMware Appliances TCP:5480

Allow VMware VADP Solution to admins Administrators VMware Appliances TCP:8543

5 Change the default rule action from Allow to Block.

a From the NSX Manager drop-down menu, select 172.16.11.65.

b Under Default Section Layer3, in the Action column for the Default Rule, change the action
to Block and click Save.

c Click Publish Changes.

Network security is improved by allowing only required network traffic by the SDDC to pass.

Test the Management Cluster NSX Configuration in Region A
Test the configuration of the NSX logical network using a ping test. A ping test checks if two hosts in a
network can reach each other.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Use the Ping Monitor to test connectivity.

a Select Home, then select Networking & Security.

b Under Logical Switches, double-click Transit Network.

c Click the Monitor tab and select Ping.

d From the Source host drop-down menu, select sfo01m01esx01.sfo01.rainpole.local.

e Leave the Size of test packet with the default of VXLAN standard.

f From the Destination host drop-down menu, select sfo01m01esx03.sfo01.rainpole.local.

g Click Start Test.

The host-to-host ping test results are displayed in the Results text box. Verify that there are no
error messages.

Deploy Application Virtual Networks in Region A
Deploy the application virtual networks for the Management workloads.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create a Universal Logical Switch for workloads .

a Under Inventories, click Networking & Security.

b In the Navigator, click Logical Switches.
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c Select 172.16.11.65 from the NSX Manager drop-down menu.

d Click the New Logical Switch icon to create a new Logical Switch.

e In the New Logical Switch dialog box, enter the following settings and click OK.

Setting Value

Name Mgmt-xRegion01-VXLAN

Transport Zone Mgmt Universal Transport Zone

Replication Mode Hybrid

3 Create a Universal Logical Switch for workloads specific to Region A.

a On the Logical Switches page, click the Add icon to create a new Logical Switch.

b In the New Logical Switch dialog box, enter the following settings, and click OK.

Setting Value

Name Mgmt-RegionA01-VXLAN

Transport Zone Mgmt Universal Transport Zone

Replication Mode Hybrid

4 Connect Mgmt-xRegion01-VXLAN to the Universal Distributed Logical Router.

a On the Logical Switches page, select the Mgmt-xRegion01-VXLAN Logical Switch.

b Click the Connect Edge icon.

c On the Connect an Edge page, select sfo01m01udlr01 and click Next.

d On the Edit NSX Edge Interface page, enter the following settings and click Next.

Setting Value

Name Mgmt-xRegion01-VXLAN

Type Internal

Connected To Mgmt-xRegion01-VXLAN

Connectivity Status Connected

Primary IP Address 192.168.11.1

Subnet Prefix Length 24

e On the Ready to complete page, click Finish. 

5 Connect Mgmt-RegionA01-VXLAN to the Universal Distributed Logical Router.

a On the Logical Switches page, select the Mgmt-RegionA01-VXLAN Logical Switch.

b Click the Connect Edge icon.

c On the Connect an Edge page, select sfo01m01udlr01 and click Next.
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d On the Edit NSX Edge Interface page, enter the following settings and click Next.

Setting Value

Name Mgmt-RegionA01-VXLAN

Type Internal

Connected To Mgmt-RegionA01-VXLAN

Connectivity Status Connected

Primary IP Address 192.168.31.1

Subnet Prefix Length 24

e On the Ready to complete page, click Finish.

6 Configure the MTU for the Logical Switches.

a In the Navigator, select NSX Edges.

b Double-click sfo01m01udlr01.

c Click the Manage tab and click Settings.

d On the Settings page, click Interfaces. 

e Under Interfaces, select Mgmt-RegionA01-VXLAN, and click Edit.

f On the Edit Logical Router Interface, configure MTU, and click OK.

Setting Value

Mgmt-RegionA01-VXLAN 9000

Mgmt-xRegion01-VXLAN 9000
 

Deploy the NSX Load Balancer in Region A
Deploy a load balancer for use by management applications connected to the application virtual network,
Mgmt-xRegion01-VXLAN.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.
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3 In the Navigator, click NSX Edges.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Click the Add icon to create an NSX Edge.

6 On the Name and description page, enter the following settings and click Next.

Setting Value

Install Type Edge Services Gateway

Name sfo01m01lb01

Hostname sfo01m01lb01.sfo01.rainpole.local

Deploy NSX Edge Selected

Enable High Availability Selected

7 On the Settings page, enter the following settings and click Next.

Setting Value

User Name admin

Password edge_admin_password

Enable SSH access Selected

Enable FIPS mode Deselected

Enable auto rule generation Selected

Edge Control Level logging INFO

8 On the Configure deployment page, perform the following configuration steps, and click Next. 

a Select sfo01-m01dc, from the Datacenter drop-down menu.

b Click Large to specify the Appliance Size.

c Click the Add icon, enter the following settings, and click OK.

Setting Value

Resource pool sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Folder sfo01-m01fd-nsx

Resource Reservation System Managed
 

d To create a second appliance, click the Add icon again, make the same selections in the New
NSX Appliance dialog box, and click OK.
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9 On the Configure interfaces page, click the Add icon to configure the OneArmLB interface, enter
the following settings, click OK, and click Next.

Setting Value

Name OneArmLB

Type Internal

Connected To Mgmt-xRegion01-VXLAN

Connectivity Status Connected

Primary IP Address 192.168.11.2

Subnet Prefix Length 24

MTU 9000

Send ICMP Redirect Selected

10 On the Default gateway settings page, click Next.

11 On the Firewall and HA page, select the following settings and click Next. 

Setting Value

Configure Firewall default policy Selected

Default Traffic Policy Accept

Logging Disable

vNIC any

Declare Dead Time 15

12 On the Ready to complete page, review the configuration settings you entered and click Finish.

13 Enable HA logging.

a In the Navigator, click NSX Edges.

b Select 172.16.11.65 from the NSX Manager drop-down menu.

c Double-click the sfo01m01lb01 device.

d Click the Manage tab and click the Settings tab.

e Click Change in the HA Configuration window.

f Select the Enable Logging checkbox and click OK.

14 Configure the Default Gateway.

a In the Navigator, click NSX Edges.

b Select 172.16.11.65 from the NSX Manager drop-down menu.

c Double-click the sfo01m01lb01 device.

d Click the Manage tab and click the Routing tab.
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e Click the Edit button to configure the Default Gateway and enter 192.168.11.1.

f Click Publish Changes.

15 Enable the Load Balancer service. 

a In the Navigator, click NSX Edges.

b Select 172.16.11.65 from the NSX Manager drop-down menu.

c Double-click the sfo01m01lb01 device.

d Click the Manage tab, click the Load Balancer tab, click Global Configuration, and click Edit.

e In the Edit Load balancer global configuration dialog, select Enable Load Balancer and click
OK.

Deploy and Configure the Shared Edge and Compute
Cluster Components in Region A
Deploy and configure the shared edge and compute cluster components.

Prerequisites for Implementation of the Shared Edge and
Compute Cluster
Before you deploy the Shared Edge and Compute vCenter Server, verify that your environment satisfies
the requirements for this deployment.

IP Addresses and Host Names
Verify that static IP addresses and FQDNs for the shared edge and compute networks are available for
the SDDC deployment.

Verify that you have configured the Platform Services Controller load balancer and the management
vCenter Server. Allocate one static IP address and an FQDN for the Shared Edge and Compute vCenter
Server.

Table 2‑14.  Network Names for SDDC Components

vCenter Server Network

vCenter Server sfo01-m01-vds01-management

Table 2‑15.  IP Addresses and Host Names for the vCenter Server in Region A

Role IP Address FQDN

Platform Services Controller load balancer VIP address 172.16.11.71 sfo01psc01.sfo01.rainpole.local

Compute vCenter Server 172.16.11.64 sfo01w01vc01.sfo01.rainpole.local

Default gateway 172.16.11.253 -

DNS server n 172.16.11.5
n 172.16.11.4

-
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Table 2‑15.  IP Addresses and Host Names for the vCenter Server in Region A
(Continued)

Role IP Address FQDN

Subnet mask 255.255.255.0 -

NTP servers n 172.16.11.251
n 172.16.11.252

n ntp.sfo01.rainpole.local

Deployment Prerequisites
Verify that your environment satisfies the following prerequisites for the deployment of the vCenter Server.

Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per vCenter Server
n Initial storage for the vCenter Server: 600 GB

Software Features n Verify that management vCenter Server is operational.
n Verify that the PSC Load Balancer is configured.

Installation Package n Download the .iso file for the vCenter Server.

License n Verify that you have obtained vCloud Suite license with a quantity that satisfies the requirements of
this design.

Active Directory n Verify that you have a parent active directory with the SDDC user roles configured for the
rainpole.local domain.

svc-domain-join(Enterprise Admins)

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the Shared Edge and

Compute vCenter Server. See the VMware Validated Design Planning and Preparation documentation

Deploy the Compute vCenter Server Instance in Region A
After you install and configure the external Platform Services Controller instance for the shared edge and
compute cluster, you can now install the vCenter Server appliance and assign a license. 

Procedure

1 Start the vCenter Server Appliance Deployment wizard.

a Browse the vCenter Server Appliance ISO file.

b Open the <dvd-drive>:\vcsa-ui-installer\win32\Installer application file.

2 Complete the vCenter Server Appliance Deployment wizard to perform the first stage of the
installation.

a Click Install to start the installation.

b Click Next on the Introduction page.
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c On the End user license agreement page, select the I accept the terms of the license
agreement check box and click Next.

d On the Select deployment type page, under External Platform Services Controller, select
the vCenter Server (Requires External Platform Services Controller) radio button and click
Next.

e On the Appliance deployment target page, enter the following settings and click Next.

Setting Value

ESXi host or vCenter Server name sfo01m01vc01.sfo01.rainpole.local

HTTPS port 443

User name administrator@vsphere.local

Password vsphere_admin_password
 

f In the Certificate Warning dialog, click Yes to accept the host certificate.

g On the Select folder page, select sfo01-m01fd-mgmt and click Next.

h On the Select compute resource page, select the sfo01-m01-mgmt01 cluster and click Next.

i On the Set up appliance VM page, enter the following settings, and click Next.

Setting Value

VM name sfo01w01vc01

Root password compvc_root_password

Confirm root password compvc_root_password
 

j On the Select deployment size page, select Large vCenter Server, and click Next.

k On the Select datastore page, select the sfo01-m01-vsan01 datastore, select the Enable Thin
Disk Mode check box, and click Next.

l On the Configure network settings page, enter the following settings, and click Next.

Setting Value

Network sfo01-m01-vds01-management

IP version IPv4

IP assignment static

System name sfo01w01vc01.sfo01.rainpole.local

IP address 172.16.11.64

Subnet mask or prefix length 255.255.255.0

Default gateway 172.16.11.253

DNS servers 172.16.11.5,172.16.11.4

HTTP 80

HTTPS 443
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m On the Ready to complete stage 1 page, review the configuration and click Finish to start the
deployment.

n After the deployment completes, click Continue to proceed to stage two of the installation.

3 Complete the Install - Stage 2: Set Up vCenter Server Appliance wizard to complete the second
stage of the installation.

a Click Next on the Introduction page.

b On the Appliance configuration page, enter the following settings, and click Next.

Setting Value

Time synchronization mode Synchronize time with NTP servers

NTP servers (comma-separated list) ntp.sfo01.rainpole.local

SSH access Enabled
 

c On the SSO configuration page, enter the following settings and click Next.

Setting Value

Platform Services Controller sfo01psc01.sfo01.rainpole.local

HTTPS port 443

SSO domain name vsphere.local

SSO password sso_password
 

d On the Ready to complete page, review the configuration and click Finish.

e Click OK on the Warning.

f On the Complete page, click Close.

Replace the Certificate of the Compute vCenter Server in Region
A
To establish trusted connection with the other SDDC management components, you replace the machine
SSL certificate on each vCenter Server instance with a custom certificate that is signed by the certificate
authority (CA) available on the parent Active Directory (AD) server.

Use the following certificate files to replace the certificate on the Compute vCenter Server:

Table 2‑16.  Certificate-Related Files on the vCenter Server Instance

vCenter Server FQDN Files for Certificate Replacement

sfo01w01vc01.sfo01.rainpole.local n sfo01w01vc01.key
n sfo01w01vc01.1.cer
n Root64.cer

Deployment for Region A

VMware, Inc.  101



Procedure

1 Log in to vCenter Server by using Secure Shell (SSH) client.

a Open an SSH connection to the sfo01w01vc01.sfo01.rainpole.local virtual machine.

b Log in using the following credentials.

Setting Value

User name root

Password vcenter_server_root_password

2 Change the vCenter Server appliance command shell to the Bash shell to enable secure copy (scp)
connections for the root user.

shell

chsh -s "/bin/bash" root

3 Copy the generated certificates to the vCenter Server Appliance.

a Run the following command to create a new temporary folder.

mkdir -p /root/certs

b Copy the certificate files sfo01w01vc01.1.cer, sfo01w01vc01.key, and Root64.cer to
the /root/certs folder.

You can use an scp software such as WinSCP.

4 Replace the CA-signed certificate on the vCenter Server instance.

a Start the vSphere Certificate Manager utility on the vCenter Server instance.

/usr/lib/vmware-vmca/bin/certificate-manager

b Select Option 1 (Replace Machine SSL certificate with Custom Certificate), enter the
default vCenter Single Sign-On user name administrator@vsphere.local and the
vsphere_admin_password password.

c When prompted for the Infrastructure Server IP, enter the IP address of the Platform Services
Controller that manages this vCenter Server instance.

Option IP Address of Connected Platform Services Controller

sfo01w01vc01.sfo01.rainpole.local 172.16.11.71
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d Select Option 2 (Import custom certificate(s) and key(s) to replace existing Machine SSL
certificate).

e When prompted, provide the full path to the custom certificate, the root certificate file, and the key
file that you copied over earlier, and confirm the import with Yes (Y).

vCenter Server Input to the vSphere Certificate Manager Utility

sfo01w01vc01.sfo01.rainpole.local Please provide valid custom certificate for Machine SSL.

File : /root/certs/sfo01w01vc01.1.cer

Please provide valid custom key for Machine SSL.

File : /root/certs/sfo01w01vc01.key

Please provide the signing certificate of the Machine SSL certificate.

File : /root/certs/Root64.cer
 

5 After Status shows 100% Completed, wait several minutes until all vCenter Server services are
restarted.

6 Restart the vami-lighttp service to update the certificate on the virtual appliance management
interface (VAMI) and to remove certificate files.

service vami-lighttp restart

cd /root/certs/

rm sfo01w01vc01.1.cer sfo01w01vc01.key Root64.cer

Set SDDC Deployment Details on the Compute vCenter Server in
in Region A
Set an identity of your SDDC deployment on the Compute vCenter Server in Region A. You can also use
this identity as a label in tools for automated SDDC deployment.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Global Inventory Lists.

3 In the Navigator, click vCenter Servers under Resources.

4 Click the sfo01w01vc01.sfo01.rainpole.local vCenter Server object and click the Configure tab in
the central pane.
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5 Under the Settings pane, click Advanced Settings and click the Edit button.

6 In the Edit Advanced vCenter Server Settings dialog box, set the following value pairs one by one,
clicking Add after each entry.

Name Value

config.SDDC.Deployed.Type VVD

config.SDDC.Deployed.Flavor Standard

config.SDDC.Deployed.Version 4.3.0

config.SDDC.Deployed.WorkloadDomain SharedEdgeAndCompute

config.SDDC.Deployed.Method DIY

config.SDDC.Deployed.InstanceId unique_identifier*

Note   * Use the unique_identifier you generated for the Management vCenter Server. See Set
SDDC Deployment Details on the Management vCenter Server in in Region A.

7 Click OK to close the window.

Add New vCenter Server Licenses in Region A
(Optional) If a license is not assigned during deployment of the Management vCenter Server and ESXi
hosts, you may add new licenses for this vCenter Server instance if needed.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click the Home icon above the Navigator and select Administration.

3 On the Administration page, click Licenses and click the Licenses tab.

4 Click the Create New Licenses icon to add license keys.

5 On the Enter license keys page, enter license keys for vCenter Server and ESXi, one per line, and
click Next.

6 On the Edit license name page, enter a descriptive name for the license key, and click Next.

7 On the Ready to complete page, review your entries, and click Finish.
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8 Assign the newly added licenses to the respective assets.

a Click the Assets tab and select vCenter Server systems.

b Select the sfo01w01vc01.sfo01.rainpole.local vCenter Server instance, and click the Assign
License icon.

c Select the vCenter Server license that you entered in the previous step and click OK.

Add the Shared Edge and Compute vCenter to the vCenter
Servers VM Group in Region A
After the vCenter Server for the Shared Edge and Computer cluster is deployed it must be added to the
vCenter VM Group.

Procedure

1 Log in to the Management vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, select Hosts and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Select the sfo01-m01-mgmt01 cluster and click Configure.

4 On the Configure page, click VM/Host Groups.

5 On the VM/Host Groups page, select the vCenter Servers VM Group.

6 Under VM/Host Group Members, click the Add button.

7 In the Add Group Member dialog, select sfo01w01vc01 and click OK.

Exclude the Compute vCenter Server from the Distributed Firewall
in Region A
Exclude vCenter Server from all of your distributed firewall rules. This ensures that network access
between vCenter Server and NSX is not blocked.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Networking & Security.

3 Click Firewall Settings and select the Exclusion List tab.

4 Select 172.16.11.65 from the NSX Manager drop-down menu.

5 Click the Add button.

6 Add sfo01w01vc01 to the Selected Objects list, and click OK.

Configure the Shared Edge and Compute Cluster in Region A
After you deploy the Compute vCenter Server, you must create and configure the shared edge and
compute cluster.

To create and configure the shared edge and compute cluster, you perform the following procedures:

n Create the cluster.

n Configure DRS.

n Add the hosts to the cluster.

n Add the hosts to the active directory domain.

n Create resource pools.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Create a data center object.

a In the Navigator, click Hosts and Clusters.

b Right-click the sfo01w01vc01.sfo01.rainpole.local instance, and select New Datacenter.

c In the New Datacenter dialog box, enter sfo01-w01dc,  and click OK.

3 Create the shared edge and compute cluster. 

a Right-click the sfo01-w01dc data center and click New Cluster.

b In the New Cluster wizard, enter the following values and click OK. 

Setting Value

Name sfo01-w01-comp01

DRS Turn ON Selected

Other DRS options Default values

vSphere HA Turn ON Deselected

EVC Set EVC mode to the highest available baseline that is supported for the lowest
CPU architecture on the hosts in the cluster

vSAN Turn ON Deselected

4 Add a host to the shared edge and compute cluster.

a Right-click the sfo01-w01-comp01 cluster, and click Add Host.

b On the Name and location page, enter sfo01w01esx01.sfo01.rainpole.local in the Host
name or IP address text box and click Next.

c On the Connection settings page, enter the following credentials, and click Next.

Setting Value

User name root

Password esxi_root_user_password
 

d In the Security Alert dialog box, click Yes.

e On the Host summary page, review the host information and click Next.

f On the Assign license page, select the ESXi license key that you entered during the vCenter
Server deployment and click Next.

g On the Lockdown mode page, click Next.

h On the Resource pool page, click Next.

i On the Ready to complete page, review your entries and click Finish.
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5 Repeat the previous step to add the remaining hosts to the cluster.

Setting Value

Host 2 sfo01w01esx02.sfo01.rainpole.local

Host 3 sfo01w01esx03.sfo01.rainpole.local

Host 4 sfo01w01esx04.sfo01.rainpole.local
 

6 Add an ESXi host to the Active Directory domain

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01w01vc01.sfo01.rainpole.local tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab.

d Under System, select Authentication Services.

e In the Authentication Services panel, click the Join Domain button.

f In the Join Domain dialog box, enter the following settings, and click OK.

Setting Value

Domain sfo01.rainpole.local

User name svc-domain-join@rainpole.local

Password svc-domain-join_password
 

7 Set the Active Directory Service to Start and stop with host.

a In the Navigator, click Hosts and Clusters and expand the entire
sfo01w01vc01.sfo01.rainpole.local tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab.

d Under System, select Security Profile.

e Click the Edit button next to Services.

f Select the Active Directory service, change the Startup Policy to Start and stop with host and
click OK.
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8 Configure resource pools for the shared edge and compute cluster.

a Right-click the sfo01-w01-comp01 cluster and select New Resource Pool.

b In the New Resource Pool dialog box, enter the following values and click OK.

Setting Resource Pool 1 Resource Pool 2 Resource Pool 3

Name sfo01-w01rp-sddc-edge sfo01-w01rp-user-edge sfo01-w01rp-user-vm

CPU-Shares High Normal Normal

CPU-Reservation 0 0 0

CPU-Reservation Type Expandable selected Expandable selected Expandable selected

CPU-Limit Unlimited Unlimited Unlimited

Memory-Shares Normal Normal Normal

Memory-Reservation 16 GB 0 0

Memory-Reservation type Expandable selected Expandable selected Expandable selected

Memory-Limit Unlimited Unlimited Unlimited

9 Repeat the previous step to add two more additional resource pools.

Create a vSphere Distributed Switch for the Shared Edge and
Compute Cluster in Region A
After all ESXi hosts are added to the cluster, you create a vSphere Distributed Switch.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create a vSphere Distributed Switch for the shared edge and compute cluster.

a In the Navigator, click Networking and expand the sfo01w01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-w01dc data center and select Distributed Switch > New Distributed
Switch to start the New Distributed Switch wizard .

c On the Name and location page, enter sfo01-w01-vds01 as the name and click Next.

d On the Select version page, ensure the Distributed switch version: 6.5.0 radio button is
selected and click Next.

Deployment for Region A

VMware, Inc.  109



e On the Edit settings page, enter the following values and click Next.

Setting Value

Number of uplinks 2

Network I/O Control Enabled

Create a default port group Deselected

f On the Ready to complete page, review your entries and click Finish.

3 Edit the settings of the sfo01-w01-vds01 distributed switch.

a Right-click the sfo01-w01-vds01 distributed switch and select Settings > Edit Settings.

b Click the Advanced tab.

c Enter 9000 as MTU (Bytes) value and click OK.

4 Create port groups in the sfo01-w01-vds01 distributed switch.

a Right-click the sfo01-w01-vds01 distributed switch, and select Distributed Port Group > New
Distributed Port Group. 

b Create port groups with the following settings and click Next.

Port Group Name Port Binding Port Allocation Number of Ports VLAN Type VLAN ID

sfo01-w01-vds01-management Static binding Elastic 8 VLAN 1631

sfo01-w01-vds01-vmotion Static binding Elastic 8 VLAN 1632

sfo01-w01-vds01-vsan Static binding Elastic 8 VLAN 1633

sfo01-w01-vds01-nfs Static binding Elastic 8 VLAN 1625

sfo01-w01-vds01-uplink01 Static binding Elastic 8 VLAN 1635

sfo01-w01-vds01-uplink02 Static binding Elastic 8 VLAN 2713

Note   You create the VXLAN port group at a later time during the configuration of NSX Manager.

c On the Ready to complete page, review your entries and click Finish.

d Repeat this step for each port group.

5 Change the Port Groups to use the Route Based on Physical NIC load teaming algorithm.

a Right-click the sfo01-w01-vds01 distributed switch and select Distributed Port Groups >
Manage Distributed Port Groups.

b On the Select port group policies page, select the Teaming and failover check box and click
Next.

c On the Select port groups page, click the Select distributed port groups button, add all port
groups except sfo01-w01-vds01-uplink01 and sfo01-w01-vds01-uplink02, click OK, and click
Next. 
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d On the Teaming and failover page, select Route based on physical NIC load from the Load
balancing drop-down menu and click Next.

e Click Finish.

6 Configure the uplinks for the sfo01-w01-vds01-uplink01 and sfo01-w01-vds01-uplink02 port groups.

a Right click the sfo01-w01-vds01-uplink01 port group, and click Edit Settings.

b Select Teaming and Failover.

c Move Uplink2 to Unused uplinks and click OK.

d Right click the sfo01-w01-vds01-uplink02 port group, and click Edit Settings.

e Select Teaming and Failover.

f Move Uplink1 to Unused uplinks and click OK.

7 Connect the ESXi host, sfo01w01esx01.sfo01.rainpole.local, to the sfo01-w01-vds01 distributed
switch by migrating its VMkernel and virtual machine network adapters.

a Right-click the sfo01-w01-vds01 distributed switch, and click Add and Manage Hosts.

b On the Select task page, select Add hosts and click Next.

c On the Select hosts page, click New hosts.

d In the Select new hosts dialog box, select sfo01w01esx01.sfo01.rainpole.local, click OK, and
click Next.

e On the Select network adapter tasks page, ensure both Manage physical
adapters and Manage VMkernel adapters check boxes are selected and click Next.

f On the Manage physical network adapters page, click vmnic1, and click Assign uplink.

g In the Select an Uplink for vmnic1 dialog box, select Uplink2 and click OK.

h On the Manage physical network adapters page, click Next.

8 Configure the VMkernel network adapters.

a On the Manage VMkernel network adapters page, click vmk0 and click Assign port group.

b Select sfo01-w01-vds01-management and click OK.

c On the Manage VMkernel network adapters page, click On this switch and click New adapter.

d On the Add Networking page, click Select and existing network, select the sfo01-w01-vds01-
nfs port group, click OK, and click Next.

e Under Port properties click Next.

f Under IPv4 settings  select Use static IPv4 settings, enter the IP address 172.16.25.101 and
the subnet 255.255.255.0, and click Finish.

g On the Manage VMkernel network adapters page, click Next.
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h On the Analyze impact page, click Next.

i On the Ready to complete page, review your entries and click Finish.

9 Create the vMotion VMkernel adapter.

a In the Navigator, click Host and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Click sfo01w01esx01.sfo01.rainpole.local.

c Click the Configure tab then select VMkernel adapters.

d Click the Add host networking icon and select VMkernel Network Adapter and click Next.

e On the Select target device page, click Select an existing network, select the sfo01-w01-
vds01-vmotion port group, click OK, and click Next.

f On the Port properties page, select vMotion from the TCP/IP stack drop-down menu and click
Next.

g On the IPv4 settings page, select Use static IPv4 settings, enter the IP address
172.16.32.101, enter the subnet 255.255.255.0, and click Next.

h Click Finish.

10 Configure the MTU on the vMotion VMkernel adapter.

a Select the vMotion VMkernel adapter created in the previous step, and click Edit Settings.

b Click the NIC settings page.

c Enter 9000 for the MTU value and click OK.

11 Configure the vMotion TCP/IP stack.

a Under Networking , click TCP/IP configuration.

b Select vMotion and click the Edit TCP/IP stack configuration icon.

c Click Routing, enter 172.16.32.253 for the VMkernel gateway address, and click OK.

12 Define Network I/O Control shares for the different traffic types on the sfo01-w01-vds01 distributed
switch.

a In the Navigator, click Networking, and click the sfo01-w01dc data center.

b Click the sfo01-w01-vds01 distributed switch.
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c Click the Configure tab, under Resource Allocation click System traffic.

d Under System Traffic, edit each of the following traffic types with the values from the table.

Traffic Type Value

vSAN Traffic High

NFS Traffic Low

vMotion Traffic Low

vSphere Replication Traffic Low

Management Traffic Normal

vSphere Data Protection Backup Traffic Low

Virtual Machine Traffic High

Fault Tolerance Traffic Low

iSCSI Traffic Low

13 Migrate the last physical adapter from the standard switch to the sfo01-w01-vds01 distributed switch.

a In the Navigator, click Networking and expand the sfo01-w01dc data center.

b Right-click the sfo01-w01-vds01 distributed switch and select Add and Manage hosts.

c On the Select task page, select Manage host networking and click Next.

d On the Select hosts page, click Attached hosts.

e On the Select member hosts dialog box, select sfo01w01esx01.sfo01.rainpole.local and
click OK.

f On the Select hosts page, click Next.

g On the Select network adapter tasks page, select Manage Physical adapters and click Next.

h On the Manage physical network adapters page, under sfo01w01esx01.sfo01.rainpole.local,
select vmnic0, and click Assign uplink.

i In the Select an Uplink for vmnic0 dialog box, select Uplink 1, click OK, and click Next.

j On the Analyze Impact page, click Next.

k On the Ready to complete page, click Finish.

14 Enable vSphere Distributed Switch Health Check.

a In the Navigator, click Networking and expand the sfo01-w01dc data center.

b Select the sfo01-w01-vds01 distributed switch and click the Configure tab.

c In the Navigator under Settings, select Health check and click the Edit button.

d Select Enabled for VLAN and MTU and Teaming and failover and click OK.
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15 Remove the vSphere Standard Switch.

a In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Click sfo01w01esx01.sfo01.rainpole.local and click Configure.

c On the Configure page, select Virtual switches.

d On the Virtual switches page, select vSwitch0, and then click the Remove selected standard
switch button.

e On the Remove Standard Switch dialog box , click Yes.

Enable vSphere HA on the Shared Edge and Compute Cluster in
Region A
After the vSphere Distributed Switch has been created and connected with all hosts, enable vSphere HA
on the cluster.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

3 Select the sfo01-w01-comp01 cluster.

4 Click the Configure tab and click vSphere Availability.

5 Click Edit.

6 In the sfo01-w01-comp01 - Edit Cluster Settings dialog, select the Turn on vSphere HA check
box.

7 Click Failures and Responses, select the following values.

Setting Value

Enable Host Monitoring Selected

Host Failure Response Restart VMs

Response for Host Isolation Power off and restart VMs

Datastore with PDL Disabled
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Setting Value

Datastore with APD Disabled

VM Monitoring VM Monitoring Only

8 Click Admission Control, select the following values.

Setting Value

Host failures cluster tolerates 1

Define host failover capacity by Cluster resource percentage

Override calculated failover capacity Deselected

Performance degradation VMs tolerate 100%

9 Click OK.

Configure SSH, NTP, and Advanced Options on the First ESXi Host
in the Shared Edge and Compute Cluster in Region A
Time synchronization issues can result in serious problems with your environment. Configure NTP for
each of your hosts in the shared edge and compute clusters. Change the default ESX Admins group to
achieve greater levels of security by removing a known administrative access point.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Enable SSH and NTP.

a In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab and under System, click Security Profile.

d Under Services section, click the Edit button.

e In the Edit Security Profile dialog box, select SSH, select Start and stop with host from the
Startup Policy drop down list, click Start button.
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f In the Edit Security Profile dialog box, select NTP Daemon, change the Startup policy to Start
and stop with host, click Start button.

g Click OK to save the changes.

3 Configure the NTP Daemon (ntpd) options.

a In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab and under System, click Time Configuration.

d Click the Edit button.

e In the Edit Time Configuration dialog box, select the Use Network Time Protocol (Enable NTP
client) radio button, change the NTP service startup policy to Start and stop with host, and
enter ntp.sfo01.rainpole.local,ntp.lax01.rainpole.local as NTP servers, click Start
button.

f Click OK to save the changes.

4 Change the default ESX Admins group.

a In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab and under System, click Advanced System Settings.

d Click the Edit button.

e In the filter box, enter esxAdmins and wait for the search results.

f Change the value of Config.HostAgent.plugins.hostsvc.esxAdminsGroup to SDDC-Admins
and click OK.

5 Disable the SSH warning banner.

a In the Navigator, click Hosts and Clusters expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Select the sfo01w01esx01.sfo01.rainpole.local host.

c Click the Configure tab and under System, click Advanced System Settings.

d Click the Edit button.

e In the filter box, enter ssh and wait for the search results.

f Change the value of UserVars.SuppressShellWarning to 1 and click OK.
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Mount NFS Storage for the Shared Edge and Compute Cluster in
Region A
You must mount an NFS datastore for the content library consumed by vRealize Automation for virtual
machine provisioning.

Create a datastore for the sfo01-w01-comp01 cluster.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Hosts and Clusters and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

3 Click sfo01w01esx01.sfo01.rainpole.local.

4 Under Storage, click the Datastores tab.

5 Click the Create a New Datastore icon.

6 On the Type page, select NFS and click Next.

7 On the Select NFS version page, select NFS 3 and click Next.

8 On the Name and configuration page, enter the following datastore information and click Next.

Setting Value

Datastore Name sfo01-w01-lib01

Folder /VVD_vRA_ComputeA_1TB

Server 172.16.25.251

9 On the Ready to complete page, review the configuration and click Finish.

Create and Apply the Host Profile for the Shared Edge and
Compute Cluster in Region A
Host Profiles ensure that all hosts in the cluster have the same configuration.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create a Host Profile from sfo01w01esx01.sfo01.rainpole.local.

a In the Navigator, select Hosts and Clusters and expand the
sfo01w01vc01.sfo01.rainpole.local tree.

b Right-click the ESXi host sfo01w01esx01.sfo01.rainpole.local and choose Host Profiles >
Extract Host Profile.

c In the Extract Host Profile page, enter sfo01-w01hp-comp01 for the Name and click Next.

d In the Ready to complete page, click Finish.

3 Attach the Host Profile to the shared edge and compute cluster.

a In the Navigator, select Hosts and Clusters and expand the
sfo01w01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-w01-comp01 cluster and choose Host Profiles > Attach Host Profile.

c In the Attach Host Profile dialog, select the sfo01-w01hp-comp01 Host Profile, select the Skip
Host Customization check box, and click Finish.

4 Create Host Customizations for the hosts in the shared edge and compute cluster.

a In the Navigator, select Policies and Profiles.

b Click Host Profiles, right-click sfo01-w01hp-comp01, and select Export Host Customizations.

c In the dialog, click Save.

d Choose a file location to save the sfo01-w01hp-comp01_host_customizations.csv file.

e Open the sfo01-w01hp-comp01_host_customizations.csv in Excel.
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f Edit the file using the following configuration value.

ESXi Host

Active Directory
Configuration
Password

Active Directory
Configuration Username

NetStack Instance
defaultTcpipStack->DNS
configuration Name for
this host

sfo01w01esx01.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01w01esx01

sfo01w01esx02.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01w01esx02

sfo01w01esx03.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01w01esx03

sfo01w01esx04.sfo01.rainpole.local svc-domain-
join_password

svc-domain-
join@rainpole.local

sfo01w01esx04

ESXi Host

Host virtual NIC sfo01-w01-
vds01:sfo01-w01-vds01-
management:management->IP
address settings IPv4 address

Host virtual NIC sfo01-w01-
vds01:sfo01-w01-vds01-
management:management->IP
address settings SubnetMask

sfo01w01esx01.sfo01.rainpole.local 172.16.31.101 255.255.255.0

sfo01w01esx02.sfo01.rainpole.local 172.16.31.102 255.255.255.0

sfo01w01esx03.sfo01.rainpole.local 172.16.31.103 255.255.255.0

sfo01w01esx04.sfo01.rainpole.local 172.16.31.104 255.255.255.0

ESXi Host

Host virtual NIC sfo01-w01-
vds01:sfo01-w01-vds01-
nfs:<UNRESOLVED>->IP address
settings IPv4 address

Host virtual NIC sfo01-w01-
vds01:sfo01-w01-vds01-
nfs:<UNRESOLVED>->IP address
settings SubnetMask

sfo01w01esx01.sfo01.rainpole.local 172.16.25.101 255.255.255.0

sfo01w01esx02.sfo01.rainpole.local 172.16.25.102 255.255.255.0

sfo01w01esx03.sfo01.rainpole.local 172.16.25.103 255.255.255.0

sfo01w01esx04.sfo01.rainpole.local 172.16.25.104 255.255.255.0

ESXi Host

Host virtual NIC sfo01-w01-
vds01:sfo01-w01-vds01-
vmotion:vmotion->IP address
settings IPv4 address

Host virtual NICsfo01-w01-
vds01:sfo01-w01-vds01-
vmotion:vmotion->IP address
settings SubnetMask

sfo01w01esx01.sfo01.rainpole.local 172.16.32.101 255.255.255.0

sfo01w01esx02.sfo01.rainpole.local 172.16.32.102 255.255.255.0

sfo01w01esx03.sfo01.rainpole.local 172.16.32.103 255.255.255.0

sfo01w01esx04.sfo01.rainpole.local 172.16.32.104 255.255.255.0

g After the file has been updated, save it and close Excel.

h Click the sfo01-w01hp-comp01 host profile and then click the Configure tab.
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i Click the Edit Host Customizations button.

j In the Edit Host Customizations window, select all hosts and click Next.

k Click the Browse button to use a customization file. Locate the sfo01-w01hp-
comp01_host_customizations.csv file saved earlier, select it, click Open, and then click Finish.

5 Remediate the hosts in the shared edge and compute cluster.

a On the Policies and Profiles page, click sfo01-w01hp-comp01, click the Monitor tab, and then
click the Compliance tab.

b In the Host/Cluster column, click sfo01-w01-comp01 and click Check Host Profile
Compliance icon.

The compliance test shows the first host is Compliant. The remaining hosts are Not Compliant.

c For each of the non-compliant hosts, click Remediate host based on its host profile icon and
click Finish.

All hosts now have Compliant status in the Host Compliance column.

6 Schedule nightly compliance checks.

a On the Policies and Profiles page, click sfo01-w01hp-comp01, click the Monitor tab, and then
click the Scheduled Tasks subtab.

b Click Schedule a New Task then click Check Host Profile Compliance.

c In the Check Host Profile Compliance (scheduled) window, click Scheduling options.

d Enter sfo01-w01hp-comp01 Compliance Check in the Task Name field.

e Click the Change button on the Configured Scheduler line.

f In the Configure Scheduler window, select Setup a recurring schedule for this action,change
the Start time to 10:00 PM, and click OK.

g In the Check Host Profile Compliance (scheduled) window, click OK.

Configure Lockdown Mode on All ESXi Hosts in Region A
To increase the security of your ESXi hosts, you enable Lockdown mode to allow administrative
operations to be performed only from vCenter Server.

vSphere supports an Exception User list for service accounts that have to log in to the host directly.
Accounts with administrative privileges that are on the Exception Users list can log in to the ESXi Shell. In
addition, these users can log in to a host's DCUI in normal lockdown mode and can exit lockdown mode.

You repeat this procedure to enable normal lockdown mode for all  hosts in the data center in the
following table.
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Table 2‑17.  Hosts in the Data Center

Host FQDN

Management host 1 sfo01m01esx01.sfo01.rainpole.local

Management host 2 sfo01m01esx02.sfo01.rainpole.local

Management host 3 sfo01m01esx03.sfo01.rainpole.local

Management host 4 sfo01m01esx04.sfo01.rainpole.local

Shared Edge and Compute host 1 sfo01w01esx01.sfo01.rainpole.local

Shared Edge and Compute host 2 sfo01w01esx02.sfo01.rainpole.local

Shared Edge and Compute host 3 sfo01w01esx03.sfo01.rainpole.local

Shared Edge and Compute host 4 sfo01w01esx04.sfo01.rainpole.local

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Hosts and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Select the sfo01m01esx01.sfo01.rainpole.local host.

4 Click Configure.

5 Under System, select Security Profile.

6 In the Lockdown Mode panel, click Edit.

7 In the Lockdown Mode dialog box, select the Normal radio button, and click OK. 

8 Repeat this procedure and enable normal lockdown mode for all remaining hosts in the data center.

Note   Lockdown Mode settings are not part of Host Profiles and must be manually enabled on all
hosts.

Create the VM and Template Folders in Region A
Create folders to group objects of the same type for easier management.
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Table 2‑18.  Folders for the Management Applications in Region A

 Management Applications Folder

NSX Manager, Controllers, and Edges sfo01-w01fd-nsx

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create folders for each of the management applications. 

a In the Navigator, click VMs and Templates and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Right-click the sfo01-w01dc data center, and select New Folder > New VM and Template
Folder.

c In the New Folder dialog box, enter sfo01-w01fd-nsx  as the name to label the folder and click
OK.

3 Delete the Discovered Virtual Machines folder.

a In the Navigator, click VMs and Templates and expand the sfo01w01vc01.sfo01.rainpole.local
tree.

b Right-click the Discovered Virtual Machines folder and select Remove from Inventory.

c On the Confirm Remove dialog, click Yes.

Deploy and Configure the Shared Edge and Compute
Cluster NSX Instance in Region A
Deploy and configure the NSX instance for the shared edge and compute cluster in Region A.

Prerequisites for Implementation of the Shared Edge and
Compute NSX Cluster in Region A
Before you deploy the NSX Components of the Shared Edge and Compute Cluster, verify that your
environment satisfies the requirements for this deployment.
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IP Addresses and Host Names
Verify that static IP addresses and FQDNs for the management networks are available for the SDDC
deployment.

Allocate static IP addresses and FQDNs for the NSX Manager, NSX Controller nodes, and components.

Table 2‑19.  Network Names for SDDC Components

NSX Manager Region A Network

NSX Manager sfo01-m01-vds01-management

NSX Controllers sfo01-w01-vds01-management

Table 2‑20.  IP Addresses and Host Names for the NSX Components in Region A

Role IP Address FQDN

NSX Manager 172.16.11.66 sfo01w01nsx01.sfo01.rainpole.local

NSX Controller Nodes 172.16.31.118 sfo01w01nsxc01.sfo01.rainpole.local

172.16.31.119 sfo01w01nsxc02.sfo01.rainpole.local

172.16.31.120 sfo01w01nsxc03.sfo01.rainpole.local

Edge Services Gateway 01 172.16.35.2 sfo01w01esg01.sfo01.rainpole.local

172.27.13.3

192.168.100.1

192.168.101.1

Edge Services Gateway 02 172.16.35.3 sfo01w01esg02.sfo01.rainpole.local

172.27.13.2

192.168.100.2

192.168.101.2

Universal Distributed Logical Router 192.168.100.3 sfo01w01udlr01.sfo01.rainpole.local

UDLR_Compute_Workload_Subnet

Distributed Logical Router 192.168.101.3 sfo01w01dlr01.sfo01.rainpole.local

DLR_Compute_Workload_Subnet

Subnet mask 255.255.255.0 -

DNS 172.16.11.5 -

172.16.11.4

Gateway 172.16.11.253 -

NTP servers n 172.16.11.251
n 172.16.11.252

n ntp.sfo01.rainpole.local
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Deployment Prerequisites
Verify that your environment satisfies the following prerequisites for the deployment of NSX Manager and
Components.

Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per NSX Manager:
n Initial storage for the NSX Manager: 60 GB

n Required storage per NSX Controller nodes and Components.
n storage requirement: 240 GB

Software Features n Verify that management vCenter Server is operational.

Installation Package n Download the .iso file for the NSX Manager.

License n Verify that you have obtained NSX license with a quantity that satisfies the requirements of this
design.

Active Directory n Verify that you have a parent active directory with the SDDC user roles configured for the
rainpole.local domain.

svc-nsxmanager(User Role)

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the NSX Manager. See the

VMware Validated Design Planning and Preparation documentation.

Deploy the NSX Manager for the Shared Edge and Compute
Cluster in Region A
NSX Manager and vCenter Server for the shared edge and compute cluster are in a one-to-one
relationship. You must connect every instance of NSX Manager to a vCenter Server instance.

Deploy the NSX Manager Appliance for the Shared Edge and Compute
Cluster in Region A
You start implementing network virtualization for tenant workloads in Region A by deploying the NSX
Manager virtual appliance.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Open the Deploy OVF Template wizard.

a In the Navigator, expand the entire sfo01m01vc01.sfo01.rainpole.local tree.

b Right-click the sfo01-m01-mgmt01 cluster, and click Deploy OVF Template.

The Deploy OVF Template appears.

3 On the Select template page, click the Browse button, select the VMware NSX Manager .ova file,
and click Next. 

4 On the Select name and location page, enter the following settings, and click Next.

Setting Value

Name sfo01w01nsx01

Folder or data center sfo01-m01fd-nsx

5 On the Select a resource page, select the following values, and click Next.

Setting Value

Cluster sfo01-m01dc

6 On the Review details page, review the extra configuration option message, and click Next.

7 On the Accept license agreements page, click Accept, and click Next.

8 On the Select storage page, enter the following settings, and click Next

Setting Value

Select virtual disk format Thin Provision

VM Storage Policy vSAN Default Storage Policy

Datastore sfo01-m01-vsan01

9 On the Select networks page, Under Destination Network, select sfo01-m01-vds01-management,
and click Next.
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10 On the Customize template page, expand the different options, enter the following settings, and
click Next.

Setting Value

DNS Server List 172.16.11.5,172.16.11.4

Domain Search List sfo01.rainpole.local

Default IPv4 Gateway 172.16.11.253

Hostname sfo01w01nsx01.sfo01.rainpole.local

Network 1 IPv4 Address 172.16.11.66

Network 1 Netmask 255.255.255.0

Enable SSH Selected

NTP Server List ntp.sfo01.rainpole.local, ntp.lax01.rainpole.local

CLI "admin" User Password / enter compnsx_admin_password

CLI "admin" User Password / confirm compnsx_admin_password

CLI Privilege Mode Password / enter compnsx_priviledge_password

CLI Privilege Mode Password / confirm compnsx_priviledge_password

VMware Customer Experience Improvement Program Selected

11 On the Ready to complete page, click Finish.

12 In the Navigator, expand the sfo01m01vc01.sfo01.rainpole.local tree, select the sfo01w01nsx01
virtual machine, and click the Power on button.

Replace the NSX Manager Certificate for the Shared Edge and Compute
Cluster in Region A
After you deploy the appliance of NSX Manager, replace the default certificate with a customer certificate
to establish trusted connection with the management components in the SDDC. The certificate generated
by the CertGenVVD utility is signed by a certificate authority (CA) on the parent Active Directory server.

Use the following files to replace the certificate on NSX Manager for the shared edge and compute
cluster:

Table 2‑21.  Certificate-Related Files on the NSX Manager Instance for the Shared Edge and
Compute Cluster in Region A

NSX Manager FQDN Certificate Filename

sfo01w01nsx01.sfo01.rainpole.local n sfo01w01nsx01.4.p12
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Procedure

1 Log in to the Compute NSX Manager appliance user interface.

a Open a Web browser and go to https://sfo01w01nsx01.sfo01.rainpole.local. 

b Log in using the following credentials.

Setting Value

User name  admin

Password  nsx_manager_admin_password
 

2 On the Home page, select Manage Appliance Settings.

3 On the Manage tab, click SSL Certificates, click Upload PKCS#12 Keystore.

4 Browse to the certificate chain file sfo01w01nsx01.4.p12, provide the keystore password or
passphrase, and click Import.

5 Restart the NSX Manager to propagate the CA-signed certificate.

a In the right corner of the NSX Manager page, click the Settings icon. 

b From the drop-down menu, select Reboot Appliance.

Connect NSX Manager to the Compute vCenter Server in Region A
After you deploy the NSX Manager virtual appliance for the shared edge and compute cluster, connect
the NSX Manager to the Compute vCenter Server so that NSX Manager can create virtual networking
components for the cluster.

Procedure

1 Log in to the Compute NSX Manager appliance user interface.

a Open a Web browser and go to https://sfo01w01nsx01.sfo01.rainpole.local. 

b Log in using the following credentials.

Setting Value

User name  admin

Password  nsx_manager_admin_password
 

2 Click Manage vCenter Registration.

3 Under Lookup Service URL, click the Edit button.

4 In the Lookup Service URL dialog, enter the following settings, and click OK.

Setting Value

Lookup Service Host sfo01psc01.sfo01.rainpole.local

Lookup Service Port 443
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Setting Value

SSO Administrator User Name administrator@vsphere.local

Password vsphere_admin_password

5 In the Trust Certificate? dialog box, click Yes.

6 Under vCenter Server, click the Edit button.

7 In the vCenter Server dialog box, enter the following settings, and click OK.

Setting Value

vCenter Server sfo01w01vc01.sfo01.rainpole.local

vCenter User Name svc-nsxmanager@rainpole.local

Password svc-nsxmanager_password

8 In the Trust Certificate? dialog box, click Yes.

9 Wait until the Status indicators for the Lookup Service URL and vCenter Server change
to Connected.

Assign Administrative Access to NSX Manager for the Shared Edge and
Compute Cluster in Region A
Assign the administrator@vsphere.local account to the NSX Enterprise Administrator Role.

Procedure

1 Log in to the Management vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name svc-nsxmanager@rainpole.local

Password svc-nsxmanager_password

2 In the Navigator, click Networking & Security and click Users and Domains.

3 Under Users and Domains, click the 172.16.11.66 instance.

4 Click the Add icon.

5 On the Identify User page, select the Specify a vCenter user radio button,
enter administrator@vsphere.local in the text box, and click Next.

6 On the Select Roles page, select the Enterprise Administrator radio button and click Finish.
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Deploy the NSX Controllers for the Shared Edge and Compute
Cluster NSX Instance in Region A
After the NSX Manager is successfully connected to the vCenter Server, you must promote it to the
primary role and deploy the three NSX Controller nodes that form the NSX Controller cluster.

It is important to deploy every node only after the previous one is successfully deployed.

To complete this procedure, you must configure a datastore for the shared edge and compute cluster in
Region A. 

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Promote the NSX Manager to the primary role.

a Under Inventories, click Networking & Security.

b In the Navigator, click Installation and Upgrade.

c On the Management tab, Select the 172.16.11.66 instance.

d Click the Actions menu and click Assign Primary Role.

e In the Assign Primary Role confirmation dialog box, click Yes.

3 Configure an IP pool for the NSX Controller Cluster.

a In the Navigator, click Groups and Tags.

b Under NSX Managers, click the 172.16.11.66 instance.
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c Click the IP Pools tab and click the Add New IP Pool icon.

d In the Add Static IP Pool dialog box, enter the following settings, and click OK.

Setting Value

Name sfo01-comp01-nsxc01

Gateway 172.16.31.253

Prefix Length 24

Primary DNS 172.16.11.5

Secondary DNS 172.16.11.4

DNS Suffix sfo01.rainpole.local

IP Pool Range 172.16.31.118-172.16.31.120

4 Deploy the NSX Controller cluster. It is important to deploy every node only after the previous one is
successfully deployed.

a In the Navigator, click Installation and Upgrade.

b Under NSX Controller nodes, click the Add icon to deploy three NSX Controller nodes with the
same configuration.

c On the Add Controller page, under Password Settings, enter the following, and click Next.

Note   You configure a password only during the deployment of the first controller. The other
controllers use the same password.

Setting Value

NSX Manager 172.16.11.66

Password compnsx_controllers_password

Confirm Password compnsx_controllers_password
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d In the Add Controller page, under Deployment & Connectivity, enter the following values and
click Finish.

Setting Value

Name sfo01w01nsxc01

Datacenter sfo01-w01dc

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Connected To sfo01-w01-vds01-management

Select IP Pool sfo01-comp01-nsxc01

e After the Status of the controller node changes to Connected, repeat the step and deploy the two
remaining NSX Controller nodes in the controller cluster with the same configuration,
incrementing the name by 1 each time.

5 Enable Controller Disconnected Operation (CDO) Mode.

a Under Inventories, click Networking & Security.

b In the Navigator, click Installation and Upgrade.

c On the Management tab, select the 172.16.11.66 instance.

d Click the Actions menu and click Enable CDO Mode.

e In the Enable CDO Mode dialog, click Yes.

6 Configure DRS affinity rules for the NSX Controllers.

a Go back to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01w01vc01.sfo01.rainpole.local tree.

c Select the sfo01-w01-comp01 cluster, and click the Manage tab.

d Under Configuration, click VM/Host Rules.

e Under VM/Host Rules, click Add.

f In the sfo01-w01-comp01 - Create VM/Host Rule dialog box, enter the following settings, and
click Add.

Setting Value

Name anti-affinity-rule-nsxc

Enable rule Selected

Type Separate Virtual Machine

g In the Add Rule Member dialog, select the three NSX Controller VMs and click OK.

h In the sfo01-w01-comp01 - Create VM/Host Rule dialog click OK and click OK.
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Prepare the ESXi Hosts in the Shared Edge and Compute Cluster
for NSX in Region A
NSX kernel modules packaged in VIB files run within the hypervisor kernel and provide services such as
distributed routing, distributed firewall, and VXLAN bridging capabilities. To use NSX, you must install the
NSX kernel modules on the ESXi hosts.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Networking & Security.

3 Click Installation and Upgrade, and click the Host Preparation tab.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Under NSX Component Installation on Hosts, click Actions then Install for the sfo01-w01-comp01
cluster and click Yes in the confirmation dialog box.

6 Verify that the Installation Status column displays the NSX version for all hosts in the cluster,
confirming that the NSX kernel modules are successfully installed.

Configure the NSX Logical Network for the Shared Edge and
Compute Clusters in Region A
After all deployment tasks are completed, you configure the NSX logical network. 

To configure the NSX logical network, you perform the following tasks:

n Configure the Segment ID allocation.

n Configure the VXLAN networking.

n Configure the transport zone.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Configure the Segment ID allocation.

a In the Navigator, click Networking & Security.

b Click Installation and Upgrade, click Logical Network Preparation, and click Segment ID.

c Select 172.16.11.66 from the NSX Manager drop-down menu.

d Click Edit, enter the following settings, and click OK.

Setting Value

Segment ID pool 5300–9000

Enable Multicast addressing Selected

Multicast addresses 239.3.0.0-239.3.255.255

Universal Segment ID Pool 20000–29000

Enable Universal Multicast addressing Selected

Universal Multicast addresses 239.4.0.0-239.4.255.255

3 Configure the VXLAN networking.

a Click the Host Preparation tab.

b Under VXLAN, click Not Configured on the sfo01-w01-comp01 row, enter the following
settings, and click OK.

Setting Value

Switch sfo01-w01-vds01

VLAN 1634

MTU 9000

VMKNic IP Addressing Use DHCP

VMKNic Teaming Policy Load Balance - SRCID

VTEP 2
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4 Configure the Universal transport zone.

a On the Installation and Upgrade page, click the Logical Network Preparation tab and
click Transport Zones.

b Select 172.16.11.66 from the NSX Manager drop-down menu.

c Click the New Transport zone icon.

d In the New Transport Zone dialog box, enter the following settings and click OK.

Setting Value

Mark this object for Universal Synchronization Selected

Name Comp Universal Transport Zone

Replication mode Hybrid

Select clusters part of the Transport Zone sfo01-w01-comp01

5 Configure the Global transport zone.

a On the Installation and Upgrade page, click the Logical Network Preparation tab and
click Transport Zones.

b Select 172.16.11.66 from the NSX Manager drop-down menu.

c Click the New Transport zone icon.

d In the New Transport Zone dialog box, enter the following settings and click OK.

Setting Value

Name Comp Global Transport Zone

Replication mode Hybrid

Select clusters part of the Transport Zone sfo01-w01-comp01

Update the Host Profile for the Shared Edge and Compute Cluster
in Region A
After an authorized change is made to a host, the Host Profile must be updated to reflect the changes.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Update the Host Profile for the compute cluster.

a In the Navigator, select Policies and Profiles.

b Click Host Profiles, right-click sfo01-w01hp-comp01, and select Copy Settings from Host.

c Select sfo01w01esx01.sfo01.rainpole.local, click OK.

3 Verify compliance and remediate the hosts.

a On the Policies and Profiles page, click the sfo01-w01hp-comp01 host profile.

b On the Monitor tab, click the Compliance tab.

c Select sfo01-w01-comp01 in the Host/Cluster column and click Check Host Profile
Compliance.

This compliance test shows that the first host is Compliant, but the other hosts are Not
Compliant.

d Click each of the non-compliant hosts and click Remediate Hosts Based on its Host Profile.

e In the Remediate Hosts Based on its Host Profile wizard, enter Host Name if prompted for
NetStack Instance vxlan->DNS configuration, and click Next.

f On the Ready to complete page, click Finish.

All hosts have Compliant status in the Host Compliance column.

Configure NSX Dynamic Routing in the Shared Edge and Compute
Cluster in Region A
NSX for vSphere creates a network virtualization layer on top of which all virtual networks are created.
This layer is an abstraction between the physical and virtual networks. You configure NSX dynamic
routing within the compute and edge clusters, deploying two NSX Edge devices and a Universal
Distributed Logical Router (UDLR).

Create Logical Switches for Use as Transit Networks in the Shared Edge and
Compute Cluster in Region A
Create universal and global transit logical switches for use as the transit networks in the cluster.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 Under Inventories, click Networking & Security.

3 In the Navigator, click Logical Switches.

4 Select 172.16.11.66 from the NSX Manager drop-down menu and click the Add icon.

5 In the New Logical Switch dialog box, enter the following settings and click OK.

Setting Value

Name Universal Transit Network

Transport Zone Comp Universal Transport Zone

Replication Mode Hybrid

Note   Universal Logical Switch created and assigned with Universal Transport Zone.

6 In the New Logical Switch dialog box, enter the following settings, and click OK.

Setting Value

Name Global Transit Network

Transport Zone Comp Global Transport Zone

Replication Mode Hybrid

Note   The Global Logical Switch is created and assigned the Global Transport Zone.

Deploy NSX Edge Devices for North-South Routing in the Shared Edge and
Compute Cluster in Region A
Deploy NSX Edge Devices for North-South routing in the shared edge and compute cluster.

Perform this procedure two times to deploy two NSX Edge devices: sfo01w01esg01 and sfo01w01esg02.

Table 2‑22.  NSX Edge Devices

NSX Edge Device Device Name

NSX Edge Device 1 sfo01w01esg01

NSX Edge Device 2 sfo01w01esg02

Table 2‑23.  NSX Edge Interfaces Settings

Interface Primary IP Address - sfo01w01esg01 Primary IP Address - sfo01w01esg02

Uplink01 172.16.35.2 172.16.35.3

Uplink02 172.27.13.3 172.27.13.2

sfo01w01udlr01 192.168.100.1 192.168.100.2

sfo01w01dlr01 192.168.101.1 192.168.101.2
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Prerequisites

To complete this procedure, you must configure data store for the shared edge and compute cluster in
Region B.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Click the Add icon to deploy a new NSX Edge.

The New NSX Edge wizard appears.

a On the Name and description page, enter the following settings, and click Next.

Setting sfo01w01esg01 sfo01w01esg02

Install Type Edge Service Gateway Edge Service Gateway

Name sfo01w01esg01 sfo01w01esg02

Hostname sfo01w01esg01.sfo01.rainpole.local sfo01w01esg02.sfo01.rainpole.local

Deploy NSX Edge Selected Selected

Enable High Availability Deselected Deselected

b On the Settings page, enter the following settings, and click Next.

Setting Value

User Name admin

Password edge_admin_password

Enable SSH access Selected

Enable FIPS mode Deselected

Enable auto rule generation Selected

Edge Control Level logging INFO

c On the Configure deployment page, select the Large radio button to specify the Appliance
Size and click the Add icon.
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d In the Add NSX Edge Appliance dialog box, enter the following settings, click OK, and click
Next.

Setting Value

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Resource Reservation System Managed

e On the Configure interfaces page, click the Add icon to configure the Uplink01 interface, enter
the following settings, and click OK.

Setting sfo01w01esg01 sfo01w01esg02

Name Uplink01 Uplink01

Type Uplink Uplink

Connected To sfo01-w01-vds01-uplink01 sfo01-w01-vds01-uplink01

Connectivity Status Connected Connected

Primary IP Address 172.16.35.2 172.16.35.3

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

f Click the Add icon to configure the Uplink02 interface, enter the following settings, and click OK.

Setting sfo01w01esg01 sfo01w01esg02

Name Uplink02 Uplink02

Type Uplink Uplink

Connected To sfo01-w01-vds01-uplink02 sfo01-w01-vds01-uplink02

Connectivity Status Connected Connected

Primary IP Address 172.27.13.3 172.27.13.2

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected
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g Click the Add icon to configure the UDLR interface, enter the following settings, click OK, and
click Next.

Setting sfo01w01esg01 sfo01w01esg02

Name sfo01w01udlr01 sfo01w01udlr01

Type Internal Internal

Connected To Universal Transit Network Universal Transit Network

Connectivity Status Connected Connected

Primary IP Address 192.168.100.1 192.168.100.2

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

h Click the Add icon to configure the DLR interface, enter the following settings, click OK, and
click Next.

Setting sfo01w01esg01 sfo01w01esg02

Name sfo01w01dlr01 sfo01w01dlr01

Type Internal Internal

Connected To Global Transit Network Global Transit Network

Connectivity Status Connected Connected

Primary IP Address 192.168.101.1 192.168.101.2

Subnet Prefix Length 24 24

MTU 9000 9000

Send ICMP Redirect Selected Selected

i On the Default gateway settings page, deselect the Configure Default Gateway check box
and click Next.

j On the Firewall and HA page, click Next.

k On the Ready to complete page, review the configuration settings that you entered
and click Finish.

6 Repeat this procedure to configure another NSX edge by using the settings for the second NSX Edge
device.
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7 Configure DRS affinity rules for the Edge Services Gateways.

Note   You do not perform this step if the Shared Edge and Compute cluster has more than four
hosts.

a Go back to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01w01vc01.sfo01.rainpole.local tree.

c Select the sfo01-w01-comp01 cluster, and click the Configure tab.

d Under Configuration, click VM/Host Rules.

e Click Add.

f In the sfo01-w01-comp01 - Create VM/Host Rule dialog, enter the following settings, and click
Add.

Setting Value

Name anti-affinity-rule-ecmpedges

Enable rule Selected

Type Separate Virtual Machine

g In the Add Rule Member dialog box, select the check box next to each of the two NSX ESG's
and click OK.

h In the sfo01-w01-comp01 - Create VM/Host Rule dialog box, click OK.

Disable the Firewall Service in the Shared Edge and Compute Cluster in
Region A
Disable the firewall of the two NSX Edge services gateways.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.
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5 Double-click the sfo01w01esg01 NSX Edge device.

6 Click the Manage tab and click Firewall.

7 On the Firewall page, click the Stop button.

8 Click Publish changes.

9 Repeat this procedure for the NSX Edge services gateway sfo01w01esg02.

Enable and Configure Routing in the Shared Edge and Compute Cluster in
Region A
Enable the Border Gateway Protocol (BGP) to exchange routing information between the NSX Edge
services gateways.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Double-click the sfo01w01esg01 NSX Edge device.

6 Click the Manage tab and click Routing.

7 Configure settings on the Global Configuration page.

a Click the Start button for ECMP.

b To configure dynamic routing, click the Edit button next to Dynamic Routing Configuration.

c Select Uplink01 as the Router ID and click OK.

d Click Publish Changes.
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8 On the Routing tab, select Static Routes to configure it.

a Click the Add icon, enter the following settings, and click OK.

Setting Value

Network UDLR_Compute_Workload_Subnet

Next Hop 192.168.100.3

Interface sfo01w01udlr01

MTU 9000

Admin Distance 210

Note   You must add all subnets that are behind the UDLR.

b Click the Add icon, enter the following settings, and click OK.

Setting Value

Network DLR_Compute_Workload_Subnet

Next Hop 192.168.101.3

Interface sfo01w01dlr01

MTU 9000

Admin Distance 210

Note   You must add all subnets that are behind the DLR.

c Click Publish Changes.

9 On the Routing tab, select BGP to configure it.

a Click the Edit button, enter the following settings, and click OK.

Setting Value

Enable BGP Selected

Enable Graceful Restart Deselected

Enable Default Originate Deselected

Local AS 65000

b On the BGP page, click the Add icon to add a Neighbor.

The New Neighbor dialog box appears. You add two neighbors: the first Top of Rack Switch and
the second Top of Rack Switch.
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c In the New Neighbor dialog box, enter the following values for the first Top of Rack Switch, and
click OK.

Setting Value

IP Address 172.16.35.1

Remote AS 65001

Weight 60

Keep Alive Time 4

Hold Down Time 12

Password BGP_password

d Click the Add icon to add another Neighbor.

The New Neighbor dialog box appears.

e In the New Neighbor dialog box, enter the following values for the second Top of Rack Switch,
and click OK.

Setting Value

IP Address 172.27.13.1

Remote AS 65001

Weight 60

Keep Alive Time 4

Hold Down Time 12

Password BGP_password

f Click the Add icon to add another Neighbor.

The New Neighbor dialog box appears. Configure the universal distributed logical router (UDLR)
as a neighbor.

g In the New Neighbor dialog box, enter the following values, and click OK.

Setting Value

IP Address 192.168.100.4

Remote AS 65000

Weight 60

Keep Alive Time 1

Hold Down Time 3

Password BGP_password

h Click the Add icon to add another Neighbor. 

The New Neighbor dialog box appears. Configure the distributed logical router (DLR) as a
neighbor.
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i In the New Neighbor dialog box, enter the following values, and click OK.

Setting Value

IP Address 192.168.101.4

Remote AS 65000

Weight 60

Keep Alive Time 1

Hold Down Time 3

Password BGP_password

j Click Publish Changes.

The four neighbors you added appear in the Neighbors table.

10 On the Routing tab, select Route Redistribution to configure it.

a On the Route Redistribution page, click the Edit button.

b In the Change redistribution settings dialog box, select the BGP check box and click OK.

c Click the Add icon for Route Redistribution Table.

d In the New Redistribution criteria dialog box, enter the following settings, and click OK.

Setting Value

Prefix Any

Learner Protocol BGP

OSPF Deselected

Static Routes Selected

Connected Selected

Action Permit

e Click the Publish Changes button.

The route redistribution configuration appears in the Route Redistribution table. Confirm that the
configuration values you entered are correct.

11 Repeat this procedure for the NSX Edge device sfo01w01esg02.

Verify Peering of Upstream Switches and Establishment of BGP in the Shared
Edge and Compute Cluster in Region A
The NSX Edge devices must to establish a connection to each of its upstream BGP switches before BGP
updates can be exchanged. Verify that the NSX Edges devices are successfully peering, and that
BGP routing has been established.

You repeat this procedure two times for each of the NSX Edge devices: sfo01w01esg01
and sfo01w01esg02.
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Procedure

1 Log in to the NSX Edge device using a Secure Shell (SSH) client.

a Open an SSH connection to the sfo01w01esg01 NSX Edge device.

b Log in using the following credentials.

Setting Value

User name admin

Password edge_admin_password

2 Run the show ip bgp neighbors command to display information about the BGP connections to
neighbors. 

The BGP State displays Established, UP if you have peered with the upstream switches.

Note   You have not yet created the universal distributed logical router or the distributed logical router,
they are not listed as BGP neighbors.
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3 Run the show ip route command to verify that you are receiving routes using BGP, and that there
are multiple routes to BGP learned networks.

You verify multiple routes to BGP learned networks by locating the same route using a different IP
address. The IP addresses are listed after the word via in the right-side column of the routing table
output. In the following image there are two different routes to the following BGP
networks: 0.0.0.0/0 and 172.27.22.0/24. You can identify BGP networks by the letter B in the left-
side column. Lines beginning with C (connected) have only a single route.

4 Repeat this procedure for the NSX Edge device sfo01w01esg02

Deploy the Universal Distributed Logical Router in the Shared Edge and
Compute Cluster in Region A
Deploy the universal distributed logical routers (UDLR).

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.
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3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Click the Add icon to create a new UDLR.

6 On the Name and description page, enter the following settings, and click Next.

Setting Value

Universal Logical Router Selected

Name sfo01w01udlr01

Hostname sfo01w01udlr01.sfo01.rainpole.local

Deploy Edge Appliance Selected

Enable High Availability Selected

Enable HA Logging Selected

Log Level INFO

7 On the Settings page, enter the following settings, and click Next.

Setting Value

User Name admin

Password udlr_admin_password 

Confirm password udlr_admin_password

Enable SSH access Selected

Enable FIPS mode Deselected

Edge Control Level logging INFO

8 On the Configure deployment page, and click the Add icon.

9 In the Add NSX Edge Appliance dialog box, enter the following settings and click Next.

Setting Value

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Resource Reservation System Managed

10 On the Configure deployment page, and click the Add icon a second time to add a second NSX
Edge device.

The Add NSX Edge Appliance dialog box appears. 
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11 In the Add NSX Edge Appliance dialog box, enter the following settings and click Next.

Setting Value

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Resource Reservation System Managed

12 On the Configure interfaces page, under HA Interface Configuration, click Select and connect
to sfo01-w01-vds01-management. 

13 On the Configure interfaces page, enter the following configuration settings and click Next.

a Enter the following settings in the Add Interface dialog box, and click OK.

The Add Interface dialog box appears.

Setting Value

Name Uplink

Type Uplink

Connected To Universal Transit Network

Connectivity Status Connected

Primary IP Address 192.168.100.3

Subnet Prefix Length 24

MTU 9000

14 On the Default gateway settings page, deselect Configure Default Gateway and click Next.

15 On the Ready to complete page, click Finish.

16 Allow SSH access in the Universal Distributed Logical Router firewall.

a Double-click the device labeled sfo01w01udlr01.

b Click the Manage tab and click the Firewall tab.
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c Click Add icon to create a new firewall rule with the following settings.

Setting Value

Name enableSSH

Source any

Destination any

Service SSH

Action Accept

d Click Publish Changes.

Note   Step 17 is optional and applicable only when the shared edge and compute cluster with
more than four Hosts.

17 Configure DRS anti-affinity rules for the UDLR Virtual Machines and ESG Virtual Machines.

a Go back to the Home page.

b In the Navigator, click Hosts and Clusters, and expand the
sfo01m01vc01.sfo01.rainpole.local  tree.

c Select the sfo01-m01-mgmt01 cluster, and click the Configure tab.

d Under Configuration, click VM/Host Rules.

e Select System created UDLR anti-affinity-rule

f Click Edit.

g In the sfo01-m01-mgmt01 - Edit VM/Host Rule dialog box, enter the following settings and click
Ok.

Setting Value

Name anti-affinity-rule-edge-

Enable rule Selected

Type Separate Virtual Machine

h Click Add, select the two NSX ESGs, and click OK.

i In the sfo01-m01-mgmt01 - Edit VM/Host Rule dialog box, click OK.

Configure Universal Distributed Logical Router for Dynamic Routing in
Shared Edge and Compute Cluster in Region A
Configure the universal distributed logical router (UDLR) in the shared edge and compute cluster to use
dynamic routing.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Configure the routing for the Universal Distributed Logical Router.

a Double-click sfo01w01udlr01.

b Click the Manage tab and click Routing.

c On the Global Configuration page, perform the following configuration steps. 

d Click the Edit button under Routing Configuration, select Enable ECMP, and click OK.

e Click the Edit button under Dynamic Routing Configuration, select Uplink as the Router
ID, and click OK.

f Click Publish Changes.

6 On the left, select BGP to configure it.

a On the BGP page, click the Edit button.

The Edit BGP Configuration dialog box appears.

b In the Edit BGP Configuration dialog box, enter the following settings and click OK.

Setting Value

Enable BGP Selected

Enable Graceful Restart Deselected

Local AS 65000

c Click the Add icon to add a Neighbor.

The New Neighbor dialog box appears.
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d In the New Neighbor dialog box, enter the following values for both NSX Edge devices, and
click OK.

You repeat this step two times to configure the UDLR for both NSX Edge
devices: sfo01w01esg01 and sfo01w01esg02.

Setting sfo01w01esg01 Value sfo01w01esg02 Value

IP Address 192.168.100.1 192.168.100.2

Forwarding Address 192.168.100.3 192.168.100.3

Protocol Address 192.168.100.4 192.168.100.4

Remote AS 65000 65000

Weight 60 60

Keep Alive Time 1 1

Hold Down Time 3 3

Password bgp_password bgp_password

e Click Publish Changes. 

7 On the left, select Route Redistribution to configure it.

a Click the Edit button.

b In the Change redistribution settings dialog box, enter the following settings, and click OK.

c On the Route Redistribution page, select the default OSPF entry and click the Edit button.

d Select BGP from the Learner Protocol drop-down menu, and click OK.

e Click Publish Changes.

Verify Establishment of BGP for the Universal Distributed Logical Router in
the Shared Edge and Compute Cluster in Region A
The universal distributed logical router (UDLR) must establish a connection to Edge Services Gateway
before BGP updates can be exchanged. Verify that the UDLR is successfully peering, and that
BGP routing has been established.

Procedure

1 Log in to the sfo01w01udlr01 by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01w01udlr01, the UDLR whose peering and BGP configuration
you want to verify.

b Log in using the following credentials.

Setting Value

User name admin

Password udlr_admin_password
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2 Run the show ip bgp neighbors command to display information about the BGP and TCP
connections to neighbors. 

The BGP State displays Established, UP if you have successfully peered with the Edge Service
Gateway.

3 Run the show ip route command to verify that you are receiving routes using BGP, and that there
are multiple routes to BGP learned networks.

You verify multiple routes to BGP learned networks by locating the same route using a different IP
address. The IP addresses are listed after the word via in the right-side column of the routing table
output. In the image below there are two different routes to the following BGP
networks: 0.0.0.0/0, 172.16.35.0/24, 172.27.13.0/24, and 172.27.22.0/24. You can identify
BGP networks by the letter B in the left-side column. Lines beginning with C (connected) have only a
single route.
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Deploy the Distributed Logical Router in the Shared Edge and Compute
Cluster in Region A
Deploy the distributed logical router (DLR).

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Click the Add icon to create a new DLR,
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6 On the Name and description page, enter the following settings, and click Next.

Setting Value

Logical (Distributed) Router Selected

Name sfo01w01dlr01

Hostname sfo01w01dlr01.sfo01.rainpole.local

Deploy Edge Appliance Selected

Enable High Availability Selected

Enable HA Logging Selected

Log Level INFO

7 On the Settings page, enter the following settings, and click Next.

Setting Value

User Name admin

Password dlr_admin_password 

Confirm password dlr_admin_password 

Enable SSH access Selected

Enable FIPS mode Deselected

Edge Control Level logging INFO

8 On the Configure deployment page, and click the Add icon. 

9 In the Add NSX Edge Appliance dialog box, enter the following settings and click OK.

Setting Value

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Resource Reservation System Managed

10 On the Configure deployment page, and click the Add icon a second time to add a second NSX
Edge device.

11 In the Add NSX Edge Appliance dialog box, enter the following settings and click OK and then click
Next.

Setting Value

Cluster/Resource Pool sfo01-w01rp-sddc-edge

Datastore sfo01_shared_edge_and_compute_datastore

Folder sfo01-w01fd-nsx

Resource Reservation System Managed
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12 On the Configure interfaces page, under HA Interface Configuration, click Select and connect
to sfo01-w01-vds01-management. 

13 On the Configure interfaces page, under Configure interfaces of this NSX Edge, click the Add icon
to configure interface.

a In the Add Interface dialog box, enter the following settings, click OK, and click Next.

Setting Value

Name Uplink

Type Uplink

Connected To Global Transit Network

Connectivity Status Connected

Primary IP Address 192.168.101.3

Subnet Prefix Length 24

MTU 9000

14 In the Default gateway settings page, deselect Configure Default Gateway and click Next.

15 In the Ready to complete page, click Finish.

16 Allow SSH access in the Distributed Logical Router firewall.

a Double click the device labeled sfo01w01dlr01.

b Click the Manage tab and click the Firewall tab.

c Click Add icon to create a new firewall rule with the following settings.

Setting Value

Name enableSSH

Source any

Destination any

Service SSH

Action Accept

d Click Publish Changes.

Configure the Distributed Logical Router for Dynamic Routing in Shared
Edge and Compute Cluster in Region A
Configure the distributed logical router (DLR) in the shared edge and compute cluster to use dynamic
routing.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Under Inventories, click Networking & Security.

3 In the Navigator, click NSX Edges.

4 Select 172.16.11.66 from the NSX Manager drop-down menu.

5 Configure the routing for the Distributed Logical Router.

a Double-click sfo01w01dlr01.

b Click the Manage tab and click Routing.

c On the Global Configuration page, perform the following configuration steps. 

d Click the Start button for ECMP.

e Click the Edit button under Dynamic Routing Configuration, select Uplink as the Router
ID, and click OK.

f Click Publish Changes.

6 On the left, select BGP to configure it.

a On the BGP page, click the Edit button.

The Edit BGP Configuration dialog box appears.

b In the Edit BGP Configuration dialog box, enter the following settings and click OK.

Setting Value

Enable BGP Selected

Enable Graceful Restart Deselected

Local AS 65000

c Click the Add icon to add a Neighbor.

The New Neighbor dialog box appears.
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d In the New Neighbor dialog box, enter the following values for both NSX Edge devices, and
click OK.

Repeat this step two times to configure the DLR for both NSX Edge devices: sfo01w01esg01
and sfo01w01esg02.

Setting sfo01w01esg01 Value sfo01w01esg02 Value

IP Address 192.168.101.1 192.168.101.2

Forwarding Address 192.168.101.3 192.168.101.3

Protocol Address 192.168.101.4 192.168.101.4

Remote AS 65000 65000

Weight 60 60

Keep Alive Time 1 1

Hold Down Time 3 3

Password bgp_password bgp_password

e Click Publish Changes. 

7 On the left, select Route Redistribution to configure it.

a Click the Edit button.

b In the Change redistribution settings dialog box, enter the following settings, and click OK.

Setting Value

OSPF Deselected

BGP Selected

  

c On the Route Redistribution page, select the default OSPF entry and click the Edit button.

d Select BGP from the Learner Protocol drop-down menu, and click OK.

e Click Publish Changes.

Verify Establishment of BGP for the Distributed Logical Router in the Shared
Edge and Compute Cluster in Region A
The distributed logical router (DLR) must establish a connection to Edge Services Gateway before BGP
updates can be exchanged. Verify that the DLR is successfully peering, and that BGP routing has been
established.
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Procedure

1 Log in to the sfo01w01dlr01 by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01w01dlr01, the DLR whose peering and BGP configuration you
want to verify.

b Log in using the following credentials.

Setting Value

User name admin

Password dlr_admin_password

2 Run the show ip bgp neighbors command to display information about the BGP and TCP
connections to neighbors. 

The BGP State displays Established,UP if you have successfully peered with the Edge Service
Gateway.
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3 Run the show ip route command to verify that you are receiving routes using BGP, and that there
are multiple routes to BGP learned networks.

You verify multiple routes to BGP learned networks by locating the same route using a different IP
address. The IP addresses are listed after the word via in the right-side column of the routing table
output. In the following image there are two different routes to the following BGP
networks: 0.0.0.0/0, 172.16.35.0/24, 172.27.13.0/24, and 172.27.22.0/24. You can identify
BGP networks by the letter B in the left-side column. Lines beginning with C (connected) have only a
single route.

Test the Shared Edge and Compute Cluster NSX Configuration in
Region A
Test the configuration of the NSX logical network by using a ping test. A ping test checks if two hosts in a
network can reach each other.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Use the Ping Monitor to test connectivity.

a In the Navigator, click Networking & Security.

b Under Logical Switches, double-click Universal Transit Network .

c Click the Monitor tab.

d From the Source host drop-down menu, select sfo01m01esx01.sfo01.rainpole.local.

e From the Destination host drop-down menu, select sfo01m01esx03.sfo01.rainpole.local.

f Click Start Test.

Тhe host-to-host ping test results are displayed in the Results dialog box. Verify that there are no
error messages.

Deployment for Region A

VMware, Inc.  160



Region A Operations
Management Implementation 3
Deploy vSphere Update Manager Download Service, vRealize Suite Lifecycle Manager, vRealize
Operations Manager, and vRealize Log Insight to add operations management capabilities to your SDDC.

Procedure

1 vSphere Update Manager Download Service Implementation in Region A

Install the vSphere Update Manager Download Service (UMDS) on a Linux virtual machine to
download and store binaries and metadata to a shared repository in the region. In the region,
connect the UMDS instance to the vSphere Update Manager for each vCenter Server.

2 vRealize Suite Lifecycle Manager Implementation in Region A

You deploy the vRealize Suite Lifecycle Manager appliance, configure common settings, replace the
appliance certificate, generate a certificate for product deployments, and configure product binaries.

3 vRealize Operations Manager Implementation in Region A

Deploy vRealize Operations Manager components to monitor the resources in your SDDC.

4 vRealize Log Insight Implementation in Region A

vSphere Update Manager Download Service
Implementation in Region A
Install the vSphere Update Manager Download Service (UMDS) on a Linux virtual machine to download
and store binaries and metadata to a shared repository in the region. In the region, connect the UMDS
instance to the vSphere Update Manager for each vCenter Server.

Procedure

1 Prerequisites for Deploying vSphere Update Manager Download Service in Region A

Before you deploy vSphere Update Manager Download Service, verify that your environment fulfills
the requirements for this deployment.

2 Configure PostgreSQL Database on Your Linux-Based Host Operating System for UMDS in Region
A

On a virtual machine with Ubuntu 14.04 Long Term Support (LTS) where you plan to install vSphere
Update Manager Download Service, configure a PostgreSQL database instance.
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3 Install UMDS on Ubuntu OS in Region A

After you install and configure the PostgreSQL database on the UMDS virtual machine, install the
UMDS software.

4 Set Up the Data to Download Using UMDS in Region A

By default UMDS downloads patch binaries, patch metadata, and notifications for hosts. Specify
which patch binaries and patch metadata to download with UMDS.

5 Install and Configure the UMDS Web Server in Region A

The UMDS server in Region A downloads upgrades, patch binaries, patch metadata, and
notifications to a directory that you must share to vSphere Update Manager by using a Web server.

6 Use the UMDS Shared Repository as the Download Source in Update Manager in Region A

Configure Update Manager to use the UMDS shared repository as a source for downloading ESXi
patches, extensions, and notifications.

Prerequisites for Deploying vSphere Update Manager Download
Service in Region A
Before you deploy vSphere Update Manager Download Service, verify that your environment fulfills the
requirements for this deployment.

Virtual Machine Specifications
You create the virtual machine for vSphere Update Manager Download Service using the following
parameters before its deployment.

Attribute Value

Guest OS Ubuntu Server 14.04 LTS

VM name sfo01umds01

Number of CPUs 2

Memory (GB) 2

Disk space (GB) 120

SCSI Controller LSI Logic SAS

Virtual machine network adapter VMXNET3

VM folder sfo01-m01fd-mgmt

Cluster sfo01-m01-mgmt01

Datastore sfo01-m01-vsan01

Application virtual network Mgmt-RegionA01-VXLAN

IP Addresses and Host Names
Verify that the static IP addresses and FQDNs for vSphere Update Manager Download Service are
available in the region-specific application virtual networks.
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Role Value

Appliance IP address 192.168.31.67

Host name sfo01umds01

Default gateway 192.168.31.1

Subnet mask 255.255.255.0

DNS servers n 172.16.11.5
n 172.16.11.4

DNS domain sfo01.rainpole.local

DNS search sfo01.rainpole.local

Deployment Prerequisites
Verify that your environment fulfills the following prerequisites for deploying vSphere Update Manager
Download Service.

Prerequisite Value

Software Features n Verify that the vCenter Server instances are operational.
n Verify that the application virtual network is available.

Active Directory User Verify that the svc-umds user is added into the parent Active Directory.

Configure PostgreSQL Database on Your Linux-Based Host
Operating System for UMDS in Region A
On a virtual machine with Ubuntu 14.04 Long Term Support (LTS) where you plan to install vSphere
Update Manager Download Service, configure a PostgreSQL database instance.

Prerequisites

n Create a virtual machine for vSphere Update Manager Download Service (UMDS). See Virtual
Machine Specifications from the Planning and Preparation documentation.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the vSphere Web Client, right-click the sfo01umds01 virtual machine and select Open Console to
open the remote console to the virtual machine.
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3 At the command prompt, log in using the following credentials.

Setting Value

User name svc-umds

Password svc-umds_password
 

4 Install Secure Shell (SSH) server, and end the session.

sudo apt-get update

sudo apt-get -y install SSH

exit

5 Log back in to the UMDS virtual machine using Secure Shell (SSH) client.

a Open an SSH connection to the virtual machine sfo01umds01.

b Log in using the following credentials.

Setting Value

User name svc-umds

Password svc-umds_password
 

6 Install and start PostgreSQL and its dependencies.

sudo apt-get -y install vim perl tar sed psmisc unixodbc postgresql postgresql-contrib odbc-

postgresql

sudo service postgresql start

The installation operation creates a user account called postgres that is associated with the default
Postgres role. The postgres account is used to establish a service account for the Update Manager
Download Service.

7 Log in as postgres user, and create a database instance and a database user, by running the
following commands.

When prompted, enter and confirm the umds_db_admin_password password.

sudo su - postgres

createdb umds_db

createuser -d -e -r umds_db_admin -P
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8 Enable password authentication for the database user.

a Navigate to the folder that contains the PostgreSQL configuration file pg_hba.conf.

Linux system Default Location

Ubuntu 14.04 /etc/postgresql/postgres_version/main

 

cd /etc/postgresql/postgres_version/main

b In the PostgreSQL configuration file, enable password authentication for the database user by
inserting the following line right above local all all peer.

You can use the vi editor to make and save the changes.

#TYPE DATABASE USER ADDRESS METHOD

local umds_db umds_db_admin md5

c Log out as a PostgreSQL user by running the following command.

logout

9 Configure the PostgreSQL driver and the data source name (DSN) for a connection to the UMDS
database.

a Edit the ODBC configuration file.

sudo vi /etc/odbcinst.ini

b Replace the file content with the following content and save the change using :wq.

[PostgreSQL]

Description=PostgreSQL ODBC driver (Unicode version)

Driver=/usr/lib/x86_64-linux-gnu/odbc/psqlodbcw.so

Debug=0

CommLog=1

UsageCount=1
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c Edit the system file /etc/odbc.ini.

sudo vi /etc/odbc.ini

d Replace the file content with the following content and save the change using :wq.

[UMDS_DSN]

;DB_TYPE = PostgreSQL

;SERVER_NAME = localhost

;SERVER_PORT = 5432

;TNS_SERVICE = <database_name>

;USER_ID = <database_username>

Driver = PostgreSQL

DSN = UMDS_DSN

ServerName = localhost

PortNumber = 5432

Server = localhost

Port = 5432

UserID = umds_db_admin

User = umds_db_admin

Database = umds_db

10 Create a symbolic link between the UMDS and the PostgreSQL by running the following command.

ln -s /var/run/postgresql/.s.PGSQL.5432 /tmp/.s.PGSQL.5432

11 Restart PostgreSQL.

sudo service postgresql restart

Install UMDS on Ubuntu OS in Region A
After you install and configure the PostgreSQL database on the UMDS virtual machine, install the UMDS
software.

Prerequisites

n Verify that you have administrative privileges on the UMDS Ubuntu virtual machine.

n Mount the ISO file of the vCenter Server Appliance to the Linux machine.
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Procedure

1 Log in to the UMDS virtual machine by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01umds01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name svc-umds

Password svc-umds_password
 

2 Mount the vCenter Server Appliance ISO to the UMDS virtual machine.

sudo mkdir -p /mnt/cdrom

sudo mount /dev/cdrom /mnt/cdrom

3 Extract the VMware-UMDS-6.5.0.-build_number.tar.gz file to the /tmp folder.

tar -xzvf /mnt/cdrom/umds/VMware-UMDS-6.5.0-build_number.tar.gz -C /tmp

4 Run the UMDS installation script.

sudo /tmp/vmware-umds-distrib/vmware-install.pl

5 Read and accept the EULA.

6 Press Enter to install UMDS in the default directory /usr/local/vmware-umds and enter yes to
confirm directory creation.

7 Enter the UMDS proxy settings if needed according to the settings of your environment.

8 Press Enter to set the default patch location to /var/lib/vmware-umds and enter yes to confirm
directory creation.

9 Provide the database details.

Setting Value

Database DSN UMDS_DSN

Database username umds_db_admin

Database password umds_db_admin_password
 

10 Type yes and press Enter to install UMDS.

Set Up the Data to Download Using UMDS in Region A
By default UMDS downloads patch binaries, patch metadata, and notifications for hosts. Specify which
patch binaries and patch metadata to download with UMDS.
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Procedure

1 Log in to the UMDS virtual machine by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01umds01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name svc-umds

Password svc-umds_password
 

2 Navigate to the directory where UMDS is installed.

cd /usr/local/vmware-umds/bin

3 Disable the updates for older hosts and virtual appliances.

sudo ./vmware-umds -S -n

sudo ./vmware-umds -S -d embeddedEsx-5.5.0

sudo ./vmware-umds -S -d embeddedEsx-6.0.0

4 Configure automatic daily downloads by creating a cron job file.

cd /etc/cron.daily/

sudo touch umds-download

sudo chmod 755 umds-download

5 Edit the download command of the cron job.

sudo vi umds-download

6 Add the following lines to the file.

#!/bin/sh

/usr/local/vmware-umds/bin/vmware-umds -D

sudo chmod -R 755 /var/lib/vmware-umds

7 Test the UMDS Download cron job.

sudo ./umds-download

UMDS downloads required patch binaries, patch metadata, and notifications for hosts. Wait until the
download is complete. This process may take several minutes.

Install and Configure the UMDS Web Server in Region A
The UMDS server in Region A downloads upgrades, patch binaries, patch metadata, and notifications to
a directory that you must share to vSphere Update Manager by using a Web server.
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The default folder to which UMDS downloads patch binaries and patch metadata on a Linux machine
is /var/lib/vmware-umds. You share this folder out to the VUM instances within the region using a
Nginx Web server.

Procedure

1 Log in to the UMDS virtual machine by using a Secure Shell (SSH) client.

a Open an SSH connection to sfo01umds01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name svc-umds

Password svc-umds_password
 

2 Install the Nginx Web server with the following command.

sudo apt-get -y install nginx

3 Change the patch repository directory permissions by running the following command.

sudo chmod -R 755 /var/lib/vmware-umds

4 Copy the default site configuration for use with the UMDS configuration.

sudo cp /etc/nginx/sites-available/default /etc/nginx/sites-available/umds

5 Edit the new /etc/nginx/sites-available/umds site configuration file by running the sudo
vi /etc/nginx/sites-available/umds command and replace the server {} block with the
following content.

server {

        listen 80 default_server;

        listen [::]:80 default_server ipv6only=on;

        root /var/lib/vmware-umds;

        index index.html index.htm;

        # Make site accessible from http://localhost/

        server_name localhost sfo01umds01 sfo01umds01.sfo01.rainpole.local;

        location / {

                # First attempt to serve request as file, then

                # as directory, then fall back to displaying a 404.

                try_files $uri $uri/ =404;

                # Uncomment to enable naxsi on this location

                # include /etc/nginx/naxsi.rules

                autoindex on;

        }

}
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6 Disable the existing default site.

sudo rm /etc/nginx/sites-enabled/default

7 Enable the new UMDS site.

sudo ln -s /etc/nginx/sites-available/umds /etc/nginx/sites-enabled/

8 To apply the new configuration, restart the Nginx Web service.

sudo service nginx restart

9 Ensure that you can browse the files on the UMDS Web server by opening a Web browser to
http://sfo01umds01.sfo01.rainpole.local.

Use the UMDS Shared Repository as the Download Source in
Update Manager in Region A
Configure Update Manager to use the UMDS shared repository as a source for downloading ESXi
patches, extensions, and notifications.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Update Manager.

3 In the Navigator pane, click the sfo01m01vc01.sfo01.rainpole.local vCenter Server for Region A.

The Objects tab also displays all the vCenter Server system to which an Update Manager instance is
connected.

4 Click the Manage tab, and under Settings, click Download Settings.

5 On the Download sources page, click the Edit button.

An Edit Download Sources dialog box opens.
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6 On the Edit Download Sources dialog box, enter the following settings, and click OK.

Setting Value

Use a shared repository Selected

URL http://sfo01umds01.sfo01.rainpole.local
 

7 On the Download sources page, click the Download Now button to run the download patch
definitions.

Verify that a new task Download patch definitions appears in the Recent Tasks pane and shows
Status as Completed.

8 Repeat the procedure to configure the http://sfo01umds01.sfo01.rainpole.local repository for the
sfo01w01vc01.sfo01.rainpole.local vCenter Server.

vRealize Suite Lifecycle Manager Implementation in
Region A
You deploy the vRealize Suite Lifecycle Manager appliance, configure common settings, replace the
appliance certificate, generate a certificate for product deployments, and configure product binaries.

Procedure

1 Prerequisites for Deploying vRealize Suite Lifecycle Manager in Region A

Before you deploy vRealize Suite Lifecycle Manager, verify that your environment fulfills the
requirements for this deployment.

2 Configure User Access in vSphere for Integration with vRealize Suite Lifecycle Manager in Region A

Configure an operations service account with the required permissions to enable vRealize Suite
Lifecycle Manager to deploy and manage the vRealize Suite components of the Software-Defined
Data Center (SDDC) on the Management vCenter Server.

3 Deploy the vRealize Suite Lifecycle Manager Appliance in Region A

You deploy the vRealize Suite Lifecycle Manager appliance and configure storage, networking, and
other key appliance attributes.

4 Configure the vRealize Suite Lifecycle Manager Appliance in Region A

You configure the vRealize Suite Lifecycle Manager appliance system settings, generate the
certificate for product deployments, replace the appliance certificate, and configure NTP settings.

5 Register vRealize Suite Lifecycle Manager with My VMware

You can integrate vRealize Suite Lifecycle Manager directly with a My VMware account to access
vRealize Suite licenses within an entitlement account and manage the download of product OVAs
for install, patch, and upgrade. The My VMware account registration is also used to download
content from the VMware Marketplace.
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6 Configure Product Binaries in vRealize Suite Lifecycle Manager in Region A

vRealize Suite Lifecycle Manager provides two methods to retrieving and storing product binaries for
install and upgrade of the vRealize Suite components. Integration with My VMware allows direct
download of product binaries for vRealize Suite entitlements. As an alternative, you can upload
product binaries to the vRealize Suite Lifecycle Manager appliance repository.

7 Add Data Centers and vCenter Server Instances to vRealize Suite Lifecycle Manager in Region A

Before you can create an environment for product deployments, you must add a data center and the
associated Management vCenter Server instance to vRealize Suite Lifecycle Manager.

Prerequisites for Deploying vRealize Suite Lifecycle Manager in
Region A
Before you deploy vRealize Suite Lifecycle Manager, verify that your environment fulfills the requirements
for this deployment.

IP Addresses and Host Names
Verify that static IP addresses and FQDNs for the application virtual networks are available for the SDDC
deployment.

Role IP Address

Static IP address of the appliance 192.168.11.20

Host name of the appliance vrslcm01svr01a.rainpole.local

Default gateway 192.168.11.1

DNS servers n 172.16.11.4
n 172.17.11.4

Subnet mask 255.255.255.0

NTP servers n ntp.sfo01.rainpole.local
n ntp.lax01.rainpole.local

Deployment Prerequisites
Verify that your environment satisfies the following prerequisites for the deployment of vRealize Suite
Lifecycle Manager.

Prerequisite Value

Storage n Virtual disk provisioning
n Thin

n Required storage: 135 GB

Software Features n Verify that vCenter Server is operational.
n Verify that the application virtual networks are available.

License n Verify that you have obtained a vRealize Suite or vCloud Suite license with a quantity that satisfies
the requirements of this design.
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Prerequisite Value

Active Directory n Verify that you have a parent active directory with the SDDC user roles configured for the
rainpole.local domain.
n svc-vrslcm-vsphere (User)

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the vRealize Suite Lifecycle

Manager. See the VMware Validated Design Planning and Preparation documentation.

My VMware Account Verify that you have a My VMware account with permissions to view licenses and download products.

Configure User Access in vSphere for Integration with vRealize
Suite Lifecycle Manager in Region A
Configure an operations service account with the required permissions to enable vRealize Suite Lifecycle
Manager to deploy and manage the vRealize Suite components of the Software-Defined Data Center
(SDDC) on the Management vCenter Server.

Define a User Role in vSphere for vRealize Suite Lifecycle Manager in Region
A
Create a user role in the vSphere Web Client with the required privileges to enable vRealize Suite
Lifecycle Manager to deploy and manage the vRealize Suite components.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 On the Home page, under Administration, click Roles.
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3 Create a role for vRealize Suite Lifecycle Manager in vSphere.

a On the Roles page, click the Create Role action icon.

b In the Create Role dialog box, configure the role using the following configuration settings, and
click OK.

Setting Value

Role Name vRealize Suite Lifecycle Manager User

Privileges n Datastore.Allocate space
n Datastore.Browse datastore
n Datastore.Update virtual machine files
n Host.Local operations.Add host to vCenter
n Host.Local operations.Create virtual machine
n Host.Local operations.Delete virtual machine
n Host.Local operations.Reconfigure virtual machine
n Network.Assign network
n Resource.Assign vApp to resource pool
n Resource.Assign virtual machine to resource pool
n Virtual machine.* (All privileges)
n vApp.* (All privileges)

Configure User Privileges in vSphere for Integration with vRealize Suite
Lifecycle Manager in Region A
Assign account permissions to the svc-vrslcm-vsphere user to deploy and manage SDDC components on
the Management vCenter Server with vRealize Suite Lifecycle Manager.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Assign permissions to the service account.

a From the Home menu, select Hosts and Clusters.

b In the Navigator, select sfo01m01vc01.sfo01.rainpole.local.

c Click Permissions tab and click the Add permission icon.

d In the Add Permission dialog box, click Add to associate a user or a group with a role.
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e In the Select Users/Groups dialog box, from the Domain drop-down menu, select
rainpole.local, in the filter box type svc, and press Enter.

f From the list of users and groups, select svc-vrslcm-vsphere, click Add, and click OK.

g In the Add Permission dialog box, from the Assigned Role drop-down menu, select vRealize
Suite Lifecycle Manager User, ensure that Propagate to children is selected, and click OK.

Deploy the vRealize Suite Lifecycle Manager Appliance in Region
A
You deploy the vRealize Suite Lifecycle Manager appliance and configure storage, networking, and other
key appliance attributes.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Global Inventory Lists > vCenter Servers.

3 Right-click sfo01m01vc01.sfo01.rainpole.local and select Deploy OVF Template.

4 On the Select template page, select Local file, browse to the location of the vRealize Suite Lifecycle
Manager OVA file, and click Next.

5 On the Select name and location page, enter the following information, and click Next.

Setting Value

Name vrslcm01svr01a

Select a data center or folder sfo01-m01fd-mgmt

6 On the Select a resource page, select sfo01-m01-mgmt01 and click Next.

7 On the Review details page, review the virtual appliance details such as product, version, download
size, and size on disk, and click Next.

8 On the Accept license agreements page, read and accept the End-User License Agreement, and
click Next.

9 On the Select configuration page, leave the default value and click Next.
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10 On the Select storage page, select the following parameters and click Next.

Setting Value

Select virtual disk format Thin provision

VM storage policy vSAN Default Storage Policy

Datastores sfo01-m01-vsan01

11 On the Select networks page, select the distributed port group that ends with Mgmt-xRegion01-
VXLAN from the Destination Network drop-down menu and click Next.

12 On the Customize template page, configure the following values and click Next.

Option Value

Hostname vrslcm01svr01a.rainpole.local

Join the VMware Customer Experience Improvement Program Selected

Common Name vrslcm01svr01a.rainpole.local

Country Code US

Organization Name Rainpole

Organization Unit Rainpole

Default Gateway 192.168.11.1

Domain Name rainpole.local

Domain Name Servers 172.16.11.4,172.17.11.4

Domain Search Path rainpole.local

Network 1 IP Address 192.168.11.20

Network 1 Netmask 255.255.255.0

13 On the Ready to complete page, click Finish and wait for the process to complete.

14 Power on the vRealize Suite Lifecycle Manager appliance.

a From the Home menu, select Hosts and Clusters.

b Expand the sfo01m01vc01.sfo01.rainpole.local tree.

c Select the vrslcm01svr01a virtual machine and from the Actions menu select Power > Power
on.

Configure the vRealize Suite Lifecycle Manager Appliance in
Region A
You configure the vRealize Suite Lifecycle Manager appliance system settings, generate the certificate for
product deployments, replace the appliance certificate, and configure NTP settings.
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Configure vRealize Suite Lifecycle Manager in Region A
After the deployment of the vRealize Suite Lifecycle Manager appliance, you perform an initial login and
configure common system settings, such as the appliance passwords, the configuration drift interval,
enablement of SSH, and joining the VMware Customer Experience Improvement Program.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface for the first time.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password (default) vmware

2 On the Choose a new LCM VA root Password page, provide the following values to set a new root
password and click Update Password.

The password must be at least eight characters long and contain at least one lowercase, uppercase,
numeric, and special character.

Setting Value

Password vrslcm_root_password

Confirm Password vrslcm_root_password

3 Close the Welcome dialog box.

4 In the Navigator pane, click the Settings icon.

5 Under Settings, click System Settings and configure the following values.

Setting Value

SSH Service Selected

Admin Password vrslcm_admin_password

Confirm Admin Password vrslcm_admin_password

Configuration Drift Interval 24 (default)

Restart Server Deselected (default)

Schedule a restart Deselected (default)

Join the VMware Customer Experience Improvement Program Selected (default)

6 Click Save, and in the Confirm Logout dialog box, click OK.

vRealize Suite Lifecycle Manager logs you out back to the vRealize Suite Lifecycle Manager login
screen.
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Generate Certificate for vRealize Suite Lifecycle Manager Environments in
Region A
Before deploying a product with vRealize Suite Lifecycle Manager, you generate a self-signed certificate
that is used during product path, solution path, or configuration file deployment.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator, click the Settings icon.

3 Under Settings, click the Certificate tab, enter the following values, and click Generate Certificate.

Setting Value

Organization Name Rainpole

Organizational Unit Rainpole

Domain Name rainpole.local,sfo01.rainpole.local,lax01.rainpole.local

Locality San Francisco

State California

Country Code US

Passphrase vrslcm_generated_certificate_passphrase

A message Certificate generate request triggered successfully appears.

4 In the Navigator, click the Requests icon and validate that ACTION#GENERATE_CERTIFICATE
displays as COMPLETED.

5 In the Navigator, click the Settings icon, click the Certificate tab, and click View Certificate to view
the certificate details.

Replace Certificate on the vRealize Suite Lifecycle Manager Appliance in
Region A
To establish a trusted connection to vRealize Suite Lifecycle Manager, you replace the SSL certificate on
the appliance with a custom certificate signed by a certificate authority available on the parent Active
Directory or on the intermediate Active Directory. See Certificate Replacement guide for additional
information.
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Procedure

1 Rename the certificates generated using the VMware Validated Design Certificate Generation Utility
for vrslcm01svr01a.rainpole.local.

Original Certificate File Name New Certificate File Name

vrslcm01svr01a.2.chain.pem server.crt

vrslcm01svr01a-orig.key server.key

2 Overwrite the existing server.crt and server.key files in the /opt/vmware/vlcm/cert directory
with the previously generated CA signed certificate files.

You can use SCP software like WinSCP.

3 Log in to vRealize Suite Lifecycle Manager appliance by using Secure Shell (SSH) client.

a Open an SSH connection to vrslcm01svr01a.rainpole.local.

b Log in using following credentials.

Setting Value

User name root

Password vrslcm_root_password

4 Restart the vRealize Suite Lifecycle Manager services to update the appliance certificate.

a Restart the system services by running the following command in the SSH session.

systemctl restart vlcm-xserver

b Check the status of the system services by running the following command in the SSH session.

systemctl status vlcm-xserver

5 After restarting the services, verify that the certificate is updated on the appliance.

a Close any opened Web browsers, open a new Web browser window, and go to
https://vrslcm01svr01a.rainpole.local/vrlcm.

b Verify that you see the new certificate in the browser.

Configure NTP on the vRealize Suite Lifecycle Manager Appliance in Region
A
Configure NTP on the vRealize Suite Lifecycle Manager appliance to keep vRealize Suite Lifecycle
Manager synchronized with the other SDDC components.

Prerequisites

Verify that the SSH service on the vRealize Suite Lifecycle Manager appliance is enabled.
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Procedure

1 Log in to vRealize Suite Lifecycle Manager appliance by using Secure Shell (SSH) client.

a Open an SSH connection to vrslcm01svr01a.rainpole.local.

b Log in using following credentials.

Setting Value

User name root

Password vrslcm_root_password

2 Configure the NTP source for the vRealize Suite Lifecycle Manager appliance.

a Open the /etc/systemd/timesyncd.conf file for editing using a text editor such as vi.

vi /etc/systemd/timesyncd.conf

b Remove the comment for the NTP configuration and add the following NTP settings.

NTP=ntp.sfo01.rainpole.local ntp.lax01.rainpole.local

3 Enable the systemd-timesyncd service and verify the status.

a Run the following command to enable the network time synchronization.

timedatectl set-ntp true

b Run the following command to enable the NTP synchronization.

systemctl restart systemd-timesyncd

c Run the following command to verify the status of the service.

timedatectl status

4 Log out of the session by entering logout.

Register vRealize Suite Lifecycle Manager with My VMware
You can integrate vRealize Suite Lifecycle Manager directly with a My VMware account to access
vRealize Suite licenses within an entitlement account and manage the download of product OVAs for
install, patch, and upgrade. The My VMware account registration is also used to download content from
the VMware Marketplace.

If your organization restricts outbound access, configure a proxy server for the vRealize Suite Lifecycle
Manager appliance.
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Prerequisites

Before registering vRealize Suite Lifecycle Manager with My VMware, verify that you have created a My
VMware account with permissions to view licenses and download products from your entitlement account.
See Prerequisites for Deploying vRealize Suite Lifecycle Manager in Region A.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 On the Navigator pane, click the Settings icon.

3 Register vRealize Suite Lifecycle Manager with My VMware.

a On the Settings page, click the My VMware tab, enter your My VMware credentials, and click
Submit.

Setting Value

User Name my_vmware_username

Password my_vmware_password

b In the Download OVA dialog box that appears prompting you to start a content download, click
NO.

After vRealize Suite Lifecycle Manager is registered with My VMware, you see a message
Service registered with My VMware credentials provided.

4 (Optional) If the access to My VMware is behind a proxy, configure the proxy sSettings for vRealize
Suite Lifecycle Manager.

a In the Navigator pane, click the Settings icon and click the My VMware tab.

b On the My VMware page, select Configure Proxy, enter the following values, and click Submit.

Setting Value

Proxy Server proxy_server_fqdn_or_ip_address (for example: proxy.rainpole.local)

Proxy Port proxy_server_port (for example: 3128)

Proxy User Name proxy_server_username

Proxy Password proxy_server_password
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Configure Product Binaries in vRealize Suite Lifecycle Manager in
Region A
vRealize Suite Lifecycle Manager provides two methods to retrieving and storing product binaries for
install and upgrade of the vRealize Suite components. Integration with My VMware allows direct
download of product binaries for vRealize Suite entitlements. As an alternative, you can upload product
binaries to the vRealize Suite Lifecycle Manager appliance repository.

Download Product Binaries to vRealize Suite Lifecycle Manager with My
VMware
You can integrate vRealize Suite Lifecycle Manager directly with a My VMware account to access
vRealize Suite entitlements. Using the My VMware integration allows you to download all or selected
product binaries for install and upgrade.

Prerequisites

Note   Using integration with My VMware simplifies and automates downloading vRealize Suite product
binaries to the vRealize Suite Lifecycle Manager repository. If your organization must restrict outbound
traffic from the management components of the Software-Defined Data Center, you can upload vRealize
Suite product binaries to the vRealize Suite Lifecycle Manager appliance directly.

n vRealize Suite Lifecycle Manager is registered with My VMware.

n Your My VMware account has permissions to view licenses and download products from your
entitlement account.

n If your organization requires the use of an HTTP Proxy, ensure that it is configured and enabled.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator pane, click the Settings icon and select My VMware tab.

3 In the bottom of the My VMware page, enable Auto Refresh.
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4 For the required products and versions in the My VMware Products, from the Actions column, click
the Download icon to start the download.

Monitor the Download Status column as each product transitions from INPROGRESS to COMPLETED.
Based on the size of each product download for install and upgrade, the process can take some time
to complete.

Add Data Centers and vCenter Server Instances to vRealize Suite
Lifecycle Manager in Region A
Before you can create an environment for product deployments, you must add a data center and the
associated Management vCenter Server instance to vRealize Suite Lifecycle Manager.

You add a data center for the deployment in Region A for each of the following groups of components:

n Cross-region components, such as the analytics cluster of vRealize Operations Manager and the
main components of the Cloud Management Platform.

n Local-region components, such as vRealize Log Insight and vRealize Log Insight Content Packs.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator, click the Data Centers icon.

3 Add the data centers.

a On the Data Centers page, click the Manage Data Centers tab and click Add Data Center.

b In the Add Data Center dialog box, add the data centers by entering the following information
and clicking Add.

Setting Value for Region A Value for Cross-Region

Name sfo01-m01dc cross-region-dc

Location San Francisco, California, US San Francisco, California, US

4 Add the vCenter Server instances.

a On the Data Centers page, click the Manage vCenter Servers tab.

b From the Select Data Center drop-down menu, select sfo01-m01dc and click Add vCenter
Server.

Deployment for Region A

VMware, Inc.  183



c In the Add vCenter Server Details dialog box, enter the following vCenter Server information for
each data center and click Submit.

Setting Value for the sfo01-m01dc Data Center Value for the cross-region-dc Data Center

Host Name sfo01m01vc01.sfo01.rainpole.local sfo01m01vc01.sfo01.rainpole.local

User Name svc-vrslcm-vsphere@rainpole.local svc-vrslcm-vsphere@rainpole.local

Password svc-vrslcm-vsphere_password svc-vrslcm-vsphere_password

vCenter Server Type Management Management

d Repeat the steps to add the vCenter Server instance to the other data center.

5 In the Navigator, click Requests and validate that VC_DATA_COLLECTION for each vCenter Server
instance shows COMPLETED.

vRealize Operations Manager Implementation in Region A
Deploy vRealize Operations Manager components to monitor the resources in your SDDC.

Deploy the vRealize Operations Manager analytics cluster with three nodes to monitor the resources in
your SDDC. Deploy also the remote collector group with a two nodes to collect data from the
management components in the SDDC.

Procedure

1 Deploy vRealize Operations Manager in Region A

Start the deployment of vRealize Operations Manager in Region A by deploying the nodes of the
analytics cluster and the remote collector nodes.

2 Move vRealize Operations Manager Nodes to Virtual Machine Folders in Region A

Use the vSphere Web Client to move the vRealize Operations Manager analytics cluster nodes and
remote collector nodes to virtual machine folders for better organization and ease of management.

3 Configure vSphere DRS Anti-Affinity Rules for vRealize Operations Manager in Region A

To protect the vRealize Operations Manager virtual machines from a host-level failure, configure
vSphere DRS to run the virtual machines of the analytics cluster and the remote collectors on
different hosts in the management cluster.

4 Replace vRealize Operations Manager Certificate in Region A

Use the PEM file that is generated using the CertGenVVD utility to replace the current certificate on
the vRealize Operations Manager by logging to the administrator user interface of the master node.

5 Configure the Load Balancer for vRealize Operations Manager in Region A

Configure load balancing for the analytics cluster on the dedicated NSX Edge services gateway. The
remote collector group in Region A does not require load balancing.

6 Group Remote Collector Nodes in Region A
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7 Add an Authentication Source for the Active Directory in Region A

Connect vRealize Operations Manager to the Active Directory of the SDDC for central user
management and access control.

8 Configure User Access in vSphere for Integration with vRealize Operations Manager in Region A

9 Add vCenter Adapter Instances to vRealize Operations Manager in Region A

10 Connect vRealize Operations Manager to the NSX Manager Instances in Region A

Install and configure the vRealize Operations Management Pack for NSX for vSphere to monitor the
NSX networking services deployed in the clusters in the region and view the vSphere hosts in the
NSX transport zones.

11 Enable Storage Device Monitoring in vRealize Operations Manager in Region A

Install and configure the vRealize Operations Management Pack for Storage Devices to view the
storage topology in the SDDC and to monitor the capacity and problems on storage components.

12 Enable vSAN Monitoring in vRealize Operations Manager in Region A

Configure the vRealize Operations Management Pack for vSAN to view the vSAN topology, and to
monitor the capacity and problems.

13 Configure Email Alerts for vRealize Operations Manager in Region A

You configure email notifications in vRealize Operations Manager so that users and applications
receive the administrative alerts from vRealize Operations Manager about certain situations in the
data center. 

Deploy vRealize Operations Manager in Region A
Start the deployment of vRealize Operations Manager in Region A by deploying the nodes of the
analytics cluster and the remote collector nodes.

Procedure

1 Prerequisites for Deploying vRealize Operations Manager in Region A

Before you deploy vRealize Operations Manager, verify that your environment fulfills the
requirements for this deployment.

2 Create the Cross Region Environment in vRealize Suite Lifecycle Manager in Region A

When you deploy vRealize Operations Manager by using the vRealize Suite Lifecycle Manager, you
first create a new environment. As part of the task, you input network, storage, and other
environment parameters required for the deployment.

3 Deploy vRealize Operations Manager Using vRealize Suite Lifecycle Manager in Region A

Configure deployment details for vRealize Operations Manager in the vRealize Suite Lifecycle
Manager installation wizard. Set advanced settings for the required VMs that are part of vRealize
Operations Manager.
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4 Monitor the Deployment for vRealize Operations Manager in vRealize Suite Lifecycle Manager in
Region A

You can monitor the status of the vRealize Operations Manager deployment in the vRealize Suite
Lifecycle Manager user interface.

Prerequisites for Deploying vRealize Operations Manager in Region A
Before you deploy vRealize Operations Manager, verify that your environment fulfills the requirements for
this deployment.

IP Addresses and Host Names

Verify that static IP addresses and FQDNs for the application virtual networks are available for the SDDC
deployment.

For the analytics cluster application virtual network, allocate three static IP addresses and FQDNs for the
nodes, one for the load balancer, and map host names to the IP addresses. For the remote collector
group, allocate two static IP addresses and FQDNs and map host names to the IP addresses.

Table 3‑1.  Application Virtual Network Names for vRealize Operations Manager

vRealize Operations Manager Component Application Virtual Network

Analytics Cluster Mgmt-xRegion01-VXLAN

Remote Collector Group Mgmt-RegionA01-VXLAN

Table 3‑2.  IP Addresses and Host Names for the Analytics Cluster in Region A

Role IP Address FQDN

External load balancer VIP address 192.168.11.35 vrops01svr01.rainpole.local

Master node 192.168.11.31 vrops01svr01a.rainpole.local

Master replica node 192.168.11.32 vrops01svr01b.rainpole.local

Data node 1 192.168.11.33 vrops01svr01c.rainpole.local

Default gateway 192.168.11.1 -

DNS server n 172.16.11.4
n 172.17.11.4

-

Subnet mask 255.255.255.0 -

NTP servers n 172.16.11.251
n 172.16.11.252

ntp.sfo01.rainpole.local

Table 3‑3.  IP Addresses and Host Names for the Remote Collectors in Region A

Role IP Address FQDN

Remote collector node 1 192.168.31.31 sfo01vropsc01a.sfo01.rainpole.local

Remote collector node 2 192.168.31.32 sfo01vropsc01b.sfo01.rainpole.local

Default gateway 192.168.31.1 -
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Table 3‑3.  IP Addresses and Host Names for the Remote Collectors in Region A
(Continued)

Role IP Address FQDN

DNS server n 172.16.11.5
n 172.16.11.4

-

Subnet mask 255.255.255.0 -

Deployment Prerequisites

Verify that your environment fulfills the following prerequisites for the deployment of vRealize Operations
Manager.

Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per analytics cluster node.
n Initial storage for the analytics cluster node: 274 GB
n Additional storage for monitoring data per analytics cluster node: 1 TB

n Required storage per remote collector group node.
n Initial storage per node: 274 GB

Software Features n Verify that vCenter Server is operational.
n Verify that the vSphere cluster has vSphere DRS and HA enabled.
n Verify that the NSX Manager is operational.
n Verify that the application virtual networks are available.
n Verify that the Load Balancer service is enabled on the NSX Edge services gateway.
n Verify that the vRealize Suite Lifecycle Manager is operational and data collection from the

management vCenter Server instance has run successfully.
n Verify that Postman App is installed.

Installation Package n Download the .pak file for the vRealize Operations Manager Management Pack for NSX for vSphere
from VMware Solutions Exchange.

n Download the .pak file for the vRealize Operations Manager Management Pack for Storage Devices
from VMware Solutions Exchange.

n Download the .pak file for the vRealize Operations Manager Management Pack for Site Recovery
Manager from My VMware https://my.vmware.com.

License n Verify that you have obtained a vRealize Suite or vCloud Suite license with a quantity that fulfills the
requirements of this design.

Active Directory Verify that you have a parent active directory with the SDDC user roles configured for the rainpole.local
domain.

svc-vrops (User)

svc-vrops-vsphere (User)

svc-vrops-nsx (User)

svc-vrops-vsan (User)

svc-vrops-mpsd (User)

svc-vrops-srm (User)
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Prerequisite Value

Certificate Authority n Configure the root Active Directory domain controller as a certificate authority for the environment.
n Download the CertGenVVD tool and generate the signed certificate for the analytics cluster. See the

VMware Validated Design Planning and Preparation documentation.

External Services n Verify that you have access to an SMTP server.
n Verify that SNMP is enabled in your network environment, to monitor network devices.
n Verify that Link Layer Discovery Protocol (LLDP) or Cisco Discovery Protocol (CDP) is enabled on

each network device for complete monitoring of your environment.

Create the Cross Region Environment in vRealize Suite Lifecycle Manager in
Region A
When you deploy vRealize Operations Manager by using the vRealize Suite Lifecycle Manager, you first
create a new environment. As part of the task, you input network, storage, and other environment
parameters required for the deployment.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 On the Home page, click Create Environment to start a new deployment.

3 On the Create Environment page, enter the following information, and click Next.

Setting Value

Data Center cross-region-dc

Environment Type Production

Environment Name Cross-Region-Env

Administrator Email deployment_admin_email

Default Password deployment_admin_password

Confirm Default Password deployment_admin_password

Customer Experience Improvement Program Selected

4 On the Products tab, select the check box for vRealize Operations from available vRealize Suite
products.
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5 Select the following options and click Next.

Setting Value

Installation type New Install

Version 6.7.0

Deployment type Small

6 On the End User License Agreement page, read the EULA, check I agree to the terms and
conditions, and click Next.

7 On the License Details page, add or select the vRealize Suite license.

a From the drop-down menu provided through the My VMware product entitlement, select Select
vRealize Suite License, select the license, and click Next.

b Or select Add vRealize Suite License, provide the vRealize Suite or vCloud Suite License key,
and click Next.

8 On the Infrastructure Details page, enter the following information, and click Next.

Setting Value

Select vCenter Server sfo01m01vc01.sfo01.rainpole.local

Select Cluster sfo01-m01-mgmt01 (sfo01-m01dc)

Select Network Distributed port group that ends with Mgmt-xRegion01-VXLAN

Select Datastore sfo01-m01-vsan01

Select Disk Format Thin

9 On the Network Details page, enter the following information and click Next.

Setting Value

Default Gateway 192.168.11.1

Domain Name rainpole.local

Domain Search Path rainpole.local

Domain Name Servers 172.16.11.4,172.17.11.4

Netmask 255.255.255.0

10 On the Certificate Details page, select Use Generated Certificate and click Next.

Deploy vRealize Operations Manager Using vRealize Suite Lifecycle Manager
in Region A
Configure deployment details for vRealize Operations Manager in the vRealize Suite Lifecycle Manager
installation wizard. Set advanced settings for the required VMs that are part of vRealize Operations
Manager.
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Procedure

1 On the vRealize Operations page, enter the following information for Product Properties.

Setting Value

NTP Server IP / Hostname ntp.sfo01.rainpole.local

Node size Medium

2 Add nodes to the vRealize Operations Manager cluster.

a In the Components frame, click Add and select a component type to add.

Role Value

Master replica node vRealize Operations Replica

Data node 1 vRealize Operations Data

Remote collector 1 vRealize Operations Remote Collector

Remote collector 2 vRealize Operations Remote Collector

3 Configure the vRealize Operations Manager master node.

a In the master VM frame, enter the following information and click the Advanced Settings icon.

Setting Value

Vrops Master VM Name vrops01svr01a

Vrops Master Hostname vrops01svr01a.rainpole.local

Vrops Master IP Address 192.168.11.31

b On the Advanced Configuration for vrops01svr01a page, enter the following information and
click Done.

Setting Value

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

Search Path rainpole.local

Extended Storage (1 TB) sfo01-m01-vsan01
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4 Configure the vRealize Operations Manager replica node.

a In the replica VM frame, enter the following information and click the Advanced Settings icon.

Setting Value

Vrops Replica VM Name vrops01svr01b

Vrops Replica Hostname vrops01svr01b.rainpole.local

Vrops Replica IP Address 192.168.11.32

b On the Advanced Configuration for vrops01svr01b page, enter the following information and
click Done.

Setting Value

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

Search Path rainpole.local

Extended Storage (1 TB) sfo01-m01-vsan01

5 Configure the vRealize Operations Manager data node.

a In the data VM frame, enter the following information and click the Advanced Settings icon.

Setting Value

Vrops Data VM Name vrops01svr01c

Vrops Data Hostname vrops01svr01c.rainpole.local

Vrops Data IP Address 192.168.11.33

b On the Advanced Configuration for vrops01svr01c page, enter the following information and
click Done.

Setting Value

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

Search Path rainpole.local

Extended Storage (1 TB) sfo01-m01-vsan01
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6 Configure the vRealize Operations Manager remotecollector node.

a In the remotecollector VM frame, enter the following information and click the Advanced
Settings icon.

Setting Value

Vrops RemoteCollector VM Name sfo01vropsc01a

Vrops RemoteCollector Hostname sfo01vropsc01a.sfo01.rainpole.local

Vrops RemoteCollector IP Address 192.168.31.31

Node Size Small

b On the Advanced Configuration for sfo01vropsc01a page, enter the following information and
click Done.

Setting Value

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

VM Network distributed port group that ends with Mgmt-RegionA01-VXLAN

Storage sfo01-m01-vsan01

Gateway 192.168.31.1

DNS 172.16.11.5,172.16.11.4

Domain sfo01.rainpole.local

Search Path sfo01.rainpole.local,rainpole.local

NetMask 255.255.255.0
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7 Configure the vRealize Operations Manager remotecollector-2 node.

a In the remotecollector-2 VM frame, enter the following information and click the Advanced
Settings icon.

Setting Value

Vrops RemoteCollector VM Name sfo01vropsc01b

Vrops RemoteCollector Hostname sfo01vropsc01b.sfo01.rainpole.local

Vrops RemoteCollector IP Address 192.168.31.32

Node Size Small

b On the Advanced Configuration for sfo01vropsc01b page, enter the following information and
click Done.

Setting Value

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

VM Network distributed port group that ends with Mgmt-RegionA01-VXLAN

Storage sfo01-m01-vsan01

Gateway 192.168.31.1

DNS 172.16.11.5,172.16.11.4

Domain sfo01.rainpole.local

Search Path sfo01.rainpole.local,rainpole.local

NetMask 255.255.255.0

8 On the Products Details page, click Next.

9 On the Pre Check Details page, click Run Pre Check. Wait for all Pre Validation successful
messages and click Next.

10 On the Request Summary page, review the information.

11 (Optional) To back up the deployment configuration, click Download Configuration.

12 Click Submit to start the deployment.

Monitor the Deployment for vRealize Operations Manager in vRealize Suite
Lifecycle Manager in Region A
You can monitor the status of the vRealize Operations Manager deployment in the vRealize Suite
Lifecycle Manager user interface.
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Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator pane, click Requests and validate that
VALIDATE_AND_CREATE_ENVIRONMENT for Environment Name: Cross-Region-Env in the
Request Info column is INPROGRESS. It can take a moment for the process to progress from
SUBMITTED to INPROGRESS state.

3 Select the INPROGRESS state for Environment Name: Cross-Region-Env in the Request Info
column.

4 In the Requests page, monitor the steps of the deployment graph until the request is marked as
COMPLETED.

Move vRealize Operations Manager Nodes to Virtual Machine
Folders in Region A
Use the vSphere Web Client to move the vRealize Operations Manager analytics cluster nodes and
remote collector nodes to virtual machine folders for better organization and ease of management.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select VMs and Templates.

3 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server and expand the sfo01-m01dc
data center.

4 Click the VMs tab.
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5 Move the vRealize Operations Manager analytics cluster virtual machines.

a Select the following virtual machines:

n vrops01svr01a

n vrops01svr01b

n vrops01svr01c

b Right-click and select Move to... and select sfo01-m01fd-vrops under VM Folders.

c Click OK.

6 Move the vRealize Operations Manager remote collector virtual machines.

a Select the following virtual machines:

n sfo01vropsc01a

n sfo01vropsc01b

b Right-click and select Move to... and select sfo01-m01fd-vropsrc under VM Folders.

c Click OK.

Configure vSphere DRS Anti-Affinity Rules for vRealize
Operations Manager in Region A
To protect the vRealize Operations Manager virtual machines from a host-level failure, configure vSphere
DRS to run the virtual machines of the analytics cluster and the remote collectors on different hosts in the
management cluster.

Use two anti-affinity rules for the vRealize Operations Manager virtual machines. One anti-affinity rule is
for the analytics nodes and another anti-affinity rule is for the remote collector nodes. This rule
configuration also accommodates the case when you place a host from the management cluster in
maintenance mode.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server object, and under the sfo01-
m01dc data center object select the sfo01-m01-mgmt01 cluster.

3 Click the Configure tab.
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4 Under the Configuration group of settings, select VM/Host Rules. 

5 Create the anti-affinity rules for the vRealize Operations Manager analytics cluster and remote
collectors using the following settings.

Setting Value for the Analytics Nodes Value for the Remote Collectors

Name anti-affinity-rule-vropsm anti-affinity-rule-vropsr

Enable rule Selected Selected

Type Separate Virtual Machines Separate Virtual Machines

Members n vrops01svr01a
n vrops01svr01b
n vrops01svr01c

n sfo01vropsc01a
n sfo01vropsc01b

a In the VM/Host Rules list, click Add above the rules list. 

b In the Create VM/Host Rule dialog box, add the new anti-affinity rule for the virtual machines of
the vRealize Operations Manager analytics cluster, and click OK.

c Repeat the step to add the anti-affinity rule for the remote collector virtual machines of the
vRealize Operations Manager.

Replace vRealize Operations Manager Certificate in Region A
Use the PEM file that is generated using the CertGenVVD utility to replace the current certificate on the
vRealize Operations Manager by logging to the administrator user interface of the master node.

Procedure

1 Log in to vRealize Operations Manager master node by using the administration interface.

a Open a Web browser and go to https://vrops01svr01a.rainpole.local/admin.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 At the upper right corner of the user interface, click the SSL Certificate icon.

3 In the SSL Certificate dialog box, click Install New Certificate.

4 In the Install New Certificate dialog box, click Browse, locate the vrops.2.chain.pem PEM file,
and click Open.

5 In the Install New Certificate dialog box, verify the certificate details, and click Install.
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Configure the Load Balancer for vRealize Operations Manager in
Region A
Configure load balancing for the analytics cluster on the dedicated NSX Edge services gateway. The
remote collector group in Region A does not require load balancing.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 and double-click the sfo01m01lb01
NSX Edge to open its network settings.

5 Configure the VIP address for load balancing for the analytics cluster.

a On the Manage tab, click the Settings tab and click Interfaces.

b Select the OneArmLB interface and click Edit.

c In the Edit NSX Edge Interface dialog box, click the Edit and in the Secondary IP
Addresses text box enter the 192.168.11.35 VIP address.

d Click OK to save the configuration.
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6 Create an application profile.

a On the Manage tab of the sfo01m01lb01 device, click the Load Balancer tab.

b Click Application Profiles, and click Add.

c In the New Profile dialog box, configure the profile using the following configuration settings, and
click OK.

Setting Value

Name vrops-https

Type HTTPS

Enable SSL Passthrough Selected

Persistence Source IP

Expires in (Seconds) 1800
 

7 Create a service monitoring entry.

a On the Load Balancer tab of the sfo01m01lb01 device, click Service Monitoring and click Add.

b In the New Service Monitor dialog box, configure the health check parameters using the
following configuration settings, and click OK.

Setting Value

Name vrops-443-monitor

Interval 3

Timeout 5

Max Retries 2

Type HTTPS

Method GET

URL /suite-api/api/deployment/node/status

Receive ONLINE (must be upper case)
 

8 Add a server pool.

a On the Load Balancer tab of the sfo01m01lb01 device, select Pools, and click Add. 

b In the New Pool dialog box, configure the load balancing profile using the following configuration
settings. 

Setting Value

Name vrops-svr-443

Algorithm LEASTCONN

Monitors vrops-443-monitor
 

c Under Members, click Add to add the pool members.
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d In the New Member dialog box, add one member for each node of the analytics cluster and click
OK.

Setting Value

Name n vrops01svr01a
n vrops01svr01b
n vrops01svr01c

IP Address n 192.168.11.31
n 192.168.11.32
n 192.168.11.33

State Enable

Port 443

Monitor Port 443

Weight 1

Max Connections 8

Min Connections 8
 

e In the New Pool dialog box, click OK.

9 Add a virtual server.

a On the Load Balancer tab of the sfo01m01lb01 device, select Virtual Servers and click Add. 

b In the New Virtual Server dialog box, configure the settings of the virtual server for the analytics
cluster and click OK.

Setting Value

Enable Virtual Server Selected

Application Profile vrops-https

Name vrops-svr-443

Description vRealize Operations Manager Cluster

IP Address 192.168.11.35

Click Select IP Address, select OneArmLB from the drop-down menu, and
select 192.168.11.35 IP for the virtual NIC.

Protocol HTTPS

Port 443

Default Pool vrops-svr-443

Connection Limit 0

Connection Rate Limit 0
 
You can now connect to the analytics cluster using the public Virtual Server IP address over
HTTPS at the https://vrops01svr01.rainpole.local address.
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10 Configure auto-redirect from HTTP to HTTPS requests.

The NSX Edge can redirect users from HTTP to HTTPS without entering another URL in the
browser. 

a On the Load Balancer tab of the sfo01m01lb01 device, select Application Profiles and click
Add.

b In the New Profile dialog box, configure the application profile settings and click OK.

Setting Value

Name vrops-http-redirect

Type HTTP

HTTP Redirect URL https://vrops01svr01.rainpole.local/vcops-web-ent/login.action

Persistence Source IP

Expires in (Seconds) 1800
 

c On the Load Balancer tab of the sfo01m01lb01 device, select Virtual Servers and click Add.

d Configure the settings of the virtual server for HTTP redirects and click OK.

Setting Value

Enable Virtual Server Selected

Application Profile vrops-http-redirect

Name vrops-svr-80-redirect

Description HTTP Redirect for vRealize Operations Manager

IP Address 192.168.11.35

Click Select IP Address, select OneArmLB from the drop-down menu, and
select 192.168.11.35 IP for the virtual NIC.

Protocol HTTP

Port 80

Default Pool None

Connection Limit 0

Connection Rate Limit 0
 
You can connect to the analytics cluster at the public Virtual Server IP address over HTTP at the
http://vrops01svr01.rainpole.local address.

11 Verify the pool configuration by examining the pool statistics that reflect the status of the components
behind the load balancer.

a Log out and then log in to the vSphere Web Client.

b From the Home menu, select Networking & Security.

c On the NSX Home page, click NSX Edges and select  172.16.11.65 from the NSX
Manager drop-down menu.

d On the NSX Edges page, double-click the sfo01m01lb01 NSX Edge.
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e On the Manage tab, click the Load Balancer tab.

f Select Pools and click Show Pool Statistics.

g In the Pool and Member Status dialog box, select the vrops-svr-443 pool.

h Verify that the load balancer pool is up.

Group Remote Collector Nodes in Region A
Join the remote collectors in a group for adapter resiliency in case the collector experiences network
interruption or becomes unavailable.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Management and click Collector Groups.

4 Click Add.

5 In the Add New Collector Group dialog box, configure the following settings, and click Save.

Setting Value

Name sfo01-remote-collectors

Description Remote collector group for sfo01

sfo01vropsc01a Selected

sfo01vropsc01b Selected
 
The sfo01-remote-collectors group appears on the Collector Groups page under the
Administration view of the user interface.

Add an Authentication Source for the Active Directory in Region
A
Connect vRealize Operations Manager to the Active Directory of the SDDC for central user management
and access control.
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Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Access and click Authentication Sources.

4 On the Authentication Sources page, click Add.

5 In the Add Source for User and Group Import dialog box, enter the settings for the rainpole.local
and sfo01.rainpole.local Active Directories, and click OK.

Active Directory Settings rainpole.local Value sfo01.rainpole.local Value

Source Display Name RAINPOLE.LOCAL SFO01.RAINPOLE.LOCAL

Source Type Active Directory Active Directory

Integration Mode Basic Basic

Domain/Subdomain RAINPOLE.LOCAL SFO01.RAINPOLE.LOCAL

Use SSL/TLS Deselected Deselected

User Name svc-vrops@rainpole.local svc-vrops@rainpole.local

Password svc-vrops_password svc-vrops_password

Settings under the Details section

Automatically synchronize user membership for
configured groups 

Selected Selected

Host dc01rpl.rainpole.local dc01sfo.sfo01.rainpole.local

Port 3268 389

Base DN dc=RAINPOLE,dc=LOCAL dc=SFO01,dc=RAINPOLE,dc=LOCAL

Common Name userPrincipalName userPrincipalName

6 Click the Test button to test the connection to the domain controller and in the Info dialog box
click OK.

7 In the Add Source for User and Group Import dialog box, click OK.

The users and user groups in the two Active Directories are added to vRealize Operations Manager.
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Configure User Access in vSphere for Integration with vRealize
Operations Manager in Region A
Configure operations service accounts with permissions that are required to enable vRealize Operations
Manager access to monitoring data on the vCenter Server instances in the region. 

You associate the svc-vrops-solution service accounts in the Active Directory with user roles that
have certain privileges and you assign the users to the vCenter Server instances in the inventory by using
global permissions.

Procedure

1 Define a User Role in vSphere for vCenter Adapters in vRealize Operations Manager in Region A

In vSphere, create a user role with privileges that are required to query information from vCenter
Server and receive metric data in vRealize Operations Manager. In vRealize Operations Manager,
you can also run actions or tasks on the objects it manages in vCenter Server. Add the privileges to
the role that are required for typical virtual machine lifecycle operations, such as snapshot
management and virtual machine resource configuration.

2 Define a User Role in vSphere for Storage Devices Adapters in vRealize Operations Manager in
Region A

In vSphere, create a user role with privileges that are required for collecting data about storage
devices in vRealize Operations Manager. 

3 Configure User Privileges in vSphere for Integration with vRealize Operations Manager in Region A

Assign global permissions to the operations service accounts to access monitoring data from
vCenter Server instances in vRealize Operations Manager.

Define a User Role in vSphere for vCenter Adapters in vRealize Operations
Manager in Region A
In vSphere, create a user role with privileges that are required to query information from vCenter Server
and receive metric data in vRealize Operations Manager. In vRealize Operations Manager, you can also
run actions or tasks on the objects it manages in vCenter Server. Add the privileges to the role that are
required for typical virtual machine lifecycle operations, such as snapshot management and virtual
machine resource configuration.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 On the Home page of the vSphere Web Client, under Administration click Roles .

3 Create a role for collecting data from and performing actions on vCenter Server.

a On the Roles page, click the Create role action icon.

b In the Create Role dialog box, configure the role using the following configuration settings, and
click OK.

Setting Value

Role name vSphere Actions User

Privilege n Virtual Machine.Configuration.Change CPU Count
n Virtual Machine.Configuration. Change Resource
n Virtual Machine.Configuration. Memory
n Virtual Machine.Interaction. Power Off
n Virtual Machine.Interaction. Power On
n Virtual Machine.Snapshot Management. Create Snapshot
n Virtual Machine.Snapshot Management. Remove Snapshot

 
This role inherits the System.Anonymous, System.View, and System.Read privileges. 

The Management vCenter Server in Region A propagates the role to the other linked vCenter
Server instances.

Define a User Role in vSphere for Storage Devices Adapters in vRealize
Operations Manager in Region A
In vSphere, create a user role with privileges that are required for collecting data about storage devices in
vRealize Operations Manager. 
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 On the Home page of the vSphere Web Client, under Administration click Roles.

3 Create a new role for collecting storage device data.

a On the Roles page, click the Create role action icon.

b In the Create Role dialog box, configure the role using the following configuration settings, and
click OK.

Setting Value

Role name MPSD Metrics User

Privilege n Host.CIM.CIM interaction
n Host.Configuration.Storage partition configuration
n Profile-driven storage.Profile-driven storage view
n Storage views.View

 
This role inherits the System.Anonymous, System.View, and System.Read privileges. 

The Management vCenter Server in Region A propagates the role to the other linked vCenter
Server instances.

Configure User Privileges in vSphere for Integration with vRealize Operations
Manager in Region A
Assign global permissions to the operations service accounts to access monitoring data from vCenter
Server instances in vRealize Operations Manager.

n The svc-vrops-vsphere user has the rights that are specifically required to collect data from and
perform actions on vCenter Server from vRealize Operations Manager.

n The svc-vrops-nsx user has read-only access on all objects in vCenter Server.

n The svc-vrops-mpsd and svc-vrops-vsan users have rights that are specifically required for access to
storage device and vSAN information, respectively, in vRealize Operations Manager on all objects in
vCenter Server.

You assign global permissions that are based on the following roles to these service accounts:
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Service Account Role

svc-vrops-vsphere@rainpole.local vSphere Actions User

svc-vrops-nsx@rainpole.local Read-only

svc-vrops-mpsd@rainpole.local MPSD Metrics User

svc-vrops-vsan@rainpole.local MPSD Metrics User

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Administration.

3 Click Global Permissions under Access Control.

4 On the Manage tab, click Add permission.

5 In the Global Permissions Root - Add Permission dialog box, click Add to associate the service
account with the role that contains the privileges for accessing data from the inventory.

6 Add the service account.

a In the Select Users/Groups dialog box, from the Domain drop-down menu, select
rainpole.local, in the filter box type svc-vrops, and press Enter.

b From the list of users and groups, select svc-vrops-vsphere, click Add, and click OK.

7 Associate the service account with the role.

a In the Global Permissions Root - Add Permission dialog box, from the Assigned Role drop-
down menu, select vSphere Actions User.

b Verify that Propogate to children is selected and click OK.

8 Repeat the steps to assign global permissions to the other service accounts.

Add vCenter Adapter Instances to vRealize Operations Manager in
Region A
After you deploy the analytics and the remote collector nodes of vRealize Operations Manager and start
vRealize Operations Manager, pair a vCenter Adapter instance with each vCenter Server instance in the
region.
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Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 From the solution table on the Solutions page, select the VMware vSphere solution, and click the
Configure icon at the top.

The Manage Solution - VMware vSphere dialog box appears.

5 Under Instance Settings, enter the settings for the connection to vCenter Server.

a If you already have added another vCenter Adapter, click the Add icon on the left side to add
adapter settings.

b Enter the following details.

Setting Value for Management vCenter Server Value for Compute vCenter Server

Display Name vCenter Adapter - sfo01m01vc01 vCenter Adapter - sfo01w01vc01

Description Management vCenter Server for sfo01 Compute vCenter Server for sfo01

vCenter Server sfo01m01vc01.sfo01.rainpole.local sfo01w01vc01.sfo01.rainpole.local

c Click the Add icon on the right side, configure the collection credentials for the connection to the
vCenter Server instance, and click OK. 

vCenter Server Credentials Attribute Value

Credential name vCenter Adapter Credentials - sfo01m01vc01

vCenter Adapter Credentials - sfo01w01vc01

User Name svc-vrops-vsphere@rainpole.local

Password svc-vrops-vsphere-password
 

d Leave Enable Actions set to Enable so that vCenter Adapter can run actions on objects in
vCenter Server from vRealize Operations Manager.

e Click Test Connection to validate the connection to the vCenter Server instance.

The vCenter Server certificate appears.

f In the Review and Accept Certificate dialog box, verify the certificate information, and
click Accept. 
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g Click OK in the Info dialog box.

h Expand the Advanced Settings section of settings.

i From the Collectors/Groups drop-down menu, select the sfo01-remote-collectors group.

j Specify a user account with administrator privileges to register vRealize Operations Manager with
the vCenter Server instance.

Setting Value

Registration user administrator@vsphere.local

Registration password vsphere_admin_password
 

6 Click Define Monitoring Goals.

7 In the Define Monitoring Goals page, under Enable vSphere Hardening Guide Alerts?, select
Yes, leave the default configuration for the other options, and click Save.

8 Click OK in the Success dialog box.

9 Click Save Settings.

10 In the Info dialog box, click OK. 

11 Repeat Step 5 to Step 10 for the Compute vCenter Server.

12 In the Manage Solution - VMware vSphere dialog box, click Close.

13 On the Solutions page, select VMware vSphere from the solution table to view the collection state
and collection status. 

The collection state indicates whether the adapter is collecting data. The collection status value
indicates whether vRealize Operations Manager is receiving data about a certain object type. An
adapter instance has a status value only if its collection state is Collecting.

The Collection State column for the vCenter Adapter displays Collecting, and the Collection Status
column displays Data receiving.

Connect vRealize Operations Manager to the NSX Manager
Instances in Region A
Install and configure the vRealize Operations Management Pack for NSX for vSphere to monitor the NSX
networking services deployed in the clusters in the region and view the vSphere hosts in the NSX
transport zones.

You can also access end-to-end logical network topologies between two virtual machines or NSX objects.
You can isolate problems in the logical or physical network by using the physical host - network device
relationship.
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Procedure

1 Install the vRealize Operations Manager Management Pack for NSX for vSphere in Region A

Install the .pak file for the management pack for NSX for vSphere to add the management pack as
a solution to vRealize Operations Manager.

2 Configure User Privileges in NSX Manager for Integration with vRealize Operations Manager in
Region A

Assign the permissions to the service account svc-vrops-nsx that are required to access monitoring
data from the NSX Manager instances in the region in vRealize Operations Manager.

3 Add NSX-vSphere Adapter Instances to vRealize Operations Manager in Region A

4 Add Network Devices Adapter to vRealize Operations Manager in Region A

Configure a Network Devices Adapter to monitor the switches and routers in your environment, and
view related alerts, metrics and object capacity.

Install the vRealize Operations Manager Management Pack for NSX for
vSphere in Region A
Install the .pak file for the management pack for NSX for vSphere to add the management pack as a
solution to vRealize Operations Manager.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, click the Add icon.

5 On the Select a Solution to Install page from the Add Solution wizard, browse to the .pak file of
the vRealize Operations Manager Management Pack for NSX for vSphere and click Upload.

After the NSX management pack file has been uploaded, you see details about the management
pack.

6 After the upload is complete, click Next.

7 On the End User License Agreement page, accept the license agreement and click Next.

The installation of the management pack starts. You see its progress on the Install Solution page. 

8 After the installation is complete, click Finish on the Install Solution page.
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The Management Pack for NSX-vSphere solution appears on the Solutions page of the vRealize
Operations Manager user interface.

Configure User Privileges in NSX Manager for Integration with vRealize
Operations Manager in Region A
Assign the permissions to the service account svc-vrops-nsx that are required to access monitoring data
from the NSX Manager instances in the region in vRealize Operations Manager.

Procedure

1 Log in to the NSX Manager by using a Secure Shell (SSH) client.

a Open an SSH connection to the NSX Manager virtual machine.

NSX Manager Host name

NSX Manager for the management cluster sfo01m01nsx01.sfo01.rainpole.local

NSX Manager for the shared compute and edge cluster sfo01w01nsx01.sfo01.rainpole.local

b Log in using the following credentials.

Setting Value

User name admin

Password nsx_manager_admin_password

2 Create the local service account svc-vrops-nsx on the NSX Manager instance.

a Run the following command to switch to Privileged mode of NSX Manager.

enable

b Enter the admin password when prompted and press Enter.

c Switch to Configuration mode.

configure terminal

d Create the service account svc-vrops-nsx.

user svc-vrops-nsx password plaintext svc-vrops-nsx_password

e Assign the svc-vrops-nsx user access to NSX Manager from the vSphere Web Client.

user svc-vrops-nsx privilege web-interface
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f Commit these updates to the NSX Manager.

write memory

g Exit Configuration mode.

exit

3 Assign the security_admin role to the svc-vrops-nsx service account.

a Log in to the Windows host that has access to your data center.

b Launch the Postman application and log in.

c Select POST from the drop-down menu that contains the HTTP request methods.

d In the URL text box next to the selected method, enter the following URL.

NSX Manager POST URL

NSX Manager for the management
cluster

https://sfo01m01nsx01.sfo01.rainpole.local/api/2.0/services/usermgmt/role/svc
-vrops-nsx?isCli=true

NSX Manager for the shared edge
and compute cluster

https://sfo01w01nsx01.sfo01.rainpole.local/api/2.0/services/usermgmt/role/svc
-vrops-nsx?isCli=true

 
e On the Authorization tab, configure the following authorization settings and click Update

Request.

Setting Value

Type Basic Auth

User name admin

Password nsx_admin_password

f On the Headers tab, enter the following header details.

Setting Value

Key Content-Type

Value text/xml

g In the Body tab, select raw and paste the following request body in the Body text box and click
Send.

<accessControlEntry>

  <role>security_admin</role>

  <resource>

    <resourceId>globalroot-0</resourceId>

  </resource>

</accessControlEntry>

The Status changes to 204 No Content.
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4 Repeat the procedure for the other NSX Manager instance.

Add NSX-vSphere Adapter Instances to vRealize Operations Manager in
Region A
After you install the management pack, configure an NSX-vSphere Adapter for each NSX Manager
instance in the region.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, select Management Pack for NSX-vSphere from the solution table, and
click Configure.

5 In the Manage Solution - Management Pack for NSX-vSphere dialog box, from the Adapter
Type table at the top, select NSX-vSphere Adapter.

6 Under Instance Settings, enter the settings for connection to the NSX Manager instance.

a If you already have added another NSX-vSphere Adapter, click the Add icon to add adapter
settings.

b Enter the display name, the FQDN of the NSX Manager, and the FQDN of the vCenter Server
instance that is connected to the NSX Manager.

Setting
Value for the NSX Manager for the
Management Cluster

Value for the NSX Manager for the Shared
Edge and Compute Cluster

Display Name NSX Adapter - sfo01m01nsx01 NSX Adapter - sfo01w01nsx01

Description Management NSX Manager for sfo01 Compute NSX Manager for sfo01

NSX Manager
Host

sfo01m01nsx01.sfo01.rainpole.local sfo01w01nsx01.sfo01.rainpole.local

VC Host sfo01m01vc01.sfo01.rainpole.local sfo01w01vc01.sfo01.rainpole.local

Enable Log Insight
integration if
configured

false false
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c Click the Add icon next to the Credential text box, configure the credentials for the connection to
NSX Manager and vCenter Server, and click OK.

vCenter Server Credentials Attribute Value

Credential name NSX Adapter Credentials - sfo01m01nsx01

NSX Adapter Credentials - sfo01w01nsx01

NSX Manager User Name svc-vrops-nsx

NSX Manager Password svc-vrops-nsx_password

vCenter User Name svc-vrops-nsx@rainpole.local

vCenter Password svc-vrops-nsx_password
 

d Click Test Connection to validate the connection to the NSX Manager instance.

The NSX Manager certificate appears.

e In the Review and Accept Certificate dialog box, verify the certificate information and click
Accept.

f Click OK in the Info dialog box.

g Expand the Advanced Settings section of settings.

h From the Collectors/Groups drop-down menu, select the sfo01-remote-collectors remote
collector group.

i Click Save Settings.

j Click OK in the Info dialog box that appears.

k Repeat the steps to create an NSX-vSphere Adapter for the other NSX Manager.

7 In the Manage Solution - Management Pack for NSX-vSphere dialog box, click Close.

The NSX-vSphere adapter appears on the Solutions page of the vRealize Operations Manager user
interface. The Collection State of the adapter is Collecting and the Collection Status is Data
receiving.

Add Network Devices Adapter to vRealize Operations Manager in Region A
Configure a Network Devices Adapter to monitor the switches and routers in your environment, and view
related alerts, metrics and object capacity.

The Network Devices Adapter collects data across all network devices that you want to monitor using
vRealize Operations Manager.

In a multi-region environment, you use a single adapter instance to access data for all regions.
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Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, select the Management Pack for NSX-vSphere from the solution table, and
click Configure.

5 In Manage Solution - Management Pack for NSX-vSphere dialog box, from the Adapter
Type table at the top, select Network Devices Adapter.

6 Under Instance Settings, enter the settings for SNMP connection to the network devices for the
management cluster.

a Enter the display name, SNMP version and credentials.

Setting Value

Display Name Network Devices Adapter

Description Global Network Devices Adapter

SNMP Ports 161

SNMP Version SNMPv2

SNMPv3 Privacy Protocol AES

SNMPv3 Authentication Protocol MD5
 

b Click the Add icon, and configure the credentials for connecting the Network Devices Adapter to
the network devices, and click OK. 

Credential Value

Credential Kind SNMPv1, SNMPv2 Credential

Credential Name Network Devices Credentials

SNMP Read Community Strings public
 
For SNMPv1 and SNMPv2 devices, enter a comma-separated list of community names (default is
public).

c Click Test Connection to verify the settings, and if the test is successful click the OK button.

d Expand the Advanced Settings section of settings, and verify that the Collectors/Groups option
is set to Default collector group.
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e Click Save Settings.

f Click OK in the Info dialog box that appears.

7 In the Manage Solution - Management Pack for NSX-vSphere dialog box, click Close.

The Network Devices Adapter appears on the Solutions page of the vRealize Operations Manager user
interface. The adapter is collecting data about the network devices in all regions of the SDDC.
The Collection State of the adapter is Collecting and the Collection Status is Data receiving.

Enable Storage Device Monitoring in vRealize Operations Manager
in Region A
Install and configure the vRealize Operations Management Pack for Storage Devices to view the storage
topology in the SDDC and to monitor the capacity and problems on storage components.

Procedure

1 Install the vRealize Operations Manager Management Pack for Storage Devices in Region A

Install the .pak file of the management pack for storage devices to add the management pack as a
solution to vRealize Operations Manager. 

2 Disable the vSAN Dashboards of the Management Pack for Storage Devices in Region A

Use the vRealize Operations Management Pack for Storage Devices to monitor fabric-based
storage such as the NFS datastores in this validated design. To monitor the vSAN datastores for the
management applications, disable the vSAN dashboards of management pack for Storage Devices
and use the dashboards of the vRealize Operations Management Pack for vSAN. The management
pack for vSAN comes pre-installed with vRealize Operations Manager.

3 Add Storage Devices Adapters in vRealize Operations Manager in Region A

Install the vRealize Operations Manager Management Pack for Storage
Devices in Region A
Install the .pak file of the management pack for storage devices to add the management pack as a
solution to vRealize Operations Manager. 

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.
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3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, click the Add icon.

5 On the Select a Solution to Install page from the Add Solution wizard, browse to the .pak file of
the vRealize Operations Manager Management Pack for Storage Devices and click Upload.

When the Storage Devices management pack file is uploaded, you see details about the
management pack.

6 After the upload is complete, click Next.

7 On the End User License Agreement page, accept the license agreement and click Next.

The installation of the management pack starts. You see its progress on the Install Solution page.

8 After the installation is complete, click Finish on the Install Solution page.

The Management Pack for Storage Devices solution appears on the Solutions page of the vRealize
Operations Manager user interface.

Disable the vSAN Dashboards of the Management Pack for Storage Devices
in Region A
Use the vRealize Operations Management Pack for Storage Devices to monitor fabric-based storage
such as the NFS datastores in this validated design. To monitor the vSAN datastores for the management
applications, disable the vSAN dashboards of management pack for Storage Devices and use the
dashboards of the vRealize Operations Management Pack for vSAN. The management pack for vSAN
comes pre-installed with vRealize Operations Manager.

Procedure

1 Log in to vRealize Operations Manager by using Secure Shell (SSH) client.

a Open an SSH connection to vrops01svr01a.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password
 

2 Disable the vSAN dashboards provided by the vRealize Operations Manager Management Pack for
Storage Devices by running the following commands.

cd /usr/lib/vmware-vcops/tools/opscli

$VMWARE_PYTHON_BIN ./ops-cli.py dashboard hide all 'VirtualSAN Heatmap'

$VMWARE_PYTHON_BIN ./ops-cli.py dashboard hide all 'VirtualSAN Entity Usage'

$VMWARE_PYTHON_BIN ./ops-cli.py dashboard hide all 'VirtualSAN Cluster Insights'

$VMWARE_PYTHON_BIN ./ops-cli.py dashboard hide all 'VirtualSAN Device Insights'

$VMWARE_PYTHON_BIN ./ops-cli.py dashboard hide all 'VirtualSAN Troubleshooting'
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3 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

4 On the main navigation bar, click Dashboards and verify that the following dashboards are no longer
visible.

n VirtualSAN Heatmap

n VirtualSAN Entity Usage

n VirtualSAN Cluster Insights

n VirtualSAN Device Insights

n VirtualSAN Troubleshooting

Add Storage Devices Adapters in vRealize Operations Manager in Region A
After you install the management pack, configure a Storage Devices adapter to collect monitoring data
about the storage devices in the SDDC. Each adapter communicates with a vCenter Server instance to
retrieve data about the storage devices from the vCenter Server inventory.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, select Management Pack for Storage Devices from the solution table and
click Configure.

The Manage Solution - Management Pack for Storage Devices dialog box appears.
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5 Under Instance Settings, enter the settings for the connection to the vCenter Server instance.

a If you already have added another Storage Devices adapter, click the Add icon on the left side to
add adapter settings.

b Enter the display name, description, and name of the vCenter Server instance.

Setting Value for the Management vCenter Server Value for the Compute vCenter Server

Display Name Storage Devices Adapter - sfo01m01vc01 Storage Devices Adapter - sfo01w01vc01

Description Storage Devices in Management vCenter for
sfo01

Storage Devices in Compute vCenter for sfo01

vCenter Server sfo01m01vc01.sfo01.rainpole.local sfo01w01vc01.sfo01.rainpole.local

SNMP
Community
Strings

- -

c Click the Add icon next to the Credential text box, and configure the collection credentials for the
connection to the vCenter Server instance, and click OK.

vCenter Server Credentials Attribute Value

Credential name Storage Devices Adapter Credentials - sfo01m01vc01

Storage Devices Adapter Credentials - sfo01w01vc01

User Name svc-vrops-mpsd@rainpole.local

Password svc-vrops-mpsd-password
 

d Click Test Connection to validate the connection to the vCenter Server.

The vCenter Server certificate appears.

e In the Review and Accept Certificate dialog box, verify the vCenter Server certificate
information, and click Accept.

f Click OK in the Info dialog box.

g Expand the Advanced Settings section of settings.

h From the Collectors/Groups drop-down menu, select the sfo01-remote-collectors remote
collector group.

i Click Save Settings.

j Click OK in the Info dialog box that appears.

k Repeat the procedure for the other vCenter Server instance.

6 In the Manage Solution - Management Pack for Storage Devices dialog box, click Close.

The Storage Devices adapter appears on the Solutions page of the vRealize Operations Manager user
interface. The Collection State column for the vCenter Adapter displays Collecting, and
the Collection Status column displays Data receiving.
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Enable vSAN Monitoring in vRealize Operations Manager in
Region A
Configure the vRealize Operations Management Pack for vSAN to view the vSAN topology, and to
monitor the capacity and problems.

The vRealize Operations Management Pack for vSAN is installed by default in the vRealize Operations
Manager version that is used in this version of VMware Validated Design.

Procedure

1 Turn on vSAN Performance Service in Region A

When you create a vSAN cluster, the performance service is disabled. Turn on the vSAN
performance service to monitor the performance of vSAN clusters, hosts, disks, and VMs.

2 Add a vSAN Adapter in vRealize Operations Manager in Region A

Configure the vSAN adapter to collect monitoring data about vSAN usage in the SDDC.

Turn on vSAN Performance Service in Region A
When you create a vSAN cluster, the performance service is disabled. Turn on the vSAN performance
service to monitor the performance of vSAN clusters, hosts, disks, and VMs.

When you turn on the performance service, vSAN places a Stats database object in the datastore to
collect statistical data. The Stats database is a namespace object in the vSAN datastore of the cluster.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, expand the sfo01-m01dc data center object.

3 Click the sfo01-m01-mgmt01 cluster object and click the Configure tab.

4 Under vSAN, select Health and Performance.

5 Next to the Performance Service settings, click Edit, configure the following settings, and click OK.

Setting Value

Turn ON vSAN performance service Selected

Storage policy vSAN Default Storage Policy
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6 If you have a vSAN datastore configured in the shared edge and compute cluster sfo01-w01-comp01,
repeat the procedure.

Add a vSAN Adapter in vRealize Operations Manager in Region A
Configure the vSAN adapter to collect monitoring data about vSAN usage in the SDDC.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, select VMware vSAN from the solution table, and click Configure.

The Manage Solution - VMware vSAN dialog box appears.

5 Under Instance Settings, enter the settings for the connection to the vCenter Server instance.

a If you already have added another vSAN adapter, click the Add icon on the left side to add
adapter settings.

b Enter the settings for the connection to the vCenter Server.

Setting Value for the Management vCenter Server

Display Name vSAN Adapter - sfo01m01vc01

Description Management vCenter Server vSAN Adapter for sfo01

vCenter Server sfo01m01vc01.sfo01.rainpole.local
 

c Click the Add icon next to the Credential text box, and configure the credentials for the
connection to vCenter Server, and click OK.

Setting Value for the Management vCenter

Credential name vSAN Adapter Credentials - sfo01m01vc01

vCenter User Name svc-vrops-vsan@rainpole.local

vCenter Password svc-vrops-vsan-password
 

d Click Test Connection to validate the connection to vCenter Server.

The vCenter Server certificate appears.
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e In the Review and Accept Certificate dialog box, verify the vCenter Server certificate
information, and click Accept.

f Click OK in the Info dialog box.

g Expand the Advanced Settings section of settings.

h From the Collectors/Groups drop-down menu, select the sfo01-remote-collectors collector
group.

i Make sure Auto Discovery is set to true.

j Click Save Settings.

k Click OK in the Info dialog box that appears.

6 If you have a vSAN datastore configured in the shared edge and compute cluster, repeat Step 5 for
the Compute vCenter Server.

7 In the Manage Solution - VMware vSAN dialog box, click Close.

The vSAN adapter appears on the Solutions page of the vRealize Operations Manager user interface.
The Collection State column for the vCenter Adapter displays Collecting, and the Collection
Status column displays Data receiving.

Configure Email Alerts for vRealize Operations Manager in Region
A
You configure email notifications in vRealize Operations Manager so that users and applications receive
the administrative alerts from vRealize Operations Manager about certain situations in the data center. 

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Management and click Outbound Settings.

4 On the Outbound Settings page, click the Add icon to create an outbound alert instance.
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5 In the Add/Edit Outbound Instance dialog box, configure the settings for the Standard Email Plug-
In.

Alert Instance Setting Value

Plugin Type Standard Email Plug-In

Instance Name SMTP Alert Mail Relay

Use Secure Connection Selected

SMTP Host FQDN of the SMTP server

SMTP Port Server port for SMTP requests

Secure Connection Type TLS

Sender Email Address Address that appears as the sender of the email

Sender Name Name that appears as the sender of the email
 

6 Click Test to verify the connection with the SMTP server and click OK.

7 Click Save.

vRealize Log Insight Implementation in Region A
Deploy vRealize Log Insight in a cluster configuration of three nodes. This configuration is set up with an
integrated load balancer and uses one master and two worker nodes.

Procedure

1 Deploy vRealize Log Insight in Region A

Start the deployment of vRealize Log Insight in Region A by deploying the master and worker nodes
and forming the vRealize Log Insight cluster.

2 Connect vRealize Log Insight to the vSphere Environment in Region A

Start collecting log information about the ESXi and vCenter Server instances in the SDDC. 

3 Connect vRealize Log Insight to vRealize Operations Manager in Region A

Connect vRealize Log Insight to vRealize Operations Manager so that you can use the Launch in
Context functionality between the two applications to troubleshoot management nodes and vRealize
Operations Manager by using dashboards and alerts in the vRealize Log Insight user interface.

4 Connect vRealize Log Insight to the NSX Instances in Region A

Install and configure the vRealize Log Insight Content Pack for NSX for vSphere for log visualization
and alerting of the NSX for vSphere real-time operation. You can use the NSX-vSphere dashboards
to monitor logs about installation and configuration, and about virtual networking services.

5 Configure Log Forwarding for vRealize Suite Lifecycle Manager in Region A

You configure the Log Insight аgent in the vRealize Suite Lifecycle Manager appliance to forward
logs to vRealize Log Insight.
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6 Collect Operating System Logs from the Management Virtual Appliances in vRealize Log Insight in
Region A

Install and configure the vRealize Log Insight Content Pack for Linux to visualize and analyze
operating system logs from the management virtual appliances.

7 Configure Log Retention and Archiving for vRealize Log Insight in Region A

Set retention notification threshold to one week and archive logs for 90 days according to the
VMware Validated Design Architecture and Design documentation.

Deploy vRealize Log Insight in Region A
Start the deployment of vRealize Log Insight in Region A by deploying the master and worker nodes and
forming the vRealize Log Insight cluster.

Procedure

1 Prerequisites for Deploying vRealize Log Insight in Region A

2 Deploy vRealize Log Insight Using vRealize Suite Lifecycle Manager in Region A

First create a local environment on vRealize Suite Lifecycle Manager, and use it to deploy vRealize
Log Insight.

3 Monitor the Deployment of vRealize Log Insight in vRealize Suite Lifecycle Manager in Region A

You can monitor the status of the vRealize Log Insight deployment in the vRealize Suite Lifecycle
Manager user interface.

4 Move vRealize Log Insight Cluster Nodes to a Virtual Machine Folder in Region A

Use the vSphere Web Client to move the vRealize Log Insight nodes to a virtual machine folder for
better organization and ease of management.

5 Configure a DRS Anti-Affinity Rule for vRealize Log Insight in Region A

To protect the vRealize Log Insight cluster from a host-level failure, configure vSphere DRS to run
the worker virtual appliances on different hosts in the cluster.

6 Configure NTP for vRealize Log Insight in Region A

After vRealize Log Insight cluster is successfully deployed, you will need to configure NTP setting
within the vRealize Log Insight UI

7 Enable Active Directory Support for vRealize Log Insight in Region A

To use service accounts in vRealize Log Insight that are maintained centrally and are inline with the
other solutions in the SDDC, enable Active Directory support.

8 Replace the Certificate of vRealize Log Insight in Region A

Update the certificate chain of vRealize Log Insight to use a trusted non-default certificate after
deployment or to replace a certificate that is soon to expire. In this way, connection to the vRealize
Log Insight user interface remains trusted.
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Prerequisites for Deploying vRealize Log Insight in Region A
Before you use vRealize Suite Lifecycle Manager to deploy vRealize Log Insight, verify that your
environment satisfies the requirements for this deployment.

IP Addresses and Host Names

Verify that static IP addresses and FQDNs for vRealize Log Insight are available in the region-specific
application virtual network.

For the application virtual network, allocate three static IP addresses for the vRealize Log Insight nodes
and one IP address for the integrated load balancer. Map host names to the IP addresses in DNS.

Note   Region A must be routable trough the vSphere management network.

Table 3‑4.  IP Addresses and Host Names for vRealize Log Insight in Region A

Role IP Address FQDN

Integrated load balancer VIP address 192.168.31.10 sfo01vrli01.sfo01.rainpole.local

Master node 192.168.31.11 sfo01vrli01a.sfo01.rainpole.local

Worker node 1 192.168.31.12 sfo01vrli01b.sfo01.rainpole.local

Worker node 2 192.168.31.13 sfo01vrli01c.sfo01.rainpole.local

Default gateway 192.168.31.1 -

DNS server n 172.16.11.5
n 172.16.11.4

-

Subnet mask 255.255.255.0 -

NTP servers n 172.16.11.251
n 172.16.11.252

n ntp.sfo01.rainpole.local

Deployment Prerequisites

Verify that your environment satisfies the following prerequisites for deploying vRealize Log Insight.

Deployment for Region A

VMware, Inc.  224



Prerequisite Value

Storage n Virtual disk provisioning.
n Thin

n Required storage per node
n Initial storage for node deployment: 510 GB

n Required storage for cluster archiving
n Initial storage for archiving: 400 GB

Software
Features

n Verify that the vCenter Server instances are operational.
n Verify that the vSphere cluster has DRS and HA enabled.
n Verify that the NSX Manager instances are operational.
n Verify that vRealize Operations Manager is operational.
n Verify that the application virtual network is available.
n Verify that the Postman application is installed.
n Verify the following NFS datastore requirements:

n Create an NFS share of 400 GB and export it as /VVD_vRLI_MgmtA_400GB.
n Verify that the NFS server supports NFS v3.
n Verify that the NFS partition allows read and write operations for guest accounts. 
n Verify that the mount does not require authentication.
n Verify that the NFS share is directly accessible to vRealize Log Insight.
n If using a Windows NFS server, allow unmapped user UNIX access (by UID/GID).

License Verify that you have obtained a vRealize Suite or vCloud Suite license with a quantity that fulfills the
requirements of this design.

Active Directory Verify that you have a parent and child Active Directory domain controllers configured with the role-specific
SDDC users and groups for the rainpole.local domain.

Certificate
Authority

Configure the Active Directory domain controller as a certificate authority for the environment. 

Email account Provide an email account to send vRealize Log Insight notifications.

Deploy vRealize Log Insight Using vRealize Suite Lifecycle Manager in
Region A
First create a local environment on vRealize Suite Lifecycle Manager, and use it to deploy vRealize Log
Insight.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 On the Home page, click Create Environment, to start a new deployment.
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3 On the Create Environment page, enter the following information, and click Next.

Setting Value

Data Center sfo01-m01dc

Environment Type Production

Environment Name SFO-Region-Env

Administrator Email deployment_admin_email

Default Password deployment_admin_password

Confirm Default Password deployment_admin_password

Customer Experience Improvement Program Selected

4 On the Product Details page, click the vRealize Log Insight tab.

5 Enter the following settings, and click Next.

Setting Value

New Install Selected

Version 4.6.0

Deployment Type Small

6 Read the EULA, select the I agree to the terms and conditions check box, and click Next.

7 On the License Details page, add or select the vRealize Suite license.

a From the drop-down menu provided through the My VMware product entitlement, select Select
vRealize Suite License, select the license, and click Next.

b Or select Add vRealize Suite License, provide the vRealize Suite or vCloud Suite License key,
and click Next.

8 Enter the following settings for Infrastructure, and click Next.  

Setting Value

Select vCenter Server sfo01m01vc01.sfo01.rainpole.local

Select Cluster sfo01-m01-mgmt01 (sfo01-m01dc)

Select Network Distributed port group that ends with Mgmt-RegionA01-VXLAN

Select Datastore sfo01-m01-vsan01

Select Disk Format Thin

9 Enter the following settings for Network, and click Next.

Setting Value

Default Gateway 192.168.31.1

Domain Name sfo01.rainpole.local

Domain Search Path sfo01.rainpole.local,rainpole.local

Deployment for Region A

VMware, Inc.  226



Setting Value

Domain Name Servers 172.16.11.5,172.16.11.4

Netmask 255.255.255.0

10 Use Generated Certificate, and click Next.

11 Enter the following settings for Product Properties.  

Option Value

Node Size Medium

Configure Cluster Virtual IPs Selected

FQDN sfo01vrli01.sfo01.rainpole.local

Virtual IP Address 192.168.31.10

12 Click Add+ and add two more vRealize Log Insight Worker Nodes

13 Enter the following settings for vrli-master.   

Option Value

VM Name sfo01vrli01a

Hostname sfo01vrli01a.sfo01.rainpole.local

IP Address 192.168.31.11

14 Enter the following settings for vrli-worker.   

Option Value

VM Name sfo01vrli01b

Hostname sfo01vrli01b.sfo01.rainpole.local

IP Address 192.168.31.12

15 Enter the following settings for vrli-worker-2.   

Option Value

VM Name sfo01vrli01c

Hostname sfo01vrli01c.sfo01.rainpole.local

IP Address 192.168.31.13

16 On the Products Details page, click Next.

17 On the Pre Check Details page, click RUN PRE CHECK. Wait for all Pre Validations successful
messages and click Next.

18 On the Request Summary page, review the configuration details.

19 (Optional) To back up the deployment configuration, click Download Configuration.

20 Click Submit to create the environment.
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Monitor the Deployment of vRealize Log Insight in vRealize Suite Lifecycle
Manager in Region A
You can monitor the status of the vRealize Log Insight deployment in the vRealize Suite Lifecycle
Manager user interface.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator pane, click Requests.

3 Validate that CREATE_ENVIRONMENT for Environment Name:SFO-Region-Env in the Request
Info column shows INPROGRESS state.

It can take a moment for the process to progress from SUBMITTED to INPROGRESS state.

4 Click the INPROGRESS state for Environment Name:SFO-Region-Env in the Request Info column.

5 On the Requests page, monitor the steps of the deployment graph, until the request moves to
COMPLETED state.

Move vRealize Log Insight Cluster Nodes to a Virtual Machine Folder in
Region A
Use the vSphere Web Client to move the vRealize Log Insight nodes to a virtual machine folder for better
organization and ease of management.

vRealize Suite Lifecycle Manager deploys three vRealize Log Insight nodes: one master node and two
worker nodes. Move them to a single VM folder to simplify management tasks.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 From the Home menu, select VMs and Templates.

3 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server and expand the sfo01-m01dc
data center.

4 Click the VMs tab.

5 Select the virtual machines sfo01vrli01a, sfo01vrli01b, and sfo01vrli01c.

6 Click the Actions menu and select Move to....

7 Under VM Folders, select sfo01-m01fd-vrli, and click OK.

Configure a DRS Anti-Affinity Rule for vRealize Log Insight in Region A
To protect the vRealize Log Insight cluster from a host-level failure, configure vSphere DRS to run the
worker virtual appliances on different hosts in the cluster.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server object, and under the sfo01-
m01dc data center object select the sfo01-m01-mgmt01 cluster.

3 On the Configure tab, select VM/Host Rules.

4 In the VM/Host Rules list, click Add above the rules list, add a new anti-affinity rule using the
following details, and click OK.

Rule Attribute Value

Name anti-affinity-rule-vrli

Enable rule Yes

Type Separate Virtual Machines

Members n sfo01vrli01a
n sfo01vrli01b
n sfo01vrli01c

 

Configure NTP for vRealize Log Insight in Region A
After vRealize Log Insight cluster is successfully deployed, you will need to configure NTP setting within
the vRealize Log Insight UI
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Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 In the vRealize Log Insight user interface, click the configuration drop-down menu icon  and
select Administration.

3 Under Configuration, click Time.

4 Input the following values

Settings Values

Sync Server Time With NTP server (recommended)

NTP Servers ntp.sfo01.rainpole.local

5 Click Test and wait for successful message.

6 Click SAVE.

Enable Active Directory Support for vRealize Log Insight in Region A
To use service accounts in vRealize Log Insight that are maintained centrally and are inline with the other
solutions in the SDDC, enable Active Directory support.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 In the vRealize Log Insight user interface, click the configuration drop-down menu icon and select
Administration.

3 On the Administration page, under Configuration, click Authentication.

4 On the Authentication Configuration page, select the Active Directory tab.
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5 Slide the toggle button to enable the support for Active Directory and configure the Active Directory
settings.

a Configure the Active Directory connection settings according to the details from your IT
administrator.

Setting Value

Enable Active Directory support Selected

Default Domain rainpole.local

Domain Controller(s) dc01rpl.rainpole.local

User Name svc-vrli

Password svc-vrli_password

Connection Type Standard

Require SSL Yes or No according to the instructions from the IT administrator
 

b Click Test Connection to verify the connection, and click Save.

Replace the Certificate of vRealize Log Insight in Region A
Update the certificate chain of vRealize Log Insight to use a trusted non-default certificate after
deployment or to replace a certificate that is soon to expire. In this way, connection to the vRealize Log
Insight user interface remains trusted.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 In the vRealize Log Insight user interface, click the configuration drop-down menu icon  and
select Administration.

3 Under Configuration, click SSL.

4 On the SSL Configuration page, next to New Certificate File (PEM format) click Choose File,
browse to the location of the PEM file on your computer, and click Save.

Certificate Generation Option Certificate File

Using the CertGenVVD tool vrli.sfo01.2.chain.pem

The certificate is uploaded to vRealize Log Insight. 
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5 Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local

A warning message that the connection is not trusted appears.

6 To review the certificate, click the padlock icon  in the address bar of the browser, and verify that
Subject Alternative Name contains the names of the vRealize Log Insight cluster nodes.

Connect vRealize Log Insight to the vSphere Environment in
Region A
Start collecting log information about the ESXi and vCenter Server instances in the SDDC. 

Procedure

1 Configure User Privileges in vSphere for Integration with vRealize Log Insight in Region A

Assign global permissions to the svc-vrli-vsphere service account to collect log information from
the vCenter Server instances and ESXi hosts with vRealize Log Insight. The svc-vrli-vsphere user
account is dedicated to collecting log information from vCenter Server and ESXi. 

2 Connect vRealize Log Insight to vSphere in Region A

After you configure the svc-vrli-vsphere Active Directory user with the vSphere privileges that are
necessary for retrieving log information from the vCenter Server instances and ESXi hosts, connect
vRealize Log Insight to vSphere in the vRealize Log Insight user interface.

3 Configure vCenter Server to Forward Log Events to vRealize Log Insight in Region A

Configure vCenter Server and Platform Services Controller appliances to forward system logs and
events to the vRealize Log Insight. You can then view and analyze all syslog information in the
vRealize Log Insight Web interface.

4 Update the Host Profiles with Syslog Settings in Region A

To have a consistent logging configuration across all ESXi hosts, update the host profile in each
cluster to accommodate the syslog settings for connection to vRealize Log Insight.

Configure User Privileges in vSphere for Integration with vRealize Log Insight
in Region A
Assign global permissions to the svc-vrli-vsphere service account to collect log information from the
vCenter Server instances and ESXi hosts with vRealize Log Insight. The svc-vrli-vsphere user account is
dedicated to collecting log information from vCenter Server and ESXi. 
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Administration and click Roles under Access Control.

3 Create a role for vRealize Log Insight. 

a From Roles provider drop-down menu, select sfo01m01vc01.sfo01.rainpole.local

b Select Read-only and click the Clone role action icon.

You clone the Read-only role because it includes the System.Anonymous, System.View,
and System.Read privileges. vRealize Log Insight requires those privileges for accessing log
information related to the vCenter Server instances.

c In the Clone Role Read-only dialog box, complete the configuration of the role and click OK. 

Setting Description

Role name vRealize Log Insight User

Privilege n Host.Configuration.Advanced settings
n Host.Configuration.Change settings
n Host.Configuration.Network configuration
n Host.Configuration.Security profile and firewall

 
These host privileges allow vRealize Log Insight to configure the syslog service on the ESXi
hosts.

Note   The vRealize Log Insight User role is propagated to other linked vCenter Server instances.

4 Assign global permissions to the svc-vrli-vsphere@rainpole.local service account.

a In the vSphere Web Client, select Administration from the Home menu and click Global
Permissions under Access Control.

b On the Manage tab, click Add Permission. 

c In the Global Permissions Root - Add Permission dialog box, click Add to associate a user or
a group with a role. 

d In the Select Users/Groups dialog box, from the Domain drop-down menu, select
rainpole.local, in the filter box type svc, and press Enter. 
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e From the list of users and groups, select the svc-vrli-vsphere user, click Add, and click OK.

f In the Add Permission dialog box, from the Assigned Role drop-down menu, select vRealize
Log Insight User, select Propagate to children, and click OK.

Note   The global permissions of the svc-vrli-vsphere@rainpole.local user propagate to all
vCenter Server instances.

Connect vRealize Log Insight to vSphere in Region A
After you configure the svc-vrli-vsphere Active Directory user with the vSphere privileges that are
necessary for retrieving log information from the vCenter Server instances and ESXi hosts, connect
vRealize Log Insight to vSphere in the vRealize Log Insight user interface.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 Click the configuration drop-down menu icon  and select Administration.

3 Under Integration, click vSphere.
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4 In the vCenter Servers pane, enter the connection settings for the vCenter Server instances in the
region.

a Enter the host name, user credentials, and collection options for the vCenter Server instances,
and click Test Connection.

vCenter Server Option Value

Hostname n sfo01m01vc01.sfo01.rainpole.local for Management vCenter Server
n sfo01w01vc01.sfo01.rainpole.local for Compute vCenter Server

Username svc-vrli-vsphere@rainpole.local

Password svc-vrli-vsphere_user_password

Collect vCenter Server events, tasks and
alarms

Selected

Configure ESXi hosts to send logs to Log
Insight

Selected

Target sfo01vrli01.sfo01.rainpole.local

b Click Advanced Options and examine the list of ESXi hosts that are connected to the vCenter
Server instance to verify that you connect to the correct vCenter Server.  

c In the Advanced Options configuration window, select Configure all ESXi hosts, select UDP
under Syslog protocol, and click OK.

5 Click Add vCenter Server to add a new settings form and repeat the steps to add the settings for the
second vCenter Server instance in Region A.

6 Click Save. 

A progress dialog box appears. 

7 Click OK in the confirmation dialog box that appears after vRealize Log Insight contacts the vCenter
Server instances.

You see the vSphere dashboards under the VMware - vSphere content pack dashboard category.

Configure vCenter Server to Forward Log Events to vRealize Log Insight in
Region A
Configure vCenter Server and Platform Services Controller appliances to forward system logs and events
to the vRealize Log Insight. You can then view and analyze all syslog information in the vRealize Log
Insight Web interface.

You configure the following vCenter Server and Platform Services Controller instances:

Appliance Type Appliance Management Interface URL

vCenter Server instances https://sfo01m01vc01.sfo01.rainpole.local:5480

https://sfo01w01vc01.sfo01.rainpole.local:5480
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Appliance Type Appliance Management Interface URL

Platform Services Controller instances https://sfo01m01psc01.sfo01.rainpole.local:5480

https://sfo01w01psc01.sfo01.rainpole.local:5480

Procedure

1 Redirect the log events from the vCenter Server Appliance to vRealize Log Insight.

a Open a Web browser and go to https://sfo01m01vc01.sfo01.rainpole.local:5480.

b Log in using the following credentials.

Setting Value

User name root

Password vc_root_password

c In the Navigator, click Syslog Configuration.

d On the Syslog Configuration page, click Edit, configure the following settings, and click OK.

Setting Value

Common Log Level *

Remote Syslog Host sfo01vrli01.sfo01.rainpole.local

Remote Syslog Port 514

Remote Syslog Protocol UDP

e Repeat the steps for the other appliances.

2 Verify that the appliances are forwarding their syslog traffic to vRealize Log Insight.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

c In the vRealize Log Insight user interface, click Dashboards and select VMware - vSphere
under Content Pack Dashboards.

d Verify that the vCenter Server nodes are presented on the All vSphere events by hostname
widget of the General Overview dashboard.

Update the Host Profiles with Syslog Settings in Region A
To have a consistent logging configuration across all ESXi hosts, update the host profile in each cluster to
accommodate the syslog settings for connection to vRealize Log Insight.
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Setting Value for the Management Cluster Value for the Shared Edge and Computer Cluster

vCenter
Server
URL

https://sfo01m01vc01.sfo01.rainpole.local/vsphere-
client/

https://sfo01w01vc01.sfo01.rainpole.local/vsphere-
client/

Host
Profiles

sfo01-m01hp-mgmt01 sfo01-w01hp-comp01

First ESXi
host

sfo01m01esx01.sfo01.rainpole.local sfo01w01esx01.sfo01.rainpole.local

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Update the host profile for the management cluster.

a From the Home menu, select Policies and Profiles.

b In the Navigator pane, clickHost Profiles.

c Right-click sfo01-m01hp-mgmt01 and select Copy Settings from Host.

d Select sfo01m01esx01.sfo01.rainpole.local and click OK.

3 Verify that the syslog host settings have been updated.

a On the Host Profiles page in the Navigator pane, click sfo01-m01hp-mgmt01.

b On the Configure tab, click Settings.

c In the Filter search box, enter Syslog.global.logHost.

d Select the Syslog.global.logHost entry from the results list and verify that value of the option is
udp://sfo01vrli01.sfo01.rainpole.local:514

4 Verify the compliance of the hosts in the management cluster.

a From the Home menu, select Hosts and Clusters.

b Click the sfo01-m01-mgmt01 cluster, click the Monitor tab, and click Profile Compliance.

c Click the Check Compliance Now button.

d Verify that all hosts are compliant with the attached profile.

5 Repeat the procedure with a host in the shared edge and compute cluster.
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Connect vRealize Log Insight to vRealize Operations Manager in
Region A
Connect vRealize Log Insight to vRealize Operations Manager so that you can use the Launch in Context
functionality between the two applications to troubleshoot management nodes and vRealize Operations
Manager by using dashboards and alerts in the vRealize Log Insight user interface.

Procedure

1 Configure User Privileges on vRealize Operations Manager for Integration with vRealize Log Insight
in Region A

Configure administrator privileges for the svc-vrli-vrops@rainpole.local service account for vRealize
Log Insight on vRealize Operations Manager. You must assign administrator privileges to the service
account for the Launch in Context integration between the two management components.

2 Enable the vRealize Log Insight Integration with vRealize Operations Manager in Region A

Connect vRealize Log Insight in the region with vRealize Operations Manager to launch vRealize
Log Insight from within vRealize Operations Manager and to send alerts to vRealize Operations
Manager.

3 Connect vRealize Operations Manager to vRealize Log Insight in Region A

4 Configure the Log Insight Agent on the Analytics Cluster to Forward Log Events to vRealize Log
Insight in Region A

After you connect vRealize Operations Manager to vRealize Log Insight for Launch in Context,
configure the Log Insight agent on vRealize Operations Manager Analytics Cluster to send audit logs
and system events to vRealize Log Insight. 

5 Configure the Log Insight Agent on the Remote Collectors to Forward Log Events to vRealize Log
Insight in Region A

After you configure the Log Insight agent on vRealize Operations Manager Analytics Cluster to send
audit logs and system events to vRealize Log Insight, configure the Remote Collectors to send audit
logs and system events to vRealize Log Insight.

Configure User Privileges on vRealize Operations Manager for Integration
with vRealize Log Insight in Region A
Configure administrator privileges for the svc-vrli-vrops@rainpole.local service account for vRealize Log
Insight on vRealize Operations Manager. You must assign administrator privileges to the service account
for the Launch in Context integration between the two management components.
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Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigator bar, click Administration.

3 On the left of vRealize Operations Manager, expand Access and click Access Control.

4 On the Access Control page, click the User Accounts tab and click the Import Users icon.

5 On the Import Users page, import the svc-vrli-vrops@rainpole.local service account.

a From the Import From drop-down menu, select RAINPOLE.LOCAL.

b Select the Basic option for the search query.

c In the Search String text box, enter svc-vrli-vrops and click Search.

The search results contain the svc-vrli-vrops user account.

d Select svc-vrli-vrops@rainpole.local and click Next.

6 On the Assign Groups and Permissions page, to assign the Administrator role to the svc-vrli-
vrops@rainpole.local service account, click the Objects tab, configure the following settings, and
click Finish.

Setting Value

Select Role Administrator

Assign this role to the user Selected

Allow access to all objects in the system Selected

7 When prompted with the warning about allowing access to all objects on the system, click Yes.

Enable the vRealize Log Insight Integration with vRealize Operations
Manager in Region A
Connect vRealize Log Insight in the region with vRealize Operations Manager to launch vRealize Log
Insight from within vRealize Operations Manager and to send alerts to vRealize Operations Manager.
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Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 In the vRealize Log Insight user interface, click the configuration drop-down menu icon  and
select Administration.

3 Under Integration, click vRealize Operations.

4 On the vRealize Operations Manager page, configure the integration settings for vRealize
Operations Manager.

Setting Value

Hostname vrops01svr01

Username svc-vrli-vrops@rainpole.local

Password svc-vrli-vrops_password

Enable alerts integration Selected

Enable launch in context Selected

Target sfo01vrli01.sfo01.rainpole.local

5 Click Test Connection to validate the connection and click Save.

A progress dialog box appears.

6 Click OK to close the dialog box.

Connect vRealize Operations Manager to vRealize Log Insight in Region A
Configure a vRealize Log Insight Adapter to integrate vRealize Log Insight with vRealize Operations
Manager in your environment. You can access unstructured log data about any object in your
environment by using Launch in Context in vRealize Operations Manager.
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Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 On the Solutions page, select VMware vRealize Log Insight, and click Configure.

The Manage Solution - VMware vRealize Log Insight dialog box appears.

5 Under Instance Settings, enter the settings for connection to vRealize Log Insight.

a Enter the display name, description, and the FQDN of the vRealize Log Insight instance.

Setting vRealize Log Insight in Region A

Display Name Log Insight Adapter - sfo01vrli01

Description vRealize Log Insight for sfo01

Log Insight server sfo01vrli01.sfo01.rainpole.local

b Click Test Connection to validate the connection to vRealize Log Insight.

6 Expand the Advanced Settings pane and select the collector group for the region from the
Collectors/Groups drop-down menu.

Setting Region A

Collectors/Groups sfo01-remote-collectors

7 Click Save Settings.

8 Click OK in the Info dialog box that appears.

9 In the Manage Solution - VMware vRealize Log Insight dialog box, click Close.

The vRealize Log Insight Adapter is available on the Solutions page of the vRealize Operations Manager
user interface. The Collection State of the adapter is Collecting and the Collection Status is Data
receiving.

Deployment for Region A

VMware, Inc.  241



Configure the Log Insight Agent on the Analytics Cluster to Forward Log
Events to vRealize Log Insight in Region A
After you connect vRealize Operations Manager to vRealize Log Insight for Launch in Context, configure
the Log Insight agent on vRealize Operations Manager Analytics Cluster to send audit logs and system
events to vRealize Log Insight. 

Procedure

1 Log in to vRealize Operations Manager master node by using the administration interface.

a Open a Web browser and go to https://vrops01svr01a.rainpole.local/admin.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 Expand Management, and click Log Forwarding.

4 Enter the following information, and click Apply Changes.

Setting Value

Output logs to external log server. Selected

Forwarded Logs Selected

Log Insight Servers sfo01vrli01.sfo01.rainpole.local

Host sfo01vrli01.sfo01.rainpole.local

Port 9000

Use SSL Deselected

Certificate Path [Blank]

Protocol cfapi

Configure the Log Insight Agent on the Remote Collectors to Forward Log
Events to vRealize Log Insight in Region A
After you configure the Log Insight agent on vRealize Operations Manager Analytics Cluster to send audit
logs and system events to vRealize Log Insight, configure the Remote Collectors to send audit logs and
system events to vRealize Log Insight.
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Procedure

1 Open an SSH connection to the vRealize Operations Manager nodes using the following settings.

Setting Value

Host name n sfo01vropsc01a.sfo01.rainpole.local
n sfo01vropsc01b.sfo01.rainpole.local

User name root

Password vrops_root_password

2 Configure the Log Insight agent in the Remote Collector nodes of vRealize Operations Manager.

a Edit the liagent.ini file on each vRealize Operations Manager Remote Collector node using a
text editor such as vi.

vi /var/lib/loginsight-agent/liagent.ini

b Locate the [server] section, remove the comment from the following parameters and input the
following values.

[server]

; Log Insight server hostname or ip address

; If omitted the default value is LOGINSIGHT

hostname=sfo01vrli01.sfo01.rainpole.local

; Set protocol to use:

; cfapi - Log Insight REST API

; syslog - Syslog protocol

; If omitted the default value is cfapi

;

proto=cfapi

; Log Insight server port to connect to. If omitted the default value is:

; for syslog: 512

; for cfapi without ssl: 9000

; for cfapi with ssl: 9543

port=9000

;ssl - enable/disable SSL. Applies to cfapi protocol only.

; Possible values are yes or no. If omitted the default value is no.

ssl=no

; Time in minutes to force reconnection to the server

; If omitted the default value is 30

;reconnect=30

c After the [server] section, add the following block on each vRealize Operations Manager
Remote Collector node.

[common|global]

tags={"vmw_vr_ops_appname":"vROps", "vmw_vr_ops_clustername":"vrops01svr01arainpolelocal", 

"vmw_vr_ops_clusterrole":"Remote Collector", 

"vmw_vr_ops_nodename":"<Your vROPS Node Name Here>", 

"vmw_vr_ops_hostname":"<Your vROPS Hostname Here>"}
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d Modify the following parameters specifically for each node.

Parameter Description Location in liagent.ini

vmw_vr_ops_nodename IP address or FQDN of the vRealize
Operations Manager node

Replace each <Your VROPS Node Name
Here> with the following names:
n sfo01vropsc01a
n sfo01vropsc01b

vmw_vr_ops_hostname Name of the vRealize Operations
Manager node that is set during node
initial configuration

Replace each <Your VROPS Hostname
Here> with the following names:
n sfo01vropsc01a.sfo01.rainpole.local
n sfo01vropsc01b.sfo01.rainpole.local

For example, on the first remote collector you change the [common|global] section to add a
context to the logs that are sent to the vRealize Log Insight cluster:

[common|global]

tags={"vmw_vr_ops_appname":"vROps", "vmw_vr_ops_clustername":"vrops01svr01arainpolelocal", 

"vmw_vr_ops_clusterrole":"Remote Collector", "vmw_vr_ops_nodename":"sfo01vropsc01a", 

"vmw_vr_ops_hostname":"sfo01vropsc01a.sfo01.rainpole.local"}
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e After the [common|global] section, add the following block on each vRealize Operations Manager
Remote Collector node.

[filelog|COLLECTOR]

event_marker = ^\d{4}-\d{2}-\d{2}[\s]\d{2}:\d{2}:\d{2}\,\d{3}

directory = /usr/lib/vmware-vcops/user/log

include = collector*.log*

tags = {"vmw_vr_ops_logtype":"COLLECTOR"}

exclude = collector-wrapper.log*;collector-gc*.log*

[filelog|COLLECTOR-GC]

include = collector-gc-*.log*

directory = /usr/lib/vmware-vcops/user/log

event_marker = ^\d{4}-\d{2}-\d{2}

tags = {"vmw_vr_ops_logtype":"COLLECTOR"}

 

[filelog|COLLECTOR_wrapper]

tags = {"vmw_vr_ops_logtype":"COLLECTOR"}

directory = /usr/lib/vmware-vcops/user/log

include = collector-wrapper.log*

event_marker = ^[DEBUG|ERROR|FATAL|INFO|TRACE|WARN|STATUS ]

[filelog|ADAPTERS]

include = *.log*

event_marker = ^\d{4}-\d{2}-\d{2}[\s]\d{2}:\d{2}:\d{2}\,\d{3}

tags = {"vmw_vr_ops_logtype":"ADAPTER"}

directory = /data/vcops/log/adapters/*

[filelog|SUITEAPI]

include = api.log*;http_api.log*;profiling_api.log*;api-gc.log*

event_marker = ^\d{4}-\d{2}-\d{2}

tags = {"vmw_vr_ops_logtype":"SUITEAPI"}

directory = /usr/lib/vmware-vcops/user/log

[filelog|SUITEAPI-api]

directory = /usr/lib/vmware-vcops/user/log/suite-api

tags = {"vmw_vr_ops_logtype":"SUITEAPI"}

event_marker = ^\d{2}-\w{3}-\d{4}[\s]\d{2}:\d{2}:\d{2}\.\d{3}

include = catalina*.log*;localhost*.log*

[filelog|ADMIN_UI-casa-catalina]

event_marker = ^\w{3}[\s]\d{1,}

directory = /usr/lib/vmware-vcops/user/log/casa

tags = {"vmw_vr_ops_logtype":"ADMIN_UI"}

include = catalina.out

[filelog|ADMIN_UI-casa]

directory = /usr/lib/vmware-vcops/user/log/casa

tags = {"vmw_vr_ops_logtype":"ADMIN_UI"}

include = *.log*

Deployment for Region A

VMware, Inc.  245



event_marker = ^\d{4}-\d{2}-\d{2}

exclude = catalina*;localhost*

[filelog|ADMIN_UI-casa-catalina-log-localhost-log]

include = catalina.*.log;localhost.*.log

exclude = localhost_access_log.*

tags = {"vmw_vr_ops_logtype":"ADMIN_UI"}

event_marker = ^\d{2}-\w{3}-\d{4}[\s]

directory = /usr/lib/vmware-vcops/user/log/casa

[filelog|ADMIN_UI-localhost_access]

directory = /usr/lib/vmware-vcops/user/log/casa

include = localhost_access_log.*

tags = {"vmw_vr_ops_logtype":"ADMIN_UI"}

[filelog|TOMCAT_WEBAPP]

tags = {"vmw_vr_ops_logtype":"TOMCAT_WEBAPP"}

include = localhost_access_log.*.txt

directory = /data/vcops/log/product-ui

[filelog|CALL_STACK]

event_marker = ^[^\s]

tags = {"vmw_vr_ops_logtype":"CALL_STACK"}

include = collector*.txt

directory = /usr/lib/vmware-vcops/user/log/callstack

[filelog|GEMFIRE]

event_marker = ^\d{4}-\d{2}-\d{2}

include = gemfire*.log*

tags = {"vmw_vr_ops_logtype":"GEMFIRE"}

directory = /usr/lib/vmware-vcops/user/log

[filelog|GEMFIRE-2]

tags = {"vmw_vr_ops_logtype":"GEMFIRE"}

directory = /usr/lib/vmware-vcops/user/log

include = gemfire-locator*.log;gemfire_vRealize*.log

event_marker = ^\[

exclude = *.marker;*.gfs;*wrapper.log*;gemfire-wrapper.log*

[filelog|OTHER-watchdog-log]

directory = /usr/lib/vmware-vcops/user/log/vcops-watchdog

tags = {"vmw_vr_ops_logtype":"OTHER"}

event_marker = ^\d{4}-\d{2}-\d{2}[\s]\d{2}:\d{2}:\d{2}\,\d{3}

include = vcops-watchdog*.log

[filelog|OTHER-misc]

directory = /usr/lib/vmware-vcops/user/log

event_marker = ^\d{4}-\d{2}-\d{2}[\s]\d{2}:\d{2}:\d{2}\,\d{3}

include = system-exit-*.log;zeroTimestampLogger-

*.log;vcopsConfigureRoles.log*;cassandradbupgrade.log;centralsqldbupgrade.log;dbupgrade.log;res

tartHttpd.log;activate_web_certificate.log;oom-handler-

cassandra.log;ip_version_configurator_*.log;upgradeVsutilitiesConfigs.py.log;hisdbupgrade.log;i
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nstaller-tools.log;his-lock-trace-*.log;actions-data-*.log;LRUCacheProfiler-*.log*;datapurging-

*.log.*;setVSUtilitiesPermissions.py.log;hafailover-*.log;deletedMetricKeys-*.log;placement-

*.log;bm-controller.log;cassandraquery-*.log;cassandradriver-*.log;shardingManager-*.log;fsdb-

accessor-*.log;actionScheduler-*.log;casa.audit*.log*;function-invocation-counter-

*.log;onlineCapacity-*.log;functioncalls-*.log;opsapi.audit*.log*;distributed*.log*

tags = {"vmw_vr_ops_logtype":"OTHER"}

[filelog|OTHER-misc-singlelines]

include = evn-checker.log*;delete_tomcat_logs.log;tomcat-enterprise-wrapper.log;meta-

gemfire*.log*;ui-gc.log.*

tags = {"vmw_vr_ops_logtype":"OTHER"}

directory = /usr/lib/vmware-vcops/user/log

[filelog|OTHER-TELEMETRY]

include = telemetry.log*

directory = /usr/lib/vmware-vcops/user/log

event_marker = ^\d{4}-\d{2}-\d{2}[\s]\d{2}:\d{2}:\d{2}

tags = {"vmw_vr_ops_logtype":"TELEMETRY"}

Note   Ensure that there are no extra carriage returns after a long line. Each [] section must have
lines in a value = value format, example tags = {"something"}. Make sure the [filelog|OTHER-
misc] section is include.

f Press Escape and enter :wq! to save the file.

3 Restart the Log Insight agent on node by running the following console command.

/etc/init.d/liagentd restart

4 Verify that the Log Insight agent is running.

/etc/init.d/liagentd status

5 Repeat the steps for the second remote collector node.

All VMware - vRops dashboards become available on the home page of vRealize Log Insight. You see
the Total number of vRops Clusters showing 1 and Total number of vRops nodes over time showing
the host names of the vRealize Operations Manager nodes.

Connect vRealize Log Insight to the NSX Instances in Region A
Install and configure the vRealize Log Insight Content Pack for NSX for vSphere for log visualization and
alerting of the NSX for vSphere real-time operation. You can use the NSX-vSphere dashboards to monitor
logs about installation and configuration, and about virtual networking services.
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Procedure

1 Install the vRealize Log Insight Content Pack for NSX for vSphere in Region A

Install the content pack for NSX for vSphere to add the dashboards for viewing log information in
vRealize Log Insight.

2 Configure NSX Manager to Forward Log Events to vRealize Log Insight in Region A

Configure the NSX Manager instances in the region to send audit logs and system events to
vRealize Log Insight. 

3 Configure NSX Controllers to Forward Events to vRealize Log Insight in Region A

Configure the NSX Controller instances to forward log information to vRealize Log Insight by using
the NSX REST API. To enable log forwarding, you can use a REST client, such as the Postman
application.

4 Configure NSX Edge Instances to Forward Log Events to vRealize Log Insight in Region A

Redirect log information from the edge services gateways, universal distributed logical router, and
load balancer to vRealize Log Insight.

Install the vRealize Log Insight Content Pack for NSX for vSphere in Region A
Install the content pack for NSX for vSphere to add the dashboards for viewing log information in vRealize
Log Insight.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 Click Marketplace, click the Refresh Content from Marketplace icon and wait for the refresh
content task to complete. You can track progress from the Request section.

3 In the Search text box, enter nsx-v and press Enter.

4 In the list of content packs, locate the NSX-v for vSphere Content Pack, click Download and wait
for the download to complete.

5 Click the Download tab and locate the NSX-v for vSphere Content Pack.

6 Click the menu icon on the top right of the NSX-v for vSphere Content Pack and select Install.
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7 In the NSX-v for vSphere Content Pack window, enter the following settings, and click Install.

Setting Value

Select Datacenter sfo01-m01dc

Select Environment SFO-Region-Env

Configure NSX Manager to Forward Log Events to vRealize Log Insight in
Region A
Configure the NSX Manager instances in the region to send audit logs and system events to vRealize Log
Insight. 

Procedure

1 Log in to the Management NSX Manager appliance user interface.

a Open a Web browser and go to following URL. 

NSX Manager URL

NSX Manager for the management cluster https://sfo01m01nsx01.sfo01.rainpole.local

NSX Manager for the shared compute and edge cluster https://sfo01w01nsx01.sfo01.rainpole.local

b Log in using the following credentials.

Setting Value

User name  admin

Password  nsx_manager_admin_password
 

2 On the main page of the appliance user interface, click Manage Appliance Settings.

3 Under Settings, click General, and in the Syslog Server pane, click Edit.

4 In the Syslog Server dialog box, configure vRealize Log Insight as a syslog server by specifying the
following settings and click OK.

Syslog Server Setting Value

Syslog Server sfo01vrli01.sfo01.rainpole.local

Port 514

Protocol UDP

5 Repeat the steps for the other NSX Manager.

Configure NSX Controllers to Forward Events to vRealize Log Insight in
Region A
Configure the NSX Controller instances to forward log information to vRealize Log Insight by using the
NSX REST API. To enable log forwarding, you can use a REST client, such as the Postman application.
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Procedure

1 Log in to the Windows host that has access to your data center.

2 Start the Postman application and log in.

3 Specify the headers for requests to the NSX Manager. 

a On the Authorization tab, configure the following authorization settings and click Update
Request.

Setting Value

Type Basic Auth

User name admin

Password nsx_admin_password

The Authorization:Basic XXX header appears in the Headers pane.

b On the Headers tab, enter the following header details.

Request Header Attribute Value

Content-Type application/xml

The Content-Type:application/xml header appears in the Headers pane.

4 Contact NSX Manager to retrieve the IDs of the associated NSX Controllers.

a Select GET from the drop-down menu that contains the HTTP request methods.

b In the URL text box next to the selected method, enter the following URL, and click Send.

NSX Manager URL

NSX Manager for the management cluster https://sfo01m01nsx01.sfo01.rainpole.local/api/2.0/vdn/controller

NSX Manager for the shared edge and compute
cluster

https://sfo01w01nsx01.sfo01.rainpole.local/api/2.0/vdn/controller

The Postman application sends a query to the NSX Manager about the installed NSX controllers.

c After the NSX Manager sends a response back, click  the Body  tab in the response pane.

The response body contains a root <controllers> XML element that groups the details about the
three controllers that form the controller cluster. 
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d Within the <controllers> element, locate the <controller> element for each controller and write
down the content of the <id> element.

Controller IDs have the controller-id format where id represents the sequence number of the
controller in the cluster, for example, controller-1 in the following image.
 

 
e Repeat the steps for the other NSX Manager.
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5 For each NSX Controller, send a request to configure vRealize Log Insight as a remote syslog server.

a In the request pane at the top, select POST from the drop-down menu that contains the HTTP
request methods, and in the URL text box, enter the following URL.

Replace controller-ID with the controller IDs you have written down.

NSX Manager
NSX Controller in the Controller
Cluster POST URL

NSX Manager for the management
cluster

NSX Controller 1 https://sfo01m01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-1/syslog

NSX Controller 2 https://sfo01m01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-2/syslog

NSX Controller 3 https://sfo01m01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-3/syslog

NSX Manager for the shared edge
and compute cluster

NSX Controller 1 https://sfo01w01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-1/syslog

NSX Controller 2 https://sfo01w01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-2/syslog

NSX Controller 3 https://sfo01w01nsx01.sfo01.rainpole
.local/api/2.0/vdn/controller/controll
er-3/syslog

b In the Request pane, click the Body tab, select Raw, and using the drop-down menu, select
XML (Application/XML).

c Paste the following request body in the Body text box and click Send.

<controllerSyslogServer>

   <syslogServer>192.168.31.10</syslogServer>

   <port>514</port>

   <protocol>UDP</protocol>

   <level>INFO</level>

</controllerSyslogServer> 

d Repeat the steps for the other NSX Controllers in the management cluster and in the shared
edge and compute cluster.
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6 Verify the syslog configuration on each NSX Controller. 

a In the Request pane, from the Method drop-down menu, select GET, in the URL text box, enter
the controller-specific syslog URL from Step 5, and click the SEND button.

b After the NSX Manager sends a response back, click the Body tab under Response. 

The response body contains a root <controllerSyslogServer> element, which represents the
settings for the remote syslog server on the NSX Controller.

c Verify that the value of the <syslogServer> element is 192.168.31.10.

d Repeat the steps for the other NSX Controllers to verify the syslog configuration.
 

 

Configure NSX Edge Instances to Forward Log Events to vRealize Log Insight
in Region A
Redirect log information from the edge services gateways, universal distributed logical router, and load
balancer to vRealize Log Insight.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.
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3 In the Navigator, click NSX Edges.

4 On the NSX Edges page, select the NSX Manager instance from the NSX Manager drop-down
menu.

NSX Manager Instance IP Address

NSX Manager for the management cluster 172.16.11.65

NSX Manager for the shared edge and compute cluster 172.16.11.66

The edge devices in the scope of the NSX Manager appear. 

5 Configure the log forwarding on each edge service gateway instance.

a Double-click the edge device to open its user interface.

Traffic Management NSX Edge Services Gateway Compute NSX Edge Services Gateway

North-South Routing sfo01m01esg01 sfo01w01esg01

North-South Routing sfo01m01esg02 sfo01w01esg02

East-West Routing sfo01m01udlr01 sfo01w01udlr01

East-West Routing - sfo01w01dlr01

Load Balancer sfo01m01lb01 -

PSC Load Balancer sfo01psc01 -

b On the NSX Edge device page, click the Manage tab, click Settings, and click Configuration.

c In the Details pane, click Change next to Syslog servers.

d In the Edit Syslog Servers Configuration dialog box, configure the following settings and click
OK.

Setting Value

Syslog Server 1 192.168.31.10

Protocol udp

e Click OK.

f Repeat the steps for the remaining NSX Edge devices for management and shared edge and
compute clusters.

The vRealize Log Insight user interface starts showing log data in the NSX-vSphere-Overview
dashboard available under the VMware - NSX-vSphere group of content pack dashboards.

Configure Log Forwarding for vRealize Suite Lifecycle Manager in
Region A
You configure the Log Insight аgent in the vRealize Suite Lifecycle Manager appliance to forward logs to
vRealize Log Insight.
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Procedure

1 Log in to vRealize Suite Lifecycle Manager appliance by using Secure Shell (SSH) client.

a Open an SSH connection to vrslcm01svr01a.rainpole.local.

b Log in using following credentials.

Setting Value

User name root

Password vrslcm_root_password

2 Edit the liagent.ini file on each vRealize Lifecycle Manager node using a text editor such as vi.

vi /var/lib/loginsight-agent/liagent.ini

3 Locate the [server] section, remove the comment for the following parameters and insert the
following values.

[server]

; Log Insight server hostname or ip address

; If omitted the default value is LOGINSIGHT

hostname=sfo01vrli01.sfo01.rainpole.local

; Set protocol to use:

; cfapi - Log Insight REST API

; syslog - Syslog protocol

; If omitted the default value is cfapi

;

proto=cfapi

; Log Insight server port to connect to. If omitted the default value is:

; for syslog: 512

; for cfapi without ssl: 9000

; for cfapi with ssl: 9543

port=9000

;ssl - enable/disable SSL. Applies to cfapi protocol only.

; Possible values are yes or no. If omitted the default value is no.

ssl=no

; Time in minutes to force reconnection to the server

; If omitted the default value is 30

;reconnect=30

4 Press Escape and enter :wq! to save the file.

5 Restart the Log Insight agent on the node by running the following console command.

/etc/init.d/liagentd restart

6 Verify that the Log Insight agent is running.

/etc/init.d/liagentd status
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Collect Operating System Logs from the Management Virtual
Appliances in vRealize Log Insight in Region A
Install and configure the vRealize Log Insight Content Pack for Linux to visualize and analyze operating
system logs from the management virtual appliances.

Procedure

1 Install the vRealize Log Insight Content Pack for Linux in Region A

Install the content pack for Linux to add dashboards for viewing log information in vRealize Log
Insight from the operating system of the management virtual appliances in the region.

2 Configure a Log Insight Agent Group for the Management Virtual Appliances in Region A

After you install the content pack for Linux, configure an agent group to apply common settings to
the agents on the appliances in the region.

Install the vRealize Log Insight Content Pack for Linux in Region A
Install the content pack for Linux to add dashboards for viewing log information in vRealize Log Insight
from the operating system of the management virtual appliances in the region.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 Click Marketplace.

Note   If you have not accessed the Marketplace in some time, click the Refresh Content from
Marketplace icon.

3 In the Search text box, enter linux and press Enter.

4 In the list of content packs, locate the Linux Content Pack, click Download, and wait for the
download to complete.

5 Click the Download tab and locate the Linux Content Pack.

6 Click the menu icon on the top right of the Linux Content Pack and select Install.
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7 In the Linux Content Pack window, enter the following settings, and click Install.

Setting Value

Select Datacenter sfo01-m01dc

Select Environment SFO-Region-Env

Configure a Log Insight Agent Group for the Management Virtual Appliances
in Region A
After you install the content pack for Linux, configure an agent group to apply common settings to the
agents on the appliances in the region.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 Click the configuration drop-down menu icon  and select Administration.

3 Under Management, click Agents.

4 From the drop-down at the top, select Linux from the Available Templates section.

5 Click Copy Template. 

6 In the Copy Agent Group dialog box, enter VA - Linux Agent Group in the Name text box and
click Copy. 

7 In the agent filter fields, use the following selections.

Press Enter to separate the host name values.

Filter Operator Values

Hostname matches n vrslcm01svr01a.rainpole.local
n vrops01svr01a.rainpole.local
n vrops01svr01b.rainpole.local
n vrops01svr01c.rainpole.local
n sfo01vropsc01a.sfo01.rainpole.local
n sfo01vropsc01b.sfo01.rainpole.local

8 Click Refresh and verify that all the agents listed in the filter appear in the Agents list.

9 Click Save New Group at the bottom of the page.
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10 Verify that log data is showing up on the Linux dashboards.

a On the main navigation bar, click Dashboards.

b Expand Linux and click Security - Overview.

You see events that have occurred over the past 48 hours.

Configure Log Retention and Archiving for vRealize Log Insight in
Region A
Set retention notification threshold to one week and archive logs for 90 days according to the VMware
Validated Design Architecture and Design documentation.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 In the vRealize Log Insight user interface, click the configuration drop-down menu icon  and
select Administration.

3 Configure notification about reaching a retention threshold of one week.

Log Insight continuously estimates how long data can be retained with the currently available pool of
storage.

If the estimation drops below the retention threshold of one week, Log Insight immediately notifies the
administrator that the amount of searchable log data is likely to drop.

a Under Configuration, click General.

b On the General Configuration page, under the Alerts section, enter the following values.

Setting Value

Email System Notifications To support-team@rainpole.local

Send HTTP Post System Notifications To https://sfo01vrli01.sfo01.rainpole.local

c Select the Send a notificationwhen capacity drops below check box next to Retention
Notification Threshold, and enter a 1-week period in the text box.

d Click Save.
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4 Configure data archiving.

a Under Configuration, click Archiving.

b Toggle Enable Data Archiving on. 

c In the Archive Location text box, enter the path in the form
of nfs://nfs-server-address/VVD_vRLI_MgmtA_400GB to an NFS partition where logs are to
be archived. 

d Click Test next to the Archive Location text box to verify that the share is accessible.

e Click Save.
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Region A Cloud Management
Implementation 4
The Cloud Management Platform (CMP) consists of integrated products that support the management of
public, private, and hybrid cloud environments. The CMP consists of vRealize Automation, an embedded
vRealize Orchestrator, and vRealize Business for Cloud.

 vRealize Automation incorporates virtual machine provisioning and a self-service portal. vRealize
Business enables billing and chargeback functions. vRealize Orchestrator provides a workflow
optimization.

This chapter includes the following topics:
n Prerequisites for Cloud Management Implementation in Region A

n Configure Service Account Privileges in Region A

n vRealize Automation and vRealize Business Deployment in Region A

n vRealize Automation Default Tenant Configuration in Region A

n vRealize Automation Tenant Creation in Region A

n Embedded vRealize Orchestrator Configuration in Region A

n Register the vRealize Business Data Collector with the Server in Region A

n Connect vRealize Business for Cloud with the Compute vCenter Server in Region A

n Cloud Management Platform Post-Installation Tasks in Region A

n Content Library Configuration in Region A

n Tenant Content Creation in Region A

n Operations Management Configuration for Cloud Management in Region A

Prerequisites for Cloud Management Implementation in
Region A
Verify that the following configurations are established before starting the Cloud Management Platform
procedures.

DNS Entries and IP Address Mappings in Region A
Verify that your DNS and IP environment fulfills the requirements for this SDDC deployment. 
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IP Addresses and Host Names
Table 4‑1.  IP Addresses and FQDNs for the vRealize Automation Instance in Region A

Role IP Address FQDN

vRealize Automation Server Appliances 192.168.11.51 vra01svr01a.rainpole.local

192.168.11.52 vra01svr01b.rainpole.local

192.168.11.50 vra01svr01c.rainpole.local

vRealize Automation Server VIP 192.168.11.53 vra01svr01.rainpole.local

vRealize Automation IWS 192.168.11.54 vra01iws01a.rainpole.local

192.168.11.55 vra01iws01b.rainpole.local

vRealize Automation IWS VIP 192.168.11.56 vra01iws01.rainpole.local

vRealize Automation IMS 192.168.11.57 vra01ims01a.rainpole.local

192.168.11.58 vra01ims01b.rainpole.local

vRealize Automation IMS VIP 192.168.11.59 vra01ims01.rainpole.local

vRealize DEM Workers 192.168.11.60 vra01dem01a.rainpole.local

192.168.11.61 vra01dem01b.rainpole.local

MS SQL Server for vRealize Automation 192.168.11.62 vra01mssql01.rainpole.local

vRealize Business for Cloud Server Appliance 192.168.11.66 vrb01svr01.rainpole.local

Default Gateway 192.168.11.1

DNS server 172.16.11.4

172.16.11.5

Subnet mask 255.255.255.0

NTP 172.16.11.251 ntp.sfo01.rainpole.local

172.16.11.252

172.17.11.251 ntp.lax01.rainpole.local

172.17.11.252

Table 4‑2.  IP Addresses and FQDNs for the Supporting Infrastructure

Role IP Address FQDN

vRealize Automation Proxy Agent 192.168.31.52 sfo01ias01a.sfo01.rainpole.local

192.168.31.53 sfo01ias01b.sfo01.rainpole.local

vRealize Business for Cloud Data
Collector

192.168.31.54 sfo01vrbc01.sfo01.rainpole.local

Default gateway 192.168.31.1

DNS server 172.16.11.5

172.16.11.4

Subnet mask 255.255.255.0
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Table 4‑2.  IP Addresses and FQDNs for the Supporting Infrastructure (Continued)

Role IP Address FQDN

NTP n 172.16.11.251
n 172.16.11.252

ntp.sfo01.rainpole.local

n 172.17.11.251
n 172.17.11.252

ntp.lax01.rainpole.local

Deployment Prerequisites
Verify that your environment fulfills the following prerequisites for the deployment of vRealize Suite
Lifecycle Manager.

Prerequisite Value

Storage n Virtual disk provisioning.
n Required storage per node.

Operating System Windows 2012 R2 Standard

Database Microsoft SQL Server 2012 Standard Edition

License Verify that you have obtained a vRealize Suite or vCloud Suite license with a quantity that satisfies the
requirements of this design.

Active Directory Verify that you have a parent Active Directory instance with the following SDDC users and groups
configured for the rainpole.local domain.

ug-vra-admins-rainpole (Group)

ug-vra-archs-rainpole (Group)

ug-vROadmins (Group)

vra-admin-rainpole (User)

vra-arch-rainpole (User)

svc-domain-join (User)

svc-vra-vrops (User)

svc-vrops-vra (User)

svc-vra (User)

svc-vro (User)

Certification Authority Configure the root Active Directory domain controller as a certificate authority for the environment. 

SQL Server Configuration for the Cloud Management Platform in
Region A
The Cloud Management Platform uses a Microsoft SQL Server database to store data for vRealize
Automation IaaS components.
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Microsoft SQL Server Recommendations in Region A
vRealize Automation and other VMware components use Microsoft SQL Server as a database to store
information. The specific configuration of SQL Server for use in your environment is not addressed in this
implementation guide. High-level guidance is provided to ensure more reliable operation of your VMware
components.

n Microsoft SQL Server must be configured with separate Operating System Level volumes (drive
letters) for each of the following items. The separation of these items into separate logical volumes
(drive letters) helps prevent database corruption if a single volume reaches capacity.

n Operating System

n Database Application

n SQL User Database Data Files

n SQL User Database Log Files

n SQL TempDB

n SQL Backup Files

n To provide optimal performance for VMware vRealize databases, configure the SQL Server virtual
machine (vra01mssql01.rainpole.local) with 8 vCPU and 16 GB vRAM.

n Configure the primary DNS of the SQL Server virtual machine (vra01mssql01.rainpole.local) to point
to 172.16.11.4 (primary DNS of Region A) and the secondary DNS to point to 172.17.11.4 (primary
DNS of Region B).

Assign the SQL Server System Role to vRealize Automation in Region A
Assign the SQL Server system role sysadmin to the vRealize Automation service account.

vRealize Automation uses the SQL Server system role privilege to create and run scripts on the SQL
Server database. By default, only users who are members of the sysadmin system role, or
the db_owner and db_ddladmin database roles, can create objects in the database. 

Procedure

1 Log in to the SQL Server virtual machine by using a Remote Desktop Protocol (RDP) client.

a Open an RDP connection to the vra01mssql01.rainpole.local virtual machine.

b Log in using the following credentials.

Settings Value

User name Windows administrator user

Password windows_administrator_password
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2 From the Start menu, click All Programs, click Microsoft SQL Server, and click SQL Server
Management Studio.

Note   If SQL Server Management Studio does not appear in your All Programs menu, you might not
have successfully installed SQL Server Management Studio. Verify that you have successfully
installed SQL Server Management Studio, and then continue with this procedure.

3 In the Connect to Server dialog box, leave the default value of the Server Name text box, select
Windows Authentication from the Authentication drop-down menu, and click Connect.

Note   During the SQL Server installation, the Database Engine configuration wizard prompts you to
provide the user name and password for the SQL Server administrator. If this user was not added
during the SQL Server installation, select SQL Authentication from the Authentication drop-down
menu, and enter the user name sa in the User name text box, and the password sa_password in the
Password text box.

4 In the Object Explorer pane, expand the VRA01MSSQL01 server instance .

5 Right-click the Security folder, click New, and click Login.

6 In the Login Properties dialog box, click the General page and enter rainpole\svc-vra in
the Login name text box.

7 Click the Server Roles page, select the sysadmin check box, and click OK.

Configure Network Access for Distributed Transaction Coordinator in Region
A
You configure network access and security between vRealize Automation and your Microsoft SQL Server
database using Microsoft Distributed Transaction Coordinator (MSDTC). MSDTC coordinates
transactions that update two or more transaction-protected resources, such as databases, message
queues, file systems. These transaction-protected resources may be on a single computer, or distributed
across many networked computers.

Procedure

1 Log in to the SQL Server virtual machine by using a Remote Desktop Protocol (RDP) client.

a Open an RDP connection to the vra01mssql01.rainpole.local virtual machine.

b Log in using the following credentials.

Settings Value

User name Windows administrator user

Password windows_administrator_password

2 From the Start menu, click Run, type comexp.msc in the Open text box, and click OK.

The Component Services manager displays. Component Services lets you manage Component
Object Model (COM+) applications.
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3 Using the navigation tree in the left-side pane, expand Component Services > Computers > My
Computer > Distributed Transaction Coordinator > Local DTC.

4 Right-click Local DTC and click Properties.

The Local DTC Properties dialog box displays.

5 Click the Security tab in the Local DTC Properties dialog box.

6 In the Security tab, configure the following values, and click OK.

Setting Value

Network DTC Access Selected

Allow Remote Clients Selected

Allow Remote Administration Deselected

Allow Inbound Selected

Allow Outbound Selected

Mutual Authentication Required Selected

Enable XA Transactions Deselected

Enable SNA LU 6.2 Transactions Selected

Account Leave the default setting (NT AUTHORITY\NetworkService)

Password Leave blank

7 Click Yes to restart the MSDTC Service, click OK to confirm that the service has successfully
restarted, and close the Component Services manager.

Allow MS SQL Server and MSDTC Access Through Windows Firewall for
vRealize Automation in Region A
You can configure the Windows Firewall to allow or block specific traffic. For vRealize Automation to
function correctly, ensure that network access to Microsoft Distributed Transaction Coordinator
(MSDTC) and SQL Server is configured to allow access.

Procedure

1 Log in to the SQL Server virtual machine by using a Remote Desktop Protocol (RDP) client.

a Open an RDP connection to the vra01mssql01.rainpole.local virtual machine.

b Log in using the following credentials.

Settings Value

User name Windows administrator user

Password windows_administrator_password

2 From the Start menu, click Run, type WF.msc in the Open text box, and click OK.

The Windows Firewall with Advanced Security dialog box appears. You use Windows Firewall with
Advanced Security to configure firewall properties for each network profile.
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3 Allow Access for Microsoft SQL Server on TCP Port 1433.

a In the navigation pane, under Windows Firewall with Advanced Security, select and right-click
Inbound Rules, and click New Rule in the action pane.

The New Inbound Rule Wizard appears.

b On the Rule Type page of the New Inbound Rule Wizard, select the Port radio button, and
click Next.

c On the Protocol and Ports page, select TCP and enter the port number 1433 in the Specific
local ports text box, and click Next.

d On the Action page, select Allow the connection, and click Next.

e On the Profile page, select the Domain,Private, and Public profiles, and click Next.

f On the Name page, enter a Name and a Description for this rule, and click Finish.

4 Allow access for Microsoft Distributed Transaction Coordinator.

a In the navigation pane, under Windows Firewall with Advanced Security, select and right-
click Inbound Rules, and click New Rule in the action pane.

b On the Rule Type page click Predefined, click Distributed Transaction Coordinator, and
click Next.

c On the Predefined Rules page, select all rules for Distributed Transaction Coordinator (RPC-
EPMAP), Distributed Transaction Coordinator (RPC), Distributed Transaction Coordinator
(TCP-In), and click Next.

d On the Action page, select Allow the connection, and click Finish.

5 Exit the Windows Firewall with Advanced Security wizard.

6 Right click Powershell, select Run as Administrator, and run the following commands. These
commands adjust the User Account Controls, disable IPv6, and restart the server to activate these
changes.

Command

set-ItemProperty -Path "HKLM:\Software\Microsoft\Windows\CurrentVersion\Policies\System" -Name

"EnableLUA" -Value "0"

set-ItemProperty -Path "HKLM:\System\CurrentControlSet\Services\TCPIP6\Parameters" -Name

"DisabledComponents" -Value 0xff

Restart-Computer

Prerequisites for IaaS Servers in Region A
All Windows servers that host IaaS components must meet certain prerequisites. Before you deploy the
Cloud Management Applications, you must ensure the IaaS Windows Servers, IaaS Web Server, and
IaaS Manager Service Host meet the requirements.
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IaaS Windows Servers
n Install Microsoft .NET Framework 4.5.2 or later.

n IaaS servers use TLS for authentication, which is enabled by default on some Windows servers.
Some sites disable TLS for security reasons, but you must leave at least one TLS protocol enabled.
This version of vRealize Automation supports TLS 1.2.

n SHA-512 for TLS 1.2 is disabled in Windows by default. Verify that you have installed the Windows
update in Microsoft KB 2973337 if you use SHA-512 certificates for vRealize Automation.

n Enable the Distributed Transaction Coordinator (DTC) service. IaaS uses DTC for database
transactions and actions such as a workflow creation. For more information on DTC enablement, see 
VMware KB 2038943 .

n Verify that the Secondary Log On service is running. You can stop the service after the deployment
is complete.

n Ports on the IaaS Windows servers must be configured before the deployment of vRealize
Automation.

Table 4‑3.  Incoming Ports for IaaS Windows Servers

Por
t

Protoc
ol Component Comments

443 TCP Manager Service Communication with IaaS components and vRealize Automation appliance over
HTTPS

443 TCP vRealize Automation
appliance

Communication with IaaS components and vRealize Automation appliance over
HTTPS

443 TCP Infrastructure Endpoint
Hosts

Communication with IaaS components and vRealize Automation appliance over
HTTPS. Typically, 443 is the default communication port for virtual and cloud
infrastructure endpoint hosts, but refer to the documentation provided by your
infrastructure hosts for a full list of default and required ports.

443 TCP Guest agent Software
bootstrap agent

Communication with Manager Service over HTTPS

443 TCP DEM Worker Communication with NSX Manager

Table 4‑4.  Outgoing Ports for IaaS Windows Servers

Port
Protoc
ol Component Comments

53 TCP,
UDP

All DNS

67, 68,
546, 547

TCP,
UDP

All DHCP

123 TCP,
UDP

All NTP

443 TCP Manager Service Communication with vRealize Automation appliance over HTTPS
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Table 4‑4.  Outgoing Ports for IaaS Windows Servers (Continued)

Port
Protoc
ol Component Comments

443 TCP Distributed Execution
Managers

Communication with Manager Service over HTTPS

443 TCP Proxy agents Communication with Manager Service and infrastructure endpoint hosts
over HTTPS

443 TCP Management Agent Communication with the vRealize Automation appliance over HTTPS

443 TCP Guest agent Software
bootstrap agent

Communication with Manager Service over HTTPS

1433 TCP Manager Service Website MSSQL

5480 TCP All Communication with the vRealize Automation appliance.

As you enable DTC between all servers, DTC requires port 135 over TCP and a random port between
1024 and 65535. The Prerequisite Checker validates that DTC is running and the required ports are
open.

IaaS Web Server
A Windows server that hosts the Web component must meet additional requirements.

n Configure Java.

n Install 64-bit Java 1.8 update 161 or later.

n Set the JAVA_HOME environment variable to the Java installation folder.

n Verify that %JAVA_HOME%\bin\java.exe is available.

n IIS 8.5 for Windows 2012 R2 must be installed.

n In addition to the configuration settings, avoid hosting additional websites in IIS. vRealize Automation
sets the binding on its communication port to all unassigned IP addresses, making no additional
bindings possible. The default vRealize Automation communication port is 443.

n Configure Internet Information Services (IIS) according to the following table.
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Table 4‑5.  IaaS Windows Server Internet Information Services

IIS Component Setting

Web Server (IIS) roles n Common HTTP Features > Default Document
n Common HTTP Features > Static Content
n Security > Windows Authentication
n Application Development > ASPNET 3.5 and ASPNET 4.5
n Application Development > ISAPI Extensions
n Application Development > ISAPI Filter

Windows Process Activation Service
Feature

n Process Model
n .Net Environment
n Configuration APIs
n Go to Features > .Net Framework 3.5 Features > HTTP Activation and Non-HTTP

Activation

IIS Authentication settings (Default
Web Site)

Set the following non-defaults.
n Windows Authentication enabled
n Anonymous Authentication disabled

Do not change the following defaults.
n Negotiate Provider enabled
n NTLM Provider enabled
n Windows Authentication Kernel Mode enabled
n Windows Authentication Extended Protection disabled
n For certificates using SHA512, TLS1.2 must be disabled on Windows 2012 variants

IaaS Manager Service Host
A Windows server that hosts the Manager Service component must meet additional requirements.

Note   The requirements apply, whether the Manager Service host is a primary or backup.

n No firewalls can exist between a Manager Service host and a DEM host. For port information, see the
preceding Incoming and Outgoing port tables.

n The Manager Service host must be able to resolve the NETBIOS name of the SQL Server database
host. If it cannot resolve the NETBIOS name, add the SQL Server NETBIOS name to the Manager
Service machine /etc/hosts file.

n Configure Internet Information Services (IIS) as per the Table 4‑5 table.

IaaS Distributed Execution Manager Host
A Windows server that hosts the Distributed Execution Manager (DEM) Orchestrator or Worker
component must meet additional requirements.

n No firewalls can exist between a DEM host and a Manager Service host. For port information, see 
Table 4‑3 and Table 4‑4.
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Configure Service Account Privileges in Region A
To provision virtual machines and logical networks, configure privileges for vRealize Automation on both
the vCenter Server and the NSX instance in the Compute cluster. If you add more vCenter Server
instances in the future, perform this procedure on those instances as well.

Configure Service Account Privileges on the Compute vCenter
Server in Region A
Configure an administrator privilege for the svc-vra and svc-vro users on the Compute vCenter Server.

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator pane, select Global Inventory Lists > vCenter Servers.

3 Right-click the sfo01w01vc01.sfo01.rainpole.local instance and select Add Permission.

4 In the Add Permission dialog box, click the Add button.

The Select Users/Groups dialog box appears.

5 Select rainpole.local from the Domain drop-down menu, and enter svc in the Show Users First text
box to filter user and group names.

6 Select svc-vra and svc-vro from the User/Group list, click the Add button, and click OK. 

7 In the Add Permission dialog box, select Administrator from the Assigned Role drop-down menu,
and click OK.

The svc-vra and svc-vro users now have Administrator privilege on the vCenter Server. 

Configure Service Account Privileges on the Compute Cluster NSX
Instance in Region A
Configure an enterprise privilege in NSX Manager for the svc-vra@rainpole.local service account.
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Networking & Security.

3 In the Navigator pane, select Users and Domains.

4 Under the Users tab, select the Compute NSX Manager 172.16.11.66 from the drop-down menu.

5 Click the Add icon.

The Assign Role wizard appears.

6 On the Identify User page, select the Specify a vCenter User radio button,
enter svc-vra@rainpole.local in the User text box, and click Next.

7 On the Select Roles page, select the Enterprise Administrator radio button, and click Finish.

vRealize Automation and vRealize Business Deployment
in Region A
A vRealize Automation installation includes installing and configuring single sign-on (SSO) capabilities,
the user interface portal, and Infrastructure as a Service (IaaS) components. vRealize Business is an IT
financial management tool that provides clarity and control over the costs and quality of IT services,
enabling alignment with the business and acceleration of IT transformation.

Load Balancing the Cloud Management Platform in Region A
You configure load balancing for all services and components related to vRealize Automation and
vRealize Orchestrator by using an NSX Edge load balancer. 

You must configure the load balancer before you deploy the vRealize Automation appliance. This
requirement is necessary because you need the virtual IP (VIP) addresses to deploy the vRealize
Automation appliance.

Add Virtual IP Addresses to the NSX Load Balancer in Region A
As the first step of configuring load balancing, you add virtual IP Addresses to the edge interfaces.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Click Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01m01lb01 NSX Edge to edit its network settings.

5 Click the Manage tab, click Settings, and select Interfaces.

6 Select the OneArmLB interface and click the Edit icon.

7 In the Edit NSX Edge Interface dialog box, add the VIP addresses of the vRealize Automation nodes
in the Secondary IP Addresses text box.

Setting Value

Secondary IP Address 192.168.11.53,192.168.11.56,192.168.11.59
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8 Click OK to save the configuration.

Create Application Profiles in Region A
To define the behavior of a particular type of network traffic, you create an application profile. After
configuring a profile, you associate the profile with a virtual server. The virtual server then processes
traffic according to the values specified in the profile. Using profiles enhances your control over managing
network traffic, and makes traffic-management tasks easier and more efficient.

You repeat this procedure twice to create two application profiles.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01m01lb01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Application Profiles.

6 Click the Add icon and in the New Profile dialog box, enter the following values.

Setting Value

Name vra-https-persist

Type HTTPS

Enable SSL Passthrough Selected

Persistence Source IP

Expires in (Seconds) 1800

7 Click OK to save the configuration.

8 Repeat the same steps to create the following application profile.

Setting Value

Name vra-https

Type HTTPS

Enable SSL Passthrough Selected

Persistence None

Create Service Monitoring in Region A
The service monitor defines health check parameters for the load balancer. You create a service monitor
for each component.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.

3 In the Navigator, click NSX Edges.

4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01m01lb01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Service Monitoring.

6 Click the Add icon and in the New Service Monitor dialog box, configure the values for the service
monitor you are adding, and click OK.

Setting vra-svr-443-monitor vra-iws-443-monitor vra-ims-443-monitor vra-vro-8283-monitor

Name vra-svr-443-monitor vra-iws-443-monitor vra-ims-443-monitor vra-vro-8283-monitor

Interval 3 3 3 3

Timeout 10 10 10 10

Max Retries 3 3 3 3

Type HTTPS HTTPS HTTPS HTTPS

Expected 204

Method GET GET GET GET

URL /vcac/services/api/health /wapi/api/status/web /VMPSProvision /vco-controlcenter/docs

Receive REGISTERED ProvisionService
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7 Repeat Step 6 to create a service monitor for each component.

Upon completion, verify that you have successfully entered the monitor names and their respective
configuration values.

Create Server Pools in Region A
A server pool consists of back-end server members. After you create a server pool, you associate a
service monitor with the pool to manage and share the back-end servers flexibly and efficiently.

The following considerations explain the design of the server pools configuration.

n The configuration uses NONE as a health monitor for all server pools. Until vRealize Automation is fully
installed and started, the health monitor marks pool members as offline. Health monitors indicate the
status of pool members correctly only after vRealize Automaton is fully installed and initialized.
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n The configuration disables the non-primary pool members of four vRealize Automation server pools
(vra-svr-443, vra-iws-443, vra-ims-443, vra-vro-8283). During the installation or power cycle of
vRealize Automation, the service inside the non-primary nodes might not be installed or initialized yet.
In this period, if the load balancer passes a request to the non-primary nodes, the request fails. If the
non-primary pool members are not disabled, you can experience random failures during a vRealize
Automation installation, and service initialization or registration failure during a vRealize Automation
power cycle.

Perform the procedure multiple times to configure five different server pools.

Table 4‑6.  Server Pools for the Cloud Management Platform

Pool Name Algorithm Monitors Member Name IP Address
Enable
Member Port Monitor Port

vra-svr-443 ROUND-
ROBIN

None vra01svr01a 192.168.11.51 Yes 443

vra01svr01b 192.168.11.52 No 443

vra01svr01c 192.168.11.50 No 443

vra-iws-443 ROUND-
ROBIN

None vra01iws01a 192.168.11.54 Yes 443

vra01iws01b 192.168.11.55 No 443

vra-ims-443 ROUND-
ROBIN

None vra01ims01a 192.168.11.57 Yes 443

vra01ims01b 192.168.11.58 No 443

vra-svr-8444 ROUND-
ROBIN

None vra01svr01a 192.168.11.51 Yes 8444 443

vra01svr01b 192.168.11.52 Yes 8444 443

vra01svr01c 192.168.11.50 Yes 8444 443

vra-vro-8283 ROUND-
ROBIN

None vra01svr01a 192.168.11.51 Yes 8283

vra01svr01b 192.168.11.52 No 8283

vra01svr01c 192.168.11.50 No 8283

Note   Pool vra-svr-8444 has all members enabled.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.

3 In the Navigator, click NSX Edges.
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4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01m01lb01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Pools.

6 Click the Add icon, and in the New Pool dialog box, enter the following values.

Setting Value

Name vra-svr-443

Algorithm ROUND-ROBIN

Monitors None

7 In the New Members dialog box, click the Add icon to add the first pool member.

8 In the New Member dialog box, enter the following values, and click OK.

Setting Value

Name vra01svr01a

IP Address/VC Container 192.168.11.51

State Enable

Port 443

Monitor Port

Weight 1

9 Repeat the previous two steps to create the other members of the pool.

10 Repeat the entire procedure to create the remaining server pools.

Create Virtual Servers in Region A
Create virtual servers for all the configured server pools. When a virtual server receives a request, it
selects the appropriate pool to send traffic to. Each pool consists of one or more members.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu of the vSphere Web Client, select Networking & Security.

3 In the Navigator, click NSX Edges.
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4 From the NSX Manager drop-down menu, select 172.16.11.65 as the NSX Manager and double-click
the sfo01m01lb01 NSX Edge to manage its network settings.

5 Click the Manage tab, click Load Balancer, and select Virtual Servers.

6 Click the Add icon, and in the New Virtual Server dialog box configure the values for the virtual
server you are adding, and click OK. 

Setting vra-svr-443 vra-iws-443 vra-ims-443 vra-svr-8444 vra-vro-8283

Enable Virtual
server

Selected Selected Selected Selected Selected

Application
Profile

vra-https-persist vra-https-persist vra-https vra-https-persist vra-https-persist

Name vra-svr-443 vra-iws-443 vra-ims-443 vra-svr-8444 vra-vro-8283

Description vRealize
Automation
Appliance UI

vRealize
Automation IaaS
Web UI

vRealize
Automation IaaS
Manager

vRealize
Automation
Remote Console
Proxy

vRealize
Orchestrator
Control Center

IP Address 192.168.11.53 192.168.11.56 192.168.11.59 192.168.11.53 192.168.11.53

Protocol HTTPS HTTPS HTTPS HTTPS HTTPS

Port 443 443 443 8444 8283

Default Pool vra-svr-443 vra-iws-443 vra-ims-443 vra-svr-8444 vra-vro-8283

7 Repeat Step 6 to create a virtual server for each component. When finished, verify that you have
successfully entered the virtual server names and their respective configuration values. 

Deploy Windows Virtual Machines for vRealize Automation in
Region A
vRealize Automation requires several Windows virtual machines to act as IaaS components in a
distributed configuration.

Create vSphere Image Customization Specifications in Region A
Create vSphere image customization specifications to configure the operating systems of your vRealize
Automation IaaS Servers and Proxy Agent deployments.

Customization specifications are XML files that hold guest operating system settings that are applied to
virtual machines during their deployment. When you apply an image customization specification, you
save effort and prevent errors and conflicts.

Create a Customization Specification File for IaaS Servers in Region A

Create a vSphere Image Customization template to use with your vRealize Automation IaaS Web,
Management, and DEM Worker Servers deployment.

The vSphere Image Customization template Sysprep answer file stores several customization settings
such as computer name, licensing information, and domain settings.
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Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home page, under Policies and Profiles, click Customization Specification Manager.

3 Select sfo01m01vc01.sfo01.rainpole.local from the vCenter Server drop-down menu.

4 Click the Create a new specification icon.

The Guest Customization wizard opens.

5 On the Specify Properties page, configure the following values, and click Next.

Setting Value

Target VM Operating System Windows

Use custom SysPrep answer file Deselected

Customization Spec Name vra7-template

6 On the Set Registration Information page, configure the following values, and click Next.

Setting Value

Name Rainpole

Organization Rainpole IT

7 On the Set Computer Name page, select the Enter a name in the Clone/Deploy wizard radio
button, and click Next.

8 On the Enter Windows License page, configure the following values, and click Next.

If you are using Microsoft License Server, or have multiple single license keys, leave the Product
Key text box blank.

Setting Value

Product Key volume_license_key

Include Server License Information Selected

Server License Mode Per seat
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9 On the Set Administrator Password page, configure the following values, and click Next.

Setting Value

Password local_administrator_pwd

Automatically logon as Administrator Selected

Number of times to logon automatically 1

10 On the Time Zone page, select (GMT) Coordinated Universal Time from the Time Zone drop-down
menu, and click Next.

11 On the Run Once page, type the following commands in the text box and click Add after each one.
These commands will add a necessary service account into the local administrators group, adjusts
the User Account Controls, and disables IPv6. Click Next.

Command

net localgroup administrators rainpole\svc-vra /add

powershell set-ItemProperty -Path "HKLM:\Software\Microsoft\Windows\CurrentVersion\Policies\System"

-Name "EnableLUA" -Value "0"

powershell set-ItemProperty -Path "HKLM:\System\CurrentControlSet\Services\TCPIP6\Parameters" -Name

"DisabledComponents" -Value 0xff

powershell Restart-Computer

12 On the Configure Network page, select the Manually select custom settings radio button, select
NIC1 from the list of network interfaces in the virtual machine, and click Edit.

The Edit Network dialog box opens.

13 In the Edit Network dialog box, on the IPv4 page, configure the following values and click DNS.

Setting Value

Prompt the user for an address when the specification is used Selected

Subnet Mask 255.255.255.0

Default Gateway 192.168.11.1

14 On the DNS page, provide DNS servers and search suffixes.

a Specify the following DNS server settings.

Setting Value

Use the following DNS server address Selected

Preferred DNS Server 172.16.11.4

Alternate DNS Server 172.17.11.4

b Enter rainpole.local in the For all connections with TCP/IP enabled text box and click the
Add button.
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c Enter sfo01.rainpole.local in the For all connections with TCP/IP enabled text box and
click the Add button.

d Enter lax01.rainpole.local in the For all connections with TCP/IP enabled text box and
click the Add button.

e Click OK to save settings and close the Edit Network dialog box, and click Next. 

15 On the Set Workgroup or Domain page, select the Windows Server Domain radio button, enter
credentials that have privileges to join the domain, and click Next.

Setting Value

Windows Server Domain rainpole.local

Username svc-domain-join@rainpole.local

Password svc-domain-join_password

16 On the Set Operating System Options page, select the Generate New Security ID (SID) check
box, and click Next. 

17 On the Ready to complete page, review the configuration settings that you entered, and click Finish.

The customization specification you created is listed in the Customization Specification Manager and
can be used to customize virtual machine guest operating systems.

Create a Customization Specification File for IaaS Proxy Agent Server in Region A

Create a vSphere Image Customization template to use with your vRealize Automation IaaS Proxy Agent
deployment.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home page, under Policies and Profiles click Customization Specification Manager.

3 Select sfo01m01vc01.sfo01.rainpole.local from the vCenter Server drop-down menu.

4 Click the Create a new specification icon.

The New VMGuest CustomizationSpec wizard opens.
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5 On the Specify Properties page, enter the following settings, and click Next.

Setting Value

Target VM Operating System Windows

Use custom SysPrep answer file Deselected

Customization Spec Name vra7-proxy-agent-template

6 On the Set Registration Information page, enter the following settings, and click Next.

Setting Value

Name Rainpole

Organization Rainpole IT

7 On the Set Computer Name page, select the Enter a name in the Clone/Deploy wizard radio
button, and click Next.

8 On the Enter Windows License page, enter the following settings, and click Next.

If you are using Microsoft License Server, or have multiple single license keys, leave the Product
Key text box blank. 

Setting Value

Product Key volume_license_key

Include Server License Information Selected

Server License Mode Per seat

9 On the Set Administrator Password page, enter the following settings, and click Next.

Setting Value

Password local_administrator_pwd

Automatically logon as Administrator Selected

Number of times to logon automatically 1

10 On the Time Zone page, select (GMT) Coordinated Universal Time from the Time Zone drop-down
menu, and click Next.

11 On the Run Once page, type in the following commands in the text box and click Add after each one.
Click Next.

Commands

net localgroup administrators rainpole\svc-vra /add

powershell set-ItemProperty -Path "HKLM:\Software\Microsoft\Windows\CurrentVersion\Policies\System"

-Name "EnableLUA" -Value "0"
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Commands

powershell set-ItemProperty -Path "HKLM:\System\CurrentControlSet\Services\TCPIP6\Parameters" -Name

"DisabledComponents" -Value 0xff

powershell Restart-Computer

These commands add a service account into the local administrators group, adjust the User Access
Controls, and disable IPv6.

12 On the Configure Network page, select the Manually select custom settings radio button,
select NIC1 from the list of network interfaces in the virtual machine, and click Edit.

The Network Properties dialog box displays.

13 In the Edit Network dialog box, on the IPv4 page, specify the following settings and click DNS.

Setting Value

Prompt the user for an address when the specification is used Selected

Subnet Mask 255.255.255.0

Default Gateway 192.168.31.1

14 On the DNS page, provide DNS servers and search suffixes. 

a Specify the following DNS server settings. 

Setting Value

Use the following DNS server address Selected

Preferred DNS Server 172.16.11.5

Alternate DNS Server 172.16.11.4

b Enter sfo01.rainpole.local in the For all connections with TCP/IP enabled text box and
click the Add button.

c Enter rainpole.local in the For all connections with TCP/IP enabled text box and click
the Add button.

d Enter lax01.rainpole.local in the For all connections with TCP/IP enabled text box and
click the Add button.

e Click OK to save settings, close the Edit Network dialog box, and click Next. 

15 On the Set Workgroup or Domain page, select the Windows Server Domain radio button, enter
credentials that have privileges to join the domain, and click Next.

Setting Value

Windows Server Domain sfo01.rainpole.local

Username svc-domain-join@rainpole.local

Password svc-domain-join_password
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16 On the Set Operating System options page, select the Generate New Security ID (SID) check box,
and click Next.

17 On the Ready to Complete page, review the settings that you entered, and click Finish.

The customization specification you created is listed in the Customization Specification Manager
and can be used to customize virtual machine guest operating systems.

Deploy Windows Virtual Machines for vRealize Automation in Region A
vRealize Automation requires multiple Windows virtual machines to act as IaaS components in a
distributed configuration.

The IaaS redundant components provide high availability for the vRealize Automation infrastructure
features.

Repeat this procedure to create the following VMs.

Virtual
Machine
Name

NetBIOS
name

vCenter
Folder IP Address vCPU Memory

Image
Customization
Specification
Template Network

vra01iws01a vra01iws01a sfo01-
m01fd-vra

192.168.11.54 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

vra01iws01b vra01iws01b sfo01-
m01fd-vra

192.168.11.55 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

vra01ims01a vra01ims01a sfo01-
m01fd-vra

192.168.11.57 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

vra01ims01b vra01ims01b sfo01-
m01fd-vra

192.168.11.58 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

vra01dem01a vra01dem01a sfo01-
m01fd-vra

192.168.11.60 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

vra01dem01b vra01dem01b sfo01-
m01fd-vra

192.168.11.61 2 8 GB vra7-template vxw-dvs-xxxx-
Mgmt-xRegion01-
VXLAN

sfo01ias01a sfo01ias01a sfo01-
m01fd-
vraias

192.168.31.52 2 8 GB vra7-proxy-agent-
template

vxw-dvs-xxxx-
Mgmt-
RegionA01-
VXLAN

sfo01ias01b sfo01ias01b sfo01-
m01fd-
vraias

192.168.31.53 2 8 GB vra7-proxy-agent-
template

vxw-dvs-xxxx-
Mgmt-
RegionA01-
VXLAN
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Prerequisites

To facilitate cloning, this design uses the customization specification templates and the
windows-2012r2-64 VM template. Verify that the windows-2012r2-64 template was created with the latest
version of VM Tools installed and is updated with the latest Windows updates.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Hosts and Clusters and click the sfo01m01vc01.sfo01.rainpole.local
instance.

3 Click the VMs tab, click VM Templates in Folders, right-click the windows-2012r2-64 IaaS Windows
template, and select New VM from This Template.

The Deploy From Template wizard opens.

4 On the Select a name and folder page, specify a name and location for the VM, and click Next.

Setting Value

Enter a name for the virtual machine vra01iws01a

Select a location for the virtual
machine

sfo01m01vc01.sfo01.rainpole.local>sfo01-m01dc>sfo01-m01fd-vra

 
5 On the Select a compute resource page, select the sfo01-m01-mgmt01 cluster, and click Next.

6 On the Select storage page, select the datastore on which to create the VM disks.

a From the VM Storage Policy drop-down menu, select vSAN Default Storage Policy.

b Select the sfo01-m01-vsan01 vSAN datastore from the datastore table, and click Next.

7 On the Select clone options page, select the Customize the operating system check box, and
click Next.

8 On the Customize guest OS page, select the vra7-template from the table, and click Next.
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9 On the User Settings page, enter the following values, and click Next.

Setting Value

NetBIOS name vra01iws01a

IPv4 address 192.168.11.54

IPv4 subnet mask 255.255.255.0
 

10 On the Ready to Complete page, review your settings and click Finish.

11 From the Home menu, select VMs and Templates, right-click the vra01iws01a virtual machine and
select Edit Settings.

12 Click Virtual Hardware and configure the settings for CPU, Memory, and Network adapter 1, and
click OK.

Setting Value

CPU 2

Memory 8192

Network adapter 1 vxw-dvs-xxxx-Mgmt-xRegion01-VXLAN
 

13 Right-click the virtual machine vra01iws01a, select Power > Power on, right-click again, select
Open Console, verify that the VM reboots, and uses the configuration settings that you specified.

14 Log in to the vra01iws01a virtual machine by using a Remote Desktop Protocol (RDP) client, and
perform final verification.

a Open an RDP connection to the vra01iws01a.rainpole.local virtual machine.

b Log in using the following credentials.

Setting Value

User name svc-vra@rainpole.local

Password svc-vra_password
 

c Verify that the IP address, computer name, and domain are correct.

d Right-click PowerShell, select Run as Administrator, run the following commands and verify the
results.

Commands Expected Result

net localgroup administrators Members:
RAINPOLE\svc-vra

Get-ItemProperty -Path

"HKLM:\Software\Microsoft\Windows\CurrentVersion\Policies\System" -Name

"EnableLUA"

EnableLUA: 0

Get-ItemProperty -Path

"HKLM:\System\CurrentControlSet\Services\TCPIP6\Parameters" -Name

"DisabledComponents"

DisabledComponents:
255
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15 Assign user privileges to the vRealize Automation service account.

a In the RDP session navigate to Administrative Tools > Local Security Policy > Local Policies
> User Rights Assignment.

b Double-click Log on as a batch job and click Add User or Group.

c Click Locations, select rainpole.local.

d Enter svc-vra@rainpole.local and click OK.

e Click OK.

f Repeat this step to assign the Log on as a service privilege to the svc-vra@rainpole.local user.

16 Repeat this procedure to deploy and configure the remaining virtual machines.

Take Snapshots of the vRealize Automation Virtual Machines in Region A
As a best practice, take snapshots of the virtual machines deployed as part of the vRealize Automation
installation. The deployment of vRealize Automation is a complex process, and if the deployment fails for
any reason, these snapshots are available as a fall back.

Perform this procedure to take snapshot of each virtual machine listed below.

Virtual Machine Folder

vra01iws01a sfo01-m01fd-vra

vra01iws01b sfo01-m01fd-vra

vra01ims01a sfo01-m01fd-vra

vra01ims01b sfo01-m01fd-vra

vra01dem01a sfo01-m01fd-vra

vra01dem01b sfo01-m01fd-vra

sfo01ias01a sfo01-m01fd-vraias

sfo01ias01b sfo01-m01fd-vraias

vra01mssql01 sfo01-m01fd-vra

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to sfo01m01vc01.sfo01.rainpole.local > sfo01-m01dc > sfo01-m01fd-vra.
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3 Right-click vra01iws01a and select Snapshots > Take Snapshot.

4 Enter Pre-deployment for Name, deselect Snapshot the virtual machine's memory, and click OK.

5 Repeat this procedure to take snapshots of the remaining virtual machines in the preceding table.

Deploy the Cloud Management Applications Using vRealize Suite
Lifecycle Manager in Region A
Configure deployment details for vRealize Automation and vRealize Business for Cloud in the vRealize
Suite Lifecycle Manager installation wizard. Because vRealize Automation and vRealize Business are
integrated, deploy the products together.

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 Click the Environments menu item on the left side of the window.

3 Click the vertical ellipsis on the top right corner of the Cross-Region-Env environment, and click Add
Products.

4 On the Add Products page, verify that Join the VMware Customer Experience Improvement
Program check box is selected, select the following products, and click Next.

Product Check box in the top right corner New Install or Import Version Deployment Type

vRealize Automation Selected New Install 7.4.0 Large with HA

vRealize Business for Cloud Selected New Install 7.4.0 Large with HA

5 On the Product Details page, click the vRealize Automation tab.

6 Enter the following information for Product Properties.

Settings Value

Windows password svc-vra_password

Windows user name RAINPOLE\svc-vra

7 Enter the following information for Cluster Virtual IPs.

Component Option Value

vRA Appliance Hostname vra01svr01.rainpole.local

IP Address 192.168.11.53
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Component Option Value

IaaS Web Hostname vra01iws01.rainpole.local

IP Address 192.168.11.56

IaaS Manager Hostname vra01ims01.rainpole.local

IP Address 192.168.11.59

8 Configure the vRealize Automation appliances.

a Click the Advanced Settings icon for the vra-server-primary component.

b On Advanced Configuration for vra-server-primary page, enter the following settings and click
Done.

Component vRA VM Name vRA Hostname vRA IP Address

vra-server-primary vra01svr01a vra01svr01a.rainpole.local 192.168.11.51

vra-server-secondary vra01svr01b vra01svr01b.rainpole.local 192.168.11.52

c Repeat this step for the vra-server-secondary component.

d To add the vra-server-secondary-2 component, navigate to the Cluster Virtual IPs section, click
ADD +, choose the vRealize Automation Secondary Server component from the drop-down
menu, enter the following settings, and click Done.

Component vRA VM Name vRA Hostname vRA IP Address

vra-server-secondary-2 vra01svr01c vra01svr01c.rainpole.local 192.168.11.50

9 Configure the database settings.

a Click the Advanced Settings icon for the db component.

b On Advanced Configuration for db page, enter the following values and click Done.

Setting Value

VM Name vra01mssql01

Database Name VRADB-01

Database Hostname vra01mssql01.rainpole.local

Database IP Address 192.168.11.62

To use SQL authentication, deselect this option. Selected
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10 Configure the IaaS Web components.

a Click the Advanced Settings icon on the iaas-web-01 component.

b On Advanced Configuration for iaas-web-01 page, enter the following values and click Done.

Component Web Name Windows Web Hostname IP Address

iaas-web-01 vra01iws01a.rainpole.local vra01iws01a.rainpole.local 192.168.11.54

iaas-web-02 vra01iws01b.rainpole.local vra01iws01b.rainpole.local 192.168.11.55

c Repeat this step for the iaas-web-02 component.

11 Configure the IaaS Manager components.

a Click the Advanced Settings icon on the iaas-manager-active component.

b On Advanced Configuration for iaas-manager-active page, enter the following values and
click Done.

Component MS Name Windows MS Hostname
DEM Orchestrator
Name IP Address

iaas-manager-
active

vra01ims01a.rainpole.local vra01ims01a.rainpole.local DEM-
ORCHESTRATOR-01

192.168.11.57

iaas-manager-
passive

vra01ims01b.rainpole.local vra01ims01b.rainpole.local DEM-
ORCHESTRATOR-02

192.168.11.58

c Repeat this step for the iaas-manager-passive component.

12 Configure the DEM Worker components.

a Click the Advanced Settings icon on the Demworker-01 component.

b On Advanced Configuration for Demworker-01 page, enter the following values and click
Done.

Component DEM Worker Name Windows DEM Hostname IP Address

Demworker-01 DEM-WORKER-01 vra01dem01a.rainpole.local 192.168.11.60

Demworker-02 DEM-WORKER-02 vra01dem01a.rainpole.local 192.168.11.60
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c Repeat this step for the Demworker-02 component.

d To add the necessary number of DEM Workers, navigate to the Cluster Virtual IPs section, click
ADD +, select the IaaS Dem Worker component from the drop-down menu, and repeat this step
for the following components.

Component DEM Worker Name Windows DEM Hostname IP Address

iaas-dem-worker-03 DEM-WORKER-03 vra01dem01a.rainpole.local 192.168.11.60

iaas-dem-worker-04 DEM-WORKER-04 vra01dem01b.rainpole.local 192.168.11.61

iaas-dem-worker-05 DEM-WORKER-05 vra01dem01b.rainpole.local 192.168.11.61

iaas-dem-worker-06 DEM-WORKER-06 vra01dem01b.rainpole.local 192.168.11.61

13 Configure the vSphere Proxy Agent components.

a Click the Advanced Settings icon on the proxy-agent-vsphere-01 component.

b On Advanced Configuration for proxy-agent-vsphere-01 page, enter the following values and
click Done.

Component
Agent
Name Windows Agent Hostname IP Address vSphere Endpoint Name

proxy-agent-
vsphere-01

VSPHERE-
AGENT-01

sfo01ias01a.sfo01.rainpole.local 192.168.31.52 sfo01w01vc01.sfo01.rainpole.local

proxy-agent-
vsphere-02

VSPHERE-
AGENT-01

sfo01ias01b.sfo01.rainpole.local 192.168.31.53 sfo01w01vc01.sfo01.rainpole.local

c Repeat this step for the proxy-agent-vsphere-02 component.

14 On the Product Details page, click the vRealize Business for Cloud tab.

15 Enter the following information for Product Properties.

Setting Value

Currency USD - US Dollar

16 Configure the vRealize Business appliances.

a Click the Advanced Settings icon on the vrb-server component.

b On the Advanced Configuration for vrb-server page, enter the following values and click
Done.

Component VM Name Hostname IP Address

vrb-server vrb01svr01 vrb01svr01.rainpole.local 192.168.11.66
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c Click the ADD + button, select the vrb-collector component from the drop-down menu, and click
the Advanced Settings icon of the vrb-collector component.

d On the Advanced Configuration for vrb-collector page, enter the following values and click
Done.

Settings Value

Component vrb-collector

vCenter Host sfo01m01vc01.sfo01.rainpole.local

vCenter Cluster Name sfo01-m01-mgmt01 (sfo01-m01dc)

VM Network Distributed port group that ends with RegionA01-VXLAN

Storage sfo01-m01-vsan01

Gateway 192.168.31.1

DNS 172.16.11.5,172.16.11.4

Domain sfo01.rainpole.local

Search Path sfo01.rainpole.local,rainpole.local,lax01.rainpole.local

NetMask 255.255.255.0

VM Name sfo01vrbc01

Hostname sfo01vrbc01.sfo01.rainpole.local

IP Address 192.168.31.54

17 Click Next and click RUN PRE CHECK.

18 On the prerequisite page, click RUN PRE CHECK.

The steps on the prerequisite page for Automatic Checks and Manual Checks have been
performed in the previous sections.

If IP address reachability check step of the pre-check fails on the Microsoft SQL Server during
precheck, enable an ICMP echo reply on the Windows Firewall and click RUN PRE CHECK.

If the pre-check fails for another reason, review the error message, remediate the issue, and click
RUN PRE CHECK.

19 Wait for the pre-check to complete successfully and click Next.

20 Click the Download Configuration button to save this configuration into a JSON file.

21 Click Submit to begin the deployment of the products.

Deployment takes several minutes to finish.

Monitor the Deployment of vRealize Automation and vRealize
Business in vRealize Suite Lifecycle Manager in Region A
You can monitor the status of the vRealize Automation and vRealize Business deployment in the vRealize
Suite Lifecycle Manager user interface.
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Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 In the Navigator, click Requests and validate that VALIDATE_AND_ADD_PRODUCT for Environment
Name:Cross-Region-Env in the Request Info is INPROGRESS.

It can take a moment for the process to progress from SUBMITTED to the INPROGRESS state.

3 Select INPROGRESS for Environment Name:Cross-Region-Env.

4 On the Requests page, monitor the steps of the deployment graph until the request is marked as
COMPLETED.

Note   If the deployment fails, review the error message, remediate the issue, and trigger the
deployment again from the Action menu.

Configure vRealize Automation for a Large-Scale Deployment in
Region A
Increase the value of the ProxyAgentBinding and maxStringContentLength attributes to configure the
vRealize Automation Manager Service to contain many data objects, for example, 3000 or more virtual
machines from vCenter Server.

Procedure

1 Log in to the virtual machine of the vRealize Automation IaaS Manager Service by using a Remote
Desktop Protocol (RDP) client.

a Open an RDP connection to the vra01ims01a.rainpole.local virtual machine.

b Log in using the following credentials.

Settings Value

User name rainpole\svc-vra

Password svc-vra_password

2 Click the Start menu, enter notepad in the search box, and click Notepad in the search results.

3 Right-click the Notepad application icon, or your preferred text editor, and select Run As
Administrator.
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4 Open the C:\Program Files (x86)\VMware\vCAC\Server\ManagerService.exe.config file for
editing in Notepad or your preferred text editor.

5 Locate the following line in the ManagerService.exe.config file.

<binding name=”ProxyAgentServiceBinding” maxReceivedMessageSize=”13107200”>

<readerQuotas maxStringContentLength=”13107200” />

6 Replace the values of the following attributes by increasing them by a factor of 10 as shown in the
following table.

Parameter Values

maxReceivedMessageSize 131072000

maxStringContentLength 131072000

7 Save your changes to the ManagerService.exe.config file, close it, and exit the text editor.

8 Click the Start menu, and select Restart to restart the virtual machine.

9 Repeat this procedure for the vra01ims01b.rainpole.local virtual machine.

Reconfigure the Memory Size of vRealize Business for Cloud Data
Collector in Region A
After vRealize Suite Lifecycle Manager deploys vRealize Business for Cloud Data Collector, you
reconfigure the memory size of the VM to 2048 MB.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select VMs and Templates.

3 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server and select the sfo01-m01dc
data center.

4 Click the VMs tab on the right side and click the Virtual Machines tab.

5 Reduce the memory size of the vRealize Business for Cloud Data Collector.

a Right-click sfo01vrbc01 and select Power > Shut Down Guest OS.

b In the Confirm Guest Shut Down dialog box, click Yes to proceed.
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c After the shutdown procedure completes, right-click the VM and select Edit Settings.

d Adjust the Memory setting to 2048 MB and click OK.

e Right-click sfo01vrbc01 and select Power > Power On.

Move vRealize Automation and vRealize Business Appliances to
Virtual Machine Folders in Region A
Use the vSphere Web Client to move vRealize Automation and vRealize Business for Cloud appliances to
virtual machine folders for better organization and ease of management.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select VMs and Templates.

3 Navigate to the sfo01m01vc01.sfo01.rainpole.local vCenter Server and select the sfo01-m01dc
data center.

4 Click the VMs tab on the right side and click the Virtual Machines tab.

5 Move the vRealize Automation and vRealize Business for Cloud server appliances.

a Select the following virtual machines:

n vra01svr01a

n vra01svr01b

n vra01svr01c

n vrb01svr01

b Right-click and select Move to... and select sfo01-m01fd-vra under VM Folders.

c Click OK.

6 Move the vRealize Business for Cloud Data Collector virtual machine.

a Select the virtual machine sfo01vrbc01.

b Right-click and select Move to... and select sfo01-m01fd-vraias under VM Folders

c Click OK.
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Replace the vRealize Automation Certificate in Region A
Replace the existing certificate for all vRealize Automation services from the vRealize Automation
Management Console. You replace the certificate on the vRealize Automation Appliance, IaaS Web
server, and IaaS Manager server to maintain a trusted communication between the vRealize Automation
nodes.

Procedure

1 Log in to the first vRealize Automation appliance.

a Open a Web browser and go to https://vra01svr01a.rainpole.local:5480

b Log in using the following credentials.

Settings Value

User name root

Password deployment_admin_password

2 On the vRA Settings tab, click the Database subtab and check which node has the MASTER label.

If the MASTER node listed is not vra01svr01a.rainpole.local, log in to the management console of the
MASTER appliance using the previous instruction.

3 On the vRA Settings tab, click the Certificates subtab.

4 Under vRA Certificate, select Import next to Certificate Action.

5 From a text editor on the Windows host where you run the CertGenVVD utility, copy the content of the
following certificate files and paste it in to the following text boxes in the user interface, and click Save
Settings.

Source Content Target Text Box

vra.key RSA Private Key

vra.3.pem Certificate Chain

Passphrase that you optionally entered at generation Passphrase

6 Scroll down on the page and verify that all cluster nodes have been successfully updated.

You might wait several minutes for the operation to finish.

7 Click the Certificates tab and repeat the procedure to configure the IaaS Web server and IaaS
Manager Service with the new certificate details.

IaaS Component Component Type Certificate Action

IaaS Web server IaaS Web Import Certificate

IaaS Manager Service Manager Service Import Certificate
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Configure NTP , and Set Database Replication Mode for vRealize
Automation in Region A
After you deploy vRealize Automation appliance, configure it with the domain NTP servers for continuous
authentication support and enable automatic failover of the PostgreSQL database.

If different SDDC components are out of sync, authentication might no longer work. Configure each
vRealize Automation appliance with the domain NTP servers. Set the replication mode of the PostgreSQL
database to allow an automatic failover.

Procedure

1 Log in to the first vRealize Automation appliance.

a Open a Web browser and go to https://vra01svr01a.rainpole.local:5480

b Log in using the following credentials.

Settings Value

User name root

Password deployment_admin_password

2 Set the Network Time Protocol of the vRealize Automation appliances to synchronize with the domain
NTP servers.

a On the VMware vRealize Appliance page, navigate to Admin > Time Settings.

b Select Use Time Server as the Time Sync Mode and specify the following time servers.

Setting Value

Time Server #1 ntp.sfo01.rainpole.local

Time Server #2 ntp.lax01.rainpole.local

c Click Save Settings.

Note   The Time Offset column shows the time delta between the vRealize Automation appliance
and the Windows IaaS VMs. Time synchronization is critical. If there are values outside of the
acceptable boundaries, remediate them before you proceed.

d Repeat this procedure for any other vRealize Automation appliances.

3 Set the PostgreSQL database replication mode for the vRealize Automation installation.

a On the VMware vRealize Appliance page, navigate to vRA Settings > Database.

b Click Sync Mode.

c Verify that the Replication mode status shows Database is in Synchronous Mode.
Automatic failover is now turned on!.
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Replace the Certificate on vRealize Business for Cloud Server in
Region A
Replace the default or existing SSL certificate of vRealize Business for Cloud with a new one using the
vRealize Business appliance management console. This certificate is used when you access the Web
interface of the vRealize Business for Cloud Server.

Prerequisites

n CA-signed certificate files generated by using VMware Validated Design Certificate Generation Utility
(CertGenVVD). See the VMware Validated Design Planning and Preparation documentation.

Procedure

1 Log in to the vRealize Business Server appliance management console.

a Open a Web browser and go to https://vrb01svr01.rainpole.local:5480.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 Click the Administration tab and click SSL.

3 On the Replace SSL Certificate page, upload the certificate files that you previously generated for
vRealize Business and click Replace Certificate.

Use the vrb.key file as the RSA Private Key (.pem) and the vrb.3.pem file for the Certificate(s)
(.pem) entry. These files are in the vrb folder that you created during certificate generation.

Setting Value

Choose mode Import PEM encoded Certificate

RSA Private Key (.pem)
------BEGIN RSA PRIVATE KEY-----
private_key_value
-----END RSA PRIVATE KEY-----

Certificate(s) (.pem)
-----BEGIN CERTIFICATE-----
Server_certificate_value
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
Intermediate_CA
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
Root_CA_certificate_value
-----END CERTIFICATE-----

Private Key Passphrase vrb_cert_passphrase

A Successfully imported the certificate message appears.
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4 Click the System tab and click Reboot for the changes to take effect.

5 On the System Reboot window, click Reboot.

Integrate vRealize Business with vRealize Automation in Region A
To prepare vRealize Business for use, you must register the vRealize Business Server to vRealize
Automation by using the management interface.

Procedure

1 Log in to the vRealize Business Server appliance management console.

a Open a Web browser and go to https://vrb01svr01.rainpole.local:5480.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 Click Registration > vRA and enter the following credentials to register with the vRealize Automation
server.

Setting Value

Hostname vra01svr01.rainpole.local

SSO Default Tenant vsphere.local

SSO Admin User administrator

SSO Admin Password deployment_admin_password

Accept "vRealize Automation" certificate Selected

3 Click Register to connect to vRealize Automation.

SSO Status changes to Connected to vRealize Automation.

Configure NTP for vRealize Business for Cloud in Region A
Configure the network time protocol (NTP) on the vRealize Business for Cloud appliances from the virtual
appliance management interface (VAMI).

Perform the procedure on both Server and Data Collector virtual appliances.

Host VAMI URL

Server https://vrb01svr01.rainpole.local:5480

Data Collector https://sfo01vrbc01.sfo01.rainpole.local:5480
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Procedure

1 Log in to the vRealize Business for Cloud Server appliance management console.

a Open a Web browser and go to https://vrb01svr01.rainpole.local:5480.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 Configure the appliance to use a time server.

a Click the Administration tab and click Time Settings.

b On the Time Settings page, enter the following settings and click Save Settings.

Setting Value

Time Sync. Mode Use Time Server

Time Server #1 ntp.sfo01.rainpole.local

Time Server #2 ntp.lax01.rainpole.local

3 Repeat the procedure on the Data Collector virtual appliance sfo01vrbc01.sfo01.rainpole.local.

vRealize Automation Default Tenant Configuration in
Region A
In shared cloud environments, where multiple companies, divisions or independent groups are using a
common infrastructure fabric, it is necessary to set up virtual private clouds where authentication,
resources, policy are customized to the needs of each group. Tenants are useful for isolating the users,
resources, and services of one tenant from those of other tenants.

Create a Local Tenant Administrator in Region A
To support Integrated Windows Authentication, join the VMware Identity Manager connectors to the
Active Directory domain. Perform this operation in the default vsphere.local tenant.

Create a local user for the default tenant in vRealize Automation and assign the Tenant Administrator
role to the default tenant.
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Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 On the Tenants page, click the default tenant vsphere.local to edit its settings.

3 Click the Local users tab and click New to add a local user to the default tenant.

4 In the User Details dialog box, enter the following settings, click OK, and click Next.

Setting Value

First name vRA

Last name LocalDefaultAdmin

Email vra-localdefaultadmin@vsphere.local

User name vra-localdefaultadmin

Password vra-localdefaultadmin_password

Confirm password vra-localdefaultadmin_password

5 On the Administrators tab, specify tenant and infrastructure administrators.

a In the Tenant administrators search text box, enter vra-localdefaultadmin, press Enter and
select the user.

b In the IaaS administrators search text box, enter vra-localdefaultadmin, press Enter and
select the user.

c Click Finish.

Join Connectors to an Active Directory Domain in Region A
To use an Active Directory domain for tenant authentication, you must join a VMware Identity Manager
connector to vRealize Automation. 

Each vRealize Automation appliance includes a connector that supports user authentication. By default,
one connector is typically configured to perform a directory synchronization. Perform the procedure by
using the vra-localdefaultadmin that you configured in the previous procedure.
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Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go
to https://vra01svr01.rainpole.local/vcac/org/vsphere.local.

b Log in using the following credentials.

Setting Value

User name vra-localdefaultadmin

Password vra-localdefaultadmin_password

2 Navigate to Administration > Directories Management > Connectors.

3 For each Connector listed, click Join Domain, specify the following settings, and click Join Domain.

Setting Value Value Value

Connector first-connector first-connector-Clone first-connector-Clone-XXX

Domain Custom Domain Custom Domain Custom Domain

rainpole.local rainpole.local rainpole.local

Domain User svc-domain-join svc-domain-join svc-domain-join

Domain Password svc-domain-join_password svc-domain-join_password svc-domain-join_password

vRealize Automation Tenant Creation in Region A
You create additional vRealize Automation tenants so that users can access the applications and
resources that they need to complete their work assignments.

A tenant is a group of users with specific privileges who work within a software instance. Administrators
can create additional tenants so that users can log in and complete their work assignments.
Administrators can create as many tenants as needed for system operation. Administrators must specify
basic configuration such as name, login URL, local users, and administrators. The tenant administrator
must also log in and set up an appropriate Active Directory connection and apply a custom branding to
tenants.

Create the Rainpole Tenant in Region A
The vRealize Automation Identity Manager provides Single-Sign On (SSO) capability for vRealize
Automation users.

vRealize Automation Identity Manager is an authentication broker and security token exchange that
interacts with the Active Directory to authenticate users. As the system administrator, you configure
Identity Manager to provide access to vRealize Automation by the Rainpole tenant. The Rainpole tenant
is the tenant through which you manage system-wide configuration which includes global system defaults
for branding, notifications, and system logs.
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Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 On the Tenants page, click New to configure a new tenant.

3 On the General tab, enter the following settings for the Rainpole tenant, and click Submit and Next.

Setting Value

Name Rainpole

URL Name rainpole

Contact email administrator@rainpole.local

4 On the Local Users tab, click New to add a local user for the tenant.

5 In the User Details dialog box, configure the following settings, click OK, and click Next.

Setting Value

First name vRA

Last name LocalRainpoleAdmin

Email vra-localrainpoleadmin@rainpole.local

User name vra-localrainpoleadmin

Password vra-localrainpoleadmin_password

Confirm password vra-localrainpoleadmin_password

6 On the Administrators tab, specify tenant and infrastructure administrators.

a Enter vra-localrainpoleadmin in the Tenant administrators search box, press Enter, and
select the user.

b Enter vra-localrainpoleadmin in the IaaS administrators search box, press Enter, and select
the user.

7 Click Finish.

8 Log out of vRealize Automation portal.
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Configure Identity Management for the vRealize Automation
Tenant in Region A
vRealize Automation uses VMware Identity Manager to authenticate users.

Each tenant must be associated with at least one directory as part of the tenant creation. You can add
more directories if necessary. Perform the procedure by using the vra-localrainpoleadmin that you
configured.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-localrainpoleadmin

Password vra-localrainpoleadmin_password

Domain vsphere.local

2 Navigate to Administration > Directories Management  > Directories.

3 Click Add Directory and select Add Active Directory over LDAP/IWA, specify the following
settings, and click Save & Next.

Setting Value

Directory Name rainpole.local

Directory Type Active Directory (Integrated Windows Authentication)

Sync Connector vra01svr01a.rainpole.local

Authentication Yes

Directory Search Attribute sAMAccountName

Certificates Deselected

Domain Name rainpole.local

Domain Admin Username svc-domain-join

Domain Admin Password svc-domain-join_password

Bind User UPN svc-vra@rainpole.local

Bind DN Password svc-vra_password

4 On the Select the Domains page, select rainpole.local (RAINPOLE), and click Next.

5 On the Map User Attributes page, click Next.
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6 On the Select the groups (users) you want to sync page, enter the group DNs to sync.

a Click the Add icon to add the distinguished name to the search criteria.

b In the Specify the group DNs text box, enter dc=rainpole,dc=local and click Find Groups.

c After the Groups to sync value updates, click the Select button.

d Select the following groups and click Save.

n ug-vra-admins-rainpole

n ug-vra-archs-rainpole

n ug-SDDC-Admins

n ug-SDDC-Ops

n ug-vROAdmins

e Click Next.

7 On the Select the Users you would like to sync page, enter the user DNs to sync.

a Click the Add icon to add the distinguished name to the search criteria.

b In the Specify the user DNs text box, enter cn=users,dc=rainpole,dc=local, click the Add
icon on the same row, and click Next.

8 On the Review page, click Sync Directory. 

Configure Directories Management for High Availability in Region
A
Each vRealize Automation appliance includes a connector that supports user authentication, although
only one connector is typically configured to perform directory synchronization.

To support Directories Management high availability, you must configure a connector that corresponds to
each vRealize Automation appliance. That secondary connectors connect to the same Identity Provider
and, through VMware Identity Manager, point to the same Active Directory instance. With this
configuration, if one appliance fails, the others can take over management of user authentication.

In a high availability environment, all nodes must serve the same set of users, authentication methods,
and other Active Directory constructs. The most direct method to accomplish this is to promote the
Identity Provider to the cluster by setting the load balancer host as the Identity Provider host. With this
configuration, all authentication requests are directed to the load balancer, which forwards the request to
either connector as appropriate.
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-localrainpoleadmin

Password vra-localrainpoleadmin_password

Domain vsphere.local

2 Navigate to Administration > Directories Management > Identity Providers.

3 Click WorkspaceIDP_1 to edit its settings.

4 Under Connector(s), enter the following settings and click Add Connector.

Setting Value for vra01svr01b Value for vra01svr01c

Add a Connector vra01svr01b.rainpole.local vra01svr01c.rainpole.local

Bind DN Password svc-vra_password svc-vra_password

Domain Admin Password domain_admin_password domain_admin_password

5 Repeat the previous step for each secondary vRA appliance.

6 In the Idp Hostname text box, enter vra01svr01.rainpole.local, the host name of the load
balancer, and click Save.

Assign Tenant Administrative Roles to Active Directory Users in
Region A
After vRealize Automation Directories Management is associated with your Active Directory domain,
domain users can administer the tenant. Assign domain user groups for tenant and infrastructure
administrators.

Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 On the Tenants page, click the Rainpole tenant to edit its settings.
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3 Click the Administrators  tab to assign domain user groups for tenant and infrastructure
administrators.

a Enter ug-vra-admins-rainpole in the Tenant administrators search box, press Enter and
select the user group.

b Enter ug-vra-admins-rainpole in the IaaS administrators search box, press Enter and select
the user group.

c Click Finish.

Brand the Tenant Login Pages in Region A
You can apply custom branding on a per-customer basis to the vRealize Automation tenant login pages. 

System administrators control the default branding for all tenants. As a tenant administrator, you change
the branding of the portal. That includes the logo, the background color, and the information in the header
and footer. If the branding for a tenant is changed, a tenant administrator can revert to the system
defaults.

Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 Navigate to Administration >  Branding and deselect the Use default check box.

3 On the Header tab, specify the following settings for the header branding.

Setting Value

Company Name Rainpole

Product Name Infrastructure Service Portal

Background hex color 3989C7

Text hex color FFFFFF

4 Click the Footer tab, specify the following settings for the footer branding, and click Finish.

Setting Value

Copyright notice Copyright Rainpole. All Rights Reserved.

Privacy policy link https://www.rainpole.local

Contact link https://www.rainpole.local/contact
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Configure the Default Email Servers in Region A
System administrators configure inbound and outbound email servers to handle email notifications about
events involving tenants machines. System administrators can create only one inbound email server and
one outbound email server. These servers are the defaults for all tenants.

If tenant administrators do not override the default email server settings before they enable notifications,
vRealize Automation uses the globally configured email server.

Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 Navigate to Administration > Email Servers, and click New.

3 In the New Email Server dialog box, select Email - Inbound, and click OK.

4 On the New Inbound Email page, specify the following values, click Test Connection to verify that
the settings are correct, and click OK.

Setting Value

Name Rainpole-Inbound

Security Deselected

Protocol IMAP

Server Name email.rainpole.local

Server Port 143

Folder Name INBOX

Processed Email Deselected

User Name administrator@rainpole.local

Password vra_administrator_password

Email Address svc-vra@rainpole.local

5 On the Email Servers page, click New to configure the outbound server settings.

6 In the New Email Server dialog box, select Email - Outbound, and click OK.
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7 On the New Outbound Email page, specify the following values, click Test Connection to verify that
the settings are correct, and click OK.

Setting Value

Name Rainpole-Outbound

Server Name email.rainpole.local

Encryption Method None

Server Port 25

Authentication Selected

User Name administrator@rainpole.local

Password vra_administrator_password

Sender Address svc-vra@rainpole.local

8 Log out of vRealize Automation portal.

Embedded vRealize Orchestrator Configuration in Region
A
vRealize Orchestrator is a platform that provides a library of extensible workflows to allow you to create
and run automated, configurable processes to manage the VMware vSphere infrastructure and other
VMware and third-party technologies.  

vRealize Orchestrator is composed of three distinct layers: an orchestration platform that provides the
common features required for an orchestration tool, a plug-in architecture to integrate control of
subsystems, and a library of workflows. vRealize Orchestrator is an open platform that can be extended
with new plug-ins and libraries, and can be integrated into larger architectures through a REST API.

Configure the Embedded vRealize Orchestrator in Region A
Configure the vRealize Orchestrator services to provide the SDDC foundation orchestration engine.

Configure the Embedded vRealize Orchestrator Service in the vRealize
Automation Appliances in Region A
To enable the embedded vRealize Orchestrator functionality, configure the vRealize Orchestrator service
in the vRealize Automation appliances. For deployments with multiple appliances, configure each
appliance to create a highly available Embedded vRealize Orchestrator cluster.

Perform this procedure on each host in the following table.

vRealize Orchestrator Instance IP Address FQDN

Host A 192.168.11.51 vra01svr01a.rainpole.local

Host B 192.168.11.52 vra01svr01b.rainpole.local

Host C 192.168.11.50 vra01svr01c.rainpole.local
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Procedure

1 Log in to the vRealize Automation appliance by using Secure Shell (SSH) client to configure the
embedded vRealize Orchestrator.

a Open an SSH connection to vra01svr01a.rainpole.local using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 Start the vco-configurator service by running the command service vco-configurator start.

3 Verify the status of vco-configurator by running the command service vco-configurator
status.

4 Run the command chkconfig vco-configurator on to enable an automatic restart of the vco-
configurator service upon subsequent reboots of the vRealize Automation appliance.

5 Repeat the procedure to configure vRealize Orchestrator for the other hosts.

Configure the Authentication Provider for vRealize Orchestrator in Region A
Configure vRealize Orchestrator to use the Rainpole local tenant in vRealize Automation for
authentication. By associating vRealize Orchestrator authentication to a non-default tenant, vRealize
Orchestrator runs workflows with end-user permissions. If vRealize Orchestrator authenticates using the
default tenant, vRealize Orchestrator users always have administrative rights.
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Procedure

1 Log in to the vRealize Orchestrator Control Center.

a Open a Web browser and go to
https://vra01svr01.rainpole.local:8283/vco-controlcenter/.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 Configure vRealize Automation as a vRealize Orchestrator authentication provider.

a On the Home page, under Manage, click Configure Authentication Provider.

b In the Default tenant text box, click the Change button, enter rainpole, and click Apply.

c In the Admin group text box, enter ug-vRO and click Search.

d From the drop-down menu, select rainpole.local\ug-vROAdmins and click Save Changes.

3 Restart the vRealize Orchestrator services.

a Open an SSH connection to vra01svr01a.rainpole.local.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

c Run the following commands.

service vco-server restart

service vco-configurator restart

Wait for services to be fully up and running.

d Repeat the steps to restart the services on all other vRA appliances.

Validate the Configuration of vRealize Orchestrator in Region A
You can verify that Embedded vRealize Orchestrator is correctly configured by opening the Validate
Configuration page in the Control Center.
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Procedure

1 Log in to the Embedded vRealize Orchestrator Control Center.

a Open a Web browser and go
to https://vra01svr01.rainpole.local:8283/vco-controlcenter.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

2 On the Home page, under Manage, click Validate Configuration, and verify that all check marks are
green.

Note   The services that were restarted in the previous procedure might take some time to start. If
some of the system components fail, wait for them to start and click the Refresh button.

Add Compute vCenter Server Instance to Embedded vRealize Orchestrator in
Region A
Add each vCenter Server instance that contributes resources to vRealize Automation and uses vRealize
Orchestrator workflows to allow for communication.

Procedure

1 Download and Install the vRealize Orchestrator Client.

a Open a Web browser and go to https://vra01svr01.rainpole.local.

b Click vRealize Orchestrator Client.

c On the VMware vRealize Orchestrator Login page, log in to the Embedded vRealize
Orchestrator by using the following hostname and credentials.

Setting Value

Host name vra01svr01.rainpole.local:443

User name svc-vra

Password svc-vra_password

2 In the left pane, click Workflows, and navigate to Library > vCenter > Configuration.
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3 Right-click the Add a vCenter Server instance workflow, and click Start Workflow. 

a On the Set the vCenter Server Instance page, configure the following settings, and click Next.

Setting Value

IP or hostname of the vCenter Server instance to add sfo01w01vc01.sfo01.rainpole.local

HTTPS port of the vCenter Server instance 443

Location of SDK that you use to connect /sdk

Will you orchestrate this instance Yes

Do you want to ignore certificate warnings Yes

b On the Set the connection properties page, configure the following settings, and click Submit.

Setting Value

Use a session per user No

User name rainpole.local\svc-vro

Password svc-vro_password

4 To verify that the workflow completed successfully, click the Inventory tab, and expand the vSphere
vCenter Plugin tree control.

The vCenter Server instance you added is now visible in the inventory.

Integrate vRealize Orchestrator with vRealize Automation in
Region A
 Configure vRealize Automation to work with the embedded vRealize Orchestrator instance.

Configure Embedded vRealize Orchestrator Server in Region A
When you use vRealize Automation workflows to call vRealize Orchestrator workflows, you must
configure vRealize Orchestrator to act as an endpoint.

Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 Click Administration > vRO Configuration > Server Configuration. 

3 Select the Use the default Orchestrator server radio button and click Test Connection.
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4 Once the Successfully connected to the Orchestrator server message appears, click OK
to complete the configuration.

Create a vRealize Orchestrator Endpoint in Region A
IaaS administrators are responsible for creating the endpoints that allow vRealize Automation to
communicate with your infrastructure. You create a vRealize Orchestrator endpoint for use by Realize
Automation to communicate workflows.

Procedure

1 Log in to the Rainpole Infrastructure Service Portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b From the Select your domain drop-down menu, select rainpole.local and click Next.

c Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Create an endpoint for vRealize Orchestrator.

a Select Infrastructure > Endpoints > Endpoints. 

b Click New > Orchestration > vRealize Orchestrator, enter the following values, and click OK to
complete the process.

Setting Value

Name vra01svr01.rainpole.local

Address https://vra01svr01.rainpole.local/vco

User name svc-vra@rainpole.local

Password svc-vra_password

Priority 1

3 Start the data collection for the newly created endpoint.

a Select the vRealize Orchestrator endpoint in the Endpoints list and click Actions > Data
Collection.

b Click Start to begin the vRealize Orchestrator data collection process. Wait several minutes for
the data collection process to complete.

c Click Refresh to verify that the data collection successfully complete. 

When a data collection succeeded status message appears, the configuration process is
complete.
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Add vRealize Automation Host in vRealize Orchestrator in Region A
To call vRealize Automation Plugin workflows, you configure the vRealize Automation host in vRealize
Orchestrator.

Procedure

1 Log in to the vRealize Orchestrator Client.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vco.

b Click Start The Orchestrator Client.

c On the VMware vRealize Orchestrator login page, log in to vRealize Orchestrator using the
following hostname and credentials.

Setting Value

Host name vra01svr01.rainpole.local:443

User name svc-vra

Password svc-vra_password

2 In the left pane, click Workflows, and navigate to Library > vRealize Automation > Configuration.

3 Right-click the Add a vRA host using component registry workflow and click Start workflow.

a On the Common parameters page, configure the following settings, and click Submit.

Setting Value

Name of the vCAC host vra01svr01.rainpole.local

Connection timeout 30.0

Operation timeout 60.0

Maximum page size for objects retrieved from this host 100.0

4 To verify that the workflow completed successfully, click the Inventory tab and expand the vRealize
Automation tree control.

The vRealize Automation Server instance that you just added is visible in the inventory.

5 In the left pane, click Workflows, and navigate to Library > vRealize Automation > Configuration.

6 Right-click the Add the IaaS host of a vRA host workflow and click Start workflow.

a On the Common parameters page, click the Not set search icon. Select
vra01svr01.rainpole.local [https://vra01svr01.rainpole.local] [rainpole] for vCAC host and
click Next.

b On the Add an IaaS host page, keep the default settings for Host Properties, and click Next.

c On the Add an IaaS host page, keep the default settings for the Proxy Settings, and click Next.

d On the Host Authentication page, select SSO for Host's authentication type, and click
Submit.
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7 To verify that the workflow completed successfully, click the Inventory tab, and expand the vRealize
Automation Infrastructure tree control.

The vRealize Automation IaaS Server instance you added is visible in the inventory.

Register the vRealize Business Data Collector with the
Server in Region A
To prepare vRealize Business Data Collector for use, you must register the vRealize Business Data
Collector with the vRealize Business server using the data collector console.

Because the tenant is configured in vRealize Automation, you register the vRealize Business Data
Collector appliance with the vRealize Business Server using the following procedure.

n Grant an added role to the tenant admin, enter the product license key, and generate a one-time key
from vRealize Automation.

n Register the vRealize Business Data Collector appliance with the vRealize Business server.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Administration > Users & Groups > Directory Users and Groups.

3 In the search text box, enter ug-vra-admins-rainpole.

4 Click the ug-vra-admins-rainpole group to edit its settings.

5 On the Edit Group page, in the Add Roles to this Group list, select the Business Management
Administrator and Business Management Controller role to add the role and click Finish.

6 Close your browser, and log in again by using the same credentials.

7 Generate a one-time use key for connecting the two vRealize Business appliances.

a Navigate to Administration > Business Management.

b Expand the Manage Data Collector > Remote Data Collection  section.
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c Click Generate a new one time use key.

d Save the one-time use key as you need it at a later stage in the implementation sequence.

Attention   The key validity is 20 minutes and is only a one-time use key for the Data Collector to
register with the server.

8 Log in to the vRealize Business Data Collector console.

a Open a Web browser and go to https://sfo01vrbc01.sfo01.rainpole.local:9443/dc-ui.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

9 Register the Data Collector with the vRealize Business server.

a Expand the Registration with vRealize Business Server section.

b Enter the following values and click Register.

Setting Value

Enter the vRB Server Url https://vrb01svr01.rainpole.local

Enter the One Time Key one_time_use_key

After you click Register, a warning message informs you that the certificate is not trusted.

c Click Install and click OK.

The vRealize Business appliances are now connected.

Connect vRealize Business for Cloud with the Compute
vCenter Server in Region A
vRealize Business for Cloud requires a connection with the vCenter Server to collect data from the entire
cluster. You add the vCenter Server to vRealize Business by using the vRealize Business Data Collector
console.

Procedure

1 Log in to the vRealize Business Data Collector console.

a Open a Web browser and go to https://sfo01vrbc01.sfo01.rainpole.local:9443/dc-ui.

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password
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2 Click Manage Private Cloud Connections, select vCenter Server, and click the Add icon.

3 In the Add vCenter Server Connections dialog box, enter the following settings, and click Save.

Setting Value

Name sfo01w01vc01.sfo01.rainpole.local

vCenter Server sfo01w01vc01.sfo01.rainpole.local

Username svc-vra@rainpole.local

Password svc_vra_password

4 In the SSL Certificate warning dialog box, click Install. 

5 In the Success dialog box, click OK.

Cloud Management Platform Post-Installation Tasks in
Region A
After you deploy vRealize Automation and vRealize Orchestrator, you create anti-affinity rules to enable
HA protection for both services, enable health monitors to check the health status of individual servers,
and remove the snapshots created during the vRealize Automation installation.

Procedure

1 Create Anti-Affinity Rules for vRealize Automation Virtual Machines in Region A

A VM/Host anti-affinity (or affinity) rule specifies the relationship between a group of virtual machines
and a group of hosts. Anti-affinity rules force selected virtual machines to remain hosted on different
hosts during failover actions, and are a requirement for high availability.

2 Create VM Groups to Define the Startup Order of the Cloud Management Platform in Region A

VM Groups allow you to define the startup order of virtual machines. The startup order you define
ensures that vSphere HA powers on virtual machines in the correct order.

3 Enable Load Balancer Health Monitoring in Region A

Previously you have disabled health monitoring for the sfo01m01lb01 load balancer to complete
configuration of vRealize Automation. Re-enable health monitoring for the sfo01m01lb01 load
balancer.  

4 Clean up the vRealize Automation VM Snapshots in Region A

After you successfully complete the installation and configuration of the vRealize Automation
appliances and virtual machines, delete the snapshots that were created earlier.

Create Anti-Affinity Rules for vRealize Automation Virtual
Machines in Region A
A VM/Host anti-affinity (or affinity) rule specifies the relationship between a group of virtual machines and
a group of hosts. Anti-affinity rules force selected virtual machines to remain hosted on different hosts
during failover actions, and are a requirement for high availability.
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Table 4‑7.  Anti-Affinity Rules for the Cloud Management Platform

Name Type Members

anti-affinity-rule-vra-svr Separate Virtual Machines vra01svr01a

vra01svr01b

vra01svr01c

anti-affinity-rule-vra-iws Separate Virtual Machines vra01iws01a

vra01iws01b

anti-affinity-rule-vra-ims Separate Virtual Machines vra01ims01a

vra01ims01b

anti-affinity-rule-vra-dem Separate Virtual Machines vra01dem01a

vra01dem01b

anti-affinity-rule-vra-ias Separate Virtual Machines sfo01ias01a

sfo01ias01b

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home page, click Hosts and Clusters.

3 Under sfo01m01vc01.sfo01.rainpole.local, click sfo01-m01dc, and click sfo01-m01-mgmt01.

4 Click the Configure tab, and under Configuration, select VM/Host Rules.

5 Under VM/Host Rules, click Add to create a virtual machine anti-affinity rule.

6 In the Create VM/Host Rule dialog box, specify the first rule for the vRealize Automation virtual
appliances.

a In the Name text box, enter anti-affinity-rule-vra-svr.

b Select the Enable rule check box.
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c Select Separate Virtual Machines from the Type drop-down menu.

d Click Add, select the following virtual machines, click OK, and click OK.

n vra01svr01a

n vra01svr01b

n vra01svr01c

7 Repeat the procedure to configure the remaining anti-affinity rules.

Create VM Groups to Define the Startup Order of the Cloud
Management Platform in Region A
VM Groups allow you to define the startup order of virtual machines. The startup order you define
ensures that vSphere HA powers on virtual machines in the correct order.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, select Host and Clusters and expand the sfo01m01vc01.sfo01.rainpole.local
tree.

3 Create a VM Group for the vRealize Automation IaaS Database.

a Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

b On the Configure page, click VM/Host Groups.

c On the VM/Host Groups page, click the Add button.

d In the Create VM/Host Group dialog box, enter vRealize Automation IaaS Database in the
Name field, select VM Group from the Type drop-down menu, and click the Add button.

e In the Add VM/Host Group Member dialog box, select vra01mssql01 and click OK.

f Click OK to save the VM/Host Group.

4 Repeat Step 3 to create the following VM/Host Groups.

VM/Host Group Name VM/Host Group Member

vRealize Automation Virtual Appliances vra01svr01a

vra01svr01b
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VM/Host Group Name VM/Host Group Member

vra01svr01c

vRealize Automation IaaS Web Servers vra01iws01a

vra01iws01b

vRealize Automation IaaS Managers vra01ims01a

vra01ims01b

vRealize Automation IaaS DEM Workers vra01dem01a

vra01dem01b

vRealize Automation IaaS Proxy Agents sfo01ias01a

sfo01ias01b

vRealize Business for Cloud Servers vrb01svr01

vRealize Business for Cloud Data Collectors sfo01vrbc01

5 Create a rule to power on the vRealize Automation Database before the vRealize Automation Virtual
Appliances.

a Select the sfo01-m01-mgmt01 cluster and click the Configure tab.

b On the Configure page, click VM/Host Rules.

c On the VM/Host Rules page, click the Add button.

d In the Create VM/Host Rule dialog box, enter SDDC Cloud Management Platform 01 in the
Name text box, ensure the Enable Rule check box is selected, and select Virtual Machines to
Virtual Machines from the Type drop-down menu.

e Select vRealize Automation IaaS Database from the First restart VMs in VM group drop-down
menu.

f Select vRealize Automation Virtual Appliances from the Then restart VMs in VM group drop-
down menu, and click OK.

6 Repeat Step 5 to create the following VM/Host Rules to ensure the correct restart order for your
Cloud Management Platform.

VM/Host Rule Name First restart VMs in VM group Then restart VMs in VM group

SDDC Cloud Management Platform 02 vRealize Automation Virtual
Appliances

vRealize Automation IaaS Web Servers

SDDC Cloud Management Platform 03 vRealize Automation IaaS Web
Servers

vRealize Automation IaaS Managers

SDDC Cloud Management Platform 04 vRealize Automation IaaS Managers vRealize Automation IaaS DEM Workers

SDDC Cloud Management Platform 05 vRealize Automation IaaS Managers vRealize Automation IaaS Proxy Agents

SDDC Cloud Management Platform 06 vRealize Automation IaaS Managers vRealize Business for Cloud Servers

SDDC Cloud Management Platform 07 vRealize Business for Cloud Servers vRealize Business for Cloud Data
Collectors
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Enable Load Balancer Health Monitoring in Region A
Previously you have disabled health monitoring for the sfo01m01lb01 load balancer to complete
configuration of vRealize Automation. Re-enable health monitoring for the sfo01m01lb01 load balancer.  

Perform this procedure multiple times to configure the health monitor and to enable the secondary
members of the server pools.

Pool Name Monitor Enable Pool Member

vra-svr-443 vra-svr-443-monitor vra01svr01b

vra01svr01c

vra-iws-443 vra-iws-443-monitor vra01iws01b

vra-svr-8444 vra-svr-443-monitor The pool already has all members enabled

vra-vro-8283 vra-vro-8283-monitor vra01svr01b

vra01svr01c

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 In the Navigator, click Networking & Security, and select NSX Edges.

3 Select 172.16.11.65 from the NSX Manager drop-down menu, and double-click sfo01m01lb01 to edit
its settings.

4 Click the Manage tab, click Load Balancer, and select Pools.

5 From the pools table, select the vra-svr-443 server pool, and click Edit icon.

6 In the Edit Pool dialog box, configure the monitor, and enable the member that is not enabled.

a From the Monitors drop-down menu, select vra-svr-443-monitor.

b From the Members table, select vra01svr01b and click Edit icon.

c In the Edit Member dialog box, from the State: drop-down menu, select Enable and click OK.

d Repeat this edit for any other non-primary members of this pool.

e Click OK to close the Edit Pool dialog box.
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7 Repeat the procedure to configure the health monitor and enable the secondary members for the
remaining server pools.

8 Click Show Pool Statistics and verify that the Status of all the server pools show as UP.

Clean up the vRealize Automation VM Snapshots in Region A
After you successfully complete the installation and configuration of the vRealize Automation appliances
and virtual machines, delete the snapshots that were created earlier.

Repeat this procedure to remove all the vRealize Automation virtual machine snapshots you created
during the implementation. The virtual machine names and their respective folders are listed in the
following table.

Virtual Machines vCenter Folder

vra01mssql01 sfo01-m01fd-vra

vra01iws01a sfo01-m01fd-vra

vra01iws01b sfo01-m01fd-vra

vra01ims01a sfo01-m01fd-vra

vra01ims01b sfo01-m01fd-vra

vra01dem01a sfo01-m01fd-vra

vra01dem01b sfo01-m01fd-vra

sfo01ias01a sfo01-m01fd-vraias

sfo01ias01b sfo01-m01fd-vraias

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select VMs and Templates.

3 In the Navigator pane, expand the sfo01m01vc01.sfo01.rainpole.local > sfo01-m01dc > sfo01-
m01fd-vra folder.

4 Right-click the vra01mssql01 virtual machine and select Snapshots  > Manage Snapshots.

5 Select the Pre-Deployment snapshot, click the Delete icon and click Yes in the Confirm Delete
dialog-box.
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6 Repeat this procedure to remove all the remaining vRealize Automation virtual machine snapshots.

Content Library Configuration in Region A
Content libraries are containers for VM templates, vApp templates, and other resources used for vRealize
Automation deployment of virtual machines and vApps. Sharing templates and files across multiple
vCenter Server instances brings out consistency, compliance, efficiency, and automation in deploying
workloads at scale.

You create and manage a content library from a single vCenter Server instance, but you can share the
library items with other vCenter Server instances if HTTP(S) traffic is allowed between them. 

Configure a Content Library in the First Compute vCenter Server
Instance in Region A
Create a content library and populate it with templates that you can use to deploy virtual machines in your
environment. Content libraries let you synchronize templates among different vCenter Server instances
so that all the templates in your environment are consistent.

There is only one Compute vCenter Server in this VMware Validated Design, but if you deploy more
instances for use by the compute cluster they can also use this content library.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select Content Libraries and click the Objects > Create a new content
library icon.

The New Content Library wizard opens.

3 On the Name and location page, specify the following settings and click Next.

Setting Value

Name sfo01-w01cl-vra01

vCenter Server sfo01w01vc01.sfo01.rainpole.local
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4 On the Configure content library page, specify the following settings, and click Next.

Setting Value

Local content library Selected

Publish externally Selected

Enable authentication Selected

Password sfo01-w01cl-vra01_password

Confirm password sfo01-w01cl-vra01_password

5 On the Add storage page, click the Select a datastore radio button, select the sfo01-w01-lib01
datastore to store the content library, and click Next.

6 On the Ready to complete page, click Finish.

Import the OVF Files for the Virtual Machine Templates in Region
A
You can import OVF packages that you previously prepared to use as templates for deploying virtual
machines. The virtual machine templates that you add to the content library are used as vRealize
Automation blueprints.

You repeat this procedure three times to import the virtual machine templates listed in Table 4‑8.

Table 4‑8.  VM Templates to Import

VM Template Name Operating System Type

redhat6-enterprise-64 Red Hat Enterprise Server 6 (64-bit)

windows-2012r2-64 Windows Server 2012 R2 (64-bit)

windows-2012r2-64-sql2012 Windows Server 2012 R2 (64-bit) with SQL 1012

Prerequisites

Verify that you have prepared the OVF templates, as specified in the Virtual Machine Template
Specifications section.

Procedure

1 Log in to vCenter Server by using the vSphere Web Client.

a Open a Web browser and go
to https://sfo01m01vc01.sfo01.rainpole.local/vsphere-client.

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password
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2 From the Home page, click Content Libraries and click the Objects tab.

3 Right-click the content library sfo01-w01cl-vra01 and select Import Item.

4 In the Import Library Item dialog box, specify the settings for the first template and click OK.

Setting Value

Source file URL or local path to redhat6-enterprise-64.ovf

Item name redhat6-enterprise-64

Notes Red Hat Enterprise Server 6 (64-bit)

5 Repeat the procedure to import the remaining virtual machine templates.

Tenant Content Creation in Region A
At this point, vRealize Automation, vRealize Orchestrator, and vRealize Business for Cloud are fully
installed and configured to a basic level with a single (non-default) tenant. The next stage of configuration
is to supply this tenant with compute, storage, and network resources from the existing virtual
infrastructure. At the end of this stage, you test the entire process by deploying virtual machines from
blueprints that you have prepared, using the resources that you have configured.

Procedure

1 Create Logical Switches for Business Groups in Region A

For each vCenter Server compute instance, you create three logical switches for each business
group which simulate networks for the web, database, and application tiers.

2 Configure User Roles in vRealize Automation in Region A

You assign user roles in the context of a specific tenant. However, some roles for the default tenant
can manage system-wide configuration settings that apply to multiple tenants.

3 Create Fabric Groups in Region A

IaaS administrators can organize virtualization compute resources and cloud endpoints into fabric
groups by type and intent. One or more fabric administrators manage the resources in each fabric
group.

4 Create Machine Prefixes in Region A

As a fabric administrator, you create machine prefixes that are used to create names for machines
provisioned through vRealize Automation. Tenant administrators and business group managers
select these machine prefixes and assign them to provisioned machines through blueprints and
business group defaults.

5 Create Business Groups in Region A

Tenant administrators create business groups to associate a set of services and resources to a set
of users that often correspond to a line of business, department, or other organizational unit. Users
must belong to a business group to request machines.
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6 Create Reservation Policies in Region A

You use reservation policies to group similar reservations together. Create the reservation policy tag
first, then add the policy to reservations to allow a tenant administrator or business group manager
to use the reservation policy in a blueprint.

7 Create a vSphere Endpoint in vRealize Automation in Region A

As an IaaS administrator, to allow vRealize Automation to manage the infrastructure, create
endpoints and configure user credentials for those endpoints. When you create a vSphere Endpoint,
vRealize Automation can communicate with the vSphere environment and discover vCenter Server-
managed compute resources, collect data, and provision machines.

8 Create an NSX Endpoint in vRealize Automation in Region A

9 Add Compute Resources to a Fabric Group in Region A

You allocate compute resources to fabric groups so that vRealize Automation can use the resources
in that compute resource for that fabric group when provisioning virtual machines.

10 Create External Network Profiles in Region A

Before members of a business group can request virtual machines, fabric administrators must create
network profiles to define the subnet and routing configuration for those virtual machines. Each
network profile is configured for a specific network port group or virtual network to specify the IP
address and the routing configuration for virtual machines provisioned to that network.

11 Create Reservations for the Compute Cluster in Region A

Before members of a business group can request machines, as a fabric administrator, you must
allocate resources to them by creating a reservation. Each reservation is configured for a specific
business group to grant them access to request machines on a specified compute resource.

12 Create Reservations for the User Edge Resources in Region A

Before members of a business group can request virtual machines, as a fabric administrator, you
must allocate NSX Edge resources to that business group by creating a reservation. Each
reservation is configured for a specific business group to grant them access to request virtual
machines on a specified compute resource.

13 Create Blueprint Customization Specifications in Compute vCenter Server in Region A

Create two customization specifications, one for Linux and one for Windows, for use by the virtual
machines you deploy. Customization specifications are XML files that contain system configuration
settings for the guest operating systems used by virtual machines. When you apply a specification to
a guest operating system during virtual machine cloning or deployment, you prevent conflicts that
might result if you deploy virtual machines with identical settings, such as duplicate computer
names.

14 Create Virtual Machines Using VM Templates in the Content Library in Region A

vRealize Automation cannot directly access virtual machine templates in the content library. You
must create a virtual machine using the virtual machine templates in the content library, then convert
the template in vCenter Server. Perform this procedure on all vCenter Server compute clusters that
you add to vRealize Automation, including the first vCenter Server compute instance.
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15 Convert Virtual Machines to VM Templates in Region A

You need to convert the virtual machines directly to templates instead of making a copy by cloning.

16 Configure Single Machine Blueprints in Region A

Virtual machine blueprints determine a machine’s attributes, the manner in which it is provisioned,
and its policy and management settings. 

Create Logical Switches for Business Groups in Region A
For each vCenter Server compute instance, you create three logical switches for each business group
which simulate networks for the web, database, and application tiers.

You repeat this procedure six times to create six logical switches.

Table 4‑9.  Logical Switch Names and Descriptions

Logical Switch Name Description

Production-Web-VXLAN Logical switch for the Web tier of Product Business Group

Production-DB-VXLAN Logical switch for the Database tier of Product Business Group

Production-App-VXLAN Logical switch for the Application tier of Product Business
Group

Development-Web-VXLAN Logical switch for the Web tier of Development Business Group

Development-DB-VXLAN Logical switch for the Database tier of Development Business
Group

Development-App-VXLAN Logical switch for the Application tier of Development Business
Group

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Create a logical switch.

a Click Networking & Security.

b In the Navigator, select Logical Switches.

c From the NSX Manager drop-down menu, select 172.16.11.66 as the NSX Manager.
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d Click the New Logical Switch icon.

The New Logical Switch dialog box appears.

e In the New Logical Switch dialog box, enter the following settings, and click OK.

Setting Value

Name Production-Web-VXLAN

Description Logical switch for Web tier of Production Business Group

Transport Zone Comp Universal Transport Zone

Replication Mode Hybrid

Enable IP Discovery Selected

Enable MAC Learning Deselected

3 Repeat this procedure to create the remaining logical switches.

Configure User Roles in vRealize Automation in Region A
You assign user roles in the context of a specific tenant. However, some roles for the default tenant can
manage system-wide configuration settings that apply to multiple tenants.

Roles are sets of privileges that you associate with users to determine what tasks they can perform.
Based on their responsibilities, individuals might have one or more roles associated with their user
account. You assign tenant architect and administrator roles to the ug-vra-admins-rainpole and ug-vra-
archs-rainpole user groups.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 On the Administration tab, navigate to Users & Groups > Directory Users and Groups. 

3 Enter ug-vra-admins-rainpole in the search box and press Enter.

The ug-vra-admins-rainpole (ug-vra-admins-rainpole@rainpole.local) group name appears in the
Name text box.

4 Click the ug-vra-admins-rainpole (ug-vra-admins-rainpole@rainpole.local) user group. 

5 In the Add Roles to this Group list, select the following roles, and click Finish.

n Application Architect

Deployment for Region A

VMware, Inc.  330



n Approval Administrator

n Business Management Administrator

n Business Management Controller

n Catalog Administrator

n Container Administrator

n Container Architect

n Infrastructure Architect

n Software Architect

n Tenant Administrator

n XaaS Architect

6 Search for ug-vra-archs-rainpole in the Tenant Administrators search box . 

The ug-vra-archs-rainpole (ug-vra-archs-rainpole@rainpole.local) group appears in the Name
text box.

7 Click the ug-vra-archs-rainpole (ug-vra-archs-rainpole@rainpole.local) user group. 

8 In the Add Roles to this Group list, select the following user groups, and click Finish.

n Application Architect

n Container Architect

n Infrastructure Architect

n Software Architect

n XaaS Architect

Create Fabric Groups in Region A
IaaS administrators can organize virtualization compute resources and cloud endpoints into fabric groups
by type and intent. One or more fabric administrators manage the resources in each fabric group.

Fabric administrators are responsible for creating reservations on the compute resources in their groups
to allocate fabric resources to specific business groups. Fabric groups are created in a specific tenant, but
their resources can be made available to users who belong to business groups in all tenants.
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Select Infrastructure > Endpoints > Fabric Groups. 

3 Click New, enter the following settings in the New Fabric Group window, and click OK.

Setting Value

Name SFO Fabric Group

Fabric administrators ug-vra-admins-rainpole@rainpole.local

You have not yet configured a vCenter Endpoint, so no compute resource is available for you to
select. You configure the vCenter Endpoint later.

Create Machine Prefixes in Region A
As a fabric administrator, you create machine prefixes that are used to create names for machines
provisioned through vRealize Automation. Tenant administrators and business group managers select
these machine prefixes and assign them to provisioned machines through blueprints and business group
defaults.

Machine prefixes are shared across all tenants. Every business group has a default machine prefix. Every
blueprint must have a machine prefix or use the group default prefix. Fabric administrators are
responsible for managing machine prefixes. A prefix consists of a base name to be followed by a counter
of a specified number of digits. When the digits are all used, vRealize Automation rolls back to the first
number.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Select Infrastructure > Administration > Machine Prefixes.
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3 Click the New icon to create a default machine prefix for the Production group using the following
settings, and click the Save icon.

Setting Value

Name Prod-

Number of Digits 5

Next Number 1

4 Click the New icon to create a default machine prefix for the Development group using the following
settings, and click the Save icon.

Setting Value

Name Dev-

Number of Digits 5

Next Number 1

Create Business Groups in Region A
Tenant administrators create business groups to associate a set of services and resources to a set of
users that often correspond to a line of business, department, or other organizational unit. Users must
belong to a business group to request machines.

For this implementation create two business groups, the Production business group and the Development
business group.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Administration > Users and Groups > Business Groups.

3 Click the New icon.

4 On the General tab, enter the following values and click Next.

Setting Value

Name Production

Send capacity alert emails to vra-admin-rainpole@rainpole.local
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5 On the Members tab, enter ug-vra-admins-rainpole@rainpole.local in the Group manager
role text box, press Enter, select the displayed group and click Next.

6 On the Infrastructure tab, select Prod- from the Default machine prefix drop-down menu and click
Finish.

7 Click the New icon.

8 On the General tab, configure the following values, and click Next. 

Setting Value

Name Development

Send capacity alert emails to vra-admin-rainpole@rainpole.local

9 On the Members tab, enter ug-vra-admins-rainpole@rainpole.local in the Group manager
role text box and click Next. 

10 On the Infrastructure tab, select Dev- from the Default machine prefix drop-down menu, and
click Finish.

Create Reservation Policies in Region A
You use reservation policies to group similar reservations together. Create the reservation policy tag first,
then add the policy to reservations to allow a tenant administrator or business group manager to use the
reservation policy in a blueprint.

When you request a machine, it can be provisioned on any reservation of the appropriate type that has
sufficient capacity for the machine. You can apply a reservation policy to a blueprint to restrict the
machines provisioned from that blueprint to a subset of available reservations. A reservation policy is
often used to collect resources into groups for different service levels, or to make a specific type of
resource easily available for a particular purpose. A reservation policy can include reservations of
different types, but only reservations that match the blueprint type are considered when selecting a
reservation for a particular request.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Reservations > Reservation Polices.
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3 Click the New icon, configure the following settings, and click OK.

Setting Value

Name SFO-Production-Policy

Type Reservation Policy

Description Reservation policy for Production Business Group in SFO

4 Click the New icon, configure the following settings, and click OK.

Setting Value

Name SFO-Development-Policy

Type Reservation Policy

Description Reservation policy for Development Business Group in SFO

5 Click the New icon, configure the following settings, and click OK.

Setting Value

Name SFO-Edge-Policy

Type Reservation Policy

Description Reservation policy for Tenant Edge resources in SFO

Create a vSphere Endpoint in vRealize Automation in Region A
As an IaaS administrator, to allow vRealize Automation to manage the infrastructure, create endpoints
and configure user credentials for those endpoints. When you create a vSphere Endpoint, vRealize
Automation can communicate with the vSphere environment and discover vCenter Server-managed
compute resources, collect data, and provision machines.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Endpoints > Endpoints, and click New > Virtual > vSphere (vCenter).
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3 On the New Endpoint - vSphere (vCenter) page, create a vSphere Endpoint with the following
settings, and click Test Connection.

Setting Value

Name sfo01w01vc01.sfo01.rainpole.local

Address https://sfo01w01vc01.sfo01.rainpole.local/sdk

User Name rainpole\svc-vra

Password svc-vra_password

Note   The vSphere Endpoint name must be identical to the Endpoint name previously referenced in
Configure vRealize Suite Lifecycle Manager to Deploy the Cloud Management Applications.

4 If a Security Alert window appears, click OK.

5 Click OK to create the Endpoint.

Create an NSX Endpoint in vRealize Automation in Region A
When you create an endpoint for NSX for the shared edge and compute cluster, vRealize Automation can
communicate with NSX Manager to discover networking resources.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Endpoints > Endpoints and click New > Network and Security >
NSX.

3 On the General page, configure the vRealize Automation Endpoint with the following settings.

Setting Value

Name SFO-NSXEndpoint

Address https://sfo01w01nsx01.sfo01.rainpole.local

User Name rainpole\svc-vra

Password svc-vra_password

4 Click the Associations tab, click New, select sfo01m01vc01.sfo01.rainpole.local from the Name
drop-down menu, and click OK.
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5 Click Test Connection.

6 If a Security Alert window appears, click OK.

7 Click OK.

Add Compute Resources to a Fabric Group in Region A
You allocate compute resources to fabric groups so that vRealize Automation can use the resources in
that compute resource for that fabric group when provisioning virtual machines.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Endpoints > Fabric Groups.

3 In the Name column, point to the fabric group name SFO Fabric Group, and click Edit.

4 On the Edit Fabric Group page, select sfo01-w01-comp01 from the Compute resources table, and
click OK.

Note   It might take several minutes for vRealize Automation to connect to the Compute vCenter
Server system and associated clusters. If you are unable to see the compute cluster after sufficient
time has passed, restart both proxy agent services in the virtual
machines sfo01ias01a.sfo01.rainpole.local and sfo01ias01b.sfo01.rainpole.local.

5 Navigate to Infrastructure > Compute Resources > Compute Resources. 

6 In the Name column, point to the compute cluster sfo01-w01-comp01, and click Data Collection.

7 Click the Request now buttons in each field on the page.

Wait for the data collection process to complete.

8 Click Refresh, and verify that Status for both Inventory and Network and Security Inventory
shows Succeeded.

Deployment for Region A

VMware, Inc.  337



Create External Network Profiles in Region A
Before members of a business group can request virtual machines, fabric administrators must create
network profiles to define the subnet and routing configuration for those virtual machines. Each network
profile is configured for a specific network port group or virtual network to specify the IP address and the
routing configuration for virtual machines provisioned to that network.

Repeat this procedure six times to create the following external network profiles.

n Ext-Net-Profile-Production-App

n Ext-Net-Profile-Production-DB

n Ext-Net-Profile-Production-Web

n Ext-Net-Profile-Development-App

n Ext-Net-Profile-Development-DB

n Ext-Net-Profile-Development-Web

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Reservations > Network Profiles, and click New > External.
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3 On the New Network Profile - External page, specify the network profiles on the General tab.

a Add the values for the Production Group External Network Profile.

Setting Production Web Value Production DB Value Production App Value

Name Ext-Net-Profile-Production-Web Ext-Net-Profile-Production-DB Ext-Net-Profile-Production-App

Description External Network profile for Web
Tier of Production Business
Group

External Network profile for DB
Tier of Production Business
Group

External Network profile for App
Tier of Production Business
Group

Subnet mask 255.255.255.0 255.255.255.0 255.255.255.0

Gateway 172.11.10.1 172.11.11.1 172.11.12.1

b Add the values for the Development Group External Network Profile.

Setting Development Web Value Development DB Value Development App Value

Name Ext-Net-Profile-Development-
Web

Ext-Net-Profile-Development-
DB

Ext-Net-Profile-Development-
App

Description External Network profile for Web
Tier of Development Business
Group

External Network profile for DB
Tier of Development Business
Group

External Network profile for App
Tier of Development Business
Group

Subnet mask 255.255.255.0 255.255.255.0 255.255.255.0

Gateway 172.12.10.1 172.12.11.1 172.12.12.1

4 On the DNS tab, enter the following values for the profile you are creating.

Setting Value

Primary DNS 172.16.11.4

Secondary DNS 172.17.11.4

DNS suffix sfo01.rainpole.local

DNS search suffixes sfo01.rainpole.local

5 Click the Network Ranges tab.
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6 On the Network Ranges tab, click the New button and enter the following values for the profile you
are creating.

a Enter the following values for Production Business Network Range.

Setting Production Web Value Production DB Value Production App Value

Name Production-Web Production-DB Production-App

Description Static IP range for Web Tier of
Production Group

Static IP range for DB Tier of
Production Group

Static IP range for App Tier of
Production Group

Start IP 172.11.10.20 172.11.11.20 172.11.12.20

End IP 172.11.10.250 172.11.11.250 172.11.12.250

b Enter the following values for Development Business Network Range.

Setting Development Web Value Development DB Value Development App Value

Name Development-Web Development-DB Development-App

Description Static IP range for Web Tier of
Development Group

Static IP range for DB Tier of
Development Group

Static IP range for App Tier of
Development Group

Start IP 172.12.10.20 172.12.11.20 172.12.12.20

End IP 172.12.10.250 172.12.11.250 172.12.12.250

c Click OK to save the network range.

7 Click OK to save the network profile.

8 Repeat this procedure to create additional external network profiles.

When all the network profiles have been added, the Network Profiles page displays six profiles.

Create Reservations for the Compute Cluster in Region A
Before members of a business group can request machines, as a fabric administrator, you must allocate
resources to them by creating a reservation. Each reservation is configured for a specific business group
to grant them access to request machines on a specified compute resource.

For the scenarios, you perform this procedure twice to create reservations for both the Production and
Development business groups.

Group Name

Production SFO01-Comp01-Prod-Res01

Development SFO01-Comp01-Dev-Res01
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Infrastructure > Reservations > Reservations, and click New > vSphere (vCenter).

3 On the New Reservation - vSphere (vCenter) page, click the General tab and configure the
following values.

Setting Production Group Value Development Group Value

Name SFO01-Comp01-Prod-Res01 SFO01-Comp01-Dev-Res01

Tenant rainpole rainpole

Business Group Production Development

Reservation Policy SFO-Production-Policy SFO-Development-Policy

Priority 100 100

Enable This Reservation Selected Selected

4 On the New Reservation - vSphere (vCenter) page, click the Resources tab.

a Select sfo01-w01-comp01(sfo01w01vc01.sfo01.rainpole.local) from the Compute resource
drop-down menu.

b In the This Reservation column of the Memory (GB) table, enter 200.

c In the Storage (GB) table, select the check box for your primary datastore, for example, sfo01-
w01-lib01, enter 2000 in the This Reservation Reserved text box, enter 1 in the Priority text
box, and click OK.

d Select sfo01-w01rp-user-vm from the Resource pool drop-down menu.

5 On the New Reservation - vSphere (vCenter) page, click the Network tab.
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6 On the Network tab, select the network path check boxes listed in the following table from the
Network Paths list, and select the corresponding network profile from the Network Profile drop-
down menu for the business group whose reservation you are configuring.

a Configure the Production Business Group with the following values.

Production Network Path Production Group Network Profile

vxw-dvs-xxxxx-Production-Web-VXLAN Ext-Net-Profile-Production-Web

vxw-dvs-xxxxx-Production-DB-VXLAN Ext-Net-Profile-Production-DB

vxw-dvs-xxxxx-Production-App-VXLAN Ext-Net-Profile-Production-App

b Configure the Development Business Group with the following values.

Development Network Path Development Group Network Profile

vxw-dvs-xxxxx-Development-Web-VXLAN Ext-Net-Profile-Development-Web

vxw-dvs-xxxxx-Development-DB-VXLAN Ext-Net-Profile-Development-DB

vxw-dvs-xxxxx-Development-App-VXLAN Ext-Net-Profile-Development-App

7 Click OK to save the reservation.

8 Repeat this procedure to create a reservation for the Development Business Group.

Create Reservations for the User Edge Resources in Region A
Before members of a business group can request virtual machines, as a fabric administrator, you must
allocate NSX Edge resources to that business group by creating a reservation. Each reservation is
configured for a specific business group to grant them access to request virtual machines on a specified
compute resource.

Perform this procedure twice to create Edge reservations for both the Production and Development
business groups.

Group Name

Production SFO01-Edge01-Prod-Res01

Development SFO01-Edge01-Dev-Res01

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local
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2 Navigate to Infrastructure > Reservations > Reservations, and click New > vSphere (vCenter).

3 On the New Reservation - vSphere (vCenter) page, click the General tab, and configure the
following values for your business group.

Setting Production Group Value Development Group Value

Name SFO01-Edge01-Prod-Res01 SFO01-Edge01-Dev-Res01

Tenant rainpole rainpole

Business Group Production Development

Reservation Policy SFO-Edge-Policy SFO-Edge-Policy

Priority 100 100

Enable This Reservation Selected Selected

4 On the New Reservation - vSphere (vCenter) page, click the Resources tab.

a Select sfo01-w01-comp01(sfo01w01vc01.sfo01.rainpole.local) from the Compute resource
drop-down menu.

b Enter 200 in the This Reservation column of the Memory (GB) table.

c In the Storage (GB) table, select the check box for your primary datastore, for example, sfo01-
w01-vsan01, enter 2000 in the This Reservation Reserved text box, enter 1 in the Priority text
box, and click OK.

d Select sfo01-w01rp-user-edge from the Resource pool drop-down menu.

5 On the New Reservation - vSphere (vCenter) page, click the Network tab.

6 On the Network tab, select the network path check boxes listed in the following tables from the
Network Paths list, and select the corresponding network profile from the Network Profile drop-down
menu for the business group whose reservation you are configuring.

Production Business Group

Production Port Group Production Network Profile

vxw-dvs-xxxxx-Production-Web-VXLAN Ext-Net-Profile-Production-Web

vxw-dvs-xxxxx-Production-DB-VXLAN Ext-Net-Profile-Production-DB

vxw-dvs-xxxxx-Production-App-VXLAN Ext-Net-Profile-Production-App

Development Business Group

Development Port Group Development Network Profile

vxw-dvs-xxxxx-Development-Web-VXLAN Ext-Net-Profile-Development-Web

vxw-dvs-xxxxx-Development-DB-VXLAN Ext-Net-Profile-Development-DB

vxw-dvs-xxxxx-Development-App-VXLAN Ext-Net-Profile-Development-App

 

7 Click OK to save the reservation.
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8 Repeat the procedure to create an Edge reservation for the Development Business Group. 

Create Blueprint Customization Specifications in Compute
vCenter Server in Region A
Create two customization specifications, one for Linux and one for Windows, for use by the virtual
machines you deploy. Customization specifications are XML files that contain system configuration
settings for the guest operating systems used by virtual machines. When you apply a specification to a
guest operating system during virtual machine cloning or deployment, you prevent conflicts that might
result if you deploy virtual machines with identical settings, such as duplicate computer names.

You will later use the customization specifications you create when you create blueprints for use with
vRealize Automation.

Create a Customization Specification for Linux Blueprints in Region A
Create a Linux guest operating system specification that you can apply when you create blueprints for
use with vRealize Automation. This customization specification can be used to customize virtual machine
guest operating systems when provisioning new virtual machines from vRealize Automation. 

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to Home > Policies and Profiles > Customization Specification Manager.

3 Select the vCenter Server sfo01w01vc01.sfo01.rainpole.local from the drop-down menu.

4 Click the Create a new specification icon.

The New VM Guest Customization Spec wizard appears.

5 On the Specify Properties page, select Linux from the Target VM Operating System drop-down
menu, enter os-linux-custom-spec for the Customization Spec Name, and click Next. 

6 On the Set Computer Name page, select Use the virtual machine name, enter
sfo01.rainpole.local in the Domain Name text box, and click Next.
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7 On the Time Zone page, specify the time zone as shown in the following table for the virtual machine,
and click Next.

Setting Value

Area America

Location Los Angeles

Hardware Clock Set To Local Time

8 On the Configure Network page, click Next. 

9 On the Enter DNS and domain settings page, leave the default settings, and click Next.

10 Click Finish to save your changes.

The customization specification that you created is listed in the Customization Specification
Manager.

Create a Customization Specification for Windows Blueprints in Region A
Create a Windows guest operating system specification that you can apply when you create blueprints for
use with vRealize Automation. This customization specification can be used to customize virtual machine
guest operating systems when provisioning new virtual machines from vRealize Automation. 

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to Home > Policies and Profiles > Customization Specification Manager.

3 Select the vCenter Server sfo01w01vc01.sfo01.rainpole.local from the drop-down menu.

4 Click the Create a new specification icon. 

The New VM Guest Customization wizard appears.

5 On the Specify Properties page, select Windows from the Target VM Operating System drop-
down menu, enter os-windows-joindomain-custom-spec for the Customization Spec Name, and
click Next.

6 On the Set Registration Information  page, enter Rainpole for the virtual machine owner’s Name
and Organization, and click Next.

Deployment for Region A

VMware, Inc.  345



7 On the Set Computer Name page, select Use the virtual machine name, and click Next.

The operating system uses this name to identify itself on the network.

8 On the Enter Windows License page, provide licensing information for the Windows operating
system, enter the volume_license_key, and click Next.

9 Specify the administrator password for use with the virtual machine, and click Next.

10 On the Time Zone page, select (GMT-08:00) Pacific Time(US & Canada), and click Next.

11 On the Run Once page, click Next. 

12 On the Configure Network page, click Next.

13 On the Set Workgroup or Domain page, select Windows Server Domain, configure the following
settings, and click Next.

Setting Value

Windows Server Domain sfo01.rainpole.local

Username svc-domain-join@rainpole.local

Password svc-domain-join_password

14 On the Set Operating System Options page, select Generate New Security ID (SID), and
click Next.

15 Click Finish to save your changes.

The customization specification that you created is listed in the Customization Specification
Manager.

Create Virtual Machines Using VM Templates in the Content
Library in Region A
vRealize Automation cannot directly access virtual machine templates in the content library. You must
create a virtual machine using the virtual machine templates in the content library, then convert the
template in vCenter Server. Perform this procedure on all vCenter Server compute clusters that you add
to vRealize Automation, including the first vCenter Server compute instance.

Repeat this procedure three times for each of the VM Templates in the content library. The table below
lists the VM Templates and the guest OS each template uses to create a virtual machine.

VM Template Name Guest OS

redhat6-enterprise-64 Red Hat Enterprise Server 6 (64-bit)

windows-2012r2-64 Windows Server 2012 R2 (64-bit)

windows-2012r2-64-sql2012 Windows Server 2012 R2 (64-bit)
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Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 From the Home menu, select VMs and Templates.

3 Expand the sfo01w01vc01.sfo01.rainpole.local vCenter Server.

4 Right-click the sfo01-w01dc data center and select New Folder > New VM and Template Folder. 

5 Enter the folder name as VM Templates. 

6 Navigate to Home > Content Libraries. 

7 Click sfo01-w01cl-vra01 > Templates.

8 Right-click the VM Template redhat6-enterprise-64 and click New VM from This Template.

The New Virtual Machine from Content Library wizard opens.

9 On the Select name and location page, use the same template name.  

Note   Use the same template name to create a common service catalog that works across different
vCenter Server instances within your datacenter environment.

10 Select VM Templates as the folder for this virtual machine, and click Next.

11 On the Select a resource page, expand cluster sfo01-w01-comp01, select resouce pool sfo01-
w01rp-user-vm, and click Next.

12 On the Review details page, verify the template details and click Next.

13 On the Select storage page, select the sfo01-w01-lib01 datastore, select Thin Provision from the
Select virtual disk format drop-down menu, and click Next.

14 On the Select networks page, select sfo01-w01-vds01-management for the Destination Network,
and click Next.

Note   vRealize Automation changes the network according to the blueprint configuration.

15 On the Ready to complete page, review the configurations that you made for the virtual machine,
and click Finish.

A new task for creating the virtual machine appears in the Recent Tasks pane. After the task is
complete, the new virtual machine is created.
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16 Repeat this procedure for all the VM Templates in the content library.

Convert Virtual Machines to VM Templates in Region A
You need to convert the virtual machines directly to templates instead of making a copy by cloning.

Repeat this procedure for each of the VM Templates in the content library. The table below lists the VM
Templates and the guest OS that each template uses to create a virtual machine.

VM Template Name Guest OS

redhat6-enterprise-64 Red Hat Enterprise Server 6 (64-bit)

windows-2012r2-64 Windows Server 2012 R2 (64-bit)

windows-2012r2-64-sql2012 Windows Server 2012 R2 (64-bit)

Procedure

1 Log in to the Compute vCenter Server by using the vSphere Web Client.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

2 Navigate to Home > VMs and Templates.

3 In the Navigator pane, expand sfo01w01vc01.sfo01.rainpole.local > sfo01-w01dc > VM
Templates.

4 Right-click the redhat6-enterprise-64 virtual machine located in the VM Templates folder, and
click Template > Convert to Template.

5 Click Yes to confirm the template conversion.

6 Repeat this procedure for all of the VM Templates in the content library, verifying that each VM
Template appears in the VM Templates folder.

Configure Single Machine Blueprints in Region A
Virtual machine blueprints determine a machine’s attributes, the manner in which it is provisioned, and its
policy and management settings. 

Procedure

1 Create a Service Catalog in Region A

A service catalog provides a common interface for consumers of IT services to request services,
track their requests, and manage their provisioned service items.   
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2 Create a Single Machine Blueprint in Region A

Create blueprints for cloning the virtual machine templates using the specified resources on the
Compute vCenter Server. Tenants can later use these blueprints for automatic provisioning. A
blueprint is the complete specification for a virtual, cloud, or physical machine. Blueprints determine
a machine's attributes, the manner in which it is provisioned, and its policy and management
settings. 

3 Create Entitlements for Business Groups in Region A

You add a service, catalog item, or action to an entitlement, allowing the users and groups identified
in the entitlement to request provisionable items in the service catalog. The entitlement allows
members of a particular business group (for example, the Production business group) to use the
blueprint. Without the entitlement, users cannot use the blueprint. 

4 Configure Entitlements for Blueprints in Region A

You entitle users to the actions and items that belong to the service catalog by associating each
blueprint with an entitlement.

5 Test the Deployment of a Single Machine Blueprint in Region A

Test your environment and confirm the successful provisioning of virtual machines using the newly
created blueprints. If multiple availability zones have been configured, you must manually place all
the virtual machines provisioned by vRealize Automation into the appropriate VM group for the
availability zone.

Create a Service Catalog in Region A
A service catalog provides a common interface for consumers of IT services to request services, track
their requests, and manage their provisioned service items.   

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to the Administration tab, click Catalog Management > Services, and click New.

The New Service page appears.
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3 In the New Service page, configure the following settings and click OK.

Setting Value

Name SFO Service Catalog

Description Default setting (blank)

Status Active

Icon Default setting (blank)

Status Default setting (blank)

Hours Default setting (blank)

Owner Default setting (blank)

Support Team Default setting (blank)

Change Window Default setting (blank)

Create a Single Machine Blueprint in Region A
Create blueprints for cloning the virtual machine templates using the specified resources on the Compute
vCenter Server. Tenants can later use these blueprints for automatic provisioning. A blueprint is the
complete specification for a virtual, cloud, or physical machine. Blueprints determine a machine's
attributes, the manner in which it is provisioned, and its policy and management settings. 

Repeat this procedure to create the following three blueprints.

Blueprint Name VM Template
Customization
Specification

Reservation
Policy

Windows Server 2012
R2 - SFO Prod

windows-2012r2-64
(sfo01m01vc01.sfo01.rainpole.local)

os-windows-joindomain-
custom-spec

SFO-Production-
Policy

Windows Server 2012
R2 With SQL2012 -
SFO Prod

windows-2012r2-64-
sql2012(sfo01m01vc01.sfo01.rainpole.local)

os-windows-joindomain-
custom-spec

SFO-Production-
Policy

Redhat Enterprise
Linux 6 - SFO Prod

redhat6-
enterprise-64(sfo01m01vc01.sfo01.rainpole.local)

os-linux-custom-spec SFO-Production-
Policy

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Design > Blueprints and click New. 
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3 In the New Blueprint dialog box, on the General tab, configure the following settings, and click OK.

Setting Value

Name Windows Server 2012 R2 - SFO Prod

Deployment limit Default setting (blank)

Lease (days): Minimum 30

Lease (days): Maximum 270

Archive (days) 15

4 Select the vSphere (vCenter) Machine icon and drag it in the Design Canvas.

5 Click the General tab, configure the following settings and click Save.

Setting Default

ID Default setting (vSphere_vCenter_Machine_1)

Description Default setting (blank)

Display location on request Deselected

Reservation policy SFO-Production-Policy

Machine prefix Use group default

Instances: Minimum Default setting

Instances: Maximum Default setting

6 Click the Build Information tab, configure the following settings and click Save.

Setting Value

Blueprint type Server

Action Clone

Provisioning workflow CloneWorkflow

Clone from windows-2012r2-64

Customization spec os-windows-joindomain-custom-spec

Note   If the value of the Clone from setting does not list windows-2012r2-64 template, you must
perform a data collection on the sfo01-w01-comp01 Compute Resource.

7 Click the Machine Resources tab, configure the following settings and click Save.

Setting Minimum Maximum

CPUs 2 4

Memory (MB) 4096 16384

Storage (GB) Default setting Default setting
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8 Click the Network tab.

a In the Categories section, select Network & Security to display the list of available network and
security components.

b Select the Existing Network component and drag it in the Design Canvas.

c Click the Existing network object and on the General tab, select the Ext-Net-Profile-
Production-Web network profile.

Blueprint Name Existing network

Windows Server 2012 R2 - SFO Prod Ext-Net-Profile-Production-Web

Windows Server 2012 R2 With SQL2012 - SFO Prod Ext-Net-Profile-Production-DB

Redhat Enterprise Linux 6 - SFO Prod Ext-Net-Profile-Production-App

d Click Save.

e In the Design Canvas, select the vSphere_vCenter_Machine object.

f Select the Network tab, click New, configure the following settings and click OK.

Network Assignment Type Address

Ext-Net-Profile-Production-Web Static IP Default setting (blank)

Ext-Net-Profile-Production-DB Static IP Default setting (blank)

Ext-Net-Profile-Production-App Static IP Default setting (blank)

g Click Finish to save the blueprint.

9 Select the blueprint Windows Server 2012 R2 - SFO Prod and click Publish.

10 Repeat this procedure to create additional blueprints.

Note   To test blueprints in a development environment, or according to your business needs, create
Development blueprints using the same process as for Production blueprints.

Create Entitlements for Business Groups in Region A
You add a service, catalog item, or action to an entitlement, allowing the users and groups identified in the
entitlement to request provisionable items in the service catalog. The entitlement allows members of a
particular business group (for example, the Production business group) to use the blueprint. Without the
entitlement, users cannot use the blueprint. 

Perform this procedure to create an entitlement for the Production business group.

Entitlement Name Status Business Group User & Groups

Prod-SingleVM-Entitlement Active Production ug-vra-admins-rainpole
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Click the Administration tab, and click Catalog Management > Entitlements.

3 Click New.

The New Entitlement page appears.

4 On the New Entitlement page, select the General tab, configure the following values, and click Next.

Setting Value

Name Prod-SingleVM-Entitlement

Description Default setting (blank)

Expiration Date Default setting (blank)

Status Active

Business Group Production

All Users and Groups Unselected

Users & Groups ug-vra-admins-rainpole
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5 Under the Items & Approvals tab.

a On the Entitled Actions page, click the Add Actions icon, add the following actions, and click
OK.

n Connect using RDP (Machine)

n Power Cycle (Machine)

n Power Off (Machine)

n Power On (Machine)

n Reboot (Machine)

n Shutdown (Machine)

b Click Finish.
 

 

Configure Entitlements for Blueprints in Region A
You entitle users to the actions and items that belong to the service catalog by associating each blueprint
with an entitlement.

Repeat this procedure to associate the blueprints with their entitlement.

Blueprint Name Service Catalog Add to Entitlement

Windows Server 2012 R2 - SFO Prod SFO Service Catalog Prod-SingleVM-Entitlement

Windows Server 2012 R2 With SQL2012 - SFO Prod SFO Service Catalog Prod-SingleVM-Entitlement

Redhat Enterprise Linux 6 - SFO Prod SFO Service Catalog Prod-SingleVM-Entitlement
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Select the Administration tab and navigate to Catalog Management >  Catalog Items.

3 On the Catalog Items pane, select the Windows Server 2012 R2 - SFO Prod blueprint in the
Catalog Items list and click Configure.

4 On the General  tab of the Configure Catalog Item dialog box, select SFO Service Catalog from
the Service drop-down menu, and click OK.

5 Associate the blueprint with the Prod-SingleVM-Entitlement entitlement.

a Click Entitlements and select Prod-SingleVM-Entitlement.

The Edit Entitlement pane appears.

b Select the Items & Approvals tab, add the Windows Server 2012 R2 - SFO Prod blueprint to
the Entitled Items list, and click OK.

c Click Finish.

6 Select the Catalog tab and verify that the blueprints are listed in the Service Catalog.

7 Repeat this procedure to associate all the blueprints with their entitlements.

Test the Deployment of a Single Machine Blueprint in Region A
Test your environment and confirm the successful provisioning of virtual machines using the newly
created blueprints. If multiple availability zones have been configured, you must manually place all the
virtual machines provisioned by vRealize Automation into the appropriate VM group for the availability
zone.
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Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Select the Catalog tab, and click SFO Service Catalog from the catalog of available services.

3 Click the Request button for the Windows Server 2012 R2 - SFO Prod blueprint.

4 Click Submit.

5 Verify the request finishes successfully.

a Select the Requests tab.

b Select the request you submitted and wait several minutes for the request to complete.

Click the Refresh icon every few minutes until a Successful message appears under Status.

c Click View Details.

d Under Status Details, verify that the virtual machine successfully provisioned.

6 Verify that the virtual machine provisions in the shared edge and compute cluster.

a Open a Web browser and go to
https://sfo01w01vc01.sfo01.rainpole.local/vsphere-client .

b Log in using the following credentials.

Setting Value

User name administrator@vsphere.local

Password vsphere_admin_password

c Select Home > Hosts and Clusters.

d In the Navigator panel, expand the vCenter Server cluster sfo01w01vc01.sfo01.rainpole.local >
sfo01-w01-comp01 > sfo01-w01rp-user-vm, and verify the existence of the virtual machine.

Operations Management Configuration for Cloud
Management in Region A
After you install the Cloud Management Platform, enable its integration with the operations management
layer. You can monitor and receive alerts and logs about the platform to a central location by using
vRealize Operations Manager and vRealize Log Insight.
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Procedure

1 Connect vRealize Operations Manager to vRealize Automation in Region A

Configure the vRealize Operations Manager Management Pack for vRealize Automation to monitor
the health and capacity risk of your cloud infrastructure in the context of the tenant's business
groups.

2 Configure vRealize Business Adapter in vRealize Operations Manager in Region A

Configure a vRealize Business for Cloud adapter to collect monitoring data from vRealize Business
for Cloud in vRealize Operations Manager.

3 Connect vRealize Log Insight to vRealize Automation in Region A

Connect vRealize Log to vRealize Automation to receive log information from all components of
vRealize Automation in the vRealize Log Insight user interface. 

Connect vRealize Operations Manager to vRealize Automation in
Region A
Configure the vRealize Operations Manager Management Pack for vRealize Automation to monitor the
health and capacity risk of your cloud infrastructure in the context of the tenant's business groups.

The vRealize Operations Manager Management Pack for vRealize Automation is installed by default on
the version of vRealize Operations Manager in this validated design.

Procedure

1 Start Collecting of Metrics from vRealize Automation in to vRealize Operations Manager in Region A

Connect vRealize Automation to vRealize Operations Manager for collecting statistics about the
tenant workloads that are provisioned by using vRealize Automation.

2 Configure Integration of vRealize Operations Manager with vRealize Automation for Workload
Reclamation in Region A

Connect vRealize Automation to vRealize Operations Manager to collect metrics that vRealize
Automation can use to identify tenant workloads for reclamation in Region A. Such workloads have
low use of CPU, memory use, or disk space.

Start Collecting of Metrics from vRealize Automation in to vRealize
Operations Manager in Region A
Connect vRealize Automation to vRealize Operations Manager for collecting statistics about the tenant
workloads that are provisioned by using vRealize Automation.
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Procedure

1 Configure User Privileges on vRealize Automation for Integration with vRealize Operations Manager
in Region A

Assign the permissions that are required to access monitoring data from the vRealize Automation in
vRealize Operations Manager to the svc-vrops-vra operations service account. The svc-vrops-vra
user has rights that are specifically required for access to vRealize Automation in vRealize
Operations Manager.

2 Add a vRealize Automation Adapter to vRealize Operations Manager in Region A

Configure a vRealize Automation adapter in vRealize Operations Manage to collect monitoring data
from vRealize Automation.

Configure User Privileges on vRealize Automation for Integration with vRealize Operations
Manager in Region A

Assign the permissions that are required to access monitoring data from the vRealize Automation in
vRealize Operations Manager to the svc-vrops-vra operations service account. The svc-vrops-vra user
has rights that are specifically required for access to vRealize Automation in vRealize Operations
Manager.

Procedure

1 Log in to the vRealize Automation portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac.

b Log in using the following credentials.

Setting Value

User name administrator

Password deployment_admin_password

Domain vsphere.local

2 On the Tenants tab, click the Rainpole tenant.

3 Click the Administrators tab to assign Tenant administrator and IaaS administrator roles to the
svc-vrops-vra service account.

a Enter svc-vrops-vra in the Tenant administrators search text box, click the Search icon, and
click svc-vrops-vra (svc-vrops-vra@rainpole.local) user that shows in the search result list to
assign the role to the account.

b Enter svc-vrops-vra in the IaaS administrators search text box, click the Search icon, and
click svc-vrops-vra (svc-vrops-vra@rainpole.local) user that shows in the search result list to
assign the role to the account.

c Click Finish.

4 Log out of the vRealize Automation portal for the default tenant.
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5 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

6 Navigate to Administration > Users & Groups > Directory Users and Groups to assign the
Software Architect role to the svc-vrops-vra service account.

a Enter svc-vrops-vra in the search box, click the Search icon and click the svc-vrops-vra (svc-
vrops-vra@rainpole.local) user.

The settings for the svc-vrops-vra account appear.

b On the General tab, select Infrastructure Architect and Software Architect under Add roles
to this User, and click Finish.

IaaS Administrator and Tenant Administrator roles are selected by default.

7 Navigate to Infrastructure > Endpoints > Fabric Groups to assign the fabric administrator role to
the svc-vrops-vra service account.

a On the Fabric Groups page, click SFO Fabric Group.

b On Edit Fabric Group page, enter svc-vrops-vra in Fabric administrators search text box
and click the Search icon.

c Click svc-vrops-vra@rainpole.local in the search result list to assign the Fabric administrator
role to the account, and click OK.

Add a vRealize Automation Adapter to vRealize Operations Manager in Region A

Configure a vRealize Automation adapter in vRealize Operations Manage to collect monitoring data from
vRealize Automation.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.
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3 In the left pane of vRealize Operations Manager, click Solutions.

4 From the solution table on the Solutions page, select VMware vRealize Automation and click
Configure.

The Manage Solution - VMware vRealize Automation dialog box appears.

5 In the Manage Solution - VMware vRealize Automation dialog box, under Instance Settings, enter
the settings for the connection to vRealize Automation.

a Enter the following details for the vRealize Automation front-end portal, and turn on data
collection for the Rainpole tenant.

Setting Value

Display Name vRealize Automation Adapter - vra01svr01 (Rainpole)

Description vRealize Automation - Rainpole Tenant

vRealize Automation Appliance URL https://vra01svr01.rainpole.local
 

b Click the Add icon next to the Credential text box, configure the credentials for the connection to
vRealize Automation, and click OK. 

Credential Value

Credential name vRA Adapter Credentials - vra01svr01

SysAdmin Username administrator@vsphere.local

SysAdmin Password deployment_admin_password

SuperUser Username svc-vrops-vra@rainpole.local

SuperUser Password svc_vrops_vra_password
 

c Click Test Connection to validate the connection to vRealize Automation.

d In the Review and Accept Certificate dialog box, verify the vRealize Automation certificate
information, and click Accept.

e Click OK in the Info dialog box.

f Expand the Advanced Settings section, and verify the following settings.

Advanced Setting Value

Collectors/Groups Default collector group

Tenants rainpole

vRA Endpoint Monitoring Enabled

Auto Discovery true
 

g Click Save Settings.

h Click OK in the Info box that appears.

6 In the Manage Solution - VMware vRealize Automation dialog box, click Close.
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The vRealize Automation Adapter appears on the Solutions page of the vRealize Operations Manager
user interface. The Collection State of the adapter is Collecting and the Collection Status is Data
receiving.

Configure Integration of vRealize Operations Manager with vRealize
Automation for Workload Reclamation in Region A
Connect vRealize Automation to vRealize Operations Manager to collect metrics that vRealize
Automation can use to identify tenant workloads for reclamation in Region A. Such workloads have low
use of CPU, memory use, or disk space.

Procedure

1 Configure User Privileges on vRealize Operations Manager for Tenant Workload Reclamation in
Region A

Configure read-only privileges for the svc-vra-vrops@rainpole.local service account on vRealize
Operations Manager. You configure these privileges so that vRealize Automation can pull metrics
from vRealize Operations Manager for reclamation of tenant workloads in Region A.

2 Add vRealize Operations Manager as a Metrics Provider in vRealize Automation in Region A

Integrate vRealize Automation with vRealize Operations Manager to pull metrics for the reclamation
of tenant workloads.

Configure User Privileges on vRealize Operations Manager for Tenant Workload Reclamation
in Region A

Configure read-only privileges for the svc-vra-vrops@rainpole.local service account on vRealize
Operations Manager. You configure these privileges so that vRealize Automation can pull metrics from
vRealize Operations Manager for reclamation of tenant workloads in Region A.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, expand Access, and click Access Control.

4 On the Access Control page, click the User Accounts tab and click the Import Users icon.

5 On the Import Users page, import the svc-vra-vrops@rainpole.local service account.

a From the Import From drop-down menu, select RAINPOLE.LOCAL.

b Select the Basic option for the search query.
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c In the Search String text box, enter svc-vra-vrops and click Search.

The search results contain the svc-vra-vrops user account.

d Select svc-vra-vrops@rainpole.local and click Next.

6 On the Assign Groups and Permissions page, to assign the ReadOnly role to the svc-vra-
vrops@rainpole.local service account, click the Objects tab, configure the following settings, and
click Finish.

Setting Value

Select Role ReadOnly

Assign this role to the user Selected

Select Object vCenter Adapter > vCenter Adapter - sfo01w01vc01

Add vRealize Operations Manager as a Metrics Provider in vRealize Automation in Region A

Integrate vRealize Automation with vRealize Operations Manager to pull metrics for the reclamation of
tenant workloads.

Procedure

1 Log in to the vRealize Automation Rainpole portal.

a Open a Web browser and go to https://vra01svr01.rainpole.local/vcac/org/rainpole.

b Log in using the following credentials.

Setting Value

User name vra-admin-rainpole

Password vra-admin-rainpole_password

Domain rainpole.local

2 Navigate to Administration > Reclamation > Metrics Provider.

3 On the Metrics Provider page, configure the vRealize Operations Manager settings.

a Select vRealize Operations Manager endpoint.

b Configure the following settings for vRealize Operations Manager.

Setting Value

URL https://vrops01svr01.rainpole.local/suite-api/

Username svc-vra-vrops@rainpole.local

Password svc-vra-vrops_password

c Click Test Connection, verify that the test connection is successful, and click Save.

d In the certificate warning message box, click OK.

The vSphere metrics provider updated successfully message appears.
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Configure vRealize Business Adapter in vRealize Operations
Manager in Region A
Configure a vRealize Business for Cloud adapter to collect monitoring data from vRealize Business for
Cloud in vRealize Operations Manager.

Procedure

1 Log in to vRealize Operations Manager by using the operations interface.

a Open a Web browser and go to https://vrops01svr01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password
 

2 On the main navigation bar, click Administration.

3 In the left pane of vRealize Operations Manager, click Solutions.

4 From the solution table on the Solutions page, select VMware vRealize Business for Cloud
solution, and click Configure.

5 In the Manage Solution - VMware vRealize Business for Cloud dialog box, under Instance
Settings, enter the following settings for the connection to vRealize Business for Cloud.

a Enter the following settings for the vRealize Business for Cloud server.

Setting Value for vRealize Business for Cloud Server

Display Name vRealize Business Adapter - vrb01svr01

Description vRealize Business for Cloud Server

vRealize Business for Cloud server vrb01svr01.rainpole.local
 

b Click Test Connection to validate the connection to the vRealize Business server instance.

c In the Info dialog box, click OK.

d Expand the Advanced Settings section.

e From the Collectors/Groups drop-down menu, verify that Default collector group is selected
and click Save Settings.

f In the Info dialog box, click OK.

6 In the Manage Solution - VMware vRealize Business for Cloud dialog box, click Close.

The vRBC Adapter appears on the Solutions page of the vRealize Operations Manager user
interface. The Collection State of the adapter is Collecting and the Collection Status is Data
receiving.
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Connect vRealize Log Insight to vRealize Automation in Region A
Connect vRealize Log to vRealize Automation to receive log information from all components of vRealize
Automation in the vRealize Log Insight user interface. 

Procedure

1 Install the vRealize Log Insight Content Packs for the Cloud Management Platform in Region A

Install the content packs for vRealize Automation, vRealize Orchestrator, and Microsoft SQL Server
to add the dashboards for viewing log information about the Cloud Management Platform in vRealize
Log Insight.

2 Install vRealize Log Insight Windows Agents in Region A

Install the vRealize Log Insight agent on the Windows virtual machines for the Distributed Execution
Manager, IaaS Manager Service, IaaS Web Server, IaaS SQL Server, and the vSphere proxy
agents. The agents forward log data to vRealize Log Insight that appears in the dashboards for
vRealize Automation.

3 Create Log Insight Agent Groups for vRealize Automation Windows Agents in Region A

Create agent groups for the vRealize Automation IaaS components and for Microsoft SQL Server.
By using the agent groups, you can configure Log Insight Windows Agents centrally from the
vRealize Log Insight user interface.

4 Configure vRealize Log Insight Linux Agents in the vRealize Automation Appliances in Region A

Log in to the VAMI console interface of the primary vRealize Automation appliance and configure the
Log Insight agent. This setting propagates to the other vRealize Automation appliances in the
cluster.

5 Configure the vRealize Log Insight Linux Agents on vRealize Business in Region A

6 Configure vRealize Orchestrator to Forward Log Events to vRealize Log Insight in Region A

You enable the vRealize Log Insight agent and configure the agent group for vRealize Orchestrator
that is embedded in vRealize Automation Appliance to start collecting log data in the vRealize
Orchestrator dashboards.

7 Add the Cloud Management Components to the Agent Group for Management Virtual Appliances in
Region A

After you deploy the Cloud Management Platform and configure the Log Agent agents on its
components, add the virtual appliance of the platform to the agent group for the management virtual
appliances. You use this agent group to configure a collection of logs from the operating system of
the appliances centrally.

Install the vRealize Log Insight Content Packs for the Cloud Management
Platform in Region A
Install the content packs for vRealize Automation, vRealize Orchestrator, and Microsoft SQL Server to
add the dashboards for viewing log information about the Cloud Management Platform in vRealize Log
Insight.
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You install the following content packs:

n vRealize Automation 7.3+ Content Pack

n vRO 7.0.1+ Log Insight Content Pack

n Microsoft SQL Server Content Pack for Log Insight

n VMware vRealize Business for Cloud 7.3+ Content Pack for Log Insight

Procedure

1 Log in to vRealize Suite Lifecycle Manager user interface.

a Open a Web browser and go to https://vrslcm01svr01a.rainpole.local/vrlcm.

b Log in using the following credentials.

Setting Value

User name admin@localhost

Password vrslcm_admin_password

2 Click Marketplace and click VMware Marketplace tab.

Note   You might need to refresh the content if you have not access the Marketplace for a while. To
refresh the content, click Refresh Content from Marketplace icon

3 In the Search text box, enter vRA and press Enter.

4 In the list of content packs, locate the vRealize Automation 7.3+ Content Pack and click Download.
Wait until the download completes.

5 Click the Download tab and locate the vRealize Automation 7.3+ Content Pack.

6 Click the menu icon on the top right of the vRealize Automation 7.3+ Content Pack and select
Install.

7 In the vRealize Automation 7.3 Content Pack window, enter the following settings, and click Install.

Setting Value

Select Datacenter sfo01-m01dc

Select Environment SFO-Region-Env

8 In the New Content Install message, click OK.

9 Repeat the procedure to install the rest of content packs. Use vro, sql, and vrbc as search phrases.

Install vRealize Log Insight Windows Agents in Region A
Install the vRealize Log Insight agent on the Windows virtual machines for the Distributed Execution
Manager, IaaS Manager Service, IaaS Web Server, IaaS SQL Server, and the vSphere proxy agents. The
agents forward log data to vRealize Log Insight that appears in the dashboards for vRealize Automation.
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Procedure

1 Log in to the Windows virtual machines of the vRealize Automation component.

a Open a Remote Desktop Protocol (RDP) connection to each of the following vRealize Automation
virtual machines.

vRealize Automation Component Host Name or VM Name

IaaS Web Server vra01iws01a.rainpole.local

IaaS Web Server vra01iws01b.rainpole.local

IaaS Manager Service and DEM Orchestrator vra01ims01a.rainpole.local

IaaS Manager Service and DEM Orchestrator vra01ims01b.rainpole.local

IaaS DEM Worker vra01dem01a.rainpole.local

IaaS DEM Worker vra01dem01b.rainpole.local

vSphere Proxy Agent sfo01ias01a.sfo01.rainpole.local

vSphere Proxy Agent sfo01ias01b.sfo01.rainpole.local

Microsoft SQL Server vra01mssql01.rainpole.local

b Log in using the following credentials.

Setting Value

User name Rainpole\svc-vra

Password svc-vra-user-password

2 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

3 Click the configuration drop-down menu icon  and select Administration.

4 Under Management, click Agents and click the Download Log Insight Agent Version link..

5 In the Download Log Insight Agent Version dialog box, click Windows MSI (32-bit/64-bit) and
save the .msi file on the vRealize Automation virtual machine.

6 Open an administrative command prompt window, and navigate to the directory to where you saved
the .msi file.

7 Run the following command to install the vRealize Log Insight agent with custom values.

VMware-Log-Insight-Agent-4.6.0-build_number_192.168.31.10.msi SERVERPORT=9000 AUTOUPDATE=yes 

LIAGENT_SSL=no
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8 In the VMware vRealize Log Insight Agent Setup wizard, accept the license agreement and click
Next.

9 With the sfo01vrli01.sfo01.rainpole.local Log Insight host name selected in the Host text box, click
Install and after the installation finishes, click Finish

10 Repeat the steps for the other vRealize Automation virtual machines.

All VMware vRA 7 dashboards become available on the home page of vRealize Log Insight.

Create Log Insight Agent Groups for vRealize Automation Windows Agents
in Region A
Create agent groups for the vRealize Automation IaaS components and for Microsoft SQL Server. By
using the agent groups, you can configure Log Insight Windows Agents centrally from the vRealize Log
Insight user interface.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 Click the configuration drop-down menu icon  and select Administration.

3 Under Management, click Agents.

4 Create an agent group for the IaaS components of vRealize Automation.

a From the drop-down menu at the top, select vRealize Automation 7 - Windows from the
Available Templates section.

b Click Copy Template.

c In the Copy Agent Group dialog box, enter vRA - Windows Agent Group in the name text box
and click Copy.
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d In the agent filter text boxes, use the following selections.

Press Enter to separate the host name values.

Filter Operator Values

Hostname Matches n vra01iws01a.rainpole.local
n vra01iws01b.rainpole.local
n vra01ims01a.rainpole.local
n vra01ims01b.rainpole.local
n vra01dem01a.rainpole.local
n vra01dem01b.rainpole.local
n sfo01ias01a.sfo01.rainpole.local
n sfo01ias01b.sfo01.rainpole.local

e Under Agent Configuration, click Edit.

f Under [filelog|vra-agent-proxy-agent-vsphere], locate directory=C:\Program Files
(x86)\VMware\vCAC\Agents\proxy-agent-vsphere\logs\ and change it to
directory=C:\Program Files (x86)\VMware\vCAC\Agents\VSPHERE-AGENT-01\logs .

g Click Refresh Data and verify that all the agents that are listed in the filter appear in the Agents
list.

h Click Save New Group at the bottom of the page.

5 Create an agent group for the Microsoft SQL Server component that is used by vRealize Automation.

a Click the configuration drop-down menu icon  and select Administration.

b Under Management, click Agents.

c From the drop-down at the top, select Microsoft - SQL Server from the Available Templates
section.

d Click Copy Template.

e In the Copy Agent Group dialog box, enter vRA - SQL Agent Group in the name text box and
click Copy.

f In the agent filter text boxes, use the following selections.

Press Enter to separate the host name values.

Filter Operator Values

Hostname Matches vra01mssql01.rainpole.local

g Under Agent Configuration, click Edit
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h Locate directory=C:\Program Files\Microsoft SQL
Server\MSSQL10.MSSQLSERVER\MSSQL\Log and change it to directory=C:\Program
Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Log

Note   In this VMware Validated Design, Microsoft SQL Server 2012 R2 has been installed in the
default location on the Windows Server virtual machine.

i Click Refresh Data and verify that all the agents listed in the filter appear in the Agents list.

j Click Save New Group at the bottom of the page.

Configure vRealize Log Insight Linux Agents in the vRealize Automation
Appliances in Region A
Log in to the VAMI console interface of the primary vRealize Automation appliance and configure the Log
Insight agent. This setting propagates to the other vRealize Automation appliances in the cluster.

Agent configuration for the vRealize Automation appliances includes the following tasks:
n In the management interface of the vRealize Automation appliances, enable log forwarding to

vRealize Log Insight.

n Create an agent group for configuring log forwarding from the vRealize Automation modules on the
appliances.

n Create an agent group for configuring log forwarding from the operating system of the appliances.

Procedure

1 Log in to the first vRealize Automation appliance.

a Open a Web browser and go to https://vra01svr01a.rainpole.local:5480

b Log in using the following credentials.

Settings Value

User name root

Password deployment_admin_password

2 Configure log forwarding to vRealize Log Insight.

a On the VRA Settings tab, click the Logs tab.

b Scroll down to the Log Insight Agent Configuration section.

c Enter the following values.

Setting Value

Host sfo01vrli01.sfo01.rainpole.local

Port 9000

Protocol CFAPI

SSL Enabled Deselected
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d Scroll down to the Agent Behavior Configuration section and enter the following values.

Setting Value

Reconnect 30

Max Buffer Size 2000

Debug Level No Debug Messages

e Scroll up and click Save Settings

f Log in to the other appliances and verify that these settings have been replicated to the rest of
vRealize Automation appliances

3 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

4 Click the configuration drop-down menu icon  and select Administration.

5 Under Management, click Agents.

6 Create the agent group for vRealize Automation appliances on vRealize Log Insight.

a From the drop-down menu on the top, select vRealize Automation 7 - Linux from the Available
Templates section.

b Click Copy Template at the bottom of the page.

c In the Copy Agent Group dialog box, enter vRA - Appliance Agent Group in the name text
box and click Copy.

d In the agent filter text boxes, enter the following values pressing Enter after each host name.

Filter Operator Values

Hostname Matches n vra01svr01a.rainpole.local
n vra01svr01b.rainpole.local
n vra01svr01c.rainpole.local

e Click Refresh Data and verify that all the hosts in the filter appear in the Agents list.

f Click Save New Group at the bottom of the page.

7 To verify the configuration, click the Dashboards tab, under the VMware - vRA 7.3 category click
General - Overview.

The dashboard shows log data from the components of the vRealize Automation Appliances.
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Configure the vRealize Log Insight Linux Agents on vRealize Business in
Region A
vRealize Log Insight Agent comes pre-installed on the vRealize Business virtual appliances.

On each vRealize Business virtual appliance in Region A, configure the agent with the location of the
vRealize Log Insight deployment in the region and update the liagent.ini configuration file.

Procedure

1 Enable Secure Shell (SSH) on the vRealize Business appliances.

a Open a Web browser and go to the following URL.

vRealize Business Node Virtual Appliance Management Interface URL

vRealize Business Server Appliance https://vrb01svr01.rainpole.local:5480

vRealzie Business Data Collector https://sfo01vrbc01.sfo01.rainpole.local:5480

b Log in using the following credentials.

Setting Value

User name root

Password deployment_admin_password

The appliance management interface of the appliance opens.

c Click the Administration tab and click Administration.

d Under the Actions section, verify that the SSH service status is Enabled.

e Repeat the step for the second vRealize Business appliance.

2 Configure the vRealize Log Insight agent in the vRealize Business appliance.

a Open an SSH connection to the vRealize Business appliance using the following settings.

Setting Value

Hostname n vrb01svr01.rainpole.local
n sfo01vrbc01.sfo01.rainpole.local

User name root

Password deployment_admin_password

b Edit the liagent.ini file in a text editor.

For example, run the following command:

vi /var/lib/loginsight-agent/liagent.ini
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c Modify the [server] section to look like the following.

[server]

hostname= sfo01vrli01.sfo01.rainpole.local

proto = cfapi

port = 9000

ssl = no

d Replace all instances of the FQDN_localhost_need_update parameter located after
agent_name with vrb01svr01.rainpole.local, by using the following commands in the vi
editor.

vRealize Business Node vi command

vRealize Business Server
Appliance :%s/FQDN_localhost_need_update/vrb01svr01.rainpole.local/g

vRealize Business Data
Collector :%s/FQDN_localhost_need_update/sfo01vrbc01.sfo01.rainpole.local/g

e Press Escape and type :wq! to save the file.

f Start the Log Insight agent.

/etc/init.d/liagentd start

g Verify that the Log Insight agent is running.

/etc/init.d/liagentd status

h Turn on autorun by default for the Log Insight agent.

chkconfig liagentd on

i Repeat this step to configure the vRealize Business Data Collector at
sfo01vrbc01.sfo01.rainpole.local.

Configure vRealize Orchestrator to Forward Log Events to vRealize Log
Insight in Region A
You enable the vRealize Log Insight agent and configure the agent group for vRealize Orchestrator that is
embedded in vRealize Automation Appliance to start collecting log data in the vRealize Orchestrator
dashboards.
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Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 Enable the vRealize Log Insight agents for vRealize Orchestrator.

a Click the configuration drop-down menu icon  and select Administration.

b Under Management, click Agents.

c From the drop-down menu at the top, select vRealize Orchestrator 7.0.1 from the All Agents
section and click Copy Template.

d In the Copy Agent Group dialog box, enter vRO - Appliance Agent Group in the name text
box and click Copy.

e In the agent filter fields, enter the following values, pressing Enter after each host name, to
determine which agents receive the configuration.

Filter Operator Values

Hostname Matches n vra01svr01a.rainpole.local
n vra01svr01b.rainpole.local
n vra01svr01c.rainpole.local

f Click Refresh Data and verify that in the Agents list vRealize Log Insight receives data from the
agents in the filter.

g Click Save New Group at the bottom of the page.

3 Verify that the vRealize Log Insight server is receiving log events from the vRealize Orchestrator
appliances.

a Click Dashboards, select VMware - Orchestrator - 7.0.1+ from the Navigator menu on the left
side.

b Verify that the Server nodes grouped by hostname widget on the Server overview dashboard
shows the vRealize Orchestrator hosts.
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Add the Cloud Management Components to the Agent Group for
Management Virtual Appliances in Region A
After you deploy the Cloud Management Platform and configure the Log Agent agents on its components,
add the virtual appliance of the platform to the agent group for the management virtual appliances. You
use this agent group to configure a collection of logs from the operating system of the appliances
centrally.

Procedure

1 Log in to the vRealize Log Insight user interface.

a Open a Web browser and go to https://sfo01vrli01.sfo01.rainpole.local.

b Log in using the following credentials.

Setting Value

User name admin

Password deployment_admin_password

2 Click the configuration drop-down menu icon , select Administration and under Management,
click Agents

3 In the All Agents drop-down menu, select VA - Linux Agent Group from the Active Groups section.

4 In the agent filter text boxes, add the host names of the vRealize Automation and vRealize Business
appliances to the list of management virtual appliances in the region, pressing Enter after each host
name.

Filter Operator Values

Hostname Matches n vrops01svr01a.rainpole.local
n vrops01svr01b.rainpole.local
n vrops01svr01c.rainpole.local
n sfo01vropsc01a.sfo01.rainpole.local
n sfo01vropsc01b.sfo01.rainpole.local
n vrslcm01svr01a.rainpole.local
n vra01svr01a.rainpole.local

n vra01svr01b.rainpole.local

n vra01svr01c.rainpole.local

n vrb01svr01.rainpole.local

n sfo01vrbc01.sfo01.rainpole.local

5 Click Refresh Data and verify that all the agents listed in the filter appear in the Agents list.

6 Click Save New Group at the bottom of the page.
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Post-Deployment Operations
Implementation in Region A 5
You perform post-deployment tasks to ensure each product deployed by vRealize Suite Lifecycle
Manager has unique passwords for its root and administrative accounts.

Remove the environments from vRealize Suite Lifecycle Manager, change the passwords for the root and
administrative accounts for each instance, and recreate the product environments in vRealize Suite
Lifecycle Manager with the updated password configuration.

Important   In this validated design, vRealize Suite products deployed by vRealize Suite Lifecycle
Manager such as vRealize Automation, vRealize Operations Manager, vRealize Log Insight, and vRealize
Business span across SDDC regions. For configuration parity between regions and environment setup
within vRealize Suite Lifecycle Manager according to design objectives, you perform the post-deployment
tasks after you complete the deployment of the vRealize Suite products in Region B.

To complete the post-deployment operations, see Post-Deployment Operations Implementation in Region
B.
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